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Р У К О В О Д С Т В О  П О  Ч Т Е Н И Ю

Как читать это руководство

Каждый раздел руководства построен по единой схеме. Слева находятся пути 
управления и технические детали, а справа, в тёплой боковой колонке, всегда 
даётся простое объяснение. Маленькие значки в начале строки одним взглядом 
подсказывают, какого рода информация последует далее.

Ч Е Т Ы Р Е  З Н АЧ К А

Где я это найду? Конкретный путь по щелчкам в приложении — строка 
меню, секция Инспектора или шаг режима новичка. Здесь же приводятся 
соответствующие клавиатурные сокращения. Значок представляет собой 
булавку на карте и показывает: вот в каком месте пользовательского интер
фейса находится данная функция.

Подробности. Значения по умолчанию, диапазоны значений и пути к коду. 
Это встречается прежде всего в настройках обучения, которые не являются 
пунктом меню, а представляют собой числовые параметры. Значок показы
вает маленькую карточку спецификации.

Технически. Что функция делает внутри, какие параметры на неё влияют, 
на что она реагирует и какие у неё побочные эффекты. Для читателей, 
желающих понять, что происходит за кулисами. Значок представляет собой 
блок ползунков и символически отображает регулировочные ручки под ка
потом.

Простыми словами. Главная мысль, выраженная ясными словами — без 
жаргона, без кода. Прочтите этот раздел сначала, если вам нужно лишь 
быстро узнать, для чего предназначена данная функция и когда она вам 
понадобится. Значок — это речевой пузырь, он означает «вкратце». Эта 
колонка всегда залита тёплым песочным оттенком, чтобы глаз сразу её на
ходил.

Ц В Е ТА  ГЛ А В

У каждой главы свой акцентный цвет, который вы узнаёте по идентификатору (на

пример M1 ) слева рядом с заголовком каждой записи и по маленьким значкам 
перед ним. При перелистывании вы сразу видите, в какой главе сейчас находи
тесь.



1 Меню 2 Инспектор 3 Настройки
4

Вспомогательные 
окна

6 Тренировка

7 Предустановки 8 Экспорты 9 SfM 10 Режим новичка

С О В Е Т Ы  П О  Н А В И ГА Ц И И

Быстрый старт. Если вас интересует только управление, переходите сразу 
к главе 10 — Режим новичка. Это пошаговый вариант из четырёх шагов, не 
требующий никаких предварительных знаний.

Более глубокое погружение. Глава 2 — Инспектор и глава 7 — Предуста­
новки объясняют элементы управления и предустановленные профили каче
ства, которые доступны в Режиме эксперта.

Справочник. Содержание и полнотекстовый поиск по PDF помогут найти 
нужную функцию. Не обязательно читать руководство с начала до конца.



R A D I A N C E K I T

Г Л А В А

Введение — Что вам следует знать

Что такое RadianceKit?

RadianceKit — это нативное приложение для macOS, которое из серии обычных 
фотографий или видео создаёт проходимую 3D-реконструкцию. На вход подаются, 
например, от 50 до 500 снимков, сделанных вокруг объекта, по комнате или над 
пейзажем. На выходе — так называемая сцена Gaussian Splatting — 3D-модель, 
которую можно в реальном времени просматривать на Mac с любого ракурса, 
экспортировать и встраивать на веб-сайты, и которая в основных аспектах выгля
дит фотореалистично.

Приложение полностью работает локально на вашем Mac — никакие изображения 
не загружаются в облако, не требуется ни вход в учётную запись, ни подписка. 
Оно интенсивно использует GPU вашего Mac на Apple Silicon (серия M): полный 
цикл обучения может занимать от двух минут до нескольких часов в зависимости 
от сцены и предустановки. Во время вычислений вы можете спокойно продолжать 
работу на Mac, RadianceKit выполняется в фоновом режиме и сообщит, когда ре
зультат будет готов.

Существует два режима работы: Режим новичка (Simple Mode) проводит вас через 
рабочий процесс Импорт → Выбор предустановки → Тренировка → Экспорт в 
четыре шага. Режим эксперта (Expert Mode) открывает большой Инспектор со все
ми регулировками, окном живого предпросмотра и диагностическими графиками. 
Между режимами можно переключаться в любой момент; данные сцены при этом 
сохраняются.

Что такое Gaussian Splatting?

Gaussian Splatting (часто сокращённо 3DGS или просто Splatting) — это сравни
тельно новый метод фотореалистичного 3D-отображения, представленный в 2023 
году в статье, подготовленной в Граце и INRIA. Идея состоит в следующем: вме
сто того чтобы моделировать сцену как классическую полигональную сетку (тре
угольники) или как воксельную решётку, её собирают из миллионов маленьких, 
мягких 3D-облачков — каждое отдельное облачко представляет собой 3D-распре
деление Гаусса (отсюда и название) со своей позицией, размером, формой, 
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R A D I A N C E K I T Введение — Что вам следует знать

цветом и прозрачностью. Эти облачка обучаются так, чтобы со всех ракурсов 
ваших входных фотографий вместе давать правильное изображение.

На практике это означает, что Gaussian Splatting способен изображать отражения, 
блики, мягкую листву, волосы или занавески так, как классическое 3D-моделиро
вание не может или может, но ценой колоссальных усилий. С другой стороны, 
результат не является редактируемой 3D-моделью в классическом понимании — 
вы не можете просто сдвинуть одну стену или переставить вазу. Это скорее замо­
роженный снимок пространства, по которому вы можете свободно перемещаться. 
Для многих применений — архитектурная визуализация, презентация продукта, 
виртуальные туры, криминалистика, культурное наследие — именно в этом и со
стоит сильная сторона метода.

Чтобы из входных изображений получилась 3D-сцена, нужно два шага. Сначала 
приложение с помощью метода под названием Structure-from-Motion (SfM) вычис
ляет, где находилась ваша камера при каждой фотографии. При этом попутно 
получается грубое облако точек сцены. Затем стартует собственно обучение 
Gaussian Splatting: исходя из этого грубого облака миллионы 3D-облачков поэтап
но распределяются, увеличиваются, уточняются и корректируются по положению и 
цвету, пока со всех входных ракурсов они не дадут подходящее изображение.

Вам не обязательно что-либо знать обо всём этом, чтобы пользоваться 
RadianceKit. Режим новичка полностью скрывает эти шаги. Но если вы хотите 
понять, что означают диагностические числа в режиме эксперта (итерация, loss, 
gaussians, SSIM …) или почему одни сцены получаются красивее других, то ответы 
вы найдёте в последующих главах руководства.
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Г Л А В А

Глава 1 — Строка меню

Строка меню RadianceKit организует все функции, которые не находятся непо
средственно в главном окне или Инспекторе. Это преимущественно действия, за
трагивающие всю сцену (Open, Save, New Project), управляющие обучением (Start, 
Pause, Continue), работающие с viewport (авто-вращение, скриншот, цвет фона) и 
запускающие экспорт в различные 3D- и медиа-форматы. Кроме того, здесь есть 
точки перехода ко всем вспомогательным окнам (User Guide, Pareto Dashboard, 
Holdout Analysis, BayesOpt Console).

Клавиатурные сокращения перечислены справа от каждого пункта меню. Согла
шения: ⌘  — клавиша Command (клавиша Apple), ⇧  — Shift, ⌥  — Option (Alt), а 
⌃  — Control. Пример: ⇧⌘T  означает Shift+Command+T. Все задокументированные 

здесь сокращения дополнительно перечислены в отдельном обзорном окне по 
Help → Keyboard Shortcuts (⌘/​).

Следующие 42 пункта документированы в порядке инвентаря (M1–M42), сгруппи
рованы по родительскому меню, к которому они принадлежат. Все пункты были 
сверены с текущим состоянием кода в (строки 175–477). Пункты не удалялись и не 
заменялись относительно инвентаря; новый пункт меню Edit (Cmd-Z для «Remove 
Image») предоставляется системным фреймворком NSUndoManager и потому не 
появляется в коде RadianceKitApp (см. примечание в конце главы).
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Меню File

Рисунок 1.  Меню File развёрнуто — пункты с M1 по M6

Меню File заменяет стандартный пункт «New Window» от Apple на действия, спе
цифичные для проекта. Оно охватывает загрузку/сохранение сцен, динамический 
список Recent, импорт рабочей области и жёсткий сброс в пустое состояние.

M1 File > Open Scene…

ГД Е

Строка меню → File → Open Scene… (⌘O).

Т Е Х Н И Ч Е С К И

Открывает файловый диалог для форматов: 
бандл RadianceScene , .ply , .splat  и .spz . 
Одиночный выбор, может показывать и файлы, 
и директории (для бандла). После успешного вы
бора путь добавляется в список Recent, и сцена 
загружается асинхронно — предыдущая заменя
ется, а конвейер обучения инициализируется за
груженным состоянием. Файлы PLY/SPZ/Splat чи
таются через соответствующие загрузчики фор
мата; бандл .radiancescene  — это директория 
с манифестом, снимком облака и результатами 
SfM.

П Р О СТ Ы М И  С Л О В А М И

Так вы загружаете уже обучен­
ную сцену обратно в приложе­
ние. Работает с собственным 
форматом RadianceKit, а так­
же со стандартными формата­
ми PLY, SPLAT и SPZ, которые 
производят другие splatting-
программы. Используйте это, 
напр., когда обучили сцену на 
ночь и хотите на следующий 
день продолжить или экспор­
тировать. При открытии теку­
щее состояние в главном окне 
заменяется — так что сначала 
сохраните, если текущая сце­
на ещё вам важна. Путь авто­
матически попадает в «Open 
Recent» (M3), чтобы в следую­
щий раз можно было быстрее к 
нему вернуться.
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M2 File > Save Scene…

ГД Е

Строка меню → File → Save Scene… (⌘S).

Т Е Х Н И Ч Е С К И

Открывает файловый диалог сохранения с ти
пом контента бандл RadianceScene  и предуста
новленным именем scene.radiancescene. Запи
сывает пакет-директорию с manifest.json , се
риализованным облаком Gaussian (PLY-snapshot) 
и дампом результата SfM, чтобы продолжение 
обучения работало и после повторного откры
тия. Пункт деактивирован, пока не существует 
ни одного Gaussian. Сохранение идёт не в путь 
training-logs, а туда, куда указывает save-диалог 
— обычно под ~/​Documents/​.

П Р О СТ Ы М И  С Л О В А М И

Сохраняет вашу текущую сце­
ну как файл (точнее: как 
package-папку, которая выгля­
дит как файл). Только после 
этого вы сможете позднее сно­
ва открыть сцену через «Open 
Scene…» (M1). Пакет содержит 
как облако Gaussian, так и ре­
зультат SfM, поэтому позднее 
можно дописать продолжение 
обучения (M12–M14). Пока вы 
не закончили прогон обучения, 
пункт серый. Имя по умолча­
нию — scene.radiancescene 
— но в Save-диалоге можно 
дать своё имя.

M3 File > Open Recent > [имена сцен]

ГД Е

Строка меню → File → Open Recent → (список).

Т Е Х Н И Ч Е С К И

Динамическое подменю, сгенерированное из 
списка недавно открытых путей (хранятся в на
стройках). Каждый пункт помечен именем файла 
и загружается по щелчку. Если список пуст, 
вместо него появляется деактивированная метка 
«No Recent Scenes». В стиле Apple список дер
жит N последних открытых сцен — ограничение 
применяется при записи в настройки, а не в са
мом построителе меню.

П Р О СТ Ы М И  С Л О В А М И

Здесь видны недавно открытые 
сцены, и можно вернуться к 
ним щелчком, не проходя че­
рез файловый диалог. Если вы 
только что начали, список пуст 
и серый в меню. Каждая откры­
тая через «Open Scene…» (M1) 
сцена автоматически попадает 
в этот список. Если список ста­
новится слишком полным или 
вы хотите очистить его по со­
ображениям приватности, ис­
пользуйте «Clear Recent» (M4).
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M4 File > Open Recent > Clear Recent

ГД Е

Строка меню → File → Open Recent → Clear 
Recent.

Т Е Х Н И Ч Е С К И

Очищает список Recent в настройках. Срабаты
вает немедленно, без диалога подтверждения. 
Пункт появляется в подменю только тогда, когда 
в списке Recent фактически есть записи (нахо
дится ниже разделителя после путей).

П Р О СТ Ы М И  С Л О В А М И

Очищает список недавно от­
крытых сцен. Удобно, если вы 
поигрались с тестовым набо­
ром данных и больше не хоти­
те видеть пути. Сами файлы 
сцен не удаляются — удаля­
ется только ссылка в меню. 
Действие срабатывает немед­
ленно, без подтверждения; за­
тем подменю показывает «No 
Recent Scenes». Пункт появля­
ется только если в списке дей­
ствительно есть сцены — когда 
список пуст, он невидим.

M5 File > Import COLMAP / Metashape Workspace…

ГД Е

Строка меню → File → Import COLMAP / 
Metashape Workspace… (⇧⌘I).

Т Е Х Н И Ч Е С К И

Открывает folder picker. Ожидает папку с рас
кладкой COLMAP-workspace (напр., sparse/​0/​
cameras.{bin,txt} плюс images/​). После выбора 
запускается предварительная проверка рабочей 
области — она определяет три варианта рас
кладки (sparse/​0/​, sparse/​, корень) и является 
ли реконструкция двоичной ( cameras.bin ) или 
в текстовой форме ETH3D ( cameras.txt ). При 
успехе рабочая область импортируется; иначе в 
журнал приложения попадает только предупре
ждение. См. также главу 9 «SfM-бэкенды», Q6 
для полной логики конвейера.

П Р О СТ Ы М И  С Л О В А М И

Если вы используе­
те Metashape, COLMAP, 
RealityCapture или подобное ПО 
для реконструкции камер и 
у вас есть экспорт, загрузите 
папку здесь. RadianceKit тогда 
пропускает этап SfM и сразу 
начинает обучение — что эко­
номит часы на больших сце­
нах. Перетаскивание на глав­
ное окно работает аналогич­
но. Ожидается папка с рас­
кладкой COLMAP (т.е. sparse/​
0/​ с cameras.*  плюс папка 
images/​). Подробнее о поддер­
живаемых раскладках и рабо­
чих процессах — в главе 9 
«SfM-бэкенды».
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M6 File > New Project

ГД Е

Строка меню → File → New Project (⇧⌘N).

Т Е Х Н И Ч Е С К И

Проверяет, есть ли несохранённая работа. Если 
да, перед тем как что-то потерять, появляется 
диалог подтверждения. Если сохранять нечего, 
сброс выполняется немедленно — очищает им
портированные изображения, результат SfM, об
лако Gaussian, состояние обучения и все зави
симые индикаторы UI. Примечание: созданная 
пользователем библиотека предустановок со
храняется, поскольку живёт в настройках прило
жения, а не в состоянии проекта.

П Р О СТ Ы М И  С Л О В А М И

Сбрасывает всё к пустому стар­
ту — как если бы вы толь­
ко что свежо открыли прило­
жение. Если у вас есть несо­
хранённая работа, приложение 
сначала спросит. Используйте 
это, когда хотите начать с ну­
ля с совершенно другой сце­
ной. Импортированные изобра­
жения, результат SfM, облако 
Gaussian и состояние обуче­
ния полностью очищаются. Ва­
ши собственные предустанов­
ки, однако, сохраняются, пото­
му что живут в настройках 
приложения и не относятся к 
сцене.

Меню Mode

Рисунок 2.  Меню Mode с переключателями Simple и Expert Mode

Два простых переключателя между направляемым Simple Mode (wizard-like, 4 
шага) и полным Expert Mode (классическая раскладка Инспектора со всеми эле
ментами управления).
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M7 Mode > Simple Mode

ГД Е

Строка меню → Mode → Simple Mode (⌘1).

Т Е Х Н И Ч Е С К И

Переключает состояние приложения в Simple 
Mode. Главная область приложения затем пока
зывает направляемый рабочий процесс вместо 
раскладки Expert. Состояние режима хранится 
в настройках (см. S1 «Default Mode» в главе 3 
«Настройки»).

П Р О СТ Ы М И  С Л О В А М И

Переключает на пошаговый ва­
риант, где приложение ведёт 
вас через импорт, обработку, 
предпросмотр и экспорт. Ре­
комендуется, если вы только 
начинаете или нужен быст­
рый результат. Большинство 
детальных элементов управле­
ния скрыты — вы работаете 
с разумными значениями по 
умолчанию. Если позднее за­
хочется копать глубже, просто 
переключитесь в Expert Mode 
(M8). Какой режим активен при 
запуске приложения, можно за­
дать в настройках (глава 3, S1).

M8 Mode > Expert Mode

ГД Е

Строка меню → Mode → Expert Mode (⌘2).

Т Е Х Н И Ч Е С К И

Переключает состояние приложения в Expert 
Mode. Это выводит полную раскладку Ин
спектора со всеми секциями (Presets, 
TrainingConfig, Enhancements, Metrics, LossChart, 
ProjectNavigator). В Expert Mode доступны 
все параметры обучения, COLMAP-picker, mid-
compact-переключатели и диагностика. Живой 
предпросмотр тоже работает только в этом ре
жиме.

П Р О СТ Ы М И  С Л О В А М И

Переключает на полный вид 
со всеми элементами управле­
ния. Здесь видны loss-графи­
ки в реальном времени, мож­
но тонко настраивать все па­
раметры и параллельно управ­
лять несколькими сравнитель­
ными конфигурациями через 
предустановки. Рекомендуется, 
если хочется понять, что обу­
чение делает внутри, или если 
хочется целенаправленно экс­
периментировать. Живой пред­
просмотр, COLMAP-picker и ди­
агностика тоже доступны толь­
ко здесь. Если ощущаете пере­
груз, вернитесь к Simple Mode 
через M7 — ваша сцена при 
этом сохраняется.
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Меню Training

Рисунок 3.  Меню Training с подменю Continue — пункты с M9 по M14

Четыре действия вокруг прогона обучения: старт, пауза, отмена, продление на 
фиксированное количество итераций. Все три пункта Continue ограничены IAP (не 
кликабельны в free trial-версии).

M9 Training > Start Training

ГД Е

Строка меню → Training → Start Training (⇧⌘T).

Т Е Х Н И Ч Е С К И

Запускает конвейер обучения асинхронно. Пред
условие: существует результат SfM, и в настоя
щее время не запущен никакой другой конвейер. 
Оба условия блокируют пункт, если не выполне
ны. При запуске считываются текущие значения 
конфигурации, создаётся новый JSONL-лог под ~/​
Documents/​RadianceKit/​Logs/​training_​YYYY-MM-DD_​

HHmmss.jsonl, и в зависимости от выбора стра
тегии берётся классический или MCMC-путь. 
Состояние обучения переключается с «idle» на 
«training».

П Р О СТ Ы М И  С Л О В А М И

Большая зелёная кнопка — по­
сле того как вы импортировали 
фотографии и сделана рекон­
струкция камер, запускается 
собственно обучение Gaussian 
Splatting. Дайте приложению 
поработать; в зависимости от 
предустановки от 1 минуты 
(Quick) до нескольких часов 
(MCMC Quality). Пункт остаёт­
ся серым, пока нет результата 
SfM или пока запущен другой 
конвейер. Каждый прогон так­
же пишет лог в ~/​Documents/​
RadianceKit/​Logs/​, который 
можно позднее проанализиро­
вать через Pareto Dashboard 
(M40).

11 / 235



R A D I A N C E K I T Глава 1 — Строка меню

M10 Training > Pause Training

ГД Е

Строка меню → Training → Pause Training.

Т Е Х Н И Ч Е С К И

Приостанавливает запущенное обучение. Актив
но только тогда, когда состояние обучения — 
«training». Пауза останавливает цикл итераций 
на следующей безопасной точке синхрониза
ции, сохраняет полное состояние GPU (буфе
ры Gaussian, моменты оптимизатора, позицию 
scheduler) и переключается в «paused». Воз
обновление — повторным нажатием (заголовок 
пункта статичен, но приложение переключает 
между Pause/Resume во внутренней логике). По
ставленные на паузу тренировки не переживают 
выход из приложения; в этом случае вместо это
го сохраните сцену и позднее продлите её через 
Continue Training (M12–M14).

П Р О СТ Ы М И  С Л О В А М И

Кратко останавливает обуче­
ние без потери прогресса. 
Удобно, когда компьютер на ко­
роткое время нужен для чего-
то более важного. Щелкните 
снова — продолжит. Не ра­
ботает между перезапусками 
приложения — если действи­
тельно хотите продолжить поз­
же, завершите обучение через 
Cancel (M11), сохраните сцену 
через Save Scene (M2), а затем 
используйте Continue Training 
(M12–M14). Во время паузы GPU 
полностью простаивает; однако 
память остаётся выделенной.

M11 Training > Cancel Training

ГД Е

Строка меню → Training → Cancel Training.

Т Е Х Н И Ч Е С К И

Отменяет запущенное обучение. Активно, когда 
состояние обучения не «idle». Устанавливает 
cancel-флаг в training-движке, который чисто за
вершает цикл итераций на следующей точке 
синхронизации, пишет итоговую summary-запись 
в JSONL-лог и сбрасывает состояние в «idle». 
Обученное к этому моменту облако сохраняется 
(можно сохранить или экспортировать), но по
мечается как «cancelled».

П Р О СТ Ы М И  С Л О В А М И

Окончательно отменяет запу­
щенное обучение. Текущее со­
стояние сохраняется — так что 
если после нескольких тысяч 
итераций у вас уже есть пре­
зентабельный результат, его 
всё ещё можно экспортиро­
вать. Если хотите только крат­
ко прервать, используйте вме­
сто этого Pause (M10). В жур­
нале обучения прогон помеча­
ется как «cancelled», а итого­
вое значение loss всё равно за­
писывается. Отменённую сцену 
можно позднее также продол­
жить через Continue Training 
(M12–M14), пока приложение 
тем временем не было закрыто.
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M12 Training > Continue Training > +5,000 iterations

ГД Е

Строка меню → Training → Continue Training → 
+5,000 iterations.

Т Е Х Н И Ч Е С К И

Продолжает обучение ещё на 5 000 итераций. 
Активно, если завершённый прогон обучения 
возобновляем и полная версия разблокирована. 
Возможность возобновления держится, если су
ществует завершённый прогон обучения и пол
ное состояние оптимизатора всё ещё в памяти. 
При продолжении переносятся моменты Adam 
и LR-scheduler, так что продолжение ведёт се
бя как непрерывный прогон 25K/45K/60K, а не 
как рестарт. JSONL-лог получает новую config-
запись с инкрементной настройкой. Доступно 
только в полной версии.

П Р О СТ Ы М И  С Л О В А М И

Добавляет ещё 5 000 ша­
гов обучения. Используйте это, 
если результат после перво­
го прогона близок, но ещё 
не достаточно резкий. Работа­
ет только в платной полной 
версии. В отличие от полно­
стью нового прогона, состоя­
ние оптимизатора сохраняется, 
так что продолжение ощуща­
ется как непрерывный прогон. 
Если нужно больше 5 000 ша­
гов, сразу переходите к M13 
(+10 000) или M14 (+20 000).

M13 Training > Continue Training > +10,000 iterations

ГД Е

Строка меню → Training → Continue Training → 
+10,000 iterations.

Т Е Х Н И Ч Е С К И

Идентично M12, но с 10 000 дополнительных 
итераций. Те же предусловия, тот же путь LR-
scheduler. Рекомендуется, когда первоначальное 
обучение прогонялось с предустановкой средне
го уровня, и хочется увидеть значительное улуч
шение качества, не перезапуская прогон с нуля.

П Р О СТ Ы М И  С Л О В А М И

Продлевает обучение на 10 000 
шагов — среднее из трёх до­
ступных значений Continue. Хо­
роший выбор, когда первый 
прогон был нормальным, но хо­
чется получить заметно лучше. 
Как у M12 и M14, расписа­
ние learning-rate продолжается 
бесшовно вместо рестарта. До­
ступно только в полной версии.
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M14 Training > Continue Training > +20,000 iterations

ГД Е

Строка меню → Training → Continue Training → 
+20,000 iterations.

Т Е Х Н И Ч Е С К И

Идентично M12 / M13, но с 20 000 допол
нительных итераций. Самый крупный preset-
continue-скачок. Для MCMC-обучения это часто 
то, что делает разницу между «нормально» и 
«benchmark-grade»; для Classic за пределами 
35–40K опыт показывает, что мало что добавля
ется.

П Р О СТ Ы М И  С Л О В А М И

Добавляет 20 000 дополни­
тельных шагов обучения, мак­
симальное значение Continue. 
Используйте это, когда дей­
ствительно хотите выжать по­
следний процент качества. Для 
классического обучения за 
пределами 40 000 шагов это 
часто не приносит много боль­
шего — тогда как для MCMC 
это часто оправдано, потому 
что сходимость там устанав­
ливается медленнее. Ожидайте 
значительного дополнительно­
го времени выполнения в зави­
симости от сцены. Как и M12 и 
M13, этот пункт также доступен 
только в полной версии.

Меню Viewport

Рисунок 4.  Меню Viewport с Edit Mode, элементами управления камерой и подменю 
Background

Управляет 3D-просмотром: Edit Mode для выбора и очистки Gaussian, элементы 
управления камерой (авто-вращение, проигрывание, запись), скриншот, цвет фона 
и сброс.
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M15 Viewport > Enter/Exit Edit Mode

ГД Е

Строка меню → Viewport → Enter Edit Mode (или 
«Exit Edit Mode», в зависимости от состояния). 
⇧⌘E.

Т Е Х Н И Ч Е С К И

Заголовок пункта динамический и показывает 
«Exit Edit Mode» или «Enter Edit Mode» в зави
симости от состояния. При нажатии Edit Mode 
переключается на рендерере viewport. При вы
ходе из Edit Mode текущий выбор также сбрасы
вается. Edit Mode активирует выбор Gaussians 
щелчком, выбор рамкой и удаление помеченных 
Gaussians (см. редакторскую область UI). Деак
тивирован, пока к viewport не подключён ренде
рер.

П Р О СТ Ы М И  С Л О В А М И

Переключает между обычным 
3D-просмотром и режимом ре­
дактирования, в котором мож­
но помечать и удалять отдель­
ные Gaussians (напр., floaters 
или выбросы на фоне). При 
выходе выбор автоматически 
сбрасывается. Пункт остаётся 
серым, пока в viewport не вид­
но сцены. Метка меняется меж­
ду «Enter Edit Mode» и «Exit 
Edit Mode» в зависимости от 
состояния — так всегда понят­
но, в каком режиме вы сейчас 
находитесь.

M16 Viewport > Toggle Auto-Rotation

ГД Е

Строка меню → Viewport → Toggle Auto-Rotation 
(⌘⌥T).

Т Е Х Н И Ч Е С К И

Включает или выключает непрерывное вращение 
камеры viewport вокруг вертикальной оси через 
центр сцены. Ось и скорость берутся из конфи
гурации управления камерой. Авто- вращение — 
чисто viewport-эффект и не влияет ни на обу
чение, ни на запись — если параллельно исполь
зуется turntable- видеорекордер (M18), авто-вра
щение даёт точно ту траекторию, которую захва
тывает рекордер.

П Р О СТ Ы М И  С Л О В А М И

Непрерывно медленно враща­
ет камеру вокруг вашей сцены, 
чтобы можно было видеть её со 
всех сторон, не таская мышью. 
Щёлкните снова, чтобы оста­
новить вращение. Удобно при 
просмотре завершённо обучен­
ных сцен или как фоновая ани­
мация для живой демонстра­
ции. Если параллельно записы­
ваете видео (M18), авто-враще­
ние даёт ровно то движение, 
которое захватывает рекордер.
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M17 Viewport > Toggle Camera Playback

ГД Е

Строка меню → Viewport → Toggle Camera 
Playback.

Т Е Х Н И Ч Е С К И

Переключает воспроизведение пути камеры. Ес
ли существует записанный путь камеры (напр., 
из предыдущей записи или потому что был за
гружен transforms.json ), путь воспроизводится 
— камера viewport больше не движется в ответ 
на ввод мыши/трекпада, а воспроизводит траек
торию покадрово. Повторное нажатие приоста
навливает воспроизведение.

П Р О СТ Ы М И  С Л О В А М И

Воспроизводит ранее запи­
санный или импортированный 
путь камеры. Так можно повто­
рить оригинальный путь, кото­
рый использовался для съёмки 
сцены, или проверить запла­
нированное орбитальное дви­
жение перед экспортом видео. 
Пока идёт воспроизведение, 
ввод мыши и трекпада деакти­
вирован — камера строго сле­
дует пути. Повторный щелчок 
ставит воспроизведение на па­
узу. Если вы не загружали и не 
записывали путь камеры, ниче­
го не происходит.

M18 Viewport > Record Turntable Video

ГД Е

Строка меню → Viewport → Record Turntable 
Video.

Т Е Х Н И Ч Е С К И

Переключает запись viewport. При первом нажа
тии запускается запись кадров во временный 
путь; при втором нажатии запись завершается, 
кодируется и пишется в MP4-путь (путь запраши
вается через save-диалог). В отличие от Export → 
Media → Orbit Video (M31), который выдаёт фик
сированную траекторию 360° с настраиваемой 
длительностью, turntable-рекордер захватывает 
вживую то, что вы видите в viewport — так что 
можно также записать ручное движение камеры.

П Р О СТ Ы М И  С Л О В А М И

Записывает видео напрямую в 
viewport. Вращается ли каме­
ра автоматически или вы сами 
двигаете её мышью — всё, что 
вы видите, сохраняется в MP4-
файл. В отличие от экспорта 
«Orbit Video» (M31), движение 
камеры вы контролируете са­
ми. Первый щелчок запускает 
запись, второй щелчок завер­
шает её и спрашивает, куда со­
хранить. Удобно, когда, напр., 
нужно показать определённый 
детальный pan, который не был 
бы возможен при жёсткой ор­
битальной траектории.
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M19 Viewport > Save Screenshot

ГД Е

Строка меню → Viewport → Save Screenshot 
(⇧⌘S).

Т Е Х Н И Ч Е С К И

Захватывает один кадр viewport на полном раз
решении рендера (т.е. не пиксельную раскладку 
окна, а полное содержимое render-target) как 
PNG-файл. Путь запрашивается через save- диа
лог. Цвет фона (M21–M23) запекается. Настройки 
MetalFX/MPS upscaling из Enhancements (см. I27/
I28) вступают в силу, если активны — скриншот 
тогда показывает увеличенный вывод.

П Р О СТ Ы М И  С Л О В А М И

Сохраняет снимок вашего теку­
щего 3D-вида как PNG-изобра­
жение. Удобно для маркетин­
говых материалов или быст­
рого сравнения. Примечание: 
фон — часть изображения — 
если нужна прозрачность, луч­
ше экспортируйте файл сце­
ны. Разрешение соответствует 
внутреннему render-target, не 
размеру вашего окна — по­
этому изображение часто рез­
че, чем выглядит в окне. Та­
кже применяются любые на­
стройки upscaling (Inspector → 
Enhancements).

M20 Viewport > Copy Camera Info

ГД Е

Строка меню → Viewport → Copy Camera Info.

Т Е Х Н И Ч Е С К И

Считывает текущую позу камеры viewport (пози
ция, look-at-точка, up-вектор) и значения FOV из 
управления камерой и записывает их как много
строчный текст в буфер обмена. Формат челове
ко-читаемый (метка = значение на строку), не 
JSON. Удобно для воспроизведения конкретного 
вида в отладочных целях или передачи в support.

П Р О СТ Ы М И  С Л О В А М И

Копирует текущую позицию ка­
меры и направление взгляда 
как текст в буфер обмена. Ес­
ли хочется, напр., показать кол­
леге-разработчику, где в сцене 
какое-то место выглядит стран­
но, просто вставьте текст в 
письмо или окно чата. Формат 
человеко-читаемый (одна стро­
ка на значение), не JSON. В 
основном предназначено для 
bug-репортов или запросов в 
поддержку.
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M21 Viewport > Background > Dark Gray

ГД Е

Строка меню → Viewport → Background → Dark 
Gray.

Т Е Х Н И Ч Е С К И

Устанавливает цвет фона viewport на тёмно-се
рый (RGB 0.1/0.1/0.1). Рендерер использует этот 
цвет как фон, против которого композитятся 
Gaussians. Цвет по умолчанию при старте прило
жения управляется опцией настроек S3 «Default 
Viewport Background».

П Р О СТ Ы М И  С Л О В А М И

Окрашивает фон 3D viewport 
тёмно-серым. Стандартный вы­
бор для большинства сцен — 
предлагает хороший контраст 
и для светлых, и для тёмных 
Gaussians, не приковывая глаз 
к чисто чёрной или белой обла­
сти. Цвет также запекается в 
скриншоты (M19) и orbit-видео 
(M31). Если Dark Gray ощуща­
ется слишком неэффектно, по­
пробуйте для сравнения также 
Black (M22) или White (M23). 
Какой цвет активен при стар­
те приложения, задаётся в на­
стройках (S3).

M22 Viewport > Background > Black

ГД Е

Строка меню → Viewport → Background → Black.

Т Е Х Н И Ч Е С К И

Устанавливает цвет фона viewport на чистый чёр
ный (RGB 0/0/0). Помогает, когда сцена имеет 
много светлых floaters и хочется их выявить, или 
для маркетинговых материалов с тёмным look-
and-feel.

П Р О СТ Ы М И  С Л О В А М И

Чёрный фон. Хорош для очень 
светлых сцен или когда хочется 
заглянуть в Edit Mode и искать 
маленькие светлые Gaussians 
(floaters), которые теряются на 
сером. Также идеален для мар­
кетинговых материалов с тём­
ным, драматическим видом. 
Цвет запекается в скриншоты и 
orbit-видео — если нужна про­
зрачность для последующего 
композита, чёрный — худший 
выбор. Для тёмных floaters пе­
реключитесь в обратную сторо­
ну на White (M23).
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M23 Viewport > Background > White

ГД Е

Строка меню → Viewport → Background → White.

Т Е Х Н И Ч Е С К И

Устанавливает цвет фона viewport на чистый бе
лый (RGB 1/1/1). Полезен, когда сцена имеет пре
имущественно тёмный контент и хочется видеть 
тёмные floaters (типичные уличные фоновые шу
мы).

П Р О СТ Ы М И  С Л О В А М И

Белый фон. Удобен, когда субъ­
ект лучше виден light- on-dark, 
или для нахождения тёмных 
выбросов, которые потом мож­
но удалить в Edit Mode (M15). 
Для уличных сцен белый ча­
сто полезнее чёрного, потому 
что типичные уличные floaters 
обычно тёмные. Как и с дру­
гими фоновыми опциями, цвет 
запекается в скриншоты и ви­
део.

M24 Viewport > Reset Camera

ГД Е

Строка меню → Viewport → Reset Camera.

Т Е Х Н И Ч Е С К И

Сбрасывает камеру viewport, покидает вид тре
нировочной камеры и останавливает авто-вра
щение. Камера возвращается в начальную пози
цию (обычно: перед сценой, чуть сверху), авто-
вращение выключено, и если рендерер показы
вал тренировочную камеру (одну из поз SfM), 
возвращается к свободной камере.

П Р О СТ Ы М И  С Л О В А М И

Возвращает камеру viewport в 
начальную позицию. Если вы 
потерялись при движении или 
вытолкнули сцену из кадра — 
щёлкните здесь один раз, и 
снова видно то, что вы должны 
видеть. Одновременно выклю­
чает авто-вращение, если оно 
сейчас работает, и возвращает­
ся от замороженной трениро­
вочной камеры к свободному 
виду. Так в любом случае полу­
чается чистый рестарт обзора.
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Меню Export

Рисунок 5.  Меню Export с тремя группами подменю — 3D Formats, Media и 
Photogrammetry

Восемь целей экспорта плюс два photogrammetry-экспорта, сгруппированные в 
три секции (3D Formats, Media, Photogrammetry). Первые шесть строятся через 
общую вспомогательную процедуру, каждая из которых открывает save-диалог 
и регистрирует экспорт в каталоге форматов. Photogrammetry-пункты имеют ин
дивидуальную логику. Все photogrammetry-экспорты и некоторые 3D-экспорты 
доступны только в полной версии.

M25 Export > 3D Formats > Export PLY…

ГД Е

Строка меню → Export → 3D Formats → PLY (⌘E).

Т Е Х Н И Ч Е С К И

Открывает save-диалог с именем по умолча
нию gaussians.ply . По OK текущее облако 
Gaussian пишется в стандартизированный ASCII/
binary PLY-формат — совместим с SuperSplat, 
PolyCam, PlayCanvas и всеми распространённы
ми 3DGS-просмотрщиками. Полные SH-коэффи
циенты, полная точность (Float32 на поле). Раз
мер файла часто несколько сотен МБ при ≥ 500K 
Gaussians.

П Р О СТ Ы М И  С Л О В А М И

Сохраняет вашу 3D-сцену как 
стандартный PLY-файл. Это са­
мый универсальный формат — 
почти любое ПО умеет его 
загружать, от SuperSplat до 
PolyCam и PlayCanvas. Файлы, 
однако, становятся большими, 
часто несколько сотен мега­
байт. Используйте PLY, когда 
хотите продолжать работу в 
полном качестве или архиви­
ровать. Если хотите делиться 
сценой в сети, посмотрите вме­
сто этого на SPZ (M27) или 
Compressed PLY (M26) — они 
существенно меньше.
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M26 Export > 3D Formats > Export Compressed PLY…

ГД Е

Строка меню → Export → 3D Formats → 
Compressed PLY.

Т Е Х Н И Ч Е С К И

Пишет облако Gaussian в формат compressed-
PLY с собственным квантованием полей пози
ции, масштаба, поворота и SH. Файлы в 5–10 
раз меньше несжатого PLY (M25) с минималь
ной визуальной потерей. Совместим с SuperSplat 
(который читает стандарт compressed-PLY) и 
PlayCanvas. Имя по умолчанию gaussians_​
compressed.ply.

П Р О СТ Ы М И  С Л О В А М И

Как обычный PLY, но в 5–10 
раз меньше. Качество остаётся 
почти таким же. Используйте 
это, когда хотите поделиться 
файлом онлайн или отправить 
по почте. Работает напрямую с 
SuperSplat и PlayCanvas. Если 
целевая система требует ещё 
меньших файлов (мобильные, 
браузерные демо), используй­
те вместо этого SPZ (M27) — 
он сжат ещё более агрессивно. 
Для полного качества редакти­
рования используйте несжатый 
PLY (M25).

M27 Export > 3D Formats > Export SPZ…

ГД Е

Строка меню → Export → 3D Formats → SPZ.

Т Е Х Н И Ч Е С К И

Пишет облако Gaussian в SPZ-формат — сжатый 
splat-формат, опубликованный Niantic, с агрес
сивным квантованием (~90 % меньше, чем 
несжатый PLY). В основном оптимизирован для 
веб-просмотрщиков и мобильных приложений. 
Совместим с Niantic Splatt3R, gsplat.js и браузер
ным просмотрщиком Niantic.

П Р О СТ Ы М И  С Л О В А М И

Один из самых маленьких фор­
матов. Примерно в 10× меньше 
обычного PLY. Используйте это 
в основном, когда хотите пока­
зать сцену в браузере или про­
сматривать в приложении те­
лефона. Для максимального ка­
чества PLY — лучший выбор. 
SPZ был разработан Niantic и 
работает напрямую с gsplat.js, 
Splatt3R и веб-просмотрщиком 
Niantic. Из-за сильного сжа­
тия SPZ-файлы больше нель­
зя легко продолжать обучать 
— для редактирования исполь­
зуйте PLY.
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M28 Export > 3D Formats > Export glTF…

ГД Е

Строка меню → Export → 3D Formats → glTF.

Т Е Х Н И Ч Е С К И

Пишет .glb -файл (binary glTF) с расширени
ем KHR_gaussian_splatting. Стандарт-конформен, 
подходит для конвейеров, использующих glTF-
движки вроде Babylon.js или Three.js и реализую
щих расширение KHR_gaussian_splatting.

П Р О СТ Ы М И  С Л О В А М И

Сохраняет сцену в форма­
те glTF, который понимают 
многие 3D-программы и веб-
движки — при условии, что 
они поддерживают расшире­
ние Gaussian-Splatting. Если у 
вас есть специфический 3D-
конвейер (напр., Three.js или 
Babylon.js), который его пони­
мает, это ваш формат. Файл вы­
ходит как двоичный .glb  — 
единый пакет, содержащий всё. 
Для классических splatting-ра­
бочих процессов обычно луч­
ший выбор — PLY или SPZ, по­
скольку их понимают больше 
инструментов.

M29 Export > 3D Formats > Export .splat…

ГД Е

Строка меню → Export → 3D Formats → .splat.

Т Е Х Н И Ч Е С К И

Пишет формат Antimatter15 .splat  — фикси
рованные 32 байта на Gaussian (позиция как 
3× Float32, масштаб как 3× Float32, пово
рот как 4× Uint8-нормализованный кватернион, 
RGB+opacity как 4× Uint8). Никаких SH-коэффи
циентов выше DC. Наименьший файл с прямой 
совместимостью с браузером. Для gsplat.js и он
лайн-демо-просмотрщика antimatter15.

П Р О СТ Ы М И  С Л О В А М И

Простейший формат веб-про­
смотрщика. Маленький и сра­
зу отображаемый в любом бра­
узере. Но теряет детальное 
освещение (высшие SH-коэф­
фициенты теряются — splat вы­
глядит одинаково с любого уг­
ла, вместо того чтобы реаги­
ровать на свет). Хорош для 
максимальной производитель­
ности в вебе, но для фотореа­
лизма лучше SPZ или PLY. Рабо­
тает с онлайн- просмотрщиком 
antimatter15 и gsplat.js. Каж­
дый Gaussian занимает фикси­
рованные 32 байта, что делает 
формат простым и совмести­
мым — но ценой глубины дета­
лизации.

22 / 235



R A D I A N C E K I T Глава 1 — Строка меню

M30 Export > 3D Formats > Export SOG…

ГД Е

Строка меню → Export → 3D Formats → SOG.

Т Е Х Н И Ч Е С К И

Пишет облако Gaussian в формат SOG. 
SOG («Self- Organizing Gaussian») — формат 
PlayCanvas с texture-atlas- раскладкой и WebP-
сжатием квантованных данных. Масштабируется 
с соотношением размеров в 15–20× лучше, чем 
PLY. Экспорт внутри вызывает cwebp  как внеш
ний инструмент — так что в sandbox-варианте 
(App Store) потенциально ограничен.

П Р О СТ Ы М И  С Л О В А М И

Очень маленький формат для 
PlayCanvas-рабочих процессов. 
Примерно в 15–20 раз меньше 
PLY, потому что данные упако­
ваны в texture-atlas-раскладку 
и сжаты WebP. Если у вас нет 
PlayCanvas-рабочего процесса, 
обычно лучший выбор — SPZ 
или Compressed PLY. Экспорт 
внутри вызывает cwebp  как 
внешний инструмент — в вер­
сии для App Store (sandbox) 
этот шаг может быть ограни­
чен.

M31 Export > Media > Export Orbit Video…

ГД Е

Строка меню → Export → Media → Orbit Video.

Т Е Х Н И Ч Е С К И

Рендерит орбиту 360° вокруг центра сцены и 
кодирует её как MP4 (H.264) или MOV (HEVC, в 
зависимости от системного дефолта). В отличие 
от M18 (живая запись), траектория здесь фикси
рованная — длительность выбирается в настрой
ках или на шаге экспорта Simple Mode.

П Р О СТ Ы М И  С Л О В А М И

Автоматически производит ви­
део разворота вашей сцены. Не 
нужно ручного движения. Хо­
рошо для соцсетей или быстро­
го демо. Если хочется контро­
лировать камеру самому, ис­
пользуйте вместо этого Record 
Turntable Video (M18). Траекто­
рия фиксирована: полная орби­
та 360° вокруг центра сцены; 
длительность выбирается в на­
стройках или на шаге экспорта 
Simple Mode. Видео выводится 
как H.264 MP4 или HEVC MOV в 
зависимости от системы.
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M32 Export > Media > Export Web Viewer…

ГД Е

Строка меню → Export → Media → Web Viewer.

Т Е Х Н И Ч Е С К И

Упаковывает автономный HTML-просмотрщик 
(на основе gsplat.js) плюс данные Gaussian, зако
дированные в Base64, в единый .html -файл. 
Этот файл работает оффлайн в любом совре
менном браузере — никаких серверных зависи
мостей, никаких внешних URL. Размер файла 
примерно в 1.3 раза больше SPZ-варианта (из-за 
overhead Base64).

П Р О СТ Ы М И  С Л О В А М И

Сохраняет вашу сцену как са­
мозапускающуюся веб-страни­
цу. Двойной щелчок по HTML-
файлу → браузер открывает­
ся → готовая интерактивная 
3D-сцена. Работает без интер­
нета, можно отправить по по­
чте, простейший способ поде­
литься результатом с друзьями 
или клиентами. Файл содержит 
полный просмотрщик gsplat.js 
и данные Gaussian в одном 
документе — ничего не загру­
жается из сети. Размер фай­
ла примерно на треть больше, 
чем у SPZ-экспорта, но взамен 
получателю не нужно дополни­
тельное ПО.

M33 Export > Photogrammetry > Export SfM (transforms.json)…

ГД Е

Строка меню → Export → Photogrammetry → 
Export SfM (transforms.json).

Т Е Х Н И Ч Е С К И

Выделенный путь экспорта (не через общую 
вспомогательную процедуру), потому что экс
портируется не облако Gaussian, а результат 
SfM. Открывает save-диалог с transforms.json  
как значением по умолчанию и типом контента 
json . По OK пишется совместимый с nerfstudio 
transforms.json  с intrinsics камер, позами (как 

матрица 4×4 в соглашении NeRF) и путями кад
ров. Help-текст в UI указывает, что тренировоч
ные изображения должны быть скопированы ря
дом как соседняя папка images/​. Активно только 
если существует результат SfM и полная версия 
разблокирована.

П Р О СТ Ы М И  С Л О В А М И

Если хотите использовать ре­
зультат SfM в другой програм­
ме вроде nerfstudio, Brush, 
gsplat или OpenSplat, здесь 
вы экспортируете позиции ка­
мер. Поместите ваши трениро­
вочные изображения дополни­
тельно в папку images/​ рядом 
с файлом transforms.json  
— иначе целевая программа 
не сможет сопоставить изобра­
жения. Пункт серый, пока нет 
результата SfM, и заблокирован 
в free trial-версии. Для рабоче­
го процесса COLMAP-workspace 
используйте вместо этого M34.
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M34 Export > Photogrammetry > Export SfM (COLMAP Workspace)…

ГД Е

Строка меню → Export → Photogrammetry → 
Export SfM (COLMAP Workspace).

Т Е Х Н И Ч Е С К И

Открывает save-диалог с именем по умолчанию 
colmap-workspace  (без расширения, потому что 

это папка). Пишет стандартную рабочую область 
COLMAP с sparse/​0/​cameras.bin, images.bin , 
points3D.bin . Позволяет открыть SfM-рекон

струкцию, рассчитанную или импортированную 
в RadianceKit, в других инструментах вроде 
Postshot, Nerfstudio или Meshroom, либо для A/B-
reрана перезагрузить её как уже рассчитанный 
ввод в самом RadianceKit (через M5) — экономит 
время вычислений. Активно только если суще
ствует результат SfM и полная версия разблоки
рована.

П Р О СТ Ы М И  С Л О В А М И

Как M33, но в формате COLMAP 
вместо nerfstudio. Если вы ис­
пользуете Postshot, Meshroom, 
Nerfstudio или другой инстру­
мент с COLMAP-рабочим про­
цессом, это ваш экспорт. Удоб­
ный побочный эффект: вы 
можете позднее перезагру­
зить эту папку через M5 в 
RadianceKit и сэкономить вре­
мя вычислений SfM на следу­
ющем прогоне — особенно на 
больших сценах экономия ча­
сов. Как и M33, доступно только 
если существует результат SfM, 
и заблокировано в free trial-
версии.

Меню Help

Рисунок 6.  Меню Help с пунктами документации, папок и анализа

Семь пунктов: два окна документации (User Guide, Keyboard Shortcuts), три ярлы
ка папок (Training Logs, Exports, Storage) и три окна анализа (Pareto Dashboard, 
Holdout Analysis, BayesOpt Console). В стиле Apple меню Help появляется в самом 
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правом углу. Стандартное меню Help полностью заменено собственным вариан
том RadianceKit.

M35 Help > User Guide

ГД Е

Строка меню → Help → User Guide (⌘?).

Т Е Х Н И Ч Е С К И

Открывает окно User Guide. Оно показывает на
вигацию с боковой панелью тем и прокручивае
мую детальную область при размере по умолча
нию 860×640. Содержимое статически встроено 
(не парсится из Markdown).

П Р О СТ Ы М И  С Л О В А М И

Открывает внутриприложенче­
ское руководство. Если не хо­
чется читать всё в этом мануа­
ле, ключевые шаги вы найдёте 
прямо в программе. Руковод­
ство построено как отдельное 
окно с боковой панелью тем — 
так что можно прыгать прямо 
к отдельным темам. Содержи­
мое короче, чем этот мануал, 
и сфокусировано на самых рас­
пространённых рабочих про­
цессах.

M36 Help > Keyboard Shortcuts

ГД Е

Строка меню → Help → Keyboard Shortcuts (⌘/).

Т Е Х Н И Ч Е С К И

Открывает окно Keyboard Shortcuts — про
стая прокручиваемая раскладка со всеми со
кращениями приложения, сгруппированными по 
родительскому меню. Размер по умолчанию 
440×560. Содержимое также статически встрое
но.

П Р О СТ Ы М И  С Л О В А М И

Открывает окно с полным спис­
ком всех клавиатурных сокра­
щений. Если не можете вспом­
нить, напр., какая клавиша за­
пускает обучение, посмотрите 
там. Сводка также есть в кон­
це этой главы. Список сгруппи­
рован по родительскому меню, 
так что вы быстро прыгаете в 
нужную область. Полезно при 
переходе со стиля работы мы­
шью на стиль работы клавиату­
рой.
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M37 Help > Open Training Logs…

ГД Е

Строка меню → Help → Open Training Logs… 
(⇧⌘L).

Т Е Х Н И Ч Е С К И

Вычисляет папку логов как ~/​Documents/​
RadianceKit/​Logs, создаёт её при необходимости 
и открывает в Finder. Каждый прогон обучения 
пишет туда свой JSONL-файл training_​YYYY-MM-
DD_​HHmmss.jsonl.

П Р О СТ Ы М И  С Л О В А М И

Открывает в Finder папку со 
всеми предыдущими протоко­
лами обучения. Если что-то 
пошло не так или хочется по­
смотреть, когда именно обуче­
ние сошлось к какому значе­
нию, вы найдёте это здесь в 
JSONL-файлах. На каждый про­
гон обучения создаётся ровно 
один файл с timestamp — его 
также можно скормить другим 
инструментам или отправить в 
support по почте. Если хочет­
ся графический анализ, луч­
шая стартовая точка — Pareto 
Dashboard (M40).

M38 Help > Open Exports Folder…

ГД Е

Строка меню → Help → Open Exports Folder…

Т Е Х Н И Ч Е С К И

Аналогично M37, но с ~/​Documents/​RadianceKit/​
Exports. Создаётся при первом auto-test-прогоне 
или при первом щелчке; после этого туда попа
дают пути по умолчанию всех auto-test- экспор
тов (напр., autotest_​<timestamp>.ply). Экспорты, 
выбранные вручную через save-диалог, НЕ обя
зательно идут сюда, а туда, куда сохраняет поль
зователь — так что эта папка интересна в основ
ном для auto-тестов.

П Р О СТ Ы М И  С Л О В А М И

Открывает папку, куда прило­
жение кладёт собственные экс­
порты (особенно auto-test-про­
гоны). Если вы вручную через 
save-диалог разместили экс­
порт где-то ещё, он там, а не 
в этой папке. Удобно для убор­
ки или для проверки, сколь­
ко места занимают предыду­
щие test-экспорты. Если хоти­
те полный обзор, включая ло­
ги и scene-bundles, используй­
те вместо этого Manage Storage 
(M39).
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M39 Help > Manage Storage…

ГД Е

Строка меню → Help → Manage Storage…

Т Е Х Н И Ч Е С К И

Открывает storage browser (см. главу 4 Вспомо
гательные окна, ID W7–W12). Перечисляет все 
сохранённые сцены, training-логи, экспорты и 
кеши в папке ~/​Documents/​RadianceKit/​ с разме
ром, позволяет reveal в Finder и перемещение в 
корзину на запись.

П Р О СТ Ы М И  С Л О В А М И

Открывает оконный браузер, 
который показывает, сколько 
дискового пространства зани­
мает RadianceKit — на сцену, 
лог и экспорт. Можно удалять 
отдельные элементы напря­
мую, не заходя в Finder. Удоб­
но после продолжительного ис­
пользования, когда диск запол­
няется — предыдущие логи и 
auto-test- экспорты могут скла­
дываться в несколько гигабайт. 
Через reveal в Finder вы в лю­
бое время попадаете и в клас­
сический вид.

M40 Help > Pareto Dashboard…

ГД Е

Строка меню → Help → Pareto Dashboard… 
(⇧⌘D).

Т Е Х Н И Ч Е С К И

Открывает Pareto Dashboard (см. главу 4, ID W13–
W22). Dashboard загружает все JSONL training-
логи из ~/​Documents/​RadianceKit/​Logs/​, органи
зует их по сценам и предустановкам и ри
сует Pareto-точечный график (по умолчанию: 
loss против Gaussians, опционально loss против 
wallclock или PSNR против итераций).

П Р О СТ Ы М И  С Л О В А М И

Открывает обзор всех преды­
дущих прогонов обучения как 
диаграмму. Сразу видно, ка­
кой прогон выдал лучший ба­
ланс качества и размера. Удоб­
но, когда хочется сравнить раз­
ные предустановки. По умол­
чанию график показывает loss 
против числа Gaussians — но 
можно также переключиться 
на wallclock- время или PSNR. 
Данные приходят из JSONL 
training-логов (M37); чем боль­
ше у вас прогонов, тем содер­
жательнее анализ.
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M41 Help > Holdout Analysis…

ГД Е

Строка меню → Help → Holdout Analysis… (⇧⌘H).

Т Е Х Н И Ч Е С К И

Открывает окно Holdout Analysis (см. главу 4, ID 
W23–W29). Загружает transforms.json , рисует 
камеры как 3D-глобус и позволяет разбиения 
train/test по фолдам (угловые или линейные, 2–8 
фолдов). Вывод — fold-assignment.json, который 
обучение может использовать как тестовый на
бор в соответствующих конфигурациях обучения.

П Р О СТ Ы М И  С Л О В А М И

Помогает разделить ваши за­
хваты камер на тренировочный 
и тестовый наборы — чтобы 
объективно измерить, насколь­
ко хороша ваша сцена (на изоб­
ражениях, которые обучение 
никогда не видело). Скорее ис­
следовательский и бенчмарк- 
инструмент. Камеры показыва­
ются как 3D-глобус; можно вы­
бирать между 2 и 8 фолдами, 
равномерно по углу или линей­
но по порядку. Результат — 
маленький JSON-файл, который 
обучение затем использует как 
тестовый набор.

M42 Help > BayesOpt Console…

ГД Е

Строка меню → Help → BayesOpt Console… 
(⇧⌘B).

Т Е Х Н И Ч Е С К И

Открывает BayesOpt Console (см. главу 4, ID 
W30–W39). Загружает предопределённые поис
ковые пространства (напр., «MCMC scale-reg + 
opacity-reg + ssim»), запускает trials байесовской 
оптимизации асинхронно и показывает кривую 
сходимости и trial-лог вживую.

П Р О СТ Ы М И  С Л О В А М И

Встроенная консоль авто-тю­
нинга. Вместо того чтобы вруч­
ную пробовать разные пара­
метры, приложение может ра­
ботать само на ночь и в конце 
предложить лучшие значения 
для вашей сцены. Очень про­
двинутый инструмент — для 
большинства рабочих процес­
сов достаточно хорошей пред­
установки (см. главу 7). Вы вы­
бираете предопределённое по­
исковое пространство (напр., 
«MCMC scale-reg + opacity-reg 
+ ssim») и видите вживую 
кривую сходимости и trial-лог. 
Планируйте от нескольких ча­
сов до дней в зависимости от 
настройки.

Примечание: Cmd-Z в меню Edit

С мая 2026 года Project Navigator в Expert Mode поддерживает удаление импор
тированных изображений через кнопку минус или клавишу Backspace и отмену 
через Cmd-Z . Это действие Cmd-Z появляется в системном меню Edit macOS 
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(предоставленном SwiftUI) как «Undo Remove Image», пока удалённое изображе
ние всё ещё восстановимо. Оно зарегистрировано через стандарт-конформную 
систему, не в ; поэтому в инвентаре нет выделенной записи с M-ID.

Обзор клавиатурных сокращений

Пункт меню Сокращение

File > Open Scene… ⌘O

File > Save Scene… ⌘S

File > Import COLMAP / Metashape Workspace… ⇧⌘I

File > New Project ⇧⌘N

Mode > Simple Mode ⌘1

Mode > Expert Mode ⌘2

Training > Start Training ⇧⌘T

Viewport > Enter/Exit Edit Mode ⇧⌘E

Viewport > Toggle Auto-Rotation ⌘⌥T

Viewport > Save Screenshot ⇧⌘S

Export > 3D Formats > PLY ⌘E

Help > User Guide ⌘?

Help > Keyboard Shortcuts ⌘/

Help > Open Training Logs… ⇧⌘L

Help > Pareto Dashboard… ⇧⌘D

Help > Holdout Analysis… ⇧⌘H

Help > BayesOpt Console… ⇧⌘B

Меню Edit (системно-предоставленное, в Expert Mode при активном выборе в 
Project Navigator):

Действие Сокращение

Undo Remove Image ⌘Z

Remove Selected Image Backspace / Delete
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Г Л А В А

Глава 2 — Инспектор (Expert View)

Рисунок 7.  Пустой Expert Mode — Project Navigator слева (Images 0, Cameras, Log), пу­
стой viewport посередине, Инспектор справа с секциями Presets/Training Configuration/

Enhancements/Training Metrics

Пустой Инспектор до импорта: Левая боковая панель показывает счётчик Images 
0 и подсказку дропа «Drop images here / or tap + to import». Инспектор справа 
полностью функционален, но предустановки только информативны (нет активно
го обучения). Предустановка по умолчанию «Preview» (5K итераций) помечена. 
Camera Alignment установлен на Apple Photogrammetry, Densification — на Classic, 
SSIM Weight — 0.20, Render Scale — 50 %. В Training Metrics и Loss History показаны 
пустые состояния («Start training to see live metrics», «Loss curve will appear during 
training»).
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Рисунок 8.  Инспектор с загруженными 60 изображениями flowers — боковая панель 
изображений показывает первые имена файлов frame_0001.jpg и далее, заголовок гла­

сит «60 images ready»

Инспектор после импорта: Статус заголовка гласит «60 images ready». 
Боковая панель изображений перечисляет все 60 импортированных кадров 
( frame_0001.jpg – frame_0945.jpg , каждый 16-й кадр из набора Bouquet на 960 
камер как подмножество для быстрых итераций). Логика автоматического render 
scale проверяет разрешение изображений (1536×2048 = 3.1 MP) и подстраивает 
Render Scale соответствующим образом. Кнопка Play (зелёная, внизу слева) теперь 
активна и запускает обучение с активной предустановкой.

Рисунок 9.  Инспектор во время обучения — живой viewport показывает реконструкцию 
flowers Bouquet, нижняя строка метрик (Loss / LR / Gaussian count / iterations), карточка 

предустановки «Preview» с пометкой «Modified», если параметры были изменены

Инспектор во время обучения: Строка заголовка показывает глобальный про
гресс «RadianceKit — Training NN %». Viewport рендерит текущую реконструкцию 
Gaussian в реальном времени (обновляется каждые 50 итераций — интервал 
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живого предпросмотра задаётся в Settings → General → Training → Live Preview). 
Строка метрик под viewport: текущий Loss, Learning Rate, число Gaussians и 
счётчик итераций (напр. 1 600/5 000 с предустановкой Preview). Карточка пред
установки «Preview» получает пометку «Modified», как только любой параметр 
отклоняется от встроенного значения по умолчанию. Боковая панель «Log» соби
рает события этапов SfM и обучения.

Рисунок 10.  Инспектор после завершения обучения — viewport показывает закончен­
ную реконструкцию flowers Bouquet (2 991 Gaussians после 5K итераций за 13 с), строка 

заголовка «Training Complete — 2,991 Gaussians»

Инспектор после обучения: Строка заголовка показывает финальное число 
Gaussians (здесь 2 991 — очень компактно, поскольку синтетическая сцена 
Bouquet из Blender имеет простую геометрию на светлом фоне). Viewport показы
вает законченное облако точек — активна orbital drag-навигация (вращает вокруг 
центра сцены). Секция Training Metrics теперь заполнена финальными значениями, 
график Loss History показывает ход всех 5 000 итераций. Секция Export внизу 
теперь активна (все кнопки форматов разблокированы).

Инспектор — это правая боковая панель в Expert Mode (⌘2). Он объединяет все 
параметры, относящиеся к обучению, в семь сворачиваемых секций. Порядок 
по умолчанию сверху вниз при первом запуске такой: Look, Presets, Training 
Configuration, Metrics, Loss Chart, Enhancements и Export. Секция «Look» (пост-
тренировочные коррекции изображения) — это реальное UI-переименование 
прежней секции «Finishing»: её внутренний enum- rawValue  по причинам пер
систентности остаётся «Finishing», а отображаемый заголовок гласит «Look». 
Каждая секция может быть свёрнута щелчком по заголовку, а порядок можно 
менять через drag-and-drop (InspectorView.swift:81-97). При первом запуске 
все семь секций свёрнуты (inspectorCollapsedSections по умолчанию равно 
Set(InspectorSection.allCases)); затем состояние приложения запоминает пред
почтения свёртывания и порядка между запусками.

Ряд элементов управления Инспектора также появляются почти в идентичной 
форме в Settings (глава 3) — обычно SfM-бэкенд, sky masking и аналогичные 
значения по умолчанию. Разделение сделано сознательно: Settings предоставляет 
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глобальный для приложения шаблон для вновь создаваемых проектов, Инспектор 
переопределяет эти значения для текущего открытого проекта. Стоит освоить ло
гику работы одной стороны — и другую можно использовать вслепую.

Левая колонка в Expert Mode — Project Navigator — не входит в Инспектор, но 
является его прямым соседом. Там можно выбирать импортированные изображе
ния щелчком, предпросматривать их по пробелу через Quick Look и удалять через 
кнопку минус или клавишу Delete (с Cmd-Z для отмены). Инспектор следует за 
текущим выбором в боковой панели контекстно-зависимой детальной информа
цией, но семь основных секций всегда остаются доступными.

Секция Look (L1–L5)

Секция Look (внутренний rawValue  по-прежнему «Finishing») — это самая верх
няя секция Инспектора, собирающая в одном месте пост-тренировочные кор
рекции изображения. Все регуляторы работают неразрушающе: каждый слайдер 
заново применяет FinishingPass  к неизменному pristine-снимку (оригинальный 
DC-цвет, -непрозрачность, -масштаб) — так что коррекция идемпотентна, а не 
накопительна. Результат появляется вживую в viewport (WYSIWYG, точно так же, 
как последующий экспорт) и запекается в каждый экспорт. Секция доступна 
лишь после завершения тренировочного прогона (до этого стоит «Available after 
a training run completes.»); её значения сбрасываются при каждом новом обуче­
нии. Пока идёт экспорт, все регуляторы заблокированы — появляется подсказка-
замок «Locked while exporting — the file uses the current settings.», а GroupBox 
деактивирован.
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L1 Слайдер Saturation

ГД Е

Инспектор → секция Look → GroupBox → 
Saturation.

Т Е Х Н И Ч Е С К И

Слайдер 0.5–1.2, отображение двузначное (напр. 
«1.00»). Масштабирует SH-DC-хрому каждого 
Splat вокруг значения яркости: 1.0 = без изме
нений, < 1.0 = обесцвечено (цвет тянется к гра
дации серого), > 1.0 = насыщеннее. Математиче
ски DC-цвет пересчитывается из pristine-снимка 
( desaturateDC ), так что повторное перетаскива
ние не суммируется. Проверено на материале 
дронов DJI (виадук Pensford), который склонен 
к перенасыщению — дефолт для дронов лежит 
на 0.82. Действует только на цветовую базу (SH-
степень 0), более высокие SH-коэффициенты 
остаются нетронутыми.

П Р О СТ Ы М И  С Л О В А М И

Насколько насыщены цвета го­
тового Splat. 1.00 оставляет всё 
как обучено, значения ниже тя­
нут цвет к серому — хорошо 
для материала дронов или ви­
део, который часто выходит пе­
ренасыщенным. Значения вы­
ше 1.0 делают его насыщеннее. 
Можно сколько угодно гонять 
туда-сюда, ничего не «раска­
чивается», потому что прило­
жение всегда считает заново от 
неизменного оригинала. Видно 
вживую в viewport и точно так 
же в экспорте.

L2 Слайдер Splat length

ГД Е

Инспектор → секция Look → GroupBox → Splat 
length.

Т Е Х Н И Ч Е С К И

Слайдер 0.3–1.0, отображение двузначное. Стя
гивает три оси масштаба каждого Gaussian в 
лог-пространстве к их среднему ( shortenScale , 
фактор alpha ): 1.0 = без изменений, меньшие 
значения делают вытянутые «игольчатые» Splat-
ы круглее, 0 были бы чистыми сферами. Воздей
ствует на игольчатые, переразвёрнутые Splat-ы, 
не меняя общий размер, и за счёт этого снижает 
типичные «конфетти»-артефакты. Применяется 
от pristine-снимка (оригинальный лог-масштаб), 
поэтому идемпотентно. Коммутирует со Splat 
size (L3), потому что оба работают в лог-про
странстве.

П Р О СТ Ы М И  С Л О В А М И

Делает слишком длинные, 
осколочные Splat-ы круглее. 
1.00 оставляет форму как обу­
чено, более низкие значения 
сминают вытянутые «иглы» в 
более округлые кляксы — это 
успокаивает зернистые, пора­
жённые конфетти-артефактами 
реконструкции. Общий размер 
остаётся прежним, речь только 
о вытянутости. Безопасно ком­
бинируется со Splat size (L3).
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L3 Слайдер Splat size

ГД Е

Инспектор → секция Look → GroupBox → Splat 
size.

Т Е Х Н И Ч Е С К И

Слайдер 0.5–2.0, отображение двузначное. Мас
штабирует каждый Gaussian равномерно по всем 
трём осям ( sizeScale ): 1.0 = без изменений, 
< 1.0 = меньше/плотнее/резче, > 1.0 = боль
ше/«пушистее» (заполняет промежутки между 
Splat-ами). Поскольку масштабы лежат в лог-
пространстве, умножение реализуется как адди
тивный log(factor) -сдвиг — это коммутирует 
со Splat length (L2), потому что постоянный сдвиг 
оставляет отклонение-от-среднего нетронутым. 
От pristine-снимка, то есть идемпотентно. Новое 
в этой версии.

П Р О СТ Ы М И  С Л О В А М И

Масштабирует все Splat-ы рав­
номерно больше или меньше. 
1.00 — это обученное состо­
яние, значения ниже делают 
облако точек теснее и рез­
че, значения выше прикрыва­
ют промежутки между Splat-
ами (выглядит мягче/«пуши­
стее»). Удобно, чтобы визу­
ально закрыть дырявую рекон­
струкцию или наоборот высво­
бодить больше детализации. 
Без проблем уживается со Splat 
length (L2) — оба регулятора не 
влияют друг на друга.
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L4 Fade far region (с суб-слайдерами)

ГД Е

Инспектор → секция Look → GroupBox → пере
ключатель «Fade far region» плюс суб-слайдеры 
«Fade start ×radius» и «Fade floor».

Т Е Х Н И Ч Е С К И

Переключатель, активирующий радиальный спад 
непрозрачности с расстоянием от центроида 
камер — слабо наблюдаемые «дальние конфет
ти» на фоне скрываются. Только для orbit-
съёмок: переключатель деактивирован, когда 
finishingContext.fadeEligible равно false (ли
нейные пролёты, слишком мало или вырожден
ные камеры); тогда вместо суб-слайдеров появ
ляется подсказка «Far-fade applies only to orbit 
captures (not this scene).» Пригодность опреде
ляется по азимутальному покрытию позиций ка
мер (orbit окружает центроид и заполняет мно
гие сектора компаса, линейный пролёт — лишь 
~2). Два суб-слайдера управляют геометрией: 
Fade start ×radius (1.0–3.0) задаёт внутренний 
радиус как кратное orbit-радиуса, внутри ко
торого действует полная непрозрачность; Fade 
floor (0.0–1.0) — это фактор непрозрачности 
далеко за fade-радиусом. Важно: fade пропус­
кает зону sky-dome (замороженные Gaussians 
индексов [0, frozenCount)), чтобы намеренная 
фоновая купола не затемнялась заодно.

П Р О СТ Ы М И  С Л О В А М И

Скрывает рыхлые остатки на 
внешнем крае сцены — именно 
те «дальние конфетти»-комоч­
ки, что висят далеко позади 
при круговых съёмках. Работа­
ет только при настоящих orbit-/
круговых съёмках; при прямых 
пролётах дрона или слишком 
малом числе камер переключа­
тель серый, а подсказка объяс­
няет почему. Если он активен, 
добавляются два тонких регу­
лятора: «Fade start ×radius» за­
даёт, с какого расстояния (как 
кратное радиуса облёта) начи­
нается скрытие, «Fade floor» 
— насколько сильно дальние 
Splat-ы в итоге остаются видны 
(0 = совсем прочь, 1 = без изме­
нений). Намеренно реконстру­
ированный sky-dome (I44) при 
этом никогда не трогается — 
небо сохраняется.
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L5 Кнопка Reset finishing

ГД Е

Инспектор → секция Look → GroupBox → «Reset 
finishing» (внизу, маленькая кнопка).

Т Е Х Н И Ч Е С К И

Сбрасывает все настройки Look на значе
ния по умолчанию (FinishingPass.Settings() 
= Saturation 1.0, fade выключен, Splat length 
1.0, Splat size 1.0) и сразу запускает по
вторный finishing, так что viewport возвраща
ется к неизменному обученному состоянию. 
controlSize(.small). Поскольку весь Look-стек 
считает идемпотентно от pristine-снимка, «назад 
к дефолту» — это в точности исходный вывод 
обучения, без потери качества от многократного 
хождения туда-сюда. Как и все регуляторы сек
ции, заблокирована во время идущего экспорта.

П Р О СТ Ы М И  С Л О В А М И

Одним щелчком возвращает 
все регуляторы Look на стан­
дарт (Saturation 1.00, fade вы­
ключен, оба Splat-слайдера на 
1.00) — viewport после это­
го снова показывает точно 
свежий обученный результат. 
Удобно, если заигрались и хо­
тите начать чисто с начала. 
Поскольку приложение всегда 
считает от оригинала, потери 
качества при этом нет. Пока 
идёт экспорт, кнопка (как и 
слайдеры) заблокирована.

Секция Presets (I1–I11)

Секция Presets — самый быстрый способ применить протестированную конфигу
рацию. Встроенные предустановки (Capture Class, Classic, MCMC, Hybrid) дают 
воспроизводимые отправные точки из 560+ задокументированных эксперимен
тов; собственные предустановки можно сохранять, экспортировать, импортиро
вать и передавать. Список сгруппирован по категориям (Capture Class, Classic, 
MCMC, Hybrid, Custom), и одновременно может быть развёрнуто несколько кате
горий. Контекстное меню (правый клик по строке) делает доступными Export, 
Duplicate, а для пользовательских предустановок — Delete.
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I1 Кнопка Save…

ГД Е

Инспектор → секция Presets → кнопка Save… (па
нель действий внизу).

Т Е Х Н И Ч Е С К И

Открывает popover с текстовым полем и 
кнопками Save/Cancel. Текущее состояние 
TrainingConfig сохраняется как новая пользова
тельская предустановка (JSON-encoded, хранит
ся для всего приложения). Процесс сохранения 
копирует все 81 параметр обучения плюс те
кущую стратегию densification. Предустановка 
автоматически попадает в категорию Custom, 
независимо от того, из какой встроенной пред
установки была получена. Пустые имена и ввод 
из одних пробелов отклоняются. Уже существую
щие имена не отклоняются — у каждой предуста
новки свой внутренний ID, дубли имён техниче
ски разрешены, но практически путают.

П Р О СТ Ы М И  С Л О В А М И

Сохраняет вашу текущую кон­
фигурацию как многоразовую 
предустановку. Щёлкните по 
кнопке, введите имя в popover 
и щёлкните Save — все 81 
параметр, включая стратегию 
densification, попадают под вы­
бранным именем в категорию 
Custom. Это нужно, когда вы 
вложили усилия и не хотите во­
зиться с настройками заново в 
следующем проекте. Особенно 
удобно для повторяющихся на­
строек вроде «Drone 4K» или 
«Indoor fast». Дубли имён тех­
нически разрешены, но практи­
чески путают — лучше выбрать 
что-то описательное.

I2 Текстовое поле Preset Name

ГД Е

Save-popover → текстовое поле «Preset Name».

Т Е Х Н И Ч Е С К И

Простое текстовое поле со скруглённой обвод
кой, широкое. При щелчке по кнопке Save зна
чение берётся как имя предустановки. Лимита 
длины в UI нет, но сохраняемое имя должно быть 
JSON-кодируемым и отображаемым в списках UI 
— эмодзи и умляуты работают. Содержимое ав
томатически сбрасывается в пустую строку при 
открытии popover. Кнопка Save остаётся деакти
вированной, пока поле пусто после trim. Auto-
suggest и pre-fill именем текущей активной пред
установки нет.

П Р О СТ Ы М И  С Л О В А М И

Сюда вы вводите имя для своей 
предустановки. Выберите что-
то описательное вроде «Drone 
4K 30fps» или «Indoor fast» 
— так позднее проще найти 
её в категории Custom. Эмодзи 
и умляуты разрешены, жёстко­
го лимита длины нет. Пока по­
ле пусто или содержит только 
пробелы, кнопка Save остаёт­
ся серой. Если popover открыть 
заново, поле снова пусто — 
pre-fill именем активной пред­
установки отсутствует.
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I3 Кнопка Cancel (диалог Save)

ГД Е

Save-popover → кнопка Cancel (слева).

Т Е Х Н И Ч Е С К И

Закрывает popover без сохранения. Отбрасывает 
содержимое текстового поля — при следующем 
открытии оно будет сброшено в пустое логикой 
кнопки Save… (I1). Стандартный стиль кнопки, 
без диалогов подтверждения и без hotkeys. Теку
щая TrainingConfig остаётся без изменений, по
скольку путь сохранения вообще не выполнялся.

П Р О СТ Ы М И  С Л О В А М И

Закрывает Save-popover без со­
хранения чего-либо. Если пе­
редумали, опечатались или 
случайно открыли диалог — 
просто щёлкните Cancel. Те­
кущая конфигурация обучения 
остаётся без изменений, по­
скольку ничего не записа­
но. При повторном открытии 
popover поле имени снова пу­
сто. Никаких safety- запросов, 
никаких hotkey — просто щёл­
каете, и его нет.

I4 Кнопка Save (диалог Save)

ГД Е

Save-popover → кнопка Save (справа, заметный 
стиль).

Т Е Х Н И Ч Е С К И

Триггерит собственно сохранение. Ещё раз ва
лидирует, что имя непустое (defensive check), и 
затем пишет текущую TrainingConfig как JSON в 
app-storage. Затем закрывает popover. Выделено 
синим, серым пока текстовое поле пусто. Если 
сохранение не удаётся (напр. из-за полного app-
storage — очень маловероятно), видимого диало
га об ошибке пока нет; предустановка просто не 
появится при следующем запуске приложения.

П Р О СТ Ы М И  С Л О В А М И

Щелчком по Save вы принима­
ете имя и записываете вашу 
текущую настройку как новую 
предустановку. Popover закры­
вается, предустановка немед­
ленно появляется в категории 
Custom списка предустановок, 
и её затем можно активировать 
щелчком. Кнопка выделена си­
ним ( borderedProminent ) и 
остаётся серой, пока поле име­
ни пусто. Если сохранение 
не удаётся (напр. UserDefaults 
полон), видимого диалога об 
ошибке нет — предустановка 
просто будет отсутствовать при 
следующем запуске приложе­
ния.
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I5 Кнопка Export…

ГД Е

Инспектор → секция Presets → панель действий 
→ кнопка Export….

Т Е Х Н И Ч Е С К И

Экспортирует текущую выбранную предустанов
ку в файл .radiancepreset  (внутри — JSON). 
Деактивирована, если не выбрана ни одна пред
установка. По щелчку приложение открывает 
save-диалог с именем файла предустановки (имя 
предустановки
1. расширение .radiancepreset ). Сохранённый 

формат содержит

полную TrainingConfig плюс метаданные (имя, 
категория, ID, built-in-флаг). Двойной щелчок в 
Finder открывает приложение, но не автомати
чески импорт; пользователь должен воспользо
ваться кнопкой Import (I6).

П Р О СТ Ы М И  С Л О В А М И

Выберите предустановку в 
списке и щёлкните Export — 
затем её можно сохранить 
как файл .radiancepreset  
и отправить коллеге, напри­
мер, или перенести на второй 
Mac. Получатель на своей сто­
роне загружает её снова кноп­
кой Import… (I6). Работает оди­
наково хорошо для встроенных 
и собственных пользователь­
ских предустановок. Кнопка се­
рая, пока в списке ничего не 
нажато. Совет: через контекст­
ное меню (I8) ещё быстрее — 
там не нужно сначала выбирать 
предустановку.

I6 Кнопка Import…

ГД Е

Инспектор → секция Presets → панель действий 
→ кнопка Import….

Т Е Х Н И Ч Е С К И

Открывает файловый диалог, разрешающий 
только файлы .radiancepreset  (multiselect от
ключён). При выборе JSON-файл загружается, 
валидируется и вставляется в категорию Custom 
— с новым внутренним ID, чтобы не было кол
лизий со встроенными. Импорт автоматически 
устанавливает категорию в Custom, даже ес
ли экспортированная предустановка изначально 
была, напр., built-in. Повреждённые или несов
местимые со старой версией схемы файлы тихо 
отклоняются, без диалога ошибки (консольный 
лог информацию даёт).

П Р О СТ Ы М И  С Л О В А М И

Читает файл 
.radiancepreset  с диска. 

Полезно, когда кто-то присыла­
ет вам проверенную настрой­
ку или вы сами хотите син­
хронизировать любимые пред­
установки между несколькими 
Mac. Импортированные пред­
установки всегда попадают в 
категорию Custom — даже ес­
ли они изначально были экс­
портированы из встроенных. 
Повреждённые или устаревшие 
файлы тихо игнорируются; кон­
сольный лог показывает причи­
ну. Multiselect в диалоге отклю­
чён, так что только один файл 
на щелчок.
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I7 Строка предустановки (активация щелчком)

ГД Е

Инспектор → секция Presets → каждая строка 
предустановки в каждой категории.

Т Е Х Н И Ч Е С К И

Щелчок по строке предустановки заменяет все 
поля TrainingConfig значениями из предустанов
ки, запоминает ID активной предустановки и 
сбрасывает статус Modified. Активная галочка 
перед строкой появляется только когда пред
установка выбрана И не изменена. Как только 
значение в TrainingConfig меняется (слайдер, 
степпер, переключатель в других секциях Ин
спектора), после имени появляется оранжевая 
пометка «Modified». Встроенные предустановки 
нельзя перезаписать — при модификации нужно 
создать копию кнопкой Save (I1).

П Р О СТ Ы М И  С Л О В А М И

Щелчок по строке активиру­
ет предустановку и принимает 
все сохранённые в ней зна­
чения в текущие настройки 
обучения. Галочка перед име­
нем показывает, какая пред­
установка сейчас активна. Как 
только после этого вы подкру­
тите любой слайдер, степпер 
или переключатель в других 
секциях, после имени появится 
оранжевая пометка «Modified» 
— потому что ваша настрой­
ка теперь отклоняется от пред­
установки. Встроенные пред­
установки перезаписать нель­
зя; если хотите сохранить из­
менения, создайте копию кноп­
кой Save… (I1) или продубли­
руйте предустановку (I9).

I8 Контекстное меню «Export…»

ГД Е

Правый клик на любой строке предустановки → 
первая запись «Export…».

Т Е Х Н И Ч Е С К И

Идентичная функциональность с I5 (кнопка 
Export…), но удобнее доступна — без необходи
мости предварительно выбирать предустановку. 
Экспортирует напрямую предустановку из стро
ки, по которой щёлкнули. Работает одинаково 
для всех категорий (built-in или custom), без 
ограничений. Экспорт содержит built-in-флаг и 
оригинальную категорию, но при повторном им
порте категория мапится в Custom, как описано 
под I6.

П Р О СТ Ы М И  С Л О В А М И

Быстрый способ экспорта — 
правый клик по желае­
мой предустановке и выбор 
«Export…». Экономит обход 
через предварительный щел­
чок и затем нажатие кнопки 
Export…. Работает одинаково 
для всех категорий, в том чис­
ле для встроенных. Создавае­
мый файл .radiancepreset  
идентичен тому, что из I5; при 
последующем повторном им­
порте он автоматически попа­
дает в категорию Custom.
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I9 Контекстное меню «Duplicate»

ГД Е

Правый клик на любой строке предустановки → 
вторая запись «Duplicate».

Т Е Х Н И Ч Е С К И

Клонирует предустановку в категорию Custom. 
Создаёт новый внутренний ID, добавляет « 
Copy» к имени и сохраняет копию. Работа
ет и для встроенных предустановок — клон 
тогда редактируем. Оригинал остаётся нетрону
тым. TrainingConfig копируется значение-за-зна
чением (JSON round-trip), так что нет reference-
bindings между оригиналом и копией.

П Р О СТ Ы М И  С Л О В А М И

Создаёт редактируемую копию 
предустановки в категории 
Custom. Удобно, если, напр., вы 
хотите взять встроенную пред­
установку «Quality» как от­
правную точку и потом под­
крутить только SSIM-слайдер. 
Рабочий процесс: duplicate, пе­
реименовать (контекстное ме­
ню или новый Save…), подстро­
ить, готово. Оригинал остаётся 
нетронутым — к нему можно 
вернуться в любой момент. Ра­
ботает и для встроенных, что — 
единственный способ исполь­
зовать их значения как основу 
и одновременно сделать редак­
тируемыми.

I10 Контекстное меню «Delete»

ГД Е

Правый клик на ваших собственных стро
ках предустановок → последняя запись 
«Delete» (красная, destructive).

Т Е Х Н И Ч Е С К И

Видна только для пользовательских предустано
вок. Встроенные удалить нельзя. Запись помече
на как destructive, появляется в контекстном ме
ню красной и отделена разделителем, чтобы не 
щёлкнуть случайно. Диалога подтверждения нет 
— щелчок сразу удаляет предустановку. Удалён
ная предустановка не восстанавливается (Cmd-
Z здесь не работает — Undo в текущей сборке 
существует только для списка изображений, не 
для операций с предустановками). Если удалён
ная предустановка только что была активной, 
текущая TrainingConfig остаётся без изменений, 
обнуляется только выбор активной предустанов
ки.

П Р О СТ Ы М И  С Л О В А М И

Удалите свои предустановки. 
Для встроенных (Quick, Preview, 
Balanced, Quality, Ultra Detail, 
Drone / Aerial, 360° Walkaround, 
Photo / Object и т.д.) «Delete» 
вообще не виден — их слу­
чайно не убить. Внимание: ни 
safety-запроса, ни undo, один 
щелчок — и предустановки нет. 
Если не уверены, сначала вы­
тяните backup на диск через 
Export… (I5/I8) — его можно по­
вторно импортировать в любой 
момент. Если предустановка 
только что была активной, ва­
ша TrainingConfig остаётся без 
изменений, исчезает только га­
лочка.
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I11 Заголовок категории (expand/collapse)

ГД Е

Инспектор → секция Presets → каждый заголовок 
категории (Capture Class, Classic, MCMC, Hybrid, 
Custom).

Т Е Х Н И Ч Е С К И

Состояние свёртывания на категорию с разны
ми значениями по умолчанию: курируемая груп
па Capture Class стартует развёрнутой, Classic, 
MCMC, Hybrid и Custom — свёрнутыми. Состо
яние не сохраняется — при перезапуске прило
жения все категории снова в значении по умол
чанию. Стрелка-шеврон поворачивается с ани
мацией. Число справа в заголовке показывает 
количество предустановок в этой категории. Hit-
area щелчка охватывает всю область заголовка.

П Р О СТ Ы М И  С Л О В А М И

Разворачивайте и сворачивай­
те категории, чтобы держать 
список предустановок аккурат­
ным. При старте приложения 
группа Capture Class открыта, 
Classic, MCMC, Hybrid и Custom 
— закрыты. Щелчок по заго­
ловку (вся область кликабель­
на), и список выезжает или 
сжимается с короткой анима­
цией шеврона. Маленькое чис­
ло справа показывает, сколько 
предустановок в категории. По­
сле перезапуска приложения 
— снова состояние по умолча­
нию — приложение сознатель­
но не сохраняет эту настройку 
свёртывания.

Секция Training Configuration (I12–I22)

Рисунок 11.  Вырезка только секции Training Configuration — Camera Alignment (Apple 
Photogrammetry активна, Native (Beta) неактивна), Densification (Classic активна), Max 

Iterations 5,000 / Densify Until 3,500 со значком link, слайдер SSIM Weight 0.20, слайдер 
Render Scale на 100 % (1,536×2,048 = 3.1 MP)

Здесь живут центральные рычаги: какой SfM-бэкенд должен считать, как рабо
тает densification, сколько итераций, сколько веса SSIM. При стратегии MCMC 
появляются два дополнительных переключателя («MCMC Quality» и «Auto-scale by 
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scene»), скрытые в Classic-режиме. При бэкенде Native SfM добавляется поле FOV 
override, нужное только для видеокадров без EXIF focal length.

I12 Picker Camera Alignment

ГД Е

Инспектор → Training Configuration → Camera 
Alignment (сегментированный picker наверху).

Т Е Х Н И Ч Е С К И

Сегментированный picker с двумя опциями: 
Apple Photogrammetry и Native (Beta). Выбор 
определяет SfM-бэкенд, используемый при сле
дующей реконструкции камер. Одновременно 
он влияет, какие дополнительные элементы 
Инспектора видны: Native дополнительно по
казывает FOV override (I13), нужный только 
для видеокадров без EXIF. Примечание: для 
очень больших уличных съёмок можно че
рез workspace import импортировать результат 
внешнего инструмента (Metashape или COLMAP) 
— см. главу 1 (M5) и главу 9 (Q3, Q6).

П Р О СТ Ы М И  С Л О В А М И

Здесь вы выбираете, как ре­
конструируются позиции ка­
мер — важнейший переключа­
тель для итогового качества. 
Apple Photogrammetry — быст­
рый стандарт и достаточен для 
большинства сканов объектов. 
Native (Beta) — совместимая 
с App Store собственная раз­
работка, хороша для орбит и 
сцен с turntable и требует FOV 
override (I13) при видеокадрах 
без EXIF. При очень больших 
уличных наборах можно аль­
тернативно рассчитать каме­
ры в Metashape или COLMAP 
и загрузить результат через 
workspace import. Подробности 
и рекомендации по типу сцен 
— в главе 9.

I13 Поле FOV Override (Native SfM)

ГД Е

Инспектор → Training Configuration → FOV 
Override (видно только при Camera Alignment = 
Native).

Т Е Х Н И Ч Е С К И

Числовое текстовое поле (диапазон 0–170°), по 
умолчанию 0 = автоматическое определение из 
EXIF или эвристика. Ручной ввод нужен, когда 
входные изображения извлечены из видео, не 
содержащего метаданных focal length. Типичные 
значения: iPhone Wide ≈ 73°, DJI Mavic Wide-
Crop ≈ 70°, дрон с full-frame-сенсором ≈ 84°. 
Значение ограничивается [0, 170] — выходящие 
значения сразу отбрасываются обратно. Влияет 
только на нативный SfM-конвейер (Q4/Q5); Apple 
Photogrammetry это значение полностью игнори
рует.

П Р О СТ Ы М И  С Л О В А М И

Если у ваших изображений нет 
EXIF (типично для извлечённых 
видеокадров), введите здесь 
горизонтальное поле зрения 
камеры в градусах. Ориентиро­
вочные значения: iPhone Wide ≈ 
73°, DJI Mavic Wide-Crop ≈ 70°, 
дрон с full-frame- сенсором ≈ 
84°. 0 позволяет приложению 
угадывать самому — часто это 
срабатывает, но с редкими объ­
ективами может пойти не так. 
Значения свыше 170° автомати­
чески ограничиваются обрат­
но. Поле видно и эффективно, 
только если выбрано Native в 
Camera Alignment (I12) — Apple 
Photogrammetry полностью его 
игнорирует.
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I15 Picker Densification

ГД Е

Инспектор → Training Configuration → 
Densification (сегментированный picker, всегда 
виден).

Т Е Х Н И Ч Е С К И

Переключает между двумя стратегиями 
densification: Classic (оригинальная процедура 
3DGS с clone/split/prune и gradient threshold) и 
MCMC (Stochastic Gradient Langevin Dynamics 
с Relocation, NeurIPS 2024). При переключе
нии с Classic на MCMC приложение автомати
чески устанавливает MCMC-специфичные поля 
в проверенные значения по умолчанию (reg 
weights = 0, MCMC cap multiplier 3.0, sample/
noise schedule). Без этой автоматической иници
ализации сессии со старыми предустановками 
страдали от 1.4.4 MCMC-collapse-бага (460K→5 
Gaussians, watchdog kill). Выбор picker дополни
тельно определяет, какие элементы Инспектора 
видны — при MCMC появляются I16/I17. Подроб
ный эффект полей — в главе 6, T11–T16 (Classic) 
и T61–T73 (MCMC).

П Р О СТ Ы М И  С Л О В А М И

Центральный выбор стратегии 
для роста числа Gaussian. 
Classic хорошо настроен по 
459 экспериментам, даёт быст­
ро и качественно результаты 
и не требует знания каких- 
либо MCMC-полей. MCMC — 
более новый подход (NeurIPS 
2024), более воспроизводимый 
и обходящийся без ручной на­
стройки порогов — но он счи­
тает примерно в 6 раз дольше 
для сравнимого качества. При 
переключении на MCMC прило­
жение автоматически устанав­
ливает безопасные значения 
по умолчанию, чтобы обучение 
не наткнулось на 1.4.4-collapse. 
Подробности о полях стратегии 
— в главе 6 (T11–T16 Classic, 
T61–T73 MCMC).
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I16 Переключатель MCMC Quality

ГД Е

Инспектор → Training Configuration → MCMC 
Quality (только при Densification = MCMC).

Т Е Х Н И Ч Е С К И

Переключает gradient accumulation на 2 шага (ак
тив) или 1 шаг (неактив). Накапливает градиенты 
из двух последовательных видов камеры перед 
выполнением шага оптимизатора. Эмпирически 
(Session 33, V544a) уменьшает финальную L1-
ошибку примерно на 6 % (0.0246 с Quality про
тив 0.0261 без, в среднем по 3 прогонам на 
Horse-Full- MCMC). Цена: удвоенное время обу
чения. При очень длинных тренировках (200K 
итераций) это приводит к 10+ минутам дополни
тельного ожидания — так что оправдано только 
если действительно нужны последние проценты 
качества. Влияет только на обучение, не на фор
мат экспорта или отображение в viewport.

П Р О СТ Ы М И  С Л О В А М И

Режим качества для MCMC с 
gradient accumulation по двум 
видам. Эмпирически делает 
финальный результат пример­
но на 6 % лучше (L1 0.0246 вме­
сто 0.0261 в Horse-тесте), но 
стоит вдвое дольше. Если у вас 
и так идёт 200K MCMC-обуче­
ние (легко 2 часа), добавляется 
ещё около часа. Оправдано для 
финальных showcase-рендеров 
или в конце quality-sweep- сес­
сии, меньше — в ежедневном 
рабочем процессе. Видно толь­
ко когда Densification установ­
лен на MCMC (I15).

I17 Переключатель Auto-scale by scene

ГД Е

Инспектор → Training Configuration → Auto-scale 
by scene (только при MCMC).

Т Е Х Н И Ч Е С К И

Когда активен, масштабирует эффективный по
толок max-Gaussians по числу SfM init-точек × 
MCMC cap multiplier (по умолчанию 3.0). При
мер: SfM даёт 250K init-точек, base cap = 
150K, multiplier 3.0 → эффективный потолок = 
max(150K, 750K) = 750K. При деактивации строго 
применяется только base. Был введён для v1.4.5, 
потому что большие уличные съёмки свыше 1000 
кадров и соответственно высокой плотностью 
SfM-точек морили densification жёстким cap 
150K по умолчанию — избыточные точки остава
лись, новые не могли появляться. По умолчанию 
OFF в пользовательских предустановках, ON во 
встроенных MCMC. Влияет только на время обу
чения, не на экспорт.

П Р О СТ Ы М И  С Л О В А М И

Позволяет максимальному чис­
лу Gaussians расти вместе с 
размером сцены (точнее: с чис­
лом SfM init-точек). На малень­
ких сценах разница едва за­
метна, на больших уличных ча­
сто решающая для качества 
— иначе обучение «задыхает­
ся», потому что потолок по 
умолчанию 150K слишком ни­
зок для сцены. Был введён для 
v1.4.5 после того, как очень 
большие уличные наборы (свы­
ше 1000 кадров) заметно упи­
рались в cap. Во встроенных 
MCMC-предустановках включён 
заранее; в ваших собственных 
предустановках выключен по 
умолчанию.
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I18 Степпер Max Iterations

ГД Е

Инспектор → Training Configuration → GroupBox → 
Max Iterations.

Т Е Х Н И Ч Е С К И

Степпер с диапазоном 1 000–100 000, шаг 1 
000. Определяет общее число итераций оптими
затора. Линейно коррелирует с временем обу
чения (половина = прим. 50 % времени). Эм
пирические sweet spots: 20K (Classic Balanced, 
L1≈0.028), 40K (Classic Quality, L1≈0.023), 200K 
(MCMC Full, L1≈0.0246). Свыше 40K с Classic 
в среднем едва ли что-то даёт — diminishing 
returns. При изменении, если активна link-функ
ция (I19), Densify Until пропорционально подтя
гивается (отношение по умолчанию: 0.5, т.е. 
Densify- Until = Max/2).

П Р О СТ Ы М И  С Л О В А М И

Сколько шагов обучения вы­
полняется — больше лучше, но 
и стоит линейно больше време­
ни. Правило большого пальца: 
20 000 для хорошего качества, 
40 000 для оптимума со страте­
гией Classic (выше в среднем 
едва что-то даёт). MCMC тре­
бует существенно больше, 200 
000 здесь — стандарт. Удвое­
ние итераций примерно удваи­
вает время обучения. С актив­
ной кнопкой link (I19) Densify 
Until подтягивается пропорци­
онально — практически всегда 
то, что вы хотите.

I19 Кнопка Link/Unlink (Densify ↔ Iterations)

ГД Е

Инспектор → Training Configuration → GroupBox 
→ маленькая link-кнопка между Max Iterations и 
Densify Until.

Т Е Х Н И Ч Е С К И

Кнопка-переключатель, замораживающая соот
ношение Densify Until к Max Iterations. Когда 
активна (link-значок выделен), при каждом из
менении Max Iterations Densify Until подтягива
ется пропорционально. Когда unlinked (значок 
link-plus), значения остаются независимыми. По 
умолчанию linked, потому что это отражает ти
пичную корреляцию — когда вы тянете обучение 
на удвоение итераций, обычно хотите, чтобы 
densification тоже шёл пропорционально дольше. 
Соотношение вычисляется из текущего значения 
при установке link-кнопки; типичное соотноше
ние — 0.5 (Densify-Until = половина числа итера
ций).

П Р О СТ Ы М И  С Л О В А М И

Маленькая кнопка-скрепка 
между Max Iterations и Densify 
Until. Когда активна (link-зна­
чок выделен), оба значения 
движутся вместе — если удво­
ить итерации, Densify Until то­
же удваивается в том же от­
ношении. Когда нет (значок 
link.badge.plus ), их мож­

но задавать независимо. По 
умолчанию linked, потому что 
это отражает типичную корре­
ляцию — более долгое обуче­
ние обычно хочет более долгой 
densification-фазы. В 99 % слу­
чаев оставляйте заблокирован­
ным.
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I20 Степпер Densify Until

ГД Е

Инспектор → Training Configuration → GroupBox → 
Densify Until.

Т Е Х Н И Ч Е С К И

Степпер с диапазоном 500–50 000, шаг 500. 
Определяет индекс итерации, начиная с кото
рого больше не добавляются новые Gaussians 
через clone/split (Classic) или relocation (MCMC). 
После достижения уточняются только позиция 
и цвет. Более высокие значения = больше 
Gaussians = больший файл, более долгое per-
iteration-время (+30–60 % GPU-времени на шаг). 
Типичные значения: 15K (для 30K max-iter), 20K 
(для 40K), 100K (для 200K MCMC). При активном 
link (I19) автоматически масштабируется. Дей
ствует по-разному при Classic vs MCMC: Classic 
полностью останавливает рост, MCMC останав
ливает relocation-логику, но адаптация sample/
noise продолжает работать.

П Р О СТ Ы М И  С Л О В А М И

До какой итерации могут до­
бавляться новые Gaussians — 
при Classic через clone/split, 
при MCMC через relocation. По­
сле этого речь идёт только 
о цвете и уточнении формы 
существующих точек. Выше = 
больше детализации, но и боль­
ший файл и +30–60 % GPU-
времени на шаг. Типичные зна­
чения: 15K (для 30K max-iter), 
20K (для 40K), 100K (для 200K 
MCMC). Обычно висит через 
link (I19) на Max Iterations — 
редко имеет смысл разъеди­
нять это вручную.
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I21 Слайдер SSIM Weight

ГД Е

Инспектор → Training Configuration → GroupBox → 
SSIM Weight.

Т Е Х Н И Ч Е С К И

Слайдер 0.0–1.0 с шагом 0.05, отображается как 
«0.20». Смешивает L1 loss (0.0) и SSIM loss (1.0). 
L1 ужесточает яркость на пиксель, SSIM ужесто
чает структурное сходство (края, локальные ста
тистики). По умолчанию 0.2 — значение из ори
гинальной статьи 3DGS (Kerbl 2023) и обратно-
инженерно определено как устойчивый компро
мисс в многочисленных сессиях. Более высокие 
значения (0.5+) способствуют сохранению дета
лей, но могут игнорировать локальные ошибки 
яркости. Более низкие значения (< 0.1) ведут 
к потере деталей на резких краях. Вычисление 
SSIM работает в шейдере с гауссовым окном 
11×11. Производительность: при 0.0 (только L1) 
обучение примерно на 8–12 % быстрее, посколь
ку вычисление SSIM в шейдере пропускается.

П Р О СТ Ы М И  С Л О В А М И

Насколько сильно структурное 
сходство изображений (края, 
локальные паттерны) взвеши­
вается против чистого сравне­
ния яркости. 0.2 — стандарт 
из оригинальной статьи 3DGS 
и достаточен почти для всех 
сцен. Выше (0.5+) для тонких 
структур вроде волос, меха или 
растительности — там больший 
структурный вес помогает. Ни­
же (0.0) делает обучение при­
мерно на 8–12 % быстрее, по­
тому что вычисление SSIM в 
шейдере пропускается, но сто­
ит деталей на резких краях. 
Если у вас нет хорошей причи­
ны для изменения, оставьте 0.2 
как есть.
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I22 Слайдер Render Scale

ГД Е

Инспектор → Training Configuration → GroupBox → 
Render Scale.

Т Е Х Н И Ч Е С К И

Слайдер 0.25–1.0 с шагом 0.25, отображается как 
«100 %». Масштабирует разрешение рендерин
га обучения относительно размера исходного 
изображения. Самый большой рычаг производи
тельности: 50 % сокращает GPU-время прим. на 
75 % (поскольку в 4× меньше пикселей), 25 % 
— прим. на 94 %. Gradient threshold автоматиче
ски масштабируется. Под слайдером появляется 
живое отображение разрешения в MP (напр. 
«2304×1296 (3.0 MP)»). Если текущее значение 
отклоняется от рекомендованного, оранжевым 
текстом показывается «— recommended: 50 %». 
Рекомендация целится в ~3 MP эффективного 
разрешения — диапазон, наиболее эффективно 
обрабатываемый GPU Apple Silicon. Для 4K-ис
ходных изображений рекомендуется, напр., 25 
%, для FullHD — 100 %. Изменение дополнитель
но триггерит buffer reallocation.

П Р О СТ Ы М И  С Л О В А М И

При каком разрешении обуче­
ние рендерит — один из самых 
больших рычагов производи­
тельности. Full (100 %) даёт луч­
шее качество, но стоит много 
GPU-времени на больших изоб­
ражениях. Half (50 %) экономит 
примерно 75 % GPU-времени, 
потому что считается вчетверо 
меньше пикселей — идеально 
для 4K-источников. Под слай­
дером видно эффективное раз­
решение в мегапикселях; при­
ложение целится в около 3 
MP, поскольку это эффектив­
нее всего работает на Apple 
Silicon. Если ваше значение 
отклоняется, приложение по­
казывает оранжевую подсказ­
ку «recommended» — обычно 
имеет смысл ей следовать.
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Секция Enhancements (I26–I29, I42–I44)

Рисунок 12.  Вырезка только секции Enhancements — три строки: Post-Training 
Compactification (переключатель on), Viewport Scaling (сегментированный picker Off/

MetalFX/Lanczos), Perceptual Loss (слайдер на «Off»). Каждая строка с подзаголовком 
объясняет свою функцию

Секция Enhancements группирует три функции, которые улучшают качество изоб
ражения, не меняя сам базовый цикл обучения. Первые две (I26–I27) — это post-
training или viewport-этапы: Compactification наводит порядок после окончания 
обучения, а Viewport Scaling — чистый viewport-рендерер, не влияющий на идущее 
обучение. Perceptual Loss (I29), несмотря на принадлежность к секции, является 
компонентой обучения — активируется как дополнительный loss-член во время 
обучения, поэтому отделена от viewport-переключателей разделителем. Начиная 
с v1.6 секция дополнительно содержит группу Outdoor (I42–I44: Sky Masking, Mid-
Training Floater Cleanup, Reconstruct Sky Dome) — тренировочные опции против 
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floaters в небе, которые раньше жили в окне Settings, а теперь сидят здесь для 
каждого проекта.

I26 Переключатель Post-Training Compactification

ГД Е

Инспектор → Enhancements → Post-Training 
Compactification.

Т Е Х Н И Ч Е С К И

Активирует V443 post-processing: после завер
шения итераций обучения Gaussians с непро
зрачностью ниже 0.01 (1 % видимости) удаляют
ся. Эмпирически это уменьшает размер файла 
на ~55–58 % при нулевой видимой потере ка
чества — потому что эти Gaussians и так не 
вносят визуального вклада. Compactification ра
ботает как GPU compact pass и занимает от 
долей секунды до нескольких секунд в зависи
мости от числа Gaussians. Не влияет на произво
дительность обучения. Если этот переключатель 
выключен, невидимые Gaussians тоже экспор
тируются — актуально только если хотите ис
пользовать формат для другого этапа обучения 
(Continue Training), иначе впустую потраченное 
хранилище.

П Р О СТ Ы М И  С Л О В А М И

Чистит после обучения 
Gaussians, которые всё равно 
не видны (непрозрачность ни­
же 1 %). Делает экспорт-фай­
лы примерно вдвое меньше 
( 55–58 % уменьшения раз­
мера) без видимой потери ка­
чества. Работает как короткий 
GPU-pass после последней ите­
рации, занимает только доли 
секунды или несколько секунд. 
Практически всегда должно 
быть включено — единствен­
ная причина это выключить — 
если позднее хотите продол­
жить обучение через Continue 
Training и нужно сохранить 
невидимые Gaussians тоже. С 
обычными рабочими процесса­
ми экспорта просто оставьте 
включённым.
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I27 Picker Viewport Scaling

ГД Е

Инспектор → Enhancements → Viewport Scaling 
(сегментированный picker с тремя опциями: Off, 
MetalFX, Lanczos).

Т Е Х Н И Ч Е С К И

Единственный сегментированный picker, выби
рающий viewport-upscaler — три опции взаимо­
исключающие. Когда разрешение обучения (че
рез I22 Render Scale) ниже размера viewport, вы
бранный режим масштабирует отрендеренный 
кадр до размера дисплея. Off = простое били
нейное растягивание. MetalFX = ML-based Spatial 
Upscaler от Apple, самая резкая опция (ML-мо
дель оптимизирована на резкие края), overhead 
прим. 1–2 мс на кадр на GPU M3. Lanczos = 
Apple Metal Performance Shaders с 8-tap sinc-
resampling, классически без ML, минимальный 
overhead (< 0.5 мс), качество ниже MetalFX, 
но без ML-типичного «заглаживания» тонких ли
нейных структур. Конвейер рендерера перекон
фигурируется вживую при переключении — вид
но немедленно, без перезапуска. Предыстория: 
раньше это были два отдельных переключателя 
(MetalFX + Lanczos), которые могли быть включе
ны одновременно — противоречивое состояние, 
в котором MetalFX молча перекрывал Lanczos. 
Picker устраняет это состояние; возможно уна
следованное от старых сессий состояние «оба 
включены» самоисцеляется при следующем пе
реключении в MetalFX. Действует только на 
живой viewport, не на отрендеренные экспорты 
(orbit video, скриншоты) — те рендерятся в пол
ном разрешении источника.

П Р О СТ Ы М И  С Л О В А М И

Заостряет живое изображение 
в viewport — особенно полез­
но, если вы работаете с умень­
шенным разрешением обуче­
ния (Render Scale 50 %, см. I22). 
Три ступени, из которых все­
гда активна только одна: «Off» 
просто растягивает пиксели, 
«MetalFX» использует машин­
ное обучение Apple для самых 
резких краёв (практически все­
гда лучший выбор), «Lanczos» 
— классический фильтр без ML 
— возьмите его как fallback, 
если MetalFX в какой-то сцене 
заглаживает линии или пока­
зывает артефакты. Вступает в 
силу вживую, без перезапус­
ка. Действует только на живой 
viewport, не на экспортирован­
ные orbit-видео или скриншо­
ты — те рендерятся в полном 
разрешении источника. В от­
личие от прежнего поведения, 
вы больше не можете случайно 
выбрать два режима одновре­
менно.
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I29 Слайдер Perceptual Loss

ГД Е

Инспектор → Enhancements → Perceptual Loss.

Т Е Х Н И Ч Е С К И

Слайдер 0.0–0.2 с шагом 0.01, при 0.0 отобра
жается как «Off», иначе как «0.05» и т.д. Активи
рует дополнительный loss-член, сравнивающий 
многомасштабное гауссово размытие рендерин
га с ground truth-изображением (3 blur scale). 
Захватывает структурные различия, которые L1+ 
SSIM сами по себе не обнаруживают. Реализа
ция V460. Эмпирически значение 0.05–0.1 улуч
шает L1-балл в сессиях на несколько процентов, 
но стоит ~5 % времени обучения (дополнитель
ный forward pass через blur-kernel). Свыше 0.15 
обучение становится нестабильным, и L1 снова 
ухудшается (loss-член доминирует в оптимиза
ции). Действует во время обучения, не в post-
processing — несмотря на позицию в секции 
«Enhancements» это не чистая post-обработка.

П Р О СТ Ы М И  С Л О В А М И

Дополнительный loss-член, 
проверяющий структурное 
сходство изображений по трём 
разным стадиям размытия. 
Особенно помогает на сценах 
с тонкими структурами вроде 
волос, тканей или раститель­
ности, потому что захватывает 
паттерны, которые L1+SSIM са­
ми по себе не видят. Меньшие 
значения безопаснее — 0.05–
0.1 — sweet spot, выше 0.15 обу­
чение становится нестабиль­
ным, и loss снова ухудшается. 
При 0 (Off) функция полностью 
выключена и ничего не стоит; 
активная съедает примерно 5 
% времени обучения на допол­
нительный forward pass через 
blur-kernel. Действует, несмот­
ря на секцию «Enhancements», 
прямо во время обучения, не 
только в post-processing.
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I42 Маскирование неба

ГД Е

Инспектор → Enhancements (группа Outdoor) 
→ переключатель «Sky Masking». Bound: 
AppState.trainingConfig.skyMaskingEnabled (для 
каждого проекта, @DefaultFalse ). По умолча
нию: false .

Т Е Х Н И Ч Е С К И

Активирует pre-training сегментацию пикселей 
неба на основе Apple Vision. Перед стартом 
обучения для каждой входной камеры через 
Apple Vision foreground mask (Sky = Background) 
извлекается область неба и назначается со
ответствующей камере как per-pixel-маска. Во 
время обучения вклад loss на пиксель умножа
ется на дополнение к Sky Masking — пиксели 
неба вносят 0 в градиент, так что Gaussians, 
проецирующиеся в небо, не получают сигна
лов оптимизации и поэтому не «уплотняются» 
и не «ярчают». Существенно снижает floaters 
(тёмные сгустки в небе) в уличных/дроновых 
сценах. Стоит ~3 % регрессии L1 в класси
ческой 40K-тренировке (см. memory/​dev_​outdoor-
floater-reduction.md). Полезно только для улич
ных сцен с явно распознаваемым небом; для 
комнатных сцен или белого фона сегментация 
неба определяет неправильные области и блоки
рует валидные сигналы loss. Значение теперь 
хранится для каждого проекта (больше не гло
бально для приложения) и следует за предуста
новкой / файлом сцены.

П Р О СТ Ы М И  С Л О В А М И

На уличных снимках с небом в 
кадре в небе часто образуются 
чёрные или цветные сгустки — 
так называемые «floaters». Эта 
опция автоматически опреде­
ляет, где находится небо, и го­
ворит обучению: «Оставь небо 
в покое.» Очень хорошо рабо­
тает для полётов дронов и пей­
зажных сцен. Для помещений 
или тёмного фона может ухуд­
шать изображение — поэтому 
включайте, только когда вид­
но настоящее небо. Подроб­
ности: memory/​dev_​outdoor-
floater-reduction.md.
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I43 Очистка floater в середине обучения

ГД Е

Инспектор → Enhancements (груп
па Outdoor) → переключатель «Mid-
Training Floater Cleanup». Bound: 
AppState.trainingConfig.floaterCleanupEnabled 
(для каждого проекта, @DefaultFalse ). По умол
чанию: false .

Т Е Х Н И Ч Е С К И

Включает два дополнительных прохода density-
control во время Classic 40K-тренировки (пред
установка «P4 Quality»): на итерации 20 000 и 
30 000. Оба прохода сканируют все Gaussians 
по трём критериям: (a) очень низкая непро
зрачность (по умолчанию 0.005), (b) крошечный 
screen-space-размер, (c) нет вкладов в loss за 
последние 1000 итераций. Gaussians, отвечаю
щие всем трём условиям, удаляются. Эффект: 
~5–15 % меньше Gaussians в конце обучения, 
заметно меньше тёмных сгустков в небе для 
дроновых/уличных сцен. Стоит ~1–3 % регрес
сии L1 на ближних комнатных сценах, поэтому 
не включено по умолчанию. Две итерации очист
ки (20K, 30K) зашиты жёстко и в настоящее 
время не могут быть изменены через UI; для 
более коротких тренировок (напр. P2 Preview 5K) 
переключатель не имеет эффекта, потому что 
никогда не достигает отметок итераций. Новое: 
переключатель доступен только когда актив
ная предустановка использует Classic-densifier 
(densificationStrategy == .classic). При MCMC 
или Hybrid он disabled, и появляется inline-под
сказка, потому что эти стратегии обрабатывают 
мёртвые Gaussians сами (MCMC через relocation, 
Hybrid через комбинированную reloc-/noise-ло
гику) — ручные проходы очистки были бы 
там бесполезны или контрпродуктивны. Ссыл
ка на код: RadianceKitApp.swift, General-вклад
ка. Подробности: memory/​dev_​outdoor-floater-
reduction.md.

П Р О СТ Ы М И  С Л О В А М И

Во время обучения иногда 
образуются «мёртвые» точки 
Gaussian, которые больше не 
вносят вклад в качество изоб­
ражения, но занимают память. 
Эта опция дважды чистит длин­
ное обучение (на 20K и 30K 
итераций) и удаляет эти тру­
пы. Для уличных сцен с небом 
это особенно полезно, потому 
что там собирается большин­
ство floaters. Для маленьких 
тренировок или снимков ме­
бели крупным планом особо 
не нужно. Переключатель мож­
но включить только когда ва­
ша предустановка использует 
Classic-densifier — при MCMC- 
или Hybrid-предустановках он 
серый (с коротким пояснени­
ем), потому что они убирают 
свои мёртвые точки сами.
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I44 Реконструировать купол неба

ГД Е

Инспектор → Enhancements (группа Outdoor) 
→ переключатель «Reconstruct Sky Dome». 
Bound: AppState.trainingConfig.skyDomeEnabled 
(для каждого проекта, @DefaultFalse ). По умол
чанию: false .

Т Е Х Н И Ч Е С К И

Активирует pre-training проекцию Sky Dome 
(V549e MVP). После SfM и перед запуском обу
чения для каждой входной камеры извлекается 
shared с S7 маска неба Apple Vision из изображе
ния, пиксели неба un-проецируются с помощью 
intrinsics камеры на виртуальную сферическую 
поверхность (радиус по умолчанию — 8× радиус 
сцены). На этой сфере инициализируется ~5000 
новых Gaussians с цветовыми средними из спро
ецированных пикселей неба, очень большим 
масштабом (1.0 в единицах сцены) и начальной 
непрозрачностью 0.95. Эти 5000 Gaussians не 
являются маской неба в классическом смысле — 
они тренируются как все остальные, но высокая 
начальная непрозрачность удерживает их в тон
кой оболочке. Результат: для 360°-novel-views в 
уличных/дроновых сценах появляются реальные 
цвет неба и облачные структуры вместо тёмных 
сгустков конфетти. Значение запоминается меж
ду перезапусками. Полезно только для уличных 
сцен с покрытием камер не менее 360°; для чи
сто объектных съёмок без обзора неба не име
ет эффекта. Статус: экспериментальное, более 
широкая A/B-валидация на большем количестве 
уличных наборов ещё предстоит.

П Р О СТ Ы М И  С Л О В А М И

Вместо того чтобы обуче­
ние пыталось «угадать» небо 
по немногим видимым пиксе­
лям (что приводит к floaters), 
RadianceKit проецирует пиксе­
ли неба напрямую на виртуаль­
ную сферу вокруг сцены ещё 
до запуска обучения. Когда вы 
потом крутите готовую сцену 
в 360°, видно настоящее небо 
вместо чёрных сгустков. Рабо­
тает только для уличных съё­
мок, где небо действительно 
попадает в кадр. Для сканов го­
стиной или студийных съёмок 
не даёт ничего.
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Секция Metrics (I30–I38)

Рисунок 13.  Вырезка только секции Training Metrics после завершённого обучения на 
Bouquet (5K итераций, финально 2 991 Gaussians) — таблица с метриками обучения 

(Iteration, Loss, SSIM Loss, Combined Loss, Gaussian Count, Learning Rate, Elapsed, ETA)

Пока идёт обучение, секция Metrics показывает девять живых значений из цикла 
обучения. До начала обучения секция пуста («Start training to see live metrics»). 
Все значения обновляются каждые ~30 итераций (частота обновления потока). 
Секция read-only — ни один элемент не кликабелен и не изменяем. Для более глу
бокого анализа смотрите JSONL- training-логи под ~/​Documents/​RadianceKit/​Logs/​ 
(скрипт python3 scripts/​analyze_​logs.py best 5).
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I30 Iteration

ГД Е

Инспектор → Metrics → Iteration. Read-only.

Т Е Х Н И Ч Е С К И

Отображается в формате «4523 / 40000» — 
текущая итерация над общим планируемым чис
лом итераций. Считает синхронно с циклом обу
чения, который отправляет значения каждые ~30 
iter. Второе число соответствует значению Max 
Iterations на момент старта; оно больше не ме
няется, даже если пользователь подкручивает 
степпер позднее — идущий прогон использует 
собственную snapshot-копию. Если приложение 
через меню Training (Continue Training +5K/+10K/
+20K) додавливает дополнительные итерации, 
знаменатель увеличивается.

П Р О СТ Ы М И  С Л О В А М И

Где сейчас находится обуче­
ние. «4523 / 40000» означает: 
4523 из 40 000 шагов прой­
дено, т.е. около 11 % готово. 
Левое число идёт в реальном 
времени; если оно зависает на 
минуты, обучение застряло — 
обычно намёк на GPU-throttling 
или конкурирующее приложе­
ние. Правое число соответству­
ет значению Max Iterations (I18) 
на старте обучения и больше 
не меняется, даже если потом 
подкрутите степпер. С Continue 
Training (+5K/+10K/+20K) оно 
растёт на дополнительные ша­
ги.

I31 Loss

ГД Е

Инспектор → Metrics → Loss. Read-only.

Т Е Х Н И Ч Е С К И

Float-значение с шестью знаками после запятой 
(напр. «0.024385»). Измеряет комбинированный 
L1+SSIM loss (смесь управляется через I21 SSIM 
Weight) плюс опциональный Perceptual Loss (I29) 
и другие регуляризаторы. Шкала не абсолютная, 
а зависит от сцены — для большинства срав
нений требуется тот же датасет. Типичные ко
нечные значения при хороших конфигурациях: - 
Classic Quality 40K iter: 0.022–0.025 (Horse, Truck, 
Garden) - MCMC Full 200K iter: 0.024–0.028 - 
Outdoor drone 30K: 0.030–0.060 (хуже из-за гео
метрии) - Indoor apartments: 0.018–0.025

Значения выше 0.10 после 5K итераций указыва
ют на SfM- проблемы (плохие позы камер) — 
прервите и пересчитайте SfM.

П Р О СТ Ы М И  С Л О В А М И

Насколько отрендеренное 
изображение всё ещё отклоня­
ется от оригинала — комби­
нированно из L1, SSIM и, воз­
можно, Perceptual Loss. Мень­
ше — лучше. Ниже 0.03 — 
обычно действительно хорошо, 
ниже 0.05 — ещё нормально, 
уличные сцены лежат по гео­
метрическим причинам скорее 
на 0.03–0.06. Выше 0.10 после 
нескольких тысяч итераций — 
сигнал тревоги, обычно дело 
в реконструкции камер (SfM 
не сработал чисто). Шкала не 
абсолютна, а зависит от сце­
ны; сравнения — только внут­
ри одного датасета. Если чис­
ло вдруг скакнуло вверх, обыч­
но произошло событие gradient 
explosion.
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I32 Learning Rate

ГД Е

Инспектор → Metrics → Learning Rate. Read-only.

Т Е Х Н И Ч Е С К И

Отображение в научной нотации (напр. 
«1.60e-04»). Текущая скорость обучения для па
раметров позиции (у 3DGS шесть независимых 
LR для позиции, SH-DC, SH-Rest, непрозрачно
сти, масштаба, поворота — здесь отображает
ся позиция-LR как представительное значение). 
Начальное значение по умолчанию — 1.6e-4, ко
торое спадает через exponential decay до ~1.6e-6 
к концу обучения. Decay настраивается через 
поле LR schedule в training configuration (T-поле 
в главе 6). Если LR остаётся необычно высоким 
(напр. 1e-3 или более после 10K итераций), это 
может указывать на неверно загруженную кон
фигурацию.

П Р О СТ Ы М И  С Л О В А М И

Насколько большие сейчас ша­
ги оптимизации — конкрет­
но скорость обучения для по­
зиций Gaussian. Стартует на 
1.60e-04 и экспоненциально 
опускается к концу обучения 
до около 1.60e-06 («1.60e-06» 
= 0.0000016). Кривая идёт авто­
матически, тут ничего подкру­
чивать не надо. Если значение 
после 10 000+ итераций всё 
ещё больше 1e-3, вероятно, за­
гружена неверная конфигура­
ция — прервите обучение и вы­
берите новую предустановку. 
Внутри у 3DGS шесть независи­
мых learning rate (позиция, SH-
DC, SH-Rest, непрозрачность, 
масштаб, поворот); здесь вы 
видите только позицию-LR как 
представителя.

I33 SH Degree

ГД Е

Инспектор → Metrics → SH Degree. Read-only.

Т Е Х Н И Ч Е С К И

Integer 0–3. Степень спherical harmonics для цве
тового представления. Стартует на 0 (только DC-
компонента, т.е. независимый от направления 
цвет на Gaussian — значит только одна RGB-
константа) и прогрессивно растёт до 3 по ходу 
обучения. Стандартное расписание поднимает 
степень на итерациях 1000/2000/3000 на 1 каж
дый раз. SH-3 соответствует 48 цветовым коэф
фициентам на Gaussian (3 RGB-канала × 16 SH-
базисных функций). Более высокая SH-степень 
= более зависимое от направления отражение 
(глянцевые поверхности выглядят корректно по-
разному под разными углами обзора), но также 
больше памяти и более медленное обучение.

П Р О СТ Ы М И  С Л О В А М И

Насколько сложно сейчас 
цветовое представление на 
Gaussian. Стартует на 0 (только 
независимый от направления 
цвет на точку) и пошагово под­
нимается до 3 — типично на 
итерациях 1000, 2000 и 3000. 
Стадия 3 означает 48 цветовых 
коэффициентов на Gaussian и 
позволяет зависящие от на­
правления отражения, т.е. что 
глянцевые поверхности выгля­
дят корректно по-разному с 
разных углов обзора. Активно 
трогать не надо, расписание 
идёт автоматически. Более вы­
сокая степень стоит больше па­
мяти и немного замедляет обу­
чение — но это цена за реали­
стичные блики.
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I34 Gaussians

ГД Е

Инспектор → Metrics → Gaussians. Read-only.

Т Е Х Н И Ч Е С К И

Текущее число Gaussians в модели, отформати
ровано с locale-разделителем (напр. «524.318»). 
Рост: - Classic: стартует на SfM init-точках (обыч
но 50K–300K), растёт через clone/split до неза
долго до Densify Until, затем статично до конца 
обучения (по модулю pruning) - MCMC: sample-
точки добавляются до MCMC cap, затем только 
relocation

Здоровые конечные значения: - Classic Quality: 
400K–700K (Horse 524K, Garden 800K) - MCMC 
Full: точно на cap (по умолчанию 150K, с auto-
scale множителем × SfM count, в зависимости от 
сцены 500K–1.5M)

При MCMC, если число падает до < 60 % cap 
→ аномалия (collapse-индикатор, указывает на 
слишком агрессивные регуляризаторы).

П Р О СТ Ы М И  С Л О В А М И

Сколько точек Gaussian сей­
час имеет 3D-модель. Рас­
тёт во время обучения, по­
ка не достигнут Densify Until 
(I20); после этого число оста­
ётся практически постоянным. 
Больше точек = больше де­
тализации, но также больший 
файл и более медленный рен­
деринг в viewport. 500 000 
Gaussians — типичное среднее 
для Classic Quality на средней 
сцене; MCMC Full попадает в 
зависимости от auto-scale (I17) 
в 500K–1.5M. Если число при 
MCMC вдруг падает ниже 60 % 
cap, это индикатор коллапса — 
обычно слишком агрессивные 
регуляризаторы.

I35 GPU Memory

ГД Е

Инспектор → Metrics → GPU Memory. Read-only.

Т Е Х Н И Ч Е С К И

Оценка потребления памяти Gaussian-буфера 
как число Gaussians × 616 байт (отформатирова
но в memory-стиле). 616 байт — эмпирический 
размер полностью оснащённого Gaussian (по
зиция, масштаб, поворот, непрозрачность, SH-
коэффициенты степени 3, gradient accumulator). 
Отображение не учитывает overhead рендерера 
(tile buffer, sort buffer, backward buffer) — реаль
ная потребность в GPU-памяти обычно в 2–3 
раза выше этого значения. При 500K Gaussians: 
отображается ~290 MB, реально ~700 MB. При 
1.5M Gaussians: отображается ~880 MB, реально 
~2.5 GB. На M3 Max с 64+ GB Unified Memory не 
критично, на M3 Pro с 18 GB уже предел.

П Р О СТ Ы М И  С Л О В А М И

Оценка того, сколько GPU-па­
мяти занимают сами Gaussians 
— около 616 байт на точку. Фак­
тическое потребление GPU в 2–
3 раза выше отображаемого, 
поскольку рендерер добавляет 
свои собственные tile-, sort- и 
backward-буферы. На MacBook 
с 16–18 GB unified memory 
лучше оставаться ниже 500K 
Gaussians; с M3 Max или Studio 
(64+ GB) можно спокойно кру­
тить 1.5M и больше. Если обу­
чение вдруг падает или систе­
ма свопит, обычно достигнут 
именно этот предел — умень­
шите Render Scale (I22) или 
Densify Until (I20).
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I36 Speed

ГД Е

Инспектор → Metrics → Speed. Read-only.

Т Е Х Н И Ч Е С К И

Итерации в секунду с одним знаком после за
пятой («24.3 it/s»). Вычисляется тренером как 
скользящее среднее по последним ~100 итера
циям. Типичные значения: - предустановка Quick 
(1K iter): 80–120 it/s (коротко, без устойчивого 
состояния) - Classic 20K @ 1.0 Render Scale (сце
на Truck, M3 Max): 25–35 it/s - Classic 20K @ 
0.5 Render Scale: 80–120 it/s - MCMC 200K @ 
0.5 Render Scale: 25–50 it/s (медленнее из-за 
relocation) - При 1M+ Gaussians и полном разре
шении: < 10 it/s

Уменьшение скорости по ходу обучения нор
мально — больше Gaussians = больше вычисле
ний на итерацию. Внезапные провалы (напр. с 30 
→ 5 it/s) указывают на GPU thermal throttling или 
конкурирующие приложения.

П Р О СТ Ы М И  С Л О В А М И

Насколько быстро идёт обуче­
ние, в итерациях в секунду. 
Обычно стоит на 20–50 it/s, 
с уменьшенным Render Scale 
(50 %) и маленькими сцена­
ми — и 80–120 it/s. Опускает­
ся по ходу обучения вполне 
естественно, поскольку больше 
Gaussians = больше работы на 
итерацию. Внезапные провалы 
(напр. 30 → 5 it/s) указывают 
на GPU thermal throttling или 
конкурирующие приложения — 
вкладки браузера с видео, Time 
Machine backup, индексацию 
Photos. Удержание приложения 
на переднем плане и закрытие 
фоновых программ часто помо­
гает. При 1M+ Gaussians и пол­
ном разрешении ниже 10 it/s — 
норма.

I37 Elapsed

ГД Е

Инспектор → Metrics → Elapsed. Read-only.

Т Е Х Н И Ч Е С К И

Уже прошедшее время как «4:23» (m:ss) или 
«1:23:45» (h:mm:ss). Смена формата от 1 часа. 
Измеряет только чистое время обучения, не 
предшествующие фазы (вычисление SfM, импорт 
изображений). С pause/resume часы продолжают 
идти — так что это wall-clock, не CPU time.

П Р О СТ Ы М И  С Л О В А М И

Сколько времени уже работа­
ет обучение, как чисто секун­
домер (wall-clock time). Формат 
— «m:ss» до одного часа, за­
тем «h:mm:ss». Не «CPU time», 
а «как долго мы уже ждём» 
— так что время пауз тоже 
считается. Измеряет только чи­
стую фазу обучения, не пред­
шествующее вычисление SfM 
или импорт изображений. По­
лезно для сравнения с ETA (I38) 
— если Elapsed явно превыша­
ет изначальный ETA, обучение 
где-то стало медленнее запла­
нированного.
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I38 ETA

ГД Е

Инспектор → Metrics → ETA. Read-only.

Т Е Х Н И Ч Е С К И

Оценочное оставшееся время как «17:42» или 
«1:12:35». Расчёт: (Max Iterations − текущая ите
рация) / итерации в секунду. Показывает «–», 
когда скорость сейчас нулевая (в самом начале 
или во время паузы). Оценка не подстраивается 
под типичное замедление к концу обучения — 
особенно при MCMC и Classic с большими значе
ниями Densify-Until обучение склонно становить
ся медленнее, потому что появляется всё больше 
Gaussians. Реально обычно остаётся на 10–20 % 
выше изначального ETA.

П Р О СТ Ы М И  С Л О В А М И

Сколько времени ожидаемо 
осталось — считается из остав­
шихся итераций и текущей ско­
рости (I36). Грубая оценка: ес­
ли Mac вдруг становится мед­
леннее (больше Gaussians из 
densify-фазы, thermal throttling, 
другие приложения), может 
длиться дольше отображённо­
го. Приложение не учитывает 
типичное замедление к концу 
обучения, так что реальный ко­
нец обычно попадает на 10–
20 % выше изначального ETA. 
Плюс 15 %, и обычно сходит­
ся. Показывает «–», когда ско­
рость сейчас 0 (старт обучения 
или пауза).
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Секция Loss Chart (I39–I41)

Рисунок 14.  Вырезка только секции Loss History после завершённого обучения — 
Current 0.0064, Min 0.0035 (зелёный), синяя кривая от 0.027 (итерация 1) к 0.0035 

(итерация 5K) с характерным изгибом около iter 200, ниже график Gaussian Count оран­
жевым

Секция Loss Chart визуализирует ход обучения со временем. Состоит из двух 
графиков: Loss Curve (большой, сверху, синий) и Gaussian Count (меньше, снизу, 
оранжевый). Оба строятся вживую во время обучения и сохраняются до следу
ющего старта обучения. До первого обучения область пуста («Loss curve will 
appear during training»). Графики — чистые SwiftUI path-drawings (не Swift Charts 
framework), поэтому рендерятся плавно даже при 100K+ точек.
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I39 Current Loss (отображение)

ГД Е

Инспектор → Loss Chart → левая label-область 
«Current: 0.0287». Read-only.

Т Е Х Н И Ч Е С К И

Float-значение последней точки loss-выборки, 
форматировано с четырьмя знаками после запя
той. Идентично с I31 (Loss в секции Metrics), 
здесь только компактнее отформатировано. Ис
точник — loss-history — список, получающий 
запись каждые ~30 итераций. В список добав
ляются только конечные значения — NaN/Infinity 
(очень редко, в случае gradient explosion bug) 
фильтруются.

П Р О СТ Ы М И  С Л О В А М И

Текущее значение loss в бо­
лее короткой нотации, чем в 
секции Metrics (четыре зна­
ка после запятой). Содержа­
тельно идентично с I31, но 
здесь отображение сидит пря­
мо у loss-графика и даёт точ­
ное числовое значение при 
наблюдении за кривой. Как 
все живые метрики, обновля­
ется каждые  30 итераций. 
NaN или Infinity (крайне ред­
ко при gradient-explosion-ба­
гах) приложение автоматиче­
ски отфильтровывает. Полезно 
при взгляде на график, чтобы 
не прыгать в другую секцию.

I40 Min Loss (отображение)

ГД Е

Инспектор → Loss Chart → правая label-область 
«Min: 0.0245» (зелёный). Read-only.

Т Е Х Н И Ч Е С К И

Минимум всех когда-либо виденных значений 
loss текущего прогона обучения. Живо пересчи
тывается из loss-history — никакого отдельного 
сохранения. Отображается зелёным текстом, по
тому что «Min» = «лучший на данный момент». 
Пунктирная зелёная линия на нижнем краю 
графика визуально маркирует эту Y-позицию. 
С continue- training-сессиями отслеживание min 
рестартует — старая история заменяется в UI но
вой (не дописывается). Если текущее обучение 
идёт хуже предыдущего, отображение min может 
оказаться больше предыдущего конечного ре
зультата.

П Р О СТ Ы М И  С Л О В А М И

Самое низкое значение loss, 
которое это обучение до сих 
пор видело — показано зе­
лёным, потому что «лучший 
на данный момент». Пунктир­
ная зелёная линия на нижнем 
краю графика визуально мар­
кирует эту позицию. Если теку­
щая кривая сейчас лежит явно 
выше неё, надеемся, ещё будет 
улучшение; обычно Min — ин­
дикатор конечного результата, 
который вас потом и интересу­
ет. С continue-training- сессия­
ми отслеживание min рестарту­
ет, потому что старая история 
заменяется в UI новой — значе­
ние min может поэтому выгля­
деть хуже предыдущего конеч­
ного результата.
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I41 График Gaussian Count

ГД Е

Инспектор → Loss Chart → второй график снизу 
(оранжевый). Read-only.

Т Е Х Н И Ч Е С К И

Линейный график числа Gaussians по итераци
ям обучения. Источник: история числа Gaussians 
(список пар (iter, count), заполняемый тренером 
каждые ~30 iter). Y- шкала динамическая между 
минимумом и максимумом истории. При страте
гии Classic кривая обычно выглядит так: стабиль
но растёт до Densify Until, потом плоская (с 
маленькими pruning-колебаниями). При MCMC: 
крутой подъём до cap, затем горизонтальная ли
ния (relocation удерживает число постоянным). 
Если кривая падает несмотря на активное обу
чение, densification прунит слишком агрессивно 
— индикация неверных дефолтов или известного 
MCMC-collapse- бага (тема hotfix v1.4.4).

П Р О СТ Ы М И  С Л О В А М И

Как развивается число 
Gaussians по времени обучения 
— меньший оранжевый график 
под кривой Loss. При стратегии 
Classic линия стабильно рас­
тёт, пока не достигнут Densify 
Until (I20), после этого остаётся 
плоской с маленькими pruning-
колебаниями. При MCMC стре­
лой выстреливает до cap, за­
тем остаётся горизонтальной, 
потому что relocation удержи­
вает число постоянным. Если 
кривая несмотря на активное 
обучение вдруг ломается вниз, 
densification слишком агресси­
вен с pruning — классический 
признак MCMC-collapse-бага из 
v1.4.4. Тогда помогает обновле­
ние приложения или возврат к 
Classic.

Как читать кривую loss?

График loss — важнейший диагностический инструмент в Инспекторе — ни один 
другой индикатор не показывает так напрямую, продвигается ли обучение полез
но или застряло. Типичная здоровая форма — быстрый спад в первые 1000–3000 
итераций (от ~0.15 до ~0.05), за которым следует медленный, устойчивый спад до 
конца обучения (до 0.020–0.030). Логарифмически кривая выглядит как гладкая 
диагональ.

Что означает плато в loss? Если кривая остаётся плоской несколько тысяч итера
ций, есть два возможных прочтения: (a) обучение «сошлось» — loss больше не 
может существенно падать, потому что модель так хороша, как может быть с дан
ными данными и настройками. Это желаемое; это «готово». (b) Обучение «висит» 
— loss мог бы ещё падать, но оптимизация застаивается (локальный минимум, 
learning rate слишком мал, densification выключен). Различение: если значение loss 
лежит в типично хорошем диапазоне (0.020–0.030 при indoor/object, 0.040–0.060 
при outdoor), и кривая плоская с 5K итераций, оно сошлось. Если значение явно 
выше, чем у сравнимых сцен (напр. 0.08), оно висит.

Примечание: плато Gaussians ≠ плато Loss. Плато по числу Gaussians не означа
ет «обучение готово». Это только означает, что densification перестал добавлять 
новые точки — либо потому что достигнут (Classic), либо потому что MCMC 
cap полон. Обучение продолжается после этого и только уточняет существующие 
точки. Фактический сигнал «готово» вы читаете по кривой loss и по отображению 
Iteration (I30), не здесь.
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Правило большого пальца для отмены: Если кривая loss после 5000+ итераций 
лежит выше 0.08 и едва ли снижается, с высокой вероятностью SfM-реконструк
ция перекошена. Прервите обучение, загляните в главу 9, подходит ли выбранный 
SfM-бэкенд к сцене, при необходимости переключитесь на COLMAP/Native, потом 
перезапустите. Лучше вложить 10 минут в лучший SfM, чем 2 часа обучения с 
плохим выравниванием камер.

Когда обращаться к Инспектору?

Быстрая справка: какая секция + какие элементы управления для какого типично
го варианта использования?
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Распространённая задача Секция ID элементов

Обесцветить цвета готового 
Splat

Look L1 (Saturation)

Округлить игольчатые/кон
фетти Splat-ы

Look L2 (Splat length)

Заполнить дырявое облако / 
увеличить Splat-ы

Look L3 (Splat size)

Притушить дальние «конфет
ти» на orbit-съёмках

Look L4 (Fade far region)

Отбросить коррекции Look Look L5 (Reset finishing)

Загрузить готовую настройку Presets I7 (клик по строке)

Сохранить свою настройку Presets I1 → I2 → I4

Поделиться настройкой с 
коллегой

Presets I5 (Export) или I6 (Import)

Сменить SfM-бэкенд (напр., 
потому что Apple-PG слиш

ком нестабилен)

Training 
Configuration

I12 (см. гл. 9)

Обработать видеокадры без 
EXIF focal length

Training 
Configuration

I13 (FOV Override)

COLMAP-производитель
ность: GLOMAP вместо 

Classic

Training 
Configuration

I14

Переключить с Classic на 
MCMC

Training 
Configuration

I15

Дать обучению дольше рабо
тать

Training 
Configuration

I18 (Max Iter) + I20 (Densify 
Until) — связаны через I19

Уполовинить GPU-время Training 
Configuration

I22 (Render Scale на 50 %)

Качество обучения +6 % 
(MCMC)

Training 
Configuration

I16 (MCMC Quality)

Уличная сцена с большим 
числом SfM-точек

Training 
Configuration

I17 (Auto-scale by scene)

Настроить / сменить путь 
COLMAP

Training 
Configuration

I23 / I24 / I25

Сделать экспорт-файлы 
меньше

Enhancements I26 (всегда оставлять вклю
чённым)

Более резкий viewport без 
увеличения времени обуче

ния

Enhancements I27 (Viewport Scaling → 
MetalFX)

MetalFX слишком сильно 
сглаживает → альтернатива

Enhancements I27 (Viewport Scaling → 
Lanczos)Последний процент детали

зации с тонкими структурами
Enhancements I29 (Perceptual Loss 0.05–0.1)Мониторинг обучения Metrics I30 (прогресс), I36 (темп), I38 

(оставшееся время)
Раннюю оценку качества Metrics I31 (Loss < 0.05 после 5K = 

хорошо)
Подозрение на SfM-пробле

му
Metrics + Loss Chart I31 + I39 (Loss > 0.08 после 

5K → SfM-redo)
Различать convergence vs за

стрял
Loss Chart I39 + I40 (читать loss-плато)Выявить densification-про

блему
Loss Chart I41 (кривая Gaussian падает → 
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Г Л А В А

Глава 3 — Настройки

Окно настроек открывается через RadianceKit → Settings… или стандартное кла
виатурное сокращение ⌘, . Оно содержит две вкладки: General и AI Helpers. В 
отличие от значений Инспектора из главы 2, настройки в этом окне действуют 
глобально для приложения (для всех проектов) — они сохраняются и пережи
вают перезапуск приложения. Вкладка General группирует три содержательные 
секции: Interface, Viewport и Training. (Три переключателя Outdoor-Floater — Sky 
Masking, Mid-Training Floater Cleanup, Reconstruct Sky Dome — которые раньше 
жили здесь, начиная с v1.6 переехали в секцию Enhancements Expert-Инспектора, 
где теперь хранятся для каждого проекта; см. главу 2, I42–I44.) Вкладка AI Helpers 
включает on-device ML-помощников (Vision, CoreML) для предобработки SfM и 
тренировки.

Прежних элементов управления для совместного включения или выключения всех 
AI Helpers в текущей версии больше нет — они здесь не документируются. Преж
няя область «Coming Soon» для ещё не поставляемых помощников также удалена 
и здесь не упоминается.
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Вкладка General

Рисунок 15.  Settings → вкладка General с секциями Interface, Viewport, Training и 
Experimental
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S1 Режим по умолчанию

ГД Е

Settings → General → Interface → Default Mode 
picker. Bound:. По умолчанию: .simple .

Т Е Х Н И Ч Е С К И

Управляет тем, в каком из двух режимов UI 
приложение открывается при следующем запус
ке. «Simple Mode» — это направляемый рабочий 
процесс мастера из 4 шагов (Import → Processing 
→ Preview → Export, документирован в главе 10 
под Z1–Z4), «Expert Mode» — классическая трёх
панельная раскладка с Navigator, 3D Viewport и 
Expert Inspector из главы 2. Значение запомина
ется между перезапусками. Эффект идентичен 
меню Mode → Simple Mode (⌘1) / Mode → Expert 
Mode (⌘2), за исключением того, что меню пере
ключает текущую сессию, а этот picker задаёт 
значение по умолчанию для будущих сессий. 
Оба режима обращаются к одному и тому же со
стоянию проекта — проекты, камеры и конфигу
рация обучения сохраняются при переключении 
режимов. Специфичные для режима кнопки па
нели инструментов перерендериваются немед
ленно.

П Р О СТ Ы М И  С Л О В А М И

Здесь вы выбираете, с каким 
интерфейсом RadianceKit запу­
стится при следующем старте. 
«Simple Mode» — режим для 
новичков: четыре чётких ша­
га, готовые предустановки, по­
чти нет опций. «Expert Mode» 
— полная раскладка с инстру­
ментами и всеми элементами 
управления, которые вы видите 
в главе 2. Можно в любой мо­
мент переключаться через ме­
ню «Mode», не теряя изображе­
ний или прогресса тренировки.
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S2 Язык

ГД Е

Settings → General → Interface → Language picker. 
Bound:. По умолчанию: .system  (следует языку 
macOS).

Т Е Х Н И Ч Е С К И

Выбирает язык отображения всего UI приложе
ния независимо от системного языка macOS. 
RadianceKit локализован на 17 языков ( de , en , 
pl , en-AU , ar-SA , плюс 12 других). При 

значении «System» приложение следует языку 
macOS. При явном выборе языковая настрой
ка запоминается между перезапусками; полный 
эффект обычно требует перезапуска приложе
ния, поскольку бандлы локализации загружаются 
только при старте. Все 298 задокументирован
ных ключей локализации в проекте учитываются, 
включая все тексты в подвидах и подсказках по
мощи.

П Р О СТ Ы М И  С Л О В А М И

Если ваш Mac работает на 
английском, но вы предпо­
читаете немецкий интерфейс 
RadianceKit (или наоборот), за­
дайте это здесь. Большинство 
текстов меняется немедленно. 
Некоторые диалоги появляются 
на новом языке только после 
перезапуска приложения.

S3 Фон Viewport

ГД Е

Settings → General → Viewport → Background 
picker. Bound:. По умолчанию: .darkGray  (RGB 
0.1, 0.1, 0.1).

Т Е Х Н И Ч Е С К И

Задаёт цвет фона по умолчанию для 3D Viewport. 
Три варианта: «Dark Gray» (RGB 0.1, 0.1, 0.1 — 
по умолчанию), «Black» (0, 0, 0) и «White» (1, 
1, 1). Настройка фиксирует значение по умолча
нию для новых проектов и сессий между переза
пусками и одновременно немедленно обновляет 
работающий рендерер Metal. Идентичные опции 
находятся в меню Viewport →
Background (M21, M22, M23), но picker настро
ек задаёт значение по умолчанию, а меню 
переключает текущее отображение. Важно для 
скриншотов и демо-видео: белый фон сильнее 
выделяет зелёные/синие floaters, тёмный фон 
лучше для чистых render-захватов.

П Р О СТ Ы М И  С Л О В А М И

Цвет за вашими 3D-моделями 
в окне предпросмотра. Тёмно-
серый — по умолчанию и под­
ходит большинству сцен. Бе­
лый хорош для скриншотов, 
чёрный смотрится изящнее на 
render- захватах. Цвет для те­
кущей сцены можно в любой 
момент переключить через ме­
ню «Viewport → Background» — 
эта настройка только опреде­
ляет, какой цвет активен снова 
при следующем открытии.
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S4 Авто-вращение после обучения

ГД Е

Settings → General → Viewport → переключатель 
«Auto-Rotate After Training». Bound:. По умолча
нию: false .

Т Е Х Н И Ч Е С К И

Запускает непрерывное вращение камеры 
Viewport вокруг центра сцены сразу после окон
чания обучения (скорость вращения по умолча
нию ~0.3 rad/s). Практически полезно для демо-
сессий, A/B-сравнений и для немедленной оцен
ки с обзора 360°, образовались ли «floaters» на 
краю сцены. Эффект визуально идентичен меню 
Viewport → Toggle Auto-Rotation (M16, ⌘⌥T), за 
исключением того, что этот переключатель сра
батывает автоматически после окончания обуче
ния, а не вручную. Может быть прерван в любой 
момент через меню или щелчком в Viewport (па
уза вращения). Не влияет на производительность 
обучения — вращение запускается только после 
его окончания.

П Р О СТ Ы М И  С Л О В А М И

Когда включено, 3D-сцена на­
чинает автоматически вра­
щаться сразу после заверше­
ния обучения — как карусель. 
Удобно, когда обучаете на ночь 
и хотите утром сразу увидеть 
результат в движении, не щёл­
кая мышкой. Для длинных сес­
сий, где вы только наблюдаете 
за обучением, оставьте выклю­
ченным.

74 / 235



R A D I A N C E K I T Глава 3 — Настройки

S5 Интервал живого предпросмотра

ГД Е

Settings → General → Training 
→ Live Preview picker. Bound: 
AppState.trainingConfig.livePreviewInterval. По 
умолчанию: 0  (Off).

Т Е Х Н И Ч Е С К И

Определяет интервал итераций, на котором 
текущий снимок обучения рендерится в 3D 
Viewport. Четыре дискретных значения: 0 
(«Off»), 50, 250, 1000 итераций. С активным 
Live Preview тренер копирует буфер Gaussian с 
GPU в отдельный render-буфер и триггерит пере
рисовку Viewport. С «Off» Viewport обновляется 
только после завершения обучения. Цена произ
водительности: каждые 50 итераций — на ~5–10 
% медленнее на M3 Ultra, каждые 250 итераций 
— ~1–2 % медленнее, каждые 1000 итераций 
— неизмеримо. Накладные расходы памяти — 
постоянные ~2 ГБ для snapshot-буфера, незави
симо от интервала. Значение служит как значе
ние по умолчанию для новых тренировок; после 
запуска обучения Training Inspector показывает 
фактическое живое значение запущенной трени
ровки. На интервале 50 визуальное впечатление 
— плавный «рост» облака точек, на 1000 выгля
дит рывками.

П Р О СТ Ы М И  С Л О В А М И

Пока идёт обучение, можно вы­
брать, как часто обновляется 
3D-вид. «Off» означает: без об­
новления во время обучения 
(быстрее всего). «Каждые 50 
итераций» показывает почти в 
реальном времени, как склады­
вается ваша сцена (чуть мед­
леннее). Для комфортного на­
блюдения за небольшим обуче­
нием «каждые 250» — хоро­
ший компромисс.
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S6 Задержка throttle

ГД Е

Settings → General → Training → Throttle picker. 
Bound: AppState.trainingConfig.throttleDelayMs. 
По умолчанию: 0  (Off).

Т Е Х Н И Ч Е С К И

Вставляет искусственную задержку в миллисе
кундах между итерациями обучения. Четыре 
дискретных значения: 0 («Off»), 2 («Light»), 5 
(«Moderate»), 10 («Eco»). Назначение: при более 
долгих тренировках (несколько часов) GPU ина
че был бы загружен на 100 %, что приводит к 
заметно более медленному системному UI (кур
сор мыши заедает, другие приложения становят
ся вялыми). Задержка throttle даёт GPU паузы, в 
которые могут выполняться другие задачи. Цена 
производительности значительна: при throttle 5 
мс типичная 40K-тренировка длится примерно 
на 50–80 % дольше, чем без throttle. В режиме 
производительности «Eco» (10 мс) задержка на 
итерацию больше самой итерации — в 2–3 ра
за медленнее. При активном throttle под picker 
появляется примечание: «Throttle is on. Training 
will be slower than usual.» Само приложение не 
реагирует заметно лучше — выигрывают только 
другие приложения.

П Р О СТ Ы М И  С Л О В А М И

Если во время длительного 
обучения Mac слишком сильно 
греется или другие програм­
мы становятся слишком мед­
ленными, включите здесь тор­
моз. «Off» даёт GPU полный газ 
(быстрее всего). «Light» делает 
маленькую паузу между каж­
дым шагом (чуть медленнее, 
но система реагирует лучше). 
«Eco» — самый сильный тор­
моз — хорошо для ночных тре­
нировок на MacBook, который 
не должен слишком греться.
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Вкладка AI Helpers

Рисунок 16.  Settings → вкладка AI Helpers с главным переключателем и подпереключа­
телями
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S11 AI Helpers включены (Master)

ГД Е

Settings → AI Helpers → первая секция → пе
реключатель «AI Helpers enabled». Bound:. По 
умолчанию: true .

Т Е Х Н И Ч Е С К И

Главный переключатель над всеми функциями AI 
Helpers в конвейере. Когда выключен, конвейер 
импорта и SfM полностью пропускает все эта
пы ML-предобработки — никаких вызовов Apple 
Vision, никакой загрузки моделей CoreML, ника
кого пробуждения NPU. Когда включен, опраши
ваются отдельные подпереключатели (S12–S13). 
Значение запоминается между перезапусками. 
Затрагивает следующие этапы: (a) предвари
тельный контроль качества кадра перед SfM 
(S12), (b) обнаружение замыкания петли (S13). 
Важно: когда выключен, два подпереключателя 
деактивированы и визуально серые. Сноска в 
нижней части подчёркивает, что все AI Helpers 
работают строго on-device — никакой загруз
ки изображений, никакой облачной обработки. 
Гарантия приватности обеспечивается исклю
чительным использованием фреймворка Apple 
Vision (локально на Neural Engine) и моделей 
CoreML, которые поставляются прямо в бандле 
приложения.

П Р О СТ Ы М И  С Л О В А М И

Главный переключатель всех 
функций, которые внутри ис­
пользуют AI/машинное обуче­
ние. По умолчанию — «вкл», 
потому что помощники эконо­
мят много времени, не давая 
вашим изображениям покидать 
Mac. Если вы хотите их полно­
стью отключить (напр. для эко­
номии энергии или потому что 
у вашего Mac нет NPU), отклю­
чите здесь — две подопции ни­
же тогда автоматически станут 
серыми и больше ничего не де­
лают.
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S12 Контроль качества кадра

ГД Е

Settings → AI Helpers → секция Available → пе
реключатель «Frame quality check». Bound:. По 
умолчанию: true .

Т Е Х Н И Ч Е С К И

Активирует screener качества кадра (фаза 3.11), 
который анализирует каждый импортированный 
кадр перед вызовом SfM. Шаги конвейера на 
кадр: (a) Laplacian variance-фильтр из Apple 
Vision (обнаружение размытия — порог ~150), 
(b) гистограмма-based проверка над-/недо-экс
позиции (порог: >5 % пикселей на 0 или 255), 
(c) blank frame detect (стандартное отклонение 
< 5 по всем пикселям). Кадры, проходящие все 
три проверки, пропускаются напрямую. Кадры, 
не прошедшие хотя бы одну проверку, тригге
рят модальный диалог подтверждения, который 
перечисляет каждый проблемный кадр с миниа
тюрой и причиной и спрашивает, нужно ли его 
удалить. Важно: никакого автоматического уда
ления — диалог всегда требуется, окончательное 
решение остаётся за пользователем. Производи
тельность: ~50 мс на кадр на M3 Ultra, работает 
параллельно. Когда выключен, все кадры пере
даются в SfM без проверки. Если мастер (S11) 
деактивирован, этот переключатель визуально 
серый и не имеет эффекта. Статус поставки по 
memory: SHIPPED 2026-05-23.

П Р О СТ Ы М И  С Л О В А М И

Перед собственно обучением 
приложение смотрит на каж­
дую фотографию: размыта ли? 
полностью тёмная или белая? 
пустая? Если да, оно спраши­
вает, не хотите ли вы выбро­
сить изображение — оно нико­
гда не удаляет ничего автома­
тически. Это потом экономит 
много часов, потому что одна 
полностью размытая фотогра­
фия иногда может испортить 
всё обучение. По умолчанию — 
«вкл», потому что стоимость 
почти нулевая, а выгода боль­
шая.
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S13 Обнаружение замыкания петли

ГД Е

Settings → AI Helpers → секция Available → пере
ключатель «Loop closure detection». Bound:. По 
умолчанию: true .

Т Е Х Н И Ч Е С К И

Активирует обнаружение замыкания петли на 
основе feature-print Apple Vision. Для каждо
го импортированного кадра вычисляется вектор 
признаков размерностью ~768, представляющий 
нейронное embedding содержания изображения. 
Все feature-prints затем попарно сравниваются 
через cosine-similarity. Пары с similarity > 0.85 
и расстоянием по индексам кадров > 50 (т.е. 
несоседние кадры) идентифицируются как «loop 
closure candidates» и записываются в sidecar 
JSONL-файл в папке проекта. Только информа
ционно — импортированная последовательность 
изображений не модифицируется. Назначение: 
даёт SfM-решателю (особенно COLMAP) под
сказку, что эти кадры кластеризуются в 3D- 
пространстве. Для нативного SfM информация 
sidecar пока только документационная; COLMAP 
использует подсказки внутренне через custom 
matches-файл (ручная интеграция возможна, не 
подключается автоматически). Производитель
ность: ~200 мс на кадр на M3 Ultra, работает 
параллельно. Когда выключен, feature prints не 
генерируются. Если мастер (S11) деактивирован, 
визуально серый.

П Р О СТ Ы М И  С Л О В А М И

Когда вы обходите объект во 
время съёмки и снова оказыва­
етесь у точки старта, компьюте­
ру это очень помогает знать. 
Эта опция автоматически опре­
деляет, какие из ваших фото­
графий сделаны «почти с того 
же места», и записывает это 
в маленький вспомогательный 
файл. SfM-инструменты (осо­
бенно COLMAP) могут исполь­
зовать эту информацию для бо­
лее чистой 3D-реконструкции. 
По умолчанию — «вкл», потому 
что работает без вашего вме­
шательства и ничего не меняет 
в ваших изображениях.

Зеркальные настройки Инспектора

Остальные записи настроек (S17–S33) из инвентарной таблицы являются зерка
лами из Expert Inspector и документируются в главе 2 (элементы управления 
Инспектора I12–I29). Они физически не появляются в окне настроек, а были 
перечислены в инвентаре только потому, что выполняются через свойства 
TrainingConfig , которые сохраняются через и поэтому формально имеют харак

тер настроек. Содержательные объяснения — см. там.
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Когда что?

Настройка Область Сохранение

S1 Default Mode Глобально для приложения Перезапуск

S2 Language Глобально для приложения Перезапуск

S3 Viewport 
Background

Глобально (по умолч.) + Runtime Перезапуск

S4 Auto-Rotate 
After Training

Глобально для приложения Перезапуск

S5 Live Preview 
Interval

По умолчанию для новых трениро
вок

Перезапуск

S6 Throttle Delay По умолчанию для новых трениро
вок

Перезапуск

S11 AI Helpers 
Master

Глобально для приложения Перезапуск

S12 Frame quality 
check

Глобально для приложения Перезапуск

S13 Loop closure 
detection

Глобально для приложения Перезапуск

«Глобально для приложения» = затрагивает все проекты. «По умолчанию для 
новых тренировок» = затрагивает только следующую создаваемую тренировку; 
идущие сессии остаются без изменений. «Текущая тренировка» = вступает в силу 
немедленно для текущей конфигурации обучения, но не сохраняется без явного 
повторного импорта.
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Г Л А В А

Глава 4 — Вспомогательные окна

Besides the main window (3D viewport plus Inspector), RadianceKit manages seven 
additional windows, all of which are opened via the Help menu. The list from top to 
bottom: User Guide (⌘?), Keyboard Shortcuts (⌘/), Open Training Logs… (does not 
open an app window, but the Finder; therefore not covered further here), Manage 
Storage…, Pareto Dashboard… (⇧⌘D), Holdout Analysis… (⇧⌘H), BayesOpt Console… 
(⇧⌘B). Three of these — Dashboard, Holdout, BayesOpt — are standalone analysis 
tools. They each have their own view-model stack, read or write JSON files on disk, and 
there is a CLI argument for each that lets you point the window at a specific file directly 
at app startup ( --dashboard-dir , --holdout-file , --bayesopt-autorun ).

The four simple windows (User Guide, Keyboard Shortcuts, Manage Storage, plus the 
submenu items Open Training Logs / Open Exports Folder) get a short entry per control. 
The three analysis windows are documented in more detail — each with an introduction 
explaining what you see in the window, when you should open it, and how to interpret 
the picture shown.

At the end of the chapter there is a cross-reference section to the main window’s 
Inspector: what you can meaningfully read from the live loss chart and the Gaussian 
count display during a running training.
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User Guide (W1–W4)

Рисунок 17.  User Guide window with sidebar on the left and rendered Markdown content on 
the right

What it is: A built-in help window that renders the guide_​<language>.md shipped with 
the app. The language is derived from the Settings (General tab → Language) or, if 
«System» is set there, from the macOS language preferences. Layout is classic: sidebar 
with all headings on the left, body text on the right.

WHEN TO OPEN  When you need a quick reminder of a single point — so as a keyword 
substitute. The full reference is this manual; the built-in help window is more like what 
a --help  would be on the command line. It is updated with every app release, but is 
intentionally kept more superficial in content.
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W1 NavigationSplitView (Sidebar + Detail)

ГД Е

Help → User Guide (⌘?)..

Т Е Х Н И Ч Е С К И

Two-column layout with a narrow sidebar (at 
least 180 pt wide) for the content tree and a 
scrollable detail area for the actual Markdown 
content. The window has a minimum size of 
700 × 500 pt. On first open, the window loads 
the matching guide_<lang>.md  from the app 
bundle (fallback guide_en.md ), parses it into block 
records (headings H1–H4, paragraphs, lists, tables, 
separators) and separately extracts the heading 
structure for the sidebar. Inline formatting (bold, 
italic, code-span) is rendered via the built-in 
Markdown engine. The language is read from the 
app settings, with the special case of Chinese 
( zh-Hans ) and Brazilian Portuguese ( pt-BR ), 
which are kept as full locale tags because these 
variants differ from zh and pt respectively.

П Р О СТ Ы М И  С Л О В А М И

The built-in help text, with 
the topic list on the left and 
the content on the right. The 
language adjusts automatically 
based on your system settings. 
Works offline, but is intentionally 
only a short version — the full 
reference is this manual.

W2 List (Heading sidebar)

ГД Е

Left column in the User Guide window..

Т Е Х Н И Ч Е С К И

List of all H2 and H3 headings of the current 
Markdown document. H2 entries appear without 
indentation in Medium font weight, H3 entries with 
16 pt left indentation and a reduced foreground 
style. H4 and deeper are ignored, because the 
depth would otherwise make the sidebar cluttered. 
Anchor IDs are generated from the heading text 
via slugification (lowercase + spaces to dashes 
+ filtering for letters/numbers/dashes — the same 
algorithm GitHub uses for its Markdown anchors, so 
external URLs to the docs would potentially land on 
the same anchor as well). The list uses the native 
macOS style.

П Р О СТ Ы М И  С Л О В А М И

The navigation bar on the left 
side. Tap an entry and you jump 
to the section.
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W3 Button (Heading → anchor jump)

ГД Е

One button per sidebar row..

Т Е Х Н И Ч Е С К И

Each sidebar entry is a button that sets the current 
anchor, but visually looks like a list entry. An 
observer variable then triggers the scroll jump to 
the matching anchor with a smooth animation over 
0.3 s. After the jump, the anchor value is reset 
so that the next click on the same anchor fires 
again (otherwise the observer wouldn’t trigger again 
because the value hasn’t changed).

П Р О СТ Ы М И  С Л О В А М И

Clicking takes you to the 
corresponding spot in the text on 
the right.

W4 ScrollView (detail content)

ГД Е

Right column..

Т Е Х Н И Ч Е С К И

Scrollable, vertically stacking content area with lazy 
rendering, because longer guides can easily have 
over 200 Markdown blocks — a non-lazy variant 
would instantiate them all at once. Each block gets 
its own ID, either the heading anchor (for jumpable 
H1–H3) or an index placeholder. Maximum width 
is 720 pt, padding 32 horizontal / 24 vertical, 
so long lines retain a well-readable layout. Tables 
are rendered cell-by-cell with horizontal stacks and 
separators; inline code via the built-in Markdown 
engine. Real code blocks are currently treated 
as paragraphs — a known limitation of the Help 
window.

П Р О СТ Ы М И  С Л О В А М И

The actual help text. Scrollable, 
well-readable width, clear 
typography.
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Keyboard Shortcuts (W5–W6)

Рисунок 18.  Keyboard Shortcuts window — five groups Navigation/Views/Capture/Editor/
Training with hotkey column on the left and description on the right

WHAT’S IN THE IMAGE  Static reference list in five sections. Navigation: Mouse Drag 
(Orbit/Fly), Shift+Drag/Right-Drag (Pan), Scroll (Zoom), WASD (fly-through movement), 
Q/E (Up/Down), F (Toggle Orbit/Fly), Double-click (Re-center), Cmd+Scroll (FoV adjust). 
Views: R (Reset Camera), T (Auto-Rotation), P (Camera Playback), B (Background 
cycle), 0–9 (jump to training cam 1=10%/5=50%/0=last), Left/Right Arrow (Prev/Next 
Cam). Capture: S (Screenshot to Desktop), V (Turntable Video), C (Copy Camera Info). 
Editor: Tab (Edit mode), Click/Drag (Paint-Select), Option+Click (Deselect), X / Delete 
(delete selection), Cmd-Z (undo last deletion), [ / ] (brush size smaller/larger), Esc 
(clear selection). Training: Start, Pause/Resume, Cancel, Continue +5K/+10K/+20K via 
the menu shortcuts in M9–M14.

What it is: A simple static overview of all keyboard shortcuts — Navigation, Views, 
Capture, Editor, Training. Content is hardcoded in, no Markdown loading.
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WHEN TO OPEN  When you’re looking for the fastest way to do something in the viewport. 
WASD fly-through, R for camera reset, B for background cycling — they’re all here.

W5 ScrollView (content area)

ГД Е

Help → Keyboard Shortcuts (⌘/)..

Т Е Х Н И Ч Е С К И

A simple scroll area with a vertical list inside. 
Padding 20 all around, no sidebar navigation tree 
(the list is short enough). Content is grouped 
into five sections (Navigation, Views, Capture, 
Editor, Training). One row per key combination with 
translatable text in both columns. Left column (key 
code) fixed to 180 pt width, so the descriptions 
on the right stay vertically aligned. No interaction 
except scrolling — clicking on a row doesn’t trigger 
anything; the shortcuts are real keyboard modifiers 
in the menu and on the viewport.

П Р О СТ Ы М И  С Л О В А М И

Table of all shortcut keys. Static 
cheat sheet for quick lookup.

W6 VStack (shortcut sections)

ГД Е

Inside the ScrollView..

Т Е Х Н И Ч Е С К И

Left-aligned stacked sections with 16 pt spacing. 
Within the five sections, each contains a heading 
+ row sequence. Headings use a secondary 
subheadline style — intentionally not a title format, 
because the sections don’t need to be navigable. 
Content is intentionally flat (no disclosure, no 
search, no filter) so that the component runs 
unchanged on every macOS version and the file 
stays readable.

П Р О СТ Ы М И  С Л О В А М И

The grouping of keys by function 
(Navigation, Views, Editor, and so 
on).
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Manage Storage (W7–W12)

Рисунок 19.  Manage Storage window — header shows „693 items · 16.74 GB total«, table 
with Export PLY files sorted by date, each with format pill + filename + size + date

WHAT’S IN THE IMAGE  Table view of all files managed by RadianceKit. Header counts 693 
items, 16.74 GB total size. Toolbar at top: «Show in Finder» + «Refresh». Each row: PLY 
icon, filename (e.g. training_​20260527T211321Z.ply), export date, size (varies 7 KB to 
218 MB), magnifier icon (Reveal) and trash icon (Move to Trash). Files are sorted by 
date, newest at the top. In this demo recording PLY exports dominate because a lot of 
work was done with --benchmark .

What it is: A disk usage overview of everything RadianceKit stores under ~/​Documents/​
RadianceKit/​ — Logs, Exports, Scenes, Capture bundles (from the iOS companion), 
Imports (staging copies of the input images). One size in bytes per entry and two 
buttons: «Show in Finder» and «Move to Trash». This is NOT automatic cleanup — the 
app doesn’t delete anything itself; you decide per entry.

WHEN TO OPEN  When the disk is filling up. Logs in particular accumulate (one JSONL 
per training attempt, plus the _​qualityMetrics.json); exports too of course (PLY 100% 
raw data, one per export). Also useful after a crash when the imports staging directory 
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still has old copies of the input images lying around (see «Disk pressure incident» in 
dev_​v549f-needle-reduction.md).

W7 Button «Show in Finder»

ГД Е

Top right of the header in the storage browser 
window..

Т Е Х Н И Ч Е С К И

Opens the entire RadianceKit directory (~/​
Documents/​RadianceKit/​) in the Finder, so you can 
see the folder structure directly and also manipulate 
it with the Finder itself. The action opens a new 
Finder window and does not switch into the app 
sandbox container — ~/​Documents/​RadianceKit/​ is 
the regular Documents domain accessible to apps, 
not a sandboxed container path.

П Р О СТ Ы М И  С Л О В А М И

Opens the directory in the Finder 
so you can work with the files 
yourself.

W8 Button «Refresh»

ГД Е

Header, next to the Finder button..

Т Е Х Н И Ч Е С К И

Triggers a background scan that runs on a user-
initiated asynchronous task so that scanning large 
directory trees doesn’t block the UI. The actual 
walk goes through every known subfolder (Logs, 
Exports, Scenes, Captures, Imports) and produces 
one storage entry per direct child. Per entry the 
recursive size is determined — preferably the actual 
disk usage (including APFS hardlink sharing) with 
fallback to the logical file size.

П Р О СТ Ы М И  С Л О В А М И

Re-reads the list in case you 
deleted or added something in 
the Finder in between.
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W9 List (storage entries)

ГД Е

Main content below the header..

Т Е Х Н И Ч Е С К И

List with this layout per row: category- specific SF 
Symbols icon (document for Logs, upload arrow 
for Exports, cube for Scenes, tray for Imports), 
name + subtitle (Kind label + formatted modification 
date), bytes counter on the right (right-aligned, 
monospaced), Reveal button (magnifier icon), 
Trash button (trash can). Sorting: primarily by 
Kind (Scenes first, then Exports, Logs, Captures, 
Imports, Other), secondarily by modification date 
descending (newest at top). If the scan is still 
running, the area shows a «Scanning…» progress 
indicator instead. If nothing was found, an empty-
state display with a tray icon.

П Р О СТ Ы М И  С Л О В А М И

List of all your RadianceKit data, 
sorted by type and recency. Per 
entry you see the size and can 
delete directly.

W10 Row button «Reveal in Finder»

ГД Е

Per row, magnifier icon on the right..

Т Е Х Н И Ч Е С К И

Opens the Finder and selects the specific item (file 
or folder). Difference from W7: W7 opens the root 
directory; W10 highlights exactly this one entry. 
Practical workflow: identify a large entry, click on 
the magnifier, then copy it to an external volume for 
example.

П Р О СТ Ы М И  С Л О В А М И

Jumps to this entry directly in 
the Finder so you can find it 
quickly.
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W11 Row button «Move to Trash»

ГД Е

Per row, trash icon on the right next to the 
magnifier..

Т Е Х Н И Ч Е С К И

Triggers the confirmation dialog box (W12). Only 
after confirmation does the macOS standard «move 
to trash» operation run (so reversible, no direct 
deletion). After successful trash, the entry is 
removed from the list and the total byte counter 
is updated. On errors, a modal error dialog is 
displayed.

П Р О СТ Ы М И  С Л О В А М И

Moves the entry to the trash. A 
dialog asks first.

W12 ConfirmationDialog (delete confirmation)

ГД Е

Triggered by W11, displayed as a macOS sheet..

Т Е Х Н И Ч Е С К И

Standard confirmation dialog with a dynamic title 
«Delete <name>?» and a message line that 
explicitly points out that the entry goes to the 
trash and can be restored from there (until the 
trash is emptied). Two buttons: «Move to Trash» as 
destructive action (shown in red) and «Cancel» with 
automatic Esc binding. The dialog is non-modal in 
the sense that it only blocks this window, not the 
whole app — that’s macOS standard for reversible 
deletions.

П Р О СТ Ы М И  С Л О В А М И

Safety prompt before deletion. 
«Move to Trash» is reversible 
— as long as the trash isn’t 
emptied.
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Pareto Dashboard (W13–W22)

Рисунок 20.  Pareto Dashboard — empty state before report import

Empty state (after first open) — empty state with call-to-action «Open Reports 
Folder…». The data points appear as soon as training reports are loaded, see next shot.

Рисунок 21.  Pareto Dashboard with 129 loaded benchmark reports — Gaussians vs PSNR 
with Pareto front, Scene/Strategy/Mip filter

WHAT’S IN THE IMAGE  Header toolbar shows «129 reports of 129» (all reports in the 
selected folder parsed successfully — 21 additional files could not be parsed due to 
older format, see hint list on the right). Axes: X-axis picker on Gaussians , Y-axis picker 
on PSNR (dB) . Scatter plot: green points = Classic strategy, blue points = MCMC. The 
dashed Pareto front line runs along the best-achieved PSNR values and plateaus around 
PSNR≈30 dB from about 500K Gaussians onwards. Filter chips on the right: 7 scenes 
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(bicycle, bonsai, family, flowers, kitchen, stump, truck), 2 strategies (classic, mcmc), 3 
Mip-Splatting options (All, On, Off). Currently all filters are open, hence the dense point 
cluster.

What it is: A multi-run comparison tool. In the past you have trained several scenes, 
or the same scene with different presets — each of these training runs produces (if 
you passed --benchmark  or called via the Benchmark function) a JSON report file 
containing among other things final PSNR, SSIM, LPIPS, Gaussian count and wallclock 
time. The Dashboard reads a whole folder of such reports at once and plots them as a 
2D scatter with selectable axes. Additionally, the Pareto front (the set of non-dominated 
points) is drawn as a dashed line.

WHEN TO OPEN  After you have produced at least three or four training reports. With 
fewer points the frontier line is not meaningful. Typical use case: you tried to 
reconstruct an outdoor scene and successively ran P3 Balanced (Classic), P4 Quality 
(Classic), P7 MCMC Quality and P9 Outdoor (tuned) — now you want to know which 
configuration delivers the best PSNR per second of training time, or which requires the 
fewest Gaussians for a given PSNR.

HOW TO INTERPRET  Both axes are freely selectable (X-axis:,, psnr , ssim , lpips , …; Y-
axis the same). The Pareto front logic in ParetoFront2D.indices knows for each metric 
whether «smaller = better» (e.g. LPIPS, Loss, Time) or «larger = better» (PSNR, SSIM) 
— so depending on the axis choice, the line runs from bottom-left to top-right or 
from top-left to bottom-right, always along the best achieved combination. A point is 
Pareto-optimal if NO other point is at least as good in BOTH dimensions (so no other 
point dominates it). Pareto-optimal points lie on the line, other points to the right/above 
(depending on axis orientation). Points ON the line are the real candidates for «best 
preset»; points FAR from the line are wasted training time.

FILTER CHIPS  You can restrict the selection to a particular scene (if you only want to 
compare outdoor runs, e.g.), to a particular strategy (Classic or MCMC), or to Mip-
Splatting on/off (relevant after Phase Q1.5, where Mip remains as an opt-in advanced 
flag).

 You have three reports for the «truck» scene under ~/​Documents/​RadianceKit/​
Reports/​: Run A (P4 Quality, 40K iter, 524K Gs, 105 s, PSNR 23.4), Run B (P7 MCMC, 
200K iter, 150K Gs, 693 s, PSNR 24.6), Run C (P9 Outdoor, 100K iter, 1.25M Gs, 312 s, 
PSNR 25.8). Set X-axis to trainingTime, Y-axis to PSNR. Run B lies upper right, Run C 
even further upper right, Run A lower left. The Pareto front connects A and C — both 
non-dominated. Run B is «lost» (C is better in Time AND PSNR). Insight: for «truck» 
the MCMC default isn’t worth it; either fast+ok (A) or long+very good (C). Save the 
configuration from C as your own preset (Inspector → I1 Save Preset).

Next action: Save the best configuration as a preset. Concretely: look at the Pareto 
points (hover shows PSNR/SSIM/LPIPS/Gs/Time in the tooltip), decide which one suits 
you best in the time-vs-quality trade-off, open the corresponding report (filename 
contains run timestamp), copy its training configuration into a new run, or save it after 
the next training session as a preset via the Inspector.
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W13 Button «Open Reports Folder…»

ГД Е

Toolbar top left..

Т Е Х Н И Ч Е С К И

Opens a folder picker dialog with the prompt 
«Select a folder containing benchmark .json 
reports». After confirmation, a background task 
runs that parses all .json  files in the folder 
sequentially. Faulty reports (broken JSON, wrong 
schema) are collected and shown at the bottom of 
the sidebar as «N file failed to parse» — no crash. 
If a second click happens while a first load is still 
running, the previous task is canceled so that two 
results don’t write into state simultaneously.

Also via CLI: --dashboard-dir /​path/​to/​reports 
loads the folder directly at app startup.

П Р О СТ Ы М И  С Л О В А М И

Selects the folder where 
your benchmark reports live. 
Default path is ~/​Documents/​
RadianceKit/​Reports/​. Then 
loads all JSONs at once.

W14 Picker «X-Axis»

ГД Е

Above the chart, on the left..

Т Е Х Н И Ч Е С К И

Menu picker with all available metric axes of the 
dashboard module (PSNR, SSIM, LPIPS, Gaussian 
count, training time and so on). Default is Gaussian 
count. On change, the hovered point is reset 
because a previously highlighted position in the old 
axis coordinate system no longer makes sense after 
axis change. The picker is constrained to content 
width so it doesn’t span the entire width.

П Р О СТ Ы М И  С Л О В А М И

Which metric should be on the 
horizontal axis. Usually «training 
time» or «Gaussian count» 
because those are the «costs» 
you want to compare.
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W15 Picker «Y-Axis»

ГД Е

Above the chart, next to X-Axis..

Т Е Х Н И Ч Е С К И

Identical to W14, except the default is PSNR. The 
axis choice is stored independently, so the user can 
also pick nonsense combinations (X=PSNR, Y=PSNR 
— would throw all points onto a diagonal). Such 
combinations are not caught, however; a deliberate 
decision, because a comparison «SSIM vs PSNR» 
is quite interesting for seeing how consistently the 
metrics behave.

П Р О СТ Ы М И  С Л О В А М И

What’s on the vertical axis. 
Normally «PSNR» or «SSIM» as a 
quality measure.

W16 Toggle «Show Pareto Front»

ГД Е

To the right of the axis pickers..

Т Е Х Н И Ч Е С К И

Standard macOS toggle. If active, a line with the 
computed 2D Pareto front is drawn in the Pareto 
chart in addition to the point cloud. Style: dashed 
(dash pattern 4–4), gray semi-transparent, line 
width 1.5 pt. The Pareto computation runs on the 
main thread — with the typical number of reports (≤ 
~50) this is fast without issue. If the toggle is off, 
the line is omitted so only the bare points remain.

П Р О СТ Ы М И  С Л О В А М И

Shows the line running through 
the «best-so-far» points. If the 
line is in the way (e.g. because 
you only want to compare 
individual trades), turn it off.
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W17 Chips «Scene» filter

ГД Е

Right sidebar in the Dashboard window..

Т Е Х Н И Ч Е С К И

Filter chips for every scene appearing in the loaded 
reports. Custom flow layout that automatically 
wraps chips into multiple lines as soon as the 
width is exhausted. Active chips get the accent 
background, inactive ones a neutral standard 
material background. Multi-selection is possible (set 
semantics); if no chip is selected, all scenes count 
as «passed through» — i.e. the set logic is «empty 
selection = all», not «empty selection = nothing».

П Р О СТ Ы М И  С Л О В А М И

Clicking a scene name filters the 
points to only this scene. Multi-
selection possible. Empty = all 
scenes.

W18 Chips «Strategy» filter

ГД Е

Below Scene filter in the sidebar..

Т Е Х Н И Ч Е С К И

Exactly like W17, but for training strategies — 
typically the two values «classic» and «mcmc», 
derived from the strategy field of the benchmark 
report JSONs. Helpful if you have mixed reports 
of both strategies and only want to see one kind 
(e.g. «only show MCMC runs because I’ve already 
excluded Classic»).

П Р О СТ Ы М И  С Л О В А М И

Filter by Classic or MCMC. By 
default both are active.
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W19 Chips «Mip-Splatting» filter

ГД Е

Below Strategy filter in the sidebar..

Т Е Х Н И Ч Е С К И

Three-valued filter (instead of a set like W17/W18): 
«All» / «On» / «Off». Background: Mip-Splatting 
was evaluated in Phase Q1.5 as an experimental 
multi-scale improvement and the final verdict was 
«no nice win across the board; keep as opt-
in flag». When you do Mip on/off comparisons 
you often want to separate very sharply. Hence 
the dedicated ternary filter with the states «let 
everything through», «only Mip on», «only Mip 
off». The sidebar section is only displayed if at least 
one Mip report AND at least one non-Mip report is 
in the data set (otherwise filtering makes no sense).

П Р О СТ Ы М И  С Л О В А М И

If you want to compare Mip-
Splatting on/off, here is a three-
way filter. Otherwise ignore.

W20 ChipButton (filter toggle, all/on/off)

ГД Е

Helper component, used in W17/W18/W19..

Т Е Х Н И Ч Е С К И

Minimalist button wrapper. Content: label text with 
caption font size and padding 10 horizontal / 5 
vertical. Background conditional: if active → app 
accent color with white text; otherwise neutral 
standard material background with black text. 
Shape is a capsule (pill-like). Plain button style 
so the capsule material isn’t overlaid by a system 
border.

П Р О СТ Ы М И  С Л О В А М И

The round filter buttons 
themselves. Visually like an iOS 
tag.
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W21 Chart (Pareto scatter)

ГД Е

Center area of the Dashboard..

Т Е Х Н И Ч Е С К И

Swift Charts diagram with two layers: 1. one point 
per report — position from the chosen X and Y 
metrics, color by strategy, symbol by Mip status. 
Symbol size normal 80, highlighted 200 (if the ID 
matches the currently hovered report).
2. a line for the Pareto front, only if the toggle is on.

Chart overlay: a transparent rectangle registers 
mouse motion; per frame the Euclidean nearest 
point position in the plot frame is determined and 
the hovered report is updated if the distance is 
under 24 px (otherwise reset). So you get the tooltip 
without clicking — hovering is enough.

П Р О СТ Ы М И  С Л О В А М И

The actual scatter plot. Each 
point is a training run. Hover for 
detail tooltip.

W22 Tooltip (hover detail)

ГД Е

Below the chart, displayed on hover..

Т Е Х Н И Ч Е С К И

Horizontal stack: scene name (headline), strategy 
tag (caption), separator, then PSNR/SSIM/LPIPS/
Gs/Time metrics each in a small vertical group 
(label + monospaced value). If Mip was activated, 
additionally a «Mip» capsule tag in accent 
color. Background semi-transparent blur, rounded 
rectangle with 8 pt radius. Only displayed when 
the mouse is actually over a point. Disappears 
automatically on leaving.

П Р О СТ Ы М И  С Л О В А М И

The detail card at the bottom 
when you hover over a point 
with the mouse. Shows all 
quality metrics and the run 
configuration at once.

98 / 235



R A D I A N C E K I T Глава 4 — Вспомогательные окна

Holdout Analysis (W23–W29)

Рисунок 22.  Holdout Analysis — empty state before loading a transforms.json

Empty state with empty state and call-to-action «Open transforms.json…». Accepts 
NeRF Studio and Instant-NGP format.

Empty state (after first open) — the camera markers appear as soon as a 
transforms.json  is loaded, see next shot.

Рисунок 23.  Holdout globe with 100 NeRF Blender mic cameras, 5 folds of 20 cameras 
each, angular strategy active

WHAT’S IN THE IMAGE  Header shows loaded file (transforms_​train.json) and cam 
count («100 cameras»). Left sidebar: strategy picker with two options — Angular 
(longitudinal) active (aligns folds along longitudinal/latitudinal sectors on the sphere 
so each test fold is geometrically dense) vs Linear
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(round-robin) (order-based, every k-th frame as the test set). k-folds slider is on 
5, test-fold picker on Fold 1. Export button produces a fold-assignment.json for 
Nerfstudio/Instant-NGP. Middle panel: 3D globe projection of all 100 cameras — green 
points = Train, red points = current test fold (Fold 1 with 20 cameras). Right sidebar 
(Angular Correlation): per fold 20 cams + Mean Nearest Angle (Fold 1: 7.9°, Fold 2: 7.8°, 
Fold 3: 7.7°, Fold 4: 7.0°, Fold 5: 6.3°) — a smaller value means the cameras within this 
fold lie close together, so the Holdout split is spatially coherent.

What it is: A 3D visualizer for your camera arrangement with cross-validation logic. 
You load a transforms.json  (the standard format from Nerfstudio / Instant-NGP for 
camera poses), the app reads all cameras, projects their view directions onto a unit 
sphere and shows them as small sphere markers on a virtual globe. Then it divides the 
cameras into k  folds (per the selected strategy: angular or linear), marks the training 
portion green and the test portion red (Holdout), and computes per fold an Angular 
Correlation score that tells you how far away the test fold is from the training fold in 
view-angle space.

WHEN TO OPEN  When you want to do Holdout evaluation — i.e. how well does your 
model generalize to unseen viewpoints? Default in training is «every-8th view as 
Holdout» (Mip-NeRF360 convention), but that is a very linear split. If your images 
are clustered in time for example (one side of the object first, then the other), then 
«every-8th» is not representative — a random sequence position ends up in the test, 
but all its neighbors are in training, which is too easy. With «angular» you stratify across 
the view-angle space instead: each fold contains cameras from all areas of the orbit so 
the test really probes generalization gaps.

HOW TO INTERPRET  Angular vs Linear: - Angular (default): divides the cameras by 
longitudinal angle (φ coordinate around the Y axis) into k  equal sectors. Fold 0 
contains cameras with φ ∈ [0°, 360/k°), Fold 1 the next ones, and so on. Advantage: 
each fold covers a portion of the orbit; the test fold is spatially compact but broadly 
distributed across the world dataset. Good for classic orbit recordings. - Linear (round-
robin): Fold index = (image_index modulo k). That is the simple «every k-th» split. 
Works if the image order has NO spatial bias (e.g. randomly sorted drone shots). Works 
poorly if the images cluster in time.

In the 3D globe you immediately see: green points (training) and red points (test). If the 
red points all cluster in one corner, the Holdout is poor (no good generalization test). 
If they lie evenly between the green ones, it’s good. The Angular Correlation score per 
fold (right sidebar, in degrees) additionally says: smaller value = the test is close to 
training (each test camera has a nearby training camera, easy test); larger value = the 
test is far from training (harder generalization).

 You captured your truck scene with 251 images, export via menu item M33 (Export 
SfM transforms.json) a Nerfstudio file. Open the Holdout window (⇧⌘H), load the 
JSON via «Open transforms.json…», look at the globe. k=5 (default) gives you 5 folds. 
Click on «Fold 3» — check whether the red markers are reasonably even. If yes: 
«Export fold-assignment.json», put the exported file in the reports folder, and at the 
next training run with --benchmark  (or the corresponding Inspector settings) exactly 
this fold assignment is used as the test Holdout — instead of the default «every-8th».
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W23 Button «Open transforms.json…»

ГД Е

Toolbar top left..

Т Е Х Н И Ч Е С К И

Opens a file picker dialog restricted to JSON files. 
After confirmation the Holdout module loads the 
file. The loader parses both the Nerfstudio format 
(camera intrinsics plus list of frames with image 
path and transform matrix) and the Instant-NGP 
format (same structure). For each frame the view 
direction is extracted from the transform matrix (z-
axis of the camera local basis) and stored. If parsing 
fails, an error message is shown in the status area.

Also via CLI: --holdout-file /​path/​to/​
transforms.json opens the window directly with the 
file loaded.

П Р О СТ Ы М И  С Л О В А М И

Loads your camera poses 
JSON. Standard are Nerfstudio 
and Instant-NGP exports. 
RadianceKit itself can export 
transforms.json via Menu → 
Export → SfM.

W24 Picker «Strategy» (angular/linear)

ГД Е

Left sidebar, at the top..

Т Е Х Н И Ч Е С К И

Radio picker with two options: Angular and 
Linear. Strategy change automatically triggers a 
recomputation of the folds. The view directions are 
a list of 3D unit vectors on the sphere; the angular 
strategy projects them onto the longitudinal angle φ 
and sorts, the linear strategy simply does a modulo 
split over the frame index.

П Р О СТ Ы М И  С Л О В А М И

Angular for evenly distributed 
orbit shots (default, safe), Linear 
only if your images don’t cluster 
spatially.
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W25 Slider «k Folds»

ГД Е

Left sidebar, in the middle..

Т Е Х Н И Ч Е С К И

Slider from 3 to 10, step size 1. On change, the fold 
computation is automatically restarted so that the 
folds list, the training/test indices and the per-fold 
score are immediately recomputed. The selected 
value is displayed as monospaced-digit text next to 
the label on the right.

Rule of thumb: k=5 is standard (gives you 20% 
test per fold, which is common for cross-validation). 
k=10 if you have a lot of data and need more folds 
for statistical significance. k=3 if you have little 
data.

П Р О СТ Ы М И  С Л О В А М И

How many folds in the split. 5 
is the default and fits almost 
always.

W26 Picker «Test Fold»

ГД Е

Left sidebar, below the k slider..

Т Е Х Н И Ч Е С К И

Menu picker. Options are dynamically 0..<k, labels 
«Fold 1» through «Fold N» (so 1-indexed in the 
UI, 0-indexed internally). If the previously selected 
index is ≥ k (e.g. because you reduced k from 10 to 
5), it is automatically reset to 0. The selected test 
fold is shown in red on the globe, all others in green.

П Р О СТ Ы М И  С Л О В А М И

Which fold is currently the test 
fold. You can click through and 
see how each individual fold 
looks on the globe.
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W27 Button «Export fold-assignment.json»

ГД Е

Left sidebar, at the bottom..

Т Е Х Н И Ч Е С К И

Opens a save dialog with default filename fold-
assignment.json. After confirmation the Holdout 
module encodes the current split into a JSON 
schema (per-frame fold assignment plus strategy 
meta block). This file can then be passed to the 
next training run with --benchmark , so the same 
Holdout is used for the final metric evaluation. Write 
errors are shown as error text; success in green text 
as «Saved to (filename)».

П Р О СТ Ы М И  С Л О В А М И

Saves the current train/test split 
as JSON. You can then pass this 
file directly to the training so the 
same test set is used again.

W28 SCNView (3D Camera Globe)

ГД Е

Center panel in the Holdout window..

Т Е Х Н И Ч Е С К И

SceneKit globe view. The scene consists of: a 
wireframe sphere (radius 1.0, 36 segments, dark 
gray), three colored axis stubs (red/green/blue for 
X/Y/Z, each 1.2 long), and per camera a small 
marker sphere (radius 0.03) at the corresponding 
view direction position on the unit sphere (slightly 
outside so it doesn’t disappear INTO the wireframe 
sphere). The markers are NOT rebuilt on each fold 
change — rebuild is only needed when the frame 
list changes (i.e. a new JSON is loaded). Instead, 
per update an in-place update of the material colors 
runs: red for test indices, green for training, light 
gray if neither. So slider ticks stay performant even 
at N > 1000 cameras.

Camera control is enabled — you can rotate, zoom 
and pan the globe with the mouse. Lighting makes 
sure the markers don’t look flat. Background is dark 
gray.

П Р О СТ Ы М И  С Л О В А М И

The 3D globe with the camera 
positions. Green = training, red 
= test, light gray = unassigned 
(doesn’t occur, all cameras 
belong somewhere). With the 
mouse you can rotate and zoom 
the globe.
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W29 FoldCard (tap to select fold)

ГД Е

Right sidebar, «Angular Correlation» section..

Т Е Х Н И Ч Е С К И

One card view per fold — rounded rectangle with 
6 pt radius, padding 10, vertical layout with two 
rows (top «Fold N» + camera count, bottom «Mean 
nearest angle:» + value in degrees). Background 
color conditional: active fold = accent color semi-
transparent, inactive = neutral standard material. 
Tapping selects the fold and the globe recolors live.

The «Mean nearest angle» score is the mean 
smallest angle per test camera to the nearest 
training camera (internally computed in radians, 
displayed in degrees in the UI).

П Р О СТ Ы М И  С Л О В А М И

One small card per fold on 
the right with the number 
of cameras and the average 
distance to the nearest training 
camera. Clicking it selects this 
fold as test.

BayesOpt Console (W30–W39)

Рисунок 24.  BayesOpt console — empty state before trial start

Empty state with search-space picker (RadianceKit defaults (6-dim)), trial budget 
slider (default 40), random seed (42) and three empty panels for convergence chart, 
trial log and search-space parameter list.

Empty state (after first open) — convergence chart and trial table fill up as soon as a run 
is started, see next shot.
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Рисунок 25.  BayesOpt console after 40 trials — convergence chart rises steeply until trial 
15, best value 0.9943, trial log with init/bo/restart tags

WHAT’S IN THE IMAGE  Status top right «Finished — best 0.9943 after 40 trials». Left 
sidebar: search-space picker on RadianceKit defaults (6-dim), trial budget 40, 
random seed 42. Parameter list shows the six hyperparameters to tune with their 
value ranges: mipSmoothing3DScale [0.05, 0.5], mipFilter2DVariance [0.1, 0.6], 
densifyGradThreshold [5e-07, 5e-06], ssimWeight [0.05, 0.5], mcmcNoiseScale 
[1e-05, 0.0001], mcmcRelocationInterval [50, 200]. Center: convergence chart (X = 
trial index 1–40, Y = objective value 0–1) — gray points = initial samples (LHS), blue 
points = BayesOpt acquisition, orange points = restart trials (#22 and #31). Best-value 
line rises steeply up to trial ~7, then only marginal improvement until trial 15, from there 
a flat plateau at 0.99+. Right sidebar: trial log #1–#34 with score + tag (init/bo/restart). 
Save Best Config button top right writes bayesopt-best.json .

What it is: A Bayesian-optimization console for hyperparameter search. Bayesian 
optimization is an automatic method that tries to find the optimum of an unknown 
function with as few experiments as possible — typically: «which combination of 
mcmcMaxGaussians, capMultiplier, ssimWeight and gradThreshold delivers the best 
PSNR for my scene class?» Instead of a grid of 6^4 = 1296 trials, Bayesian optimization 
tries about 40–100 informed trials and gets close to the optimum that way.

Important: The version currently shipped in the app does not run the optimization 
against real training runs (that would take days) but against a synthetic demo 
objective — a multi-modal landscape with hill-climbing character plus light noise. 
This is intentional: the window is meant to show you the behavior of the optimizer 
(convergence curve, sample points, best-so-far) and let you understand the search-
space definitions. For real training-driven BayesOpt runs (as carried out in Phase Q7 for 
the scene-class presets), a separate offline CLI workflow is used; the window is the live 
UI variant.

WHEN TO OPEN  Three use cases: 1. You want to understand how BayesOpt works — then 
start a demo run and observe the convergence chart. 2. You’re planning a new scene 
class (such as «aquariums» or «antique furniture») for which the built-in 10 presets 
don’t fit perfectly. Mentally define a search space, test it here with the «Bowl demo» 
or «Densify» preset, then export the best config as JSON and use it as a starting 
point for a real training run. 3. You want to inspect the default search spaces defined 
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in the RKBayesOpt package (Mip subset, RadianceKit defaults) — they are listed in the 
parameter panel of the left sidebar.

HOW TO INTERPRET  - Convergence chart (middle column): Y = best objective function 
value achieved so far. X = trial index. Initially rises steeply (BayesOpt tries the initial 
samples randomly, some of them lucky), then flattens out increasingly because the 
near-optimum region is exhausted. If the line stays flat for 20+ trials, you can stop the 
run — additional trials won’t add anything. The individual points in the chart are the 
individual trial values (so not «best so far»), colored by phase: gray = initial sample, 
blue = BayesOpt acquisition, orange = restart. - Trial table (right column): #1, #2, 
#3, … each with value and phase tag. The best trial so far is marked with a yellow 
star. From the table you can identify the best trial and inspect its parameter values 
later during export. - Search-space inspector (left sidebar): shows for the selected 
preset all parameter names and their search ranges [lo, hi] . If you’re on the preset 
«RadianceKit defaults (6-dim)», you see e.g. «densifyGradThreshold [5e-7, 5e-6]» — 
so log-uniform between these two values.

 Pick preset «RadianceKit defaults (6-dim)», trial budget 40, seed 42. Click «Start». 
Observe: the first 8 trials are gray (initial samples, LHS Latin hypercube), the following 
ones blue (BayesOpt-acquired). The convergence chart rises steeply up to trial ~15, 
after that it flattens out. At trial ~30–40 the best value stabilizes. Click «Save Best 
Config» — a bayesopt-best.json  is saved with the preset name, trial index, value, and 
the decoded parameter values. You can then manually copy this JSON into your preset 
definition.

W30 Button «Start»

ГД Е

Toolbar on the left, in idle/finished state..

Т Е Х Н И Ч Е С К И

Resets the trial list, switches into running state, 
generates a new run ID (for stale detection on 
multiple Start clicks) and creates a fresh pause 
gate. Then a background task starts that runs 
the optimizer as an asynchronous stream. Initial-
samples size is min(8, budget /​ 4 + 1) — so 
typically 8 Latin-hypercube samples at budget ≥ 28, 
fewer at small budget. Trial updates are received 
incrementally and appended to the list. Stale-run 
protection: if in the meantime a second Start click 
sets a new run ID, updates from the old run are 
discarded.

Primary action style for the prominent button look.

П Р О СТ Ы М И  С Л О В А М И

Starts a fresh optimization run 
with the current search space, 
budget and seed.
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W31 Button «Pause»

ГД Е

Toolbar on the left, in running state..

Т Е Х Н И Ч Е С К И

Activates the pause gate and switches into paused 
state. The actual effect: the runner waits in a 50 ms 
polling loop before it evaluates the next objective 
function. This means a trial currently running is 
run to completion (it’s synthetic and only takes 
microseconds), but no further trial is started. As 
soon as Resume runs, it continues where it left off.

П Р О СТ Ы М И  С Л О В А М И

Pauses the run. The current 
computation still runs to 
completion, then it pauses.

W32 Button «Stop»

ГД Е

Toolbar on the left, in running and paused state..

Т Е Х Н И Ч Е С К И

Cancels the runner task, nulls the reference, 
releases the pause gate (if still paused) and 
switches into finished state (if trials exist) or idle 
state (if not). The already computed trials remain 
visible in the list — Stop does not delete them. 
Destructive button role shows the button in red 
because it cancels the run.

П Р О СТ Ы М И  С Л О В А М И

Cancels the run permanently. 
Trials stay visible; you can still 
export the best config.

W33 Button «Resume»

ГД Е

Toolbar on the left, in paused state..

Т Е Х Н И Ч Е С К И

Releases the pause gate and switches back to 
running state. The runner task is already running 
(it’s waiting in the polling loop); as soon as the loop 
notices that the pause has been lifted, it continues 
and starts the next trial.

П Р О СТ Ы М И  С Л О В А М И

Resumes a paused run.
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W34 Button «Save Best Config»

ГД Е

Toolbar on the right, always visible (but disabled if 
no bestTrial exists)..

Т Е Х Н И Ч Е С К И

Opens a save dialog with default filename 
bayesopt-best.json , restricted to JSON. After 

confirmation a payload dictionary is built: 
preset name, trial index, value (objective score), 
parameters (dictionary of decoded parameter 
names → values). The decoding projects the 
normalized search-space coordinates in [0,1]^d 
back into the original value range (with log-uniform/
linear/integer scales accordingly). JSON output is 
pretty-printed and with sorted keys. On write errors 
(in the current demo version) is silently ignored — 
no error UI because it’s a demo path.

The button stays gray as long as no trial has run.

П Р О СТ Ы М И  С Л О В А М И

Saves the parameter values of 
the best trial so far as JSON. 
You can then manually copy 
these values into your preset 
configuration.

W35 Picker «Search Space» preset

ГД Е

Left sidebar, at the top..

Т Е Х Н И Ч Е С К И

Menu picker with four preset options: - 
«RadianceKit defaults (6-dim)» — the full standard 
search space with all Q7 hyperparameters. - «Mip 
subset (2-dim)» — only mipSmoothing3DScale [0.05, 
0.5] log-uniform and mipFilter2DVariance [0.1, 0.6] 
linear. Useful when you want to tune Mip-Splatting 
for a scene class. - «densify-until + ssim-weight + 
grad-thresh» — three Densify-relevant parameters 
(densifyGradThreshold log-uniform, ssimWeight  
linear, densifyUntilIter  integer). - «Bowl demo 
(1-dim)» — pedagogical single-parameter search 
space for «this is how BayesOpt works» demos.

While a run is active, the search space cannot be 
switched (would confuse the optimizer).

П Р О СТ Ы М И  С Л О В А М И

Which hyperparameter search 
space BayesOpt explores. 
Default is «RadianceKit 
defaults». For targeted Mip-
tuning attempts «Mip subset». 
To understand how BayesOpt 
works «Bowl demo».
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W36 Slider «Trial Budget»

ГД Е

Left sidebar, below the search-space picker..

Т Е Х Н И Ч Е С К И

Slider from 10 to 200, step size 5. Default
40. This means: BayesOpt may do a maximum of N 

trials. Of these the

first few are initial samples (Latin hypercube), the 
rest are real BayesOpt trials. Rules of thumb for 
practice: a search space with d dimensions needs 
about 10d to 20d trials for a good optimum. At 6-
dim defaults that’s 60–120, at 2-dim Mip subset 20–
40, at 1-dim Bowl demo 10–20.

During the run the slider is disabled.

П Р О СТ Ы М И  С Л О В А М И

How many optimization attempts 
at most. More attempts = better 
solution, but costs more time. 40 
is a good default for the demo 
objective.

W37 Slider «Random Seed»

ГД Е

Left sidebar, below the budget slider..

Т Е Х Н И Ч Е С К И

Slider from 1 to 100, step size 1. Default
42. The seed is passed both to the initial Latin-

hypercube samples

and to the noise component of the demo objective. 
Reproducibility: same seed + same search space + 
same budget yields exactly the same trial sequence. 
Useful for «do all your colleagues get the same run 
when they rebuild the demo?». Disabled during the 
run.

П Р О СТ Ы М И  С Л О В А М И

Controls the random generator. 
Same seed = same run — for 
reproducing.
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W38 Chart (Convergence)

ГД Е

Middle column of the window..

Т Е Х Н И Ч Е С К И

Swift Charts diagram with two layers: 1. a line 
for «best-value-so-far» per trial — a monotonically 
rising or constant curve in accent color. 2. one point 
per trial with the individual objective value, colored 
by phase. Symbol size 40. Three phase labels: 
«init» (gray), «bo» (blue), «restart» (orange).

A small legend shows the phase colors at the top 
left. If the trial list is empty (before the first start), 
an empty-state display with a chart icon and the 
hint «Press Start to begin a BayesOpt run.» is 
displayed instead.

П Р О СТ Ы М И  С Л О В А М И

The progress chart. The solid line 
is «best solution found so far»; 
the points are the individual 
attempts. If the line stays flat for 
a long time, BayesOpt has found 
the optimum.

W39 Table (Trial Log)

ГД Е

Right column of the window..

Т Е Х Н И Ч Е С К И

Scroll area with lazily stacked trial rows. One 
horizontal stack per row: trial number (3-digit 
monospaced, on the left), value (monospaced, 
right-aligned, 70 pt wide), phase tag (capsule, filled 
with phase color at 25% opacity), optionally a 
yellow star if this trial is currently the best. An auto-
scroll mechanism automatically jumps to the end as 
soon as a new trial is added — so you can follow the 
live progression at the bottom of the screen without 
scrolling yourself.

П Р О СТ Ы М И  С Л О В А М И

The table of all attempts. Value, 
phase, star for the best. Auto-
scrolls along, new trials appear 
at the bottom.

Main Window: Loss Curve and Gaussian Count (I39–I41, cross-
reference)

Three of the Inspector displays in the main window deserve their own explanation 
because they are constantly visible during a running training and there are important 
rules of thumb for when the curve looks healthy. The displays are in the Inspector under 
the «Loss Chart» section (see Chapter 2 — Inspector) and complement the Holdout 
analysis from the auxiliary window above.
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When is the loss curve healthy? A healthy loss curve shows three phases: (1) Warmup 
— the first 200–500 iterations the loss falls steeply from high (typically 0.15–0.25 for 
L1+SSIM combined depending on the scene) to about half. If the loss does NOT fall in 
this phase, the input is usually wrong (broken images, bad SfM poses, too few initial 
Gaussians). (2) Densification — between ~500 and densifyUntilIteration (classic 15K, 
MCMC up to 20K or 25K) the loss continues to fall, often with small jumps downward 
when densify operations insert new Gaussians and the optimizer exploits them. The 
Gaussian count rises in this phase. (3) Refinement — after that the loss runs into a tail 
that flattens out. Typical end values: Tanks-&-Temples Truck with P4 Quality lands at 
L1 ≈ 0.023, Horse with Full Classic V546 at L1 ≈ 0.0230, outdoor Mip-NeRF360 scenes 
often worse (0.04–0.07).

What does a plateau mean? A plateau (loss curve runs horizontally over several 
thousand iterations) has two interpretations: (a) the model has converged, more 
training won’t add anything — the good case. (b) the model is stuck (local minimum, 
bad gradient information, a cap at the buffer limit) — the bad case. Both look identical 
in the chart. Distinction: look at the Gaussian count. If it’s also flat AND close to the 
MCMC cap (e.g. 150K of 150K at .fullMCMC ), you are at the limit — either raise the 
cap or accept the plateau. If the Gaussian count is still growing but the loss isn’t falling, 
it’s stuck.

When to abort vs continue training? Rule of thumb: 10K iterations long no 
improvement of the min loss → abort, further iterations are wasted. Before that: you can 
append an extension via Cmd+T (Training menu → Continue Training → +5K iterations), 
if you see marginal improvement. Watch out: with MCMC the plateau is often real — the 
cap is the natural limit.

Gaussian count plateau is NOT a «done» signal. It only means that MCMC has 
reached the cap or that Classic Densification is exhausted. The real «done» question is 
answered only by the Holdout analysis — PSNR/SSIM/LPIPS on an independent test set, 
evaluated in the Holdout window (W23–W29) or via the --benchmark  flag.

PSNR/Holdout is the truth, loss is only a proxy. Loss is a relative metric: it falls 
as your model fits the training views. A low loss does not automatically mean a good 
model — if the model has memorized the training images (overfitting), the loss would 
be small, but PSNR on unseen views (Holdout) would be bad. Therefore: for final quality 
assessment always look at Holdout metrics, not end-loss alone.

Rule-of-Thumb Box

• User Guide and Keyboard Shortcuts are static help — for keyword questions fast, for 
depth use this manual at hand.

• Open Manage Storage as soon as the disk falls below 10% free space. Logs and 
imports staging are the usual culprits.

• Pareto Dashboard only useful after at least three or four training reports. X-axis = 
costs (Time / Gs), Y-axis = quality (PSNR / SSIM). The Pareto front shows the efficient 
combinations.
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• Use Holdout Analysis before publishing PSNR benchmarks with others — it assures 
you that your test set is really representative.

• BayesOpt Console is primarily a learning and inspection tool for search-space 
definitions. For real training-driven hyperparameter tuning use the offline CLI 
workflow.

• Loss plateau and Gaussian-count plateau are to be interpreted separately. Cap limit is 
not a «done» signal. Real quality is measured only by Holdout PSNR.

• 10K iterations without min-loss improvement → stop training.
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Г Л А В А

Глава 6 — Конфигурация обучения

Рисунок 26.  Preview preset exported as JSON and displayed in TextEdit — fields id/
name/category/version/createdAt/description, trainingConfig with all relevant parameters 

(maxIterations 5000, densifyUntilIteration 3500, ssimWeight 0.20, renderScale 0.50, 
strategy classic, cameraAlignment applePhotogrammetry, densifyGradThreshold 2.0e-06, 

opacityResetInterval 3000, minOpacity 0.005, six boolean toggles)

WHAT YOU SEE IN THE IMAGE  A typical preset JSON export. Top-level fields: id  (UUID), 
name , (classic | mcmc | sceneClass | custom), (schema version), (timestamp), (free 

text). The nested object holds the parameters that are critical for reproducibility — on 
import the entire block is deserialized into the TrainingConfig  struct, and defaults 
from the current app version fill in any fields missing from the JSON (e.g. after an app 
update). To hand a preset over to another Mac, you just ship this JSON file.

The TrainingConfig  struct is the heart of every training run in RadianceKit. It collects 
every parameter that influences training — from maximum iteration count over the eight 
learning rates to the special fields for MCMC, Mip-Splatting, the curriculum and the 
scene-aware cap logic. You edit it in the sidebar in the Training Configuration section 
(Expert View), save it as a preset or hand it over as a JSON export to another Mac. At 
training start this very object is frozen and handed to the GPU backend.
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This chapter is reference material for power users and script authors. It lists all 
81 public fields, the 9 static presets and the one public method. The source file 
is TrainingConfig.swift — when in doubt the doc comment stored there and the 
initializer default are the source of truth.

N OT E  ·  U I  V S .  P R E S E T/ C L I

Only 12 of the 81 fields have a direct slider, toggle or picker in the Inspector 
(sandboxed App Store build): T1, T2, T17, T20, T22, T38, T56–T58, T60, T61, 
T73. The remaining 69 fields are set via the chosen preset (Chapter 7) and can 
only be overridden directly via a CLI flag (see Chapter 5). This separation is by 
design: defaults stay stable and production-tested, while power users still have an 
escape hatch. If a field really interests you, first check Chapter 2 (Inspector) and 
Chapter 5 (CLI) to see whether you can reach it without JSON tinkering.

Table of contents:

1. Iteration (T1–T2)
2. Learning Rates (T3–T10)
3. Densification — Classic (T11–T16)
4. Loss (T17–T20)
5. SH Degree Progression (T21)
6. Performance (T22–T25)
7. Diagnostics and Point Cloud Preparation (T26–T30)
8. Regularization (T31–T37)
9. Refinement (T38–T44)

10. Sky Dome (T45–T48)
11. Adam + LR Schedule (T49–T55)
12. Post-Processing + Apple AI (T56–T60)
13. MCMC Densification (T61–T73)
14. Mip-Splatting (Q1.5) (T74–T76)
15. Adaptive Densification (Q5) (T77–T79)
16. Curriculum (Q6) (T80–T81)
17. Static Presets (TP1–TP9)
18. Method:
19. Which field for what? (Cheat Sheet)
20. Dangerous Fields
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Iteration (T1–T2)

T1 maxIterations

П ОД Р О Б Н О СТ И

Default: 30 000 (initializer), 35 000 ( .full ), 200 
000 ( .fullMCMC ) Range: 1 000 – 500 000 (UI 
slider), no hard upper limit in the logic Defined in:

Т Е Х Н И Ч Е С К И

Total number of training iterations the backend 
runs through. One iteration means a forward render 
of a single training camera, one backward pass 
over all loss components (L1 + SSIM + optional 
regularizations + sky mask) and one Adam optimizer 
step. This number directly drives the other 
schedules: position learning rate follows a cosine 
annealing curve from 0 to either T1  itself or to 
T49 positionLRScheduleEndIteration; densification 
stops at T2 densifyUntilIteration; MCMC noise 
decay ends at T69 mcmcNoiseDecayEnd; SH degree 
upgrades happen at the three marks in T21 . 
For classic densification the empirically determined 
sweet spot is at 20 000–35 000 iterations (Sessions 
1–32, V546 tests), for MCMC at 60 000–200 000 
(V534). Pushing well beyond the values stored in 
the preset rarely brings additional quality — Adam 
momentum saturates, and without an LR decay end 
the loss stagnates. Conversely, going below ~5 000 
leads to incompletely converged geometry (density 
control has too little time to clone/split).

П Р О СТ Ы М И  С Л О В А М И

How long the app trains. More 
iterations = better result, but 
eventually no longer noticeably 
better, just much longer. The 
presets are chosen so that 
without thinking you get a good 
value: Quick 1 000, Preview 5 
000, Balanced 20 000, Quality 35 
000, MCMC Quality 200 000. If 
you turn the knob yourself: with 
MCMC feel free to go high (100 
000–200 000), with Classic not 
above 40 000 — doesn’t help any 
more after that.
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T2 densifyUntilIteration

П ОД Р О Б Н О СТ И

Default: 15 000 (initializer), 5 000 ( .full ), 160 
000 ( .fullMCMC ) Range: 0 – Defined in:

Т Е Х Н И Ч Е С К И

Iteration at which densification stops. Up to this 
point Gaussians are cloned, split and pruned 
according to the rules parameterized in T11–T16  
(Classic) or T67–T70  (MCMC); after that the 
Gaussian count stays constant and only positions, 
rotations, scales, opacities and SH coefficients are 
optimized (refinement phase). In the 3DGS original 
paper the value sits at 50 % of T1 , in RadianceKit’s 
.full  preset at only ~14 % (5 000 of 35 000) 

— a consequence of the V310/V338 experiments 
which showed that after 5 000 iterations further 
densification makes the result worse (more floaters, 
higher memory use, no quality gain). MCMC, on 
the other hand, runs relocation up to 80 % of T1  
(V504b) because MCMC does not produce harmful 
floaters. If T2  is chosen too small (< 1 000), too 
few Gaussians arise; too large under Classic (> 50 
% of T1 ) leads to overgrowth and RGB saturation 
outliers (see Outdoor Overtraining Findings).

П Р О СТ Ы М И  С Л О В А М И

Up to when the app is allowed 
to create new Gaussians. After 
that, only what already exists 
is refined. With classic training 
at 35 000 iterations, 5 000 is 
the right value here — anything 
above makes the scene mushier. 
With MCMC it is 80 % of total 
iterations (so 160 000 for a 200 
000 run). If you change the 
Quality preset, better leave this 
field alone.
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Learning Rates (T3–T10)

T3 positionLearningRate

П ОД Р О Б Н О СТ И

Default: 0.00016 Range: 1e-7 – 1e-3 
(recommended) Defined in:

Т Е Х Н И Ч Е С К И

Adam learning rate for each Gaussian’s XYZ 
position at the start of training (iteration 0). It 
follows a cosine annealing curve and decays over 
training down to T4 positionLearningRateFinal. 
The default 0.00016 comes from the 3DGS original 
paper (Kerbl et al. 2023) and in RadianceKit is not 
to be scaled even with higher image resolution — 
position moves in world coordinates, not in pixel 
space. A clear increase (> 0.0005) makes Gaussians 
jump over long distances and the loss becomes 
unstable; values well below (< 0.00005) mean badly 
initialized point clouds never find their place. V414 
tested doubling the initial value → 16.8 % worse L1 
loss; the V544a tunings confirmed the paper default 
as optimal. Note: under .fullMCMC  we deliberately 
leave this at the default — MCMC needs constant 
learning rates for its relocation logic, so tuning here 
brings nothing.

П Р О СТ Ы М И  С Л О В А М И

How fast the splat points 
are allowed to move through 
space. The default value is 
very well tuned and basically 
doesn’t need changing. Only 
when splats «wobble» in the 
image or a whole corner is 
missing because nothing moves 
there would the learning rate be 
something to adjust — but then 
typically something else is wrong 
upstream (camera poses, initial 
point cloud).
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T4 positionLearningRateFinal

П ОД Р О Б Н О СТ И

Default: 0.0000016 (initializer + paper), 0.000016 
( .full , .fullMCMC  — 10× higher) Range: 0 – 
Defined in:

Т Е Х Н И Ч Е С К И

End value of the position LR cosine annealing 
curve. It is reached either at T1 maxIterations  
or, if set, at T49 positionLRScheduleEndIteration. 
The RadianceKit .full  preset uses 0.000016 — 
i.e. 10× higher than the paper default 0.0000016. 
V420 experiments showed that 0.5× of the final 
value (0.000008) makes loss 6.4 % worse; V414 
showed that 2× the initial value makes it 16.8 
% worse. The high final value is not a trade-
off but a deliberate choice: with too aggressive a 
decay, Gaussians lose during the refinement phase 
the ability to react to newly arrived densification 
candidates. Through the V431/V433 extension the 
schedule phase can be shortened ( T49 < T1 ), so 
that T4  is reached before the end of training 
and the rest of training runs at the constant 
mini-LR — typical configuration: T49 = 20 000 , 
T1 = 35 000 , refinement thus at 0.000016 for 15 

000 iterations.

П Р О СТ Ы М И  С Л О В А М И

How slow the position learning 
rate becomes at the end of 
training. We’ve intentionally set 
this less aggressively than the 
original paper — splats can still 
wiggle a bit until the very end, 
which makes them sharper. If 
you turn the knob: higher = more 
restless splats at the end, lower = 
splats can no longer adapt when 
new ones appear.
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T5 shDCLearningRate

П ОД Р О Б Н О СТ И

Default: 0.0025 (initializer + paper), 0.005 ( .full  
and all MCMC presets — 2×) Range: 0.0001 – 0.05 
Defined in:

Т Е Х Н И Ч Е С К И

Adam learning rate for the DC component (degree 
0, i.e. constant albedo) of the spherical harmonic 
color. SH-DC corresponds to the direction-
independent base tone of a Gaussian, essentially 
the «base color». V176 and V188 experiments 
found 2× higher than the paper default to be 
optimal — faster color convergence, especially 
because with short training (, 5 000 iterations) the 
SH-DC otherwise does not converge. Unlike the 
geometric LRs, SH-DC has no decay; the learning 
rate stays constant over all iterations (or just follows 
the optional extended-phase decay from T51 ). 
V416 tested a quadrupling to 0.01 → 6.4 % worse 
loss with beta2=0.99 Adam.

П Р О СТ Ы М И  С Л О В А М И

How fast the base color of each 
splat adapts. You almost never 
change this value yourself — 
the presets have the right value. 
Higher would be faster but can 
lead to unstable colors.
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T6 shRestLearningRate

П ОД Р О Б Н О СТ И

Default: 0.000125 (initializer + paper), 0.00025 
( .full  and MCMC — 2×) Range: 0.000001 – 
0.005 Defined in:

Т Е Х Н И Ч Е С К И

Adam learning rate for the higher-order SH 
coefficients (degree 1, 2, 3 — i.e. the 
view-direction-dependent color components that 
produce highlights, reflections and soft shading). 
20× smaller than T5  per paper convention, 
because these coefficients grow quadratically in 
count (3 for degree 1, 5 for degree 2, 7 for degree 
3 → 15 floats total per Gaussian) and without a 
smaller learning rate would oversaturate the image. 
They are unlocked in two steps — until the first mark 
in T21 shDegreeUpgradeIterations only degree 0 is 
active (so only T5 ), after that 1, then 2, finally 
3. Low values here are particularly important on 
scenes with lots of diffuse lighting; on very glossy 
surfaces (car paint, water) tuning doesn’t help — 
the SH representation itself is limited.

П Р О СТ Ы М И  С Л О В А М И

How fast the view-dependent 
color effects (reflections, gloss) 
learn. By default very small, 
otherwise everything starts to 
shine. Better leave the value 
alone — if you want better 
highlights, you’re better served 
by MCMC and longer training 
time than by this LR.
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T7 opacityLearningRate

П ОД Р О Б Н О СТ И

Default: 0.05 (initializer + paper), 0.1 ( .full , 
MCMC — 2×) Range: 0.001 – 1.0 Defined in:

Т Е Х Н И Ч Е С К И

Adam learning rate for the logit opacity of each 
Gaussian. The app stores opacity as an unbounded 
float value and transforms it with sigmoid into 
[0, 1]; the LR acts in logit space. The paper 
default 0.05 was restored after V50 tests (best 
single-run L1 0.1664), V71 reverted V67′s 0.025. 
The V188 doubling to 0.1 makes pruning more 
efficient — dead Gaussians fall faster below the 
T14 pruneOpacityThreshold. V418 showed: 0.05 
with beta2=0.99 Adam is 7.1 % worse than 0.1 — 
the interaction with the Adam configuration is non-
trivial. Low values (< 0.01) mean «dead» Gaussians 
linger forever and waste memory; too-high values 
(> 0.5) can lead to opacity explosion, which is why 
the logit value is clamped in the optimizer to [−15, 
3] (see the «Opacity Explosion Prevention» note in 
CLAUDE.md).

П Р О СТ Ы М И  С Л О В А М И

How fast splats become 
transparent or opaque. 
Important for cleanup — splats 
that contribute nothing have 
to vanish quickly so no haze 
appears. The default value fits, 
only pros change it.
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T8 opacityLearningRateFinal

П ОД Р О Б Н О СТ И

Default: 0.0 (= «no decay») Range: 0 or 0.001 – 
Defined in:

Т Е Х Н И Ч Е С К И

Optional cosine decay end value for the opacity 
LR (V427). When 0.0, decay is disabled and the 
opacity LR stays constant at T7  over the entire 
training. V427 tested a decay 0.1 → 0.01 — 
result was 11.5 % worse loss; reverted, hence the 
default «off». The hypothesis behind the field: 
in the refinement phase, a constant opacity LR 
could lead to oscillation, so that splats which had 
already reached the right level of transparency 
would be pushed around again by random gradient 
fluctuations. Empirically this is not the case — the 
logit clamping logic catches that anyway. The field 
stays available for future experiments; very long 
MCMC runs (> 500K iterations) might also benefit 
from it.

П Р О СТ Ы М И  С Л О В А М И

Whether the opacity learning 
rate should become smaller 
toward the end. Default: no. We 
tried it, it was worse, we leave it 
off. Stay at 0.

T9 scaleLearningRate

П ОД Р О Б Н О СТ И

Default: 0.005 (initializer + paper), 0.01 ( .full , 
MCMC — 2×) Range: 0.0001 – 0.1 Defined in:

Т Е Х Н И Ч Е С К И

Adam learning rate for the three scale components 
of each Gaussian in log space (RadianceKit stores 
log(scale) so that scales stay positive). The paper 
default 0.005, doubled in RadianceKit to 0.01 
for better scale convergence with the optimized 
learning rate configurations. V423 experiment: 
0.005 with beta2=0.99 Adam → 18.7 % worse 
loss and visibly too few Gaussians (density 
control couldn’t clone because scale updates 
were too sluggish). Scale controls the extent 
of each Gaussian — too fast learning leads to 
«needle» Gaussians (extremely long thin splats, see 
T34 scaleRatioPruneThreshold), too slow learning 
keeps splats too compact and density control has to 
split too often.

П Р О СТ Ы М И  С Л О В А М И

How fast the shape of the splats 
adapts. Default is good. If you 
push this up you get «needle» 
splats — extremely long thin 
droplets that make the image 
float.
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T10 rotationLearningRate

П ОД Р О Б Н О СТ И

Default: 0.001 (initializer + paper), 0.002 ( .full , 
MCMC — 2×) Range: 0.0001 – 0.05 Defined in:

Т Е Х Н И Ч Е С К И

Adam learning rate for the four quaternion 
components of each Gaussian. The quaternion is re-
normalized after each Adam update (L2 norm = 1) — 
otherwise the covariance matrix would degenerate. 
RadianceKit doubles the paper default in the Quality 
presets because rotation has smaller absolute 
gradient magnitudes than scale/position (on the 
unit sphere each step stays short) and without 2× 
rotation would be clearly under-converged in the 
35 000 iteration window. V188 documents this. On 
NeRF-Blender scenes (Lego, Chair) rotation matters 
particularly — the edges of objects only line up 
properly after 5 000–10 000 iterations.

П Р О СТ Ы М И  С Л О В А М И

How fast the splats learn to 
rotate — that is, to orient 
themselves correctly on the 
surface of an object. Default fits. 
Put another way: if splats look 
like slabs lying askew instead 
of hugging the surface, training 
time is too short rather than this 
learning rate too low.
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Densification — Classic (T11–T16)

T11 densifyGradThreshold

П ОД Р О Б Н О СТ И

Default: 0.000002 (initializer, calibrated for 0.5× 
resolution), 0.0000011 ( .full , calibrated for 1.0×), 
0.000004 ( .quickTest , calibrated for 0.25×), 
2e-7 ( .fullClassicPaper ) Range: 1e-8 – 1e-3 
(resolution-dependent) Defined in:

Т Е Х Н И Ч Е С К И

Threshold for the L2 norm of the screen-
space projected gradient dMean2D , above which 
a Gaussian is marked for cloning or splitting. 
The absolute value depends directly on the 
training resolution — dMean2D  scales roughly 
as 1/resolution² (more pixels = smaller per-pixel 
gradients). Hence every T22 trainingRenderScale 
step needs a calibrated threshold: 0.25× → 4e-6, 
0.5× → 2e-6, 1.0× → 5e-8 … 1.1e-6 ( .full ). 
The paper default 0.0002 is NDC-normalized and 
not directly comparable to RadianceKit’s world-
space pipeline. With the V440-introduced T52 
adaptiveDensifyThreshold flag the value can be 
derived at runtime from the p98 of the current 
gradient distribution — but V440 tested this on real 
scenes and produced 63 K Gaussians (catastrophic 
pruning loss); the flag stays off. Q5 (T77–T79) 
provides an alternative adaptive logic via rolling 
median. This field is not harmless — halving 
creates 2–4× more Gaussians (memory pressure, 
OOM risk); doubling can under-densify the scene.

П Р О СТ Ы М И  С Л О В А М И

How sensitive the app is when 
deciding whether a splat is 
under-represented and should 
be duplicated. Lower value = 
more sensitive = more splats. 
Higher = fewer splats. This is one 
of the most dangerous values of 
all: too low and your Mac fills up 
with millions of splats and may 
crash. Leave the field alone, or 
change it only in steps of 10 %.
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T12 densifyFromIteration

П ОД Р О Б Н О СТ И

Default: 500 Range: 100 – 5 000 Defined in:

Т Е Х Н И Ч Е С К И

First iteration at which densification becomes 
active. Before that only «bare» learning on the 
initial SfM point cloud happens, without new 
Gaussians being created. The default 500 comes 
from the 3DGS paper and gives initialization time 
to stabilize — if densification starts as early as 
iteration 0, mis-positioned SfM points are cloned 
many times before they even find their proper place. 
V349 tested 1000 → slightly worse loss; the default 
is optimal.

П Р О СТ Ы М И  С Л О В А М И

When the app first starts cloning 
splats. Before that it just learns 
the already existing points. 500 
is the default — gives the app 
enough time to find its bearings 
first before multiplying.

T13 densifyInterval

П ОД Р О Б Н О СТ И

Default: 100 (initializer, MCMC), 200 ( .full ) 
Range: 50 – 1 000 Defined in:

Т Е Х Н И Ч Е С К И

How many iterations sit between two densification 
steps. Paper default 100 — every 100 iterations the 
list of densify candidates is evaluated, cloned/split, 
and at the same time the list of prune candidates 
(sigmoid(opacity) < T14 pruneOpacityThreshold) is 
removed. V112 tests found 200 to be optimal for 
.full  — this relieves the GPU because fewer 

reorganization passes run, and gives each Gaussian 
more time to settle after a clone action. V417 
tested 100 with beta2=0.99 → 5.8 % worse (957 
K Gaussians, over-densification). Under MCMC the 
same field is interpreted as the relocation interval; 
see T67 mcmcRelocationInterval for the MCMC-
specific logic.

П Р О СТ Ы М И  С Л О В А М И

How often the app looks for 
new splats. 100 = often, 200 
= medium. Higher means: each 
splat has more time to settle 
before being multiplied again. 
That’s good. Reducing to 50 can 
keep the GPU busy permanently 
without it being noticeably 
better.
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T14 pruneOpacityThreshold

П ОД Р О Б Н О СТ И

Default: 0.005 (initializer, paper, MCMC), 0.001 
( .full ) Range: 0.0001 – 0.1 Defined in:

Т Е Х Н И Ч Е С К И

Sigmoid opacity threshold below which a Gaussian 
is deleted at the next densification step. Works 
together with T7 opacityLearningRate and the logit 
clamp logic in the optimizer. V393 lowered the 
default from 0.005 to 0.001 in .full  — result: 
splats that only matter under exotic viewing angles 
are kept longer and contribute to SH detail. V394 
tested 0.0001 → slightly worse (too little pruned, 
memory wasted). Important: density control MUST 
always prune, even if buffer capacity is already full 
due to other measures (see «Density Control Must 
Always Prune» in CLAUDE.md) — otherwise dead 
Gaussians accumulate and the count freezes.

П Р О СТ Ы М И  С Л О В А М И

When a splat counts as 
«transparent enough» to be 
deleted. 0.005 is the paper 
default, in Quality we have 0.001 
— i.e. we give splats a chance 
for longer. That makes soft light 
and faint shadows easier to 
represent. Setting higher (above 
0.01) makes the splat count 
drop quickly — can make sense 
with memory pressure but costs 
detail.

T15 opacityResetInterval

П ОД Р О Б Н О СТ И

Default: 3 000 (initializer + paper), 100 
000 ( .full  = effectively disabled), 200 000 
( .fullMCMC  = disabled) Range: 1 000 – 100 000+ 
Defined in:

Т Е Х Н И Ч Е С К И

How many iterations between resetting the opacity 
of all Gaussians to a low value (~0.01) — a measure 
from the 3DGS paper to reassess «frozen» splats. 
V194 showed that with RadianceKit’s warmup
1. stochastic training setup + 2× learning rates, 

opacity reset costs

5.5 % quality and that logit clamping already covers 
the reset function. Hence in .full  practically 
disabled (100 000 > 35 000, so never triggered). 
V421 tested reset every 3 000 with beta2=0.99 → 
4.9 % worse; reverted. Under .fullClassicPaper  
(Q1.5-A, paper-true test) it is deliberately set back 
to 3 000 — that was one of the levers with which 
the paper-magnitude Gaussian budgets were to be 
reached.

П Р О СТ Ы М И  С Л О В А М И

How many iterations between 
the app resetting the visibility of 
all splats to «almost invisible» — 
a kind of reset button for opacity. 
With us disabled (value so high 
that it never fires) because 
other mechanisms make it 
unnecessary. Only enable for 
paper-faithful experiments.
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T16 maxScreenSize

П ОД Р О Б Н О СТ И

Default: 0.0 (= disabled) Range: 0 (off) or > 0 
Defined in:

Т Е Х Н И Ч Е С К И

Maximum screen-space size (in projected pixels) 
a Gaussian may reach before being forcibly 
split. The value is set to 0 (V48 tested and 
reverted) — RadianceKit’s density control instead 
uses the world-space scale threshold from the 
dMean2D  logic. Stays in the field catalog because 

future experiments with Mip-Splatting (T74–T76) 
or scene-specific splatting strategies could benefit 
from it. Enabling (value > 0, e.g. 20) would 
force splats that have grown very large on screen 
to subdivide — relevant with large smooth wall 
surfaces where a single giant splat offers too little 
detail.

П Р О СТ Ы М И  С Л О В А М И

Limit on how large a single splat 
is allowed to get on screen. With 
us off. Turning it on would cause 
huge flat splats (e.g. on a wall) to 
be forcibly broken up into several 
smaller ones. Leave off unless 
explicitly experimenting with it.
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Loss (T17–T20)

T17 ssimWeight

П ОД Р О Б Н О СТ И

Default: 0.2 (initializer + paper + .full ), 0.05 (all 
MCMC presets) Range: 0.0 – 1.0 Defined in:

Т Е Х Н И Ч Е С К И

Weight of the D-SSIM term in the combined loss 
function loss = (1 - λ) * L1 + λ * D-
SSIM, where λ = T17 . The 3DGS paper default 0.2 
is optimal for classic densification — V383 tested 
0.3 → 28.9 % worse, V373b confirmed 0.2 as 
the sweet spot. For MCMC it was independently 
established in V521b/V534: 0.05 is optimal because 
MCMC, through its stochastic exploration, needs 
a stronger L1 signal component — higher SSIM 
weights would dilute the relocation decisions. 
SSIM is significantly more expensive to compute 
than L1 (local 11×11 windows over the whole 
image); RadianceKit uses an MPS-accelerated 
implementation that stays under 1 ms per 1080p 
image. Q7 BayesOpt sweeps found scene-specific 
optima between 0.05 ( .outdoorPreset : 0.082) and 
0.171 ( .indoorPreset ).

П Р О СТ Ы М И  С Л О В А М И

How important the app 
considers «structures are 
similar» alongside «every pixel 
matches». 0.2 is the default 
and gives a good image. Lower 
= more pixel-accurate but can 
result in softer transitions. 
Higher = more structurally 
similar but details get softer. Let 
the presets decide.
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T18 ssimWeightRefinement

П ОД Р О Б Н О СТ И

Default: 0.0 (= «no switch, keep ssimWeight») 
Range: 0 or 0 – 1.0 Defined in:

Т Е Х Н И Ч Е С К И

Optional SSIM value for the refinement phase after 
T2 densifyUntilIteration. V428 tested 0.2 → 
0.3 in refinement → 16 % worse loss (both L1 
and SSIM degraded); reverted, hence default 0.0. 
The hypothesis behind the field was that after 
densification — when no more new Gaussians are 
being created — a stronger SSIM share would 
maximize structural sharpness. Empirically false: 
increasing SSIM weight means indirectly lowering 
L1 weight, and L1 is the much more meaningful 
signal in the final refinement phase. The field stays 
available for future experiments with perceptual loss 
(T60) or edge loss (T19), where a refinement-
specific loss composition might make sense.

П Р О СТ Ы М И  С Л О В А М И

Special setting for the second 
training phase (refinement 
after splat duplication). At 
0.0: same SSIM weighting as 
before. Tweaking brings nothing 
empirically, so off.

T19 edgeLossWeight

П ОД Р О Б Н О СТ И

Default: 0.0 (= disabled) Range: 0 or 0.001 – 1.0 
Defined in:

Т Е Х Н И Ч Е С К И

V437 experimental loss: weight of a Sobel-gradient-
domain L1 loss that compares image edges directly 
(ground-truth Sobel vs render Sobel) on top 
of L1+SSIM. Hypothesis: edge information is a 
perceptual cornerstone of image quality and an 
explicit term should encourage Gaussians to hit 
edges better. Test results: weight 0.1 → 11 % worse 
loss, 0.01 → quality-neutral but 10 % slower. The 
Sobel pass costs an extra MPS forward on ground 
truth and render. Hence permanently disabled. 
Future use case: scenes with hard artificial edges 
(architecture, furniture, renderings) could benefit — 
Q7 scene class presets didn’t pick it though, instead 
they scaled the SSIM weight.

П Р О СТ Ы М И  С Л О В А М И

Experimental extra that treats 
edges as particularly important. 
Brings nothing empirically. Stays 
off.
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T20 skyMaskingEnabled

П ОД Р О Б Н О СТ И

Default: false (initializer and all presets) Range: 
boolean Defined in:

Т Е Х Н И Ч Е С К И

Enables sky masking. In every image the sky 
region is masked out via Apple Vision Framework 
(VNGenerateForegroundInstanceMaskRequest), and 
the loss in this region is set to zero. Reason: 
outdoor scenes often suffer from blue/gray/white 
sky pixels driving the app to place Gaussians 
exactly there — which is perceived as «floaters». 
Without a sky mask the loss in this region would 
never be zero because the sky in the image varies 
slightly and the app keeps trying to rebuild it with 
splats. The Vision mask is computed once per 
camera before training and held in RAM. Typically 
activated together with T45 skyDomeEnabled  (UI 
logic in the Settings view). Leave disabled for indoor 
scenes or synthetic renderings — the mask would 
erroneously detect ceilings or walls as «sky».

П Р О СТ Ы М И  С Л О В А М И

Enables a special mode for 
outdoor captures: the sky is 
ignored during training, so the 
app doesn’t try to rebuild it with 
splats. Recommended for every 
outdoor scene. Leave off for 
indoor or for 3D renderings from 
Blender.
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SH Degree Progression (T21)

T21 shDegreeUpgradeIterations

П ОД Р О Б Н О СТ И

Default: [1_​000, 2_​000, 3_​000] (initializer), 
[2_​000, 5_​000, 8_​000] ( .full , MCMC), 
[1_000, 2_000]  ( .preview  — degree 3 

skipped) Range: [Int] , each value in 
[0, maxIterations] , monotonically increasing 

Defined in:

Т Е Х Н И Ч Е С К И

Iterations at which the active SH degree is 
upgraded 0→1, 1→2, 2→3. Before the first mark 
only the DC components are active (i.e. T5 
shDCLearningRate), after the first mark DC + 3 
degree-1 coefficients, after the second mark + 
5 degree-2 coefficients, after the third mark all 
15 coefficients. Memory consumption per Gaussian 
grows in steps accordingly — 4 floats → 16 floats 
→ 36 floats → 64 floats. The Quality presets 
delay the upgrades compared to initializer defaults 
(V228) because the geometry should stabilize first, 
before the color details with their higher frequency 
are added on top. V384 tested [1K, 2K, 3K]  for 
.full  → 9.3 % worse — confirms the delay. 
.preview  caps at degree 2, because degree 3 

doesn’t converge in 5 000 iterations and just 
consumes optimizer capacity. Q6 (T80–T81) offers 
an alternative curriculum logic that dynamically 
overrides this list.

П Р О СТ Ы М И  С Л О В А М И

At which points during training 
the app learns that colors can 
look different from different 
viewing angles (highlights, 
reflections). Only late — so first 
the shape is right, then the 
color. The values in the presets 
are set so this works well. 
Don’t change anything unless 
you know exactly why.
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Performance (T22–T25)

T22 trainingRenderScale

П ОД Р О Б Н О СТ И

Default: 1.0 (initializer, .full , MCMC, Scene-
Class), 0.5 ( .preview ), 0.25 ( .quickTest ) Range: 
0.05 – 2.0 (typically 0.25, 0.5, 1.0) Defined in:

Т Е Х Н И Ч Е С К И

Rendering resolution during training relative to the 
original resolution of the training images. At 0.5 
every image is downscaled to 50 % width × 50 % 
height (i.e. 25 % of the pixels) and the Gaussian 
rendering happens at this lower resolution. Reduces 
both memory and compute quadratically. Important: 
T11 densifyGradThreshold has to match the chosen 
resolution — the gradient magnitudes scale with 1/
resolution², which is why .quickTest  (0.25×) has 
a much higher threshold (4e-6) than .full  (1.0×, 
1.1e-6). RadianceKit warns at very large images and 
adjusts automatically — 3 MP target resolution. With 
extreme 4K input images, 0.5 or even 0.25 would 
make sense, otherwise any Mac will run only in CPU 
compaction.

П Р О СТ Ы М И  С Л О В А М И

How big the images are during 
training. 1.0 = original, 0.5 = 
half size. Half size = four times 
faster but the finest details 
are missing. The presets pick 
the right value; with extremely 
large input images (over 12 
megapixels) the app switches 
down automatically.

T23 resolutionWarmupScale

П ОД Р О Б Н О СТ И

Default: 0.0 (= disabled) Range: 0 or 0.1 – Defined 
in:

Т Е Х Н И Ч Е С К И

V133 optimization: train the densification phase (iter 
0 to T2 ) at a lower resolution than the refinement 
phase. V308 turned it off again for .full  because 
with T22 = 1.0  and cosine annealing, the time win 
was marginal and quality suffered slightly. Stays in 
the field catalog because it could become useful 
again with 4K inputs and long training runs — Q6 
curriculum (T80) picked up a similar logic, though 
there it is tied to the LR schedule. If enabled and 
T80 curriculumResolutionRamp is also true, Q6 wins 
and overrides this value.

П Р О СТ Ы М И  С Л О В А М И

Special feature: in the first 
training half learn from smaller 
images, in the second from large 
ones. Saves time. Off because 
the newer Q6 variant solves it 
better.
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T24 tileSize

П ОД Р О Б Н О СТ И

Default: 16 Range: 8, 16, 32 Defined in:

Т Е Х Н И Ч Е С К И

Size of the rasterization tiles in pixels. The Gaussian 
Splatting rendering is tile-based: the image is 
divided into 16×16 pixel tiles, each tile collects 
the Gaussians relevant to it, sorts them by depth 
and blends them. 16 is the standard used by 
practically all 3DGS implementations and is hard-
coded in RadianceKit’s Metal kernels; changing this 
value would require shader recompilation and is not 
effective in the current state. Stays as a field in case 
a future engine version supports dynamic tile size.

П Р О СТ Ы М И  С Л О В А М И

Internal render parameter. 
Default 16, do not change.

T25 throttleDelayMs

П ОД Р О Б Н О СТ И

Default: 0 (initializer, .full , MCMC, Scene-
Class), 0 ( .preview ) Range: 0 – 100 Defined in:

Т Е Х Н И Ч Е С К И

Artificial delay between training iterations in 
milliseconds. 0 = full speed (default). Higher 
values make the Mac more «usable» during 
training, by giving GPU/CPU regular breathers — 
the responsiveness of other apps improves, but 
training time grows linearly with the delay. Typical 
values: 1–2 ms («light» throttling, +5 % training 
time, Mac feels more responsive), 5 ms («medium», 
+15 % training time), 10+ ms («eco», potentially 
double the training time). Offered in the Inspector 
under «Performance» but not in the default 
view — see backlog dev_ux-backlog.md  which 
suggests removing it from the Expert View because 
misunderstood it dramatically extends training time.

П Р О СТ Ы М И  С Л О В А М И

How many milliseconds of pause 
the app makes between training 
steps. 0 = no pause, as fast as 
possible. Higher values make the 
Mac more usable during training 
— but the training takes longer 
too. On an M3 Ultra or Mac Studio 
you can leave this at 0; on a 
MacBook Air 2 or 5 would be a 
good value.
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Diagnostics and Point Cloud Preparation (T26–T30)

T26 depthDistortionWeight

П ОД Р О Б Н О СТ И

Default: 0.0 (= disabled) Range: 0 or 0.0001 – 0.05 
Defined in:

Т Е Х Н И Ч Е С К И

V366 experimental: weight of a depth distortion 
regularization loss. Penalizes Gaussians that, along 
a render ray, are stacked in depth but conceptually 
belong to the same surface — this encourages 
concentrated depth distributions and reduces 
floaters. Tests: 0.01 → 4.5 % worse, 0.001 → 8.1 
% worse. The theoretical advantage — improving 
multi-view consistency — does not show up in the 
L1 loss, because the hypothesis implicitly assumes 
that the SfM geometry is correct and the Gaussians 
just need to be «stacked». In practice the SfM 
point cloud is usually the weakest component, not 
the stacking. Stays available for multi-view datasets 
with particularly clean poses (synthetic, Mip-NeRF 
360 with ground truth).

П Р О СТ Ы М И  С Л О В А М И

Experimental feature to avoid 
multiple splats lined up at the 
same spot. Not enabled because 
the tests showed no benefit.

T27 singleViewOverfit

П ОД Р О Б Н О СТ И

Default: false Range: boolean Defined in:

Т Е Х Н И Ч Е С К И

Diagnostic flag: when true, every training iteration 
must use camera index 0 instead of a random one 
from the camera pool. Reason: if the model can’t 
even overfit a single view (i.e. the loss on view 0 
doesn’t go to zero even after 10 000 iterations), 
there’s a fundamental bug in the forward/backward 
pass. This switch was used intensively during 
the development of the Metal shaders and the 
differentiable rasterizer kernels — V42–V47 phase. 
Today only available as a sanity check if someone 
has modified backend code and wants to do a 
regression test. Via CLI with --single-view .

П Р О СТ Ы М И  С Л О В А М И

Test mode for developers. They 
can use it to check whether 
the app can even learn from 
a SINGLE image. Irrelevant for 
normal users, always leave off.
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T28 maxCameras

П ОД Р О Б Н О СТ И

Default: 0 (= «use all cameras») Range: 0 or 1 – N 
Defined in:

Т Е Х Н И Ч Е С К И

Diagnostic limit from V43: train only with the first 
N cameras, ignore all further ones. Original reason: 
test the hypothesis that too many cameras create 
gradient conflicts (too many conflicting loss signals 
for the same Gaussian). Test result: no systematic 
advantage from artificial limiting — more frames 
practically always bring more quality. Stays as a CLI 
flag ( --max-cameras N ) for targeted experiments, 
e.g. «does training work on the first 100 images of a 
1 500-image drone flight?» Not exposed in the UI.

П Р О СТ Ы М И  С Л О В А М И

Diagnostic field for developers 
— use only the first N images, 
ignore the rest. Normal user 
doesn’t need this, value at 0 
= all images. More images = 
better result (see feedback_​
more-frames-better.md).

T29 maxInitialPoints

П ОД Р О Б Н О СТ И

Default: 0 (= «use all SfM points») Range: 0 or 1 
000 – 200 000+ Defined in:

Т Е Х Н И Ч Е С К И

V54 safety net: limits the number of initial SfM 
points the training starts with. Dense COLMAP 
reconstructions can produce > 60 000 points, 
which with large initial scales leads to 200–300 
Gaussians per pixel overlap — this creates a 
«fog field» in which training does not converge. 
Subsampling to ~16 000 points (hard-cap logic in 
the training engine) brings initial density to the level 
used by reference 3DGS, and dramatically reduces 
overlap. Set automatically with very dense SfMs; via 
CLI with --max-points N .

П Р О СТ Ы М И  С Л О В А М И

How many starting points 
from the camera reconstruction 
are used. With very dense 
reconstructions (more than 60 
000) the app automatically limits 
to 16 000 — otherwise there is 
too much fog at the beginning. 
You don’t have to set this; the 
app handles it.
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T30 cameraClusterOutlierMultiplier

П ОД Р О Б Н О СТ И

Default: 10.0 (all presets — never overridden) 
Range: 1.0 – 100.0 Defined in:

Т Е Х Н И Ч Е С К И

Multiplier for the camera cluster outlier filter, 
introduced in Phase 3.10 A.1. Before training 
the training engine computes the centroid of all 
camera positions and the maximum distance of 
any camera from the centroid. SfM points whose 
distance from the centroid exceeds multiplier 
× maxCameraDistance are discarded as outliers. 
Default 10× preserves the pre-Phase 3.10 behavior. 
A subtle bug: tighter SfM (cameras closer together) 
→ smaller → smaller threshold → more points are 
discarded as outliers. Looser SfM → larger threshold 
→ fewer points discarded. This is one of the causes 
of the Phase 3.9 funnel-vs-training anti-correlation: 
better SfM can downstream lead to worse training 
because too many initial points are killed. The 
field is available as a CLI override (--camera-
cluster-outlier-multiplier) for the A.3 sweeps; 
not exposed in the UI. Values below 5 are usually 
too restrictive, above 20 ineffective.

П Р О СТ Ы М И  С Л О В А М И

Special filter that discards points 
from the reconstruction lying far 
away from the camera cloud. 10 
= the app is generous, keeps 
almost everything. Increasing 
can make sense when far-
away points (mountains in the 
distance) look in the image like 
floating blobs. Lower setting only 
in emergencies — you’ll lose 
detail in the distance.
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Regularization (T31–T37)

T31 coarseToFineBlurRadius

П ОД Р О Б Н О СТ И

Default: 0 (= disabled) Range: 0 or 1 – 10 Defined 
in:

Т Е Х Н И Ч Е С К И

V369 experimental: box blur radius applied at the 
start of the densification phase to the ground 
truth image, reduced linearly to 0 by the end 
of densification ( T2 ). Hypothesis: coarse-to-fine 
training — first learn coarse structures, then details 
— should yield more stable geometry. Tests: r=3 
→ 9.6 % worse, r=1 → 5.1 % worse. Reason 
for failure: densification decides based on image 
domain gradients, and blurring reduces exactly the 
signals important for «must clone here». Stays in 
the field catalog for future tests with a different 
density control scheme.

П Р О СТ Ы М И  С Л О В А М И

Experimental «coarse-first-then-
detail» mode. Brought nothing, 
stays off.

T32 scaleRegWeight

П ОД Р О Б Н О СТ И

Default: 0.0 (= disabled) Range: 0 or 0.0001 – 0.05 
Defined in:

Т Е Х Н И Ч Е С К И

V370 experimental: L1 regularization on world-
space scale. Penalizes Gaussians that grow too 
large — prevents «mega splats» covering whole 
wall surfaces with a single Gaussian. Tests: 0.01 → 
200 % worse loss (2 M Gaussians, total explosion), 
0.001 → 214 % worse. Reason: scale regularization 
conflicts with density control — smaller scales mean 
more Gaussians are needed, so density control 
splits more often, which in turn means more 
gradient work. Disabled, but documented for Mip-
Splatting experiments (T74): in that context a scale 
lower bound could make sense.

П Р О СТ Ы М И  С Л О В А М И

Regularization that forces splats 
to stay small. Triggered splat 
explosions in tests (millions of 
splats). Do not enable.
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T33 anisotropyRegWeight

П ОД Р О Б Н О СТ И

Default: 0.0 (= disabled) Range: 0 or 0.0001 – 0.05 
Defined in:

Т Е Х Н И Ч Е С К И

V445 experimental: penalty on the max(scale)/
min(scale) ratio, intended to prevent extremely 
elongated «needle» Gaussians perceived as 
floaters. Tests: 0.01 → 69 % worse, 0.001 → 
15 % worse. Reason: regularization forces splats 
toward «round» shape, which on a flat surface 
(wall, table, floor) is exactly wrong — there 
a flat, broad Gaussian is more efficient than 
a spherical one. Disabled. V549f offered with 
T34 scaleRatioPruneThreshold an alternative more 
targeted approach, which was also reverted.

П Р О СТ Ы М И  С Л О В А М И

Regularization that penalizes 
very long thin splats. Sounds 
sensible but was worse in tests. 
Off.

T34 scaleRatioPruneThreshold

П ОД Р О Б Н О СТ И

Default: 0.0 (= disabled) Range: 0 or 5.0 – 100.0 
(typically 10.0 – 30.0) Defined in:

Т Е Х Н И Ч Е С К И

Experimental post-training pruning that deletes 
each Gaussian whose max(scale)/min(scale) ratio 
exceeds the linear threshold set here. Targets 
extremely elongated «needle/disc» floaters that 
can’t be eliminated by regularization alone. In 
tests the pruning removed floaters as hoped, but 
also useful flat splats on walls and floors — 
the image became hole-ier. Hence off by default; 
the CLI flag (--scale-ratio-prune N) remains for 
targeted experiments. Recommended values if you 
do want to test: 30 (very conservative, removes only 
extreme outliers), 10 (aggressive, costs detail).

П Р О СТ Ы М И  С Л О В А М И

Attempt to filter out very 
elongated splats after training. 
Was net-negative in tests — 
floaters gone but also detail 
gone. Off.
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T35 opacityRegWeight

П ОД Р О Б Н О СТ И

Default: 0.0 (= disabled) Range: 0 or 0.0001 – 0.05 
Defined in:

Т Е Х Н И Ч Е С К И

V446 experimental: binary cross-entropy penalty 
that pulls opacity toward 0 or 1 (i.e. away from 
«semi-transparent»). Hypothesis: sharper opacity 
distribution would improve image clarity. Tested 
combined with T33 → regularization costs quality, 
both disabled. Disabled. Attention: in 1.4.3 beta a 
bug appeared that had exactly this field with a 
changed default value (initializer = 0.01), which led 
to mass extinction of the Gaussian count (460 K → 
5 in one iteration). Since 1.4.4 hard-pinned to 0.0 as 
default.

П Р О СТ Ы М И  С Л О В А М И

Regularization that makes splats 
either fully transparent or fully 
solid. Brings nothing, can even 
become dangerous (1.4.3 bug 
mass extinction). Leave at 0.

T36 opacityDecayFactor

П ОД Р О Б Н О СТ И

Default: 0.0 (initializer = disabled), 0.9995 ( .full , 
.classicBalanced  — HTGS standard) Range: 0 

(off) or 0.95 – 1.0 Defined in:

Т Е Х Н И Ч Е С К И

V546 implementation of the HTGS scheme 
(Hierarchical Time-Gating, Eurographics 2025): 
every T37 opacityDecayInterval iterations the 
sigmoid opacity of each Gaussian is multiplied 
by this factor. 0.9995 × 100 applications gives 
~95 % residual per densification phase — a 
slight but steady downward pressure on all 
opacities, which reliably drops weakly contributing 
Gaussians below the T14 pruneOpacityThreshold. 
The result: 14 % better L1 loss on Horse Full 
(3-trial avg V546) vs V438 without decay. Active 
only during the densification phase (until T2 ), 
after that training continues without decay so 
the opacities established during refinement stay 
stable. Not used under MCMC (MCMC has its own 
mechanisms via T67 mcmcRelocationInterval + T68 
mcmcDeadOpacityThreshold).

П Р О СТ Ы М И  С Л О В А М И

«Gentle fade» of all splats over 
the training time. Makes inactive 
splats transparent faster, so they 
disappear during cleanup. Was 
the most important quality lever 
of the V546 update: 14 % better. 
Built into the Quality preset. 
Even tweaking not recommended 
because precisely balanced.
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T37 opacityDecayInterval

П ОД Р О Б Н О СТ И

Default: 50 Range: 10 – 500 Defined in:

Т Е Х Н И Ч Е С К И

Iteration interval at which T36 opacityDecayFactor 
is applied. HTGS paper default 50, left at that in 
.full . Long intervals (>200) partially cancel the 

effect because between two applications enough 
gradient updates happen that opacity rises again. 
Shorter intervals (<20) make decay too aggressive. 
Active only in the densification phase.

П Р О СТ Ы М И  С Л О В А М И

How often the «fade» is applied. 
50 = every 50 iterations a small 
fade step. Fits.

Refinement (T38–T44)

T38 gradientAccumulationSteps

П ОД Р О Б Н О СТ И

Default: 1 (= «one view per Adam step») Range: 1 
– 8 Defined in:

Т Е Х Н И Ч Е С К И

V424 feature: number of views whose gradients 
are accumulated before an Adam update runs. 
With > 1  the app runs on a separate «unfused» 
backward project path that sums the gradients into 
a separate buffer; the final application scales by 1/
N to keep magnitude constant. V424 tested 2-view 
→ quality-neutral but 10 % slower (because unfused 
is more expensive than fused). Reverted for .full  
but deliberately used for MCMC — .fullMCMC  runs 
with, but V544a tests showed that with the quality 
gap to Classic shrinks to 5 % (instead of 11 %). 
In the initializer default 1, in the current preset 1, 
remains a CLI flag ( --accum-steps N ).

П Р О СТ Ы М И  С Л О В А М И

How many images the app 
considers before adjusting the 
splats. 1 = each image 
individually. Higher = look at 
several images together and 
then apply an average. Brings 
nothing in the standard case; 
under MCMC 2 can help a bit.
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T39 testViewIndices

П ОД Р О Б Н О СТ И

Default: []  (= empty, all views are used for 
training) Range: Set<Int> , arbitrary subset of 
camera indices Defined in:

Т Е Х Н И Ч Е С К И

V546 feature: set of camera indices that are NOT 
used for training but saved as holdout for PSNR/
SSIM/LPIPS evaluation. Set automatically when the 
--benchmark  CLI flag is active: then every 8th 

view starting from index 0 (LLFF standard, identical 
to Mip-NeRF 360 and 3DGS paper conventions). 
Without benchmark empty — training uses all 
views. Caution: manually setting this field without 
understanding the indices can make the benchmark 
unusable (e.g. when all indices are set above N 
while there are only N-50 views → no holdouts 
→ no evaluation). When you export your own 
preset, testViewIndices is not persisted because 
it is scene-dependent and would otherwise leave 
nonsensical values between different datasets.

П Р О СТ Ы М И  С Л О В А М И

Which images during training are 
«left out» to use later for quality 
measurement. You don’t set this 
yourself; the --benchmark  
flag does it automatically (every 
eighth image is test). If you 
set your own indices: dangerous, 
can corrupt the benchmark.

T40 refinementPruneInterval

П ОД Р О Б Н О СТ И

Default: 0 (= disabled) Range: 0 or 100 – 5 000 
Defined in:

Т Е Х Н И Ч Е С К И

V425 feature: every N iterations during 
the refinement phase (after T2 ) an 
additional prune pass runs that removes 
Gaussians with sigmoid(opacity) < T41 
refinementPruneOpacityThreshold. Reason: during 
densification there are regular density control calls, 
after that not anymore — but Gaussians whose 
opacity continues to drop stay in the buffer. 
V425 tested and reverted: the additional pruning 
correlated with V426 (Two-Phase Densification, 
which also ended in 0-Gaussians cascade failure). 
Disabled. CLI flag available for experiments; if 
enabled, 1 000 or 2 000 are sensible values.

П Р О СТ Ы М И  С Л О В А М И

Additional cleanup during 
the refinement phase. Brings 
nothing, stays off.

141 / 235



R A D I A N C E K I T Глава 6 — Конфигурация обучения

T41 refinementPruneOpacityThreshold

П ОД Р О Б Н О СТ И

Default: 0.0 (= «use T14 ») Range: 0 or 0.001 – 0.1 
Defined in:

Т Е Х Н И Ч Е С К И

V425b: separate opacity threshold for refinement 
pruning. After densification most Gaussians have 
reached a clearly higher opacity (> 0.001), so the 
default T14 pruneOpacityThreshold would be too 
lax. If T40  is active, this field determines its own 
threshold. At 0.0 T14  is used as before. Only 
relevant if T40 > 0.

П Р О СТ Ы М И  С Л О В А М И

Threshold for the additional 
refinement cleanup (see T40). 
Both fields inactive, so 
irrelevant.

T42 midTrainingCompactificationIterations

П ОД Р О Б Н О СТ И

Default: []  (= disabled) Range: [Int] , values in 
(densifyUntilIteration, maxIterations) Defined 
in:

Т Е Х Н И Ч Е С К И

V549 feature: explicit iteration points during the 
refinement phase at which a compactification 
pass runs (removes sigmoid(opacity) < 0.01 
+ outlier-scale Gaussians, same logic as 
T56 postTrainingCompactification). Reason: long 
refinement phases can show confetti/floater 
accumulation, whose SH then overfits to view-
specific artifacts. Typical configuration if enabled: 
[10000, 20000, 30000] for 40K Classic. BUT: V549 
A/B tests on the Family dataset showed worse L1 in 
all configurations: [10K,20K,30K]@0.01  → −48 % 
count but +36 % L1; [20K,30K]@0.005  → −44 % 
count but +45 % L1; [20K,30K]@0.001  → −17 % 
count but +87 % L1. Hence disabled. CLI flag --mid-
compact "10000,20000" available, if you prefer the 
visual floater tradeoff (less confetti in the viewport) 
over the loss regression.

П Р О СТ Ы М И  С Л О В А М И

Mid-training cleanup actions 
during training. In tests the 
cleanup made the end result 
worse (yes, fewer floaters, but 
also less detail). Off, can 
be enabled via CLI, in case 
floaters bother you more than a 
somewhat mushier image.
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T43 frustumCullEnabled

П ОД Р О Б Н О СТ И

Default: false Range: boolean Defined in:

Т Е Х Н И Ч Е С К И

V549b feature: after training all Gaussians outside 
the union of all training camera frusta are removed. 
Such Gaussians were never constrained by the loss 
signal and are always floaters. Particularly effective 
for scenes where the novel view sits behind or 
beside the camera path (e.g. behind a linear drone 
flight) — the floaters there are never visible during 
training but very much so later when moving in 
the 3D viewer. V549b A/B on drone flights showed 
positive results, hence available as opt-in. Default 
false because for object captures with full orbit 
coverage the frustum union encompasses the whole 
scene and the feature removes nothing — offered 
in Settings under «Floater Reduction» and also 
implicitly tested in Q9 Outdoor preset via T44 
frustumCullExpansion (Q7 BayesOpt didn’t enable 
it though, because outdoor sky dome solves the 
same problem better).

П Р О СТ Ы М И  С Л О В А М И

Special filter for drone flights 
or linear captures: after training, 
splats that were not «seen» 
in any camera are deleted. 
Optional, switchable on in 
Settings. For simple object 
captures unnecessary.

T44 frustumCullExpansion

П ОД Р О Б Н О СТ И

Default: 1.1 Range: 1.0 – 2.0 Defined in:

Т Е Х Н И Ч Е С К И

NDC margin for T43 frustumCullEnabled. 1.0 would 
cut exactly at the image edge, which would trim 
wobbly splats near the edge too aggressively. 1.1 
= 10 % padding beyond the exact camera framing 
— gives some tolerance for edge pixels that might 
still become visible in a slightly shifted novel view. 
Values > 1.2 make the cull practically ineffective 
because the expanded frustum encompasses too 
much space.

П Р О СТ Ы М И  С Л О В А М И

How strictly the above-
mentioned filter clips. 1.1 = a bit 
of safety margin to the image 
edge. Leave the value.
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Sky Dome (T45–T48)

T45 skyDomeEnabled

П ОД Р О Б Н О СТ И

Default: false (initializer + all presets except P9 
Outdoor) Range: boolean Defined in:

Т Е Х Н И Ч Е С К И

V549e feature: before training starts a spherical 
point cloud is generated (Fibonacci sphere with 
T46  sample points), placed at a radius of T47 
skyDomeRadiusMultiplier × scene_​extent around 
the scene center, and initialized with the colors from 
sky-masked pixels of all training cameras (see T20 
skyMaskingEnabled). These sky dome Gaussians 
are inserted at the beginning of the Gaussian 
buffer and during training «frozen» (position/scale/
rotation gradients = 0, only SH and opacity remain 
optimizable). Effect: instead of black «confetti» 
areas in the distance, the user sees a real sky 
in novel views. The V549e MVP works very well 
on drone and landscape scenes; in P9 Outdoor 
preset default-on. Leave off for indoor scenes — the 
sphere would dangle uselessly outside the room.

П Р О СТ Ы М И  С Л О В А М И

Enables an artificial «sky dome» 
around the scene. Makes outdoor 
captures much nicer: instead 
of black blobs at the image 
edge, the app shows the real 
sky. Mandatory for drone flights 
and landscapes, pointless for 
interiors.

T46 skyDomeSampleCount

П ОД Р О Б Н О СТ И

Default: 5 000 Range: 1 000 – 50 000 (typical 2 
000 – 10 000) Defined in:

Т Е Х Н И Ч Е С К И

Number of Fibonacci sphere sample points on the 
sky dome sphere. Higher values → denser sky dome 
(better at large resolutions and lots of visible sky), 
but higher memory consumption. 5 000 is the sweet 
spot for 4K renderings; at lower resolutions 2 000–
3 000 suffice. The points are initialized by cosine 
distance to each training camera view vector with 
the corresponding sky-masked pixels — sample 
points whose view cone is seen by no camera 
keep a low opacity initial value, but stay unchanged 
during training (frozen).

П Р О СТ Ы М И  С Л О В А М И

How dense the artificial sky is. 
5 000 points usually suffice. 
More = smoother transition from 
the distance, but costs some 
memory.
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T47 skyDomeRadiusMultiplier

П ОД Р О Б Н О СТ И

Default: 30.0 (initializer + most presets), 59.0 (P9 
Outdoor, Q7 BayesOpt optimum) Range: 5.0 – 
200.0 Defined in:

Т Е Х Н И Ч Е С К И

Radius of the sky dome sphere relative to the 
scene extent (= mean distance between camera 
positions). 30 = the sphere has 30× the diameter 
of the camera cloud. Too small (< 5) → sky dome 
interferes with the scene itself (e.g. a sky dome 
splat lands in the foreground); too large (> 100) → 
float32 precision loss at the sky dome positions, 
which triggers render glitches in the distance. Q7 
BayesOpt on Bicycle (Mip-NeRF 360) found 59.0 
as scene-specific optimum for outdoor — this 
suggests that the default 30.0 is too small for deep 
landscapes and that sky dome pixels visibly render 
as a «wall» in image-edge regions.

П Р О СТ Ы М И  С Л О В А М И

How far away the artificial sky 
dome should be. 30 = quite far. 
With big landscapes 50–60 is 
better (Outdoor preset handles 
that automatically). Too small 
would be like having blobs right 
in front of the lens.

T48 frozenGaussianCount

П ОД Р О Б Н О СТ И

Default: 0 (= no frozen Gaussians) Range: 0 or 1 – 
T46  Defined in:

Т Е Х Н И Ч Е С К И

Number of Gaussians at the start of the buffer 
whose position/scale/rotation gradients are zeroed 
in the optimizer — they remain spatially rigid over 
the entire training. Density control may not clone, 
split or prune them. Used for sky dome injection 
(see T45 ): when sky dome is on, this field 
is automatically set to T46 skyDomeSampleCount. 
Manual setting is possible (e.g. to freeze a pre-
placed point cloud from a LiDAR scan), but not 
directly accessible in the UI. Important: the first N 
Gaussians in the buffer are always the frozen ones 
— the order in the buffer decides, not an explicit 
index.

П Р О СТ Ы М И  С Л О В А М И

How many splats at the 
beginning are fixed and may not 
move. Set automatically to the 
sky dome count when sky dome 
is on. You don’t need to tweak 
this yourself.
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Adam + LR Schedule (T49–T55)

T49 adamResetIteration

П ОД Р О Б Н О СТ И

Default: 0 (= disabled) Range: 0 or 100 – Defined 
in:

Т Е Х Н И Ч Е С К И

V430 feature: iteration at which the Adam 
optimizer momentum accumulators (m1, m2) are 
reset to zero. Bias correction afterwards runs with 
(iter - adamResetIteration) instead of iter . 
V430 tested reset at 5 000 (after densification 
end) → 12.8 % worse loss. Reason: the Adam 
momentum that built up during densification carries 
information about the typical gradient magnitudes 
and accelerates the refinement phase. Throwing it 
away costs the first ~500 iterations of refinement 
in convergence. Disabled. Stays as CLI flag for 
research experiments.

П Р О СТ Ы М И  С Л О В А М И

Reset button for the internal 
Adam optimizer «memory». Hurt 
in tests, stays off.

T50 positionLRScheduleEndIteration

П ОД Р О Б Н О СТ И

Default: 0 (initializer = «use maxIterations»), 20 
000 ( .full  — cosine ends at 20K although 
maxIter=35K), 30 000 ( .fullClassicPaper ) 
Range: 0 or 1 000 – Defined in:

Т Е Х Н И Ч Е С К И

V431 feature: iteration at which the cosine annealing 
curve for position LR reaches its minimum. If 0, 
this is identical to T1 maxIterations . If > 0, the 
schedule runs up to this value and stays constant 
at T4 positionLearningRateFinal afterwards. This 
allows an «extended refinement phase» with 
minimal but constant learning rate — refines 
positions slowly without a new decay. .full  does 
this (schedule ends at 20K, training runs to 35K), 
V434c/V434d confirmed: 15K and 25K both about 
the same, 20K marginally optimal. Used together 
with T51  to also modify the non-position LRs in the 
extended phase.

П Р О СТ Ы М И  С Л О В А М И

When the app stops lowering the 
position learning rate further. 
If lower than the maximum 
iteration, the rest runs with a 
constant mini rate — this refines 
very slowly but very stably. Built 
into the Quality preset, you don’t 
need to tweak.
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T51 extendedPhaseLRDecay

П ОД Р О Б Н О СТ И

Default: 0.0 (= disabled, constant LRs) Range: 0 or 
0.01 – 1.0 Defined in:

Т Е Х Н И Ч Е С К И

V433 feature: minimal multiplier for the non-
position LRs (scale, rotation, opacity, SH) in the 
«extended phase» — i.e. after T50  is reached and 
position LR is already at T4 . If 0.1, scale/rotation/
opacity/SH are themselves cosine-decayed from 1.0 
(= their standard LR) to 0.1× of their standard. If 
0.0 (default), they stay constant. V457 tested full 
decay (0.0, i.e. decay to zero) against no decay and 
found: avg 0.0400 (2 runs), the same loss as V438 
without decay. Behavior cleaner with decay but not 
measurably better. Hence disabled. Stays in the CLI 
as --nonpos-lr-scale F.

П Р О СТ Ы М И  С Л О В А М И

In the late refinement phase also 
make color and shape learning 
rates smaller. Makes training 
«more stable» but empirically 
not better. Off.

T52 adaptiveDensifyThreshold

П ОД Р О Б Н О СТ И

Default: false Range: boolean Defined in:

Т Е Х Н И Ч Е С К И

V440 experimental: when true, the app computes 
each densification step the p98 of the current 
gradient distribution and uses it as dynamic 
threshold (clamped to at least 0.5× of the 
configured value from T11  so it doesn’t drift 
too far). Hypothesis: automatic adaptation to the 
current scene phase would make density control 
more robust — e.g. stricter pruning at the start, 
laxer later, or vice versa. V440 tested and reverted: 
catastrophic drop to 63 K Gaussians (mass pruning, 
because the p98 in the first iterations is extremely 
high and afterwards almost nothing exceeds the 
threshold). The fixed threshold is already well 
calibrated, dynamic adjustment hurts more than it 
helps. Q5 (T77) offers an alternative adaptive logic 
via rolling median that avoids the problem.

П Р О СТ Ы М И  С Л О В А М И

Adaptive version of the densify 
threshold. In tests catastrophic 
(splat count crashed to 63K). Off. 
Q5 has a better variant.
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T53 mergeAfterDensification

П ОД Р О Б Н О СТ И

Default: false (initializer), true ( .full , 
.classicBalanced , .fullClassicPaper ) Range: 

boolean Defined in:

Т Е Х Н И Ч Е С К И

V438 feature: at the end of the densification 
phase (iter T2 ) a one-time merge pass runs that 
combines nearby Gaussians with similar scale and 
color. Reduces the Gaussian count by typically 5–15 
% without visible quality loss. Reason: after intense 
cloning, clusters of nearly identical Gaussians arise 
that contribute nothing new — merging frees 
optimizer capacity for other areas. Default in Classic 
Quality presets. Not used under MCMC, because 
MCMC through its relocation logic doesn’t let such 
clusters form in the first place.

П Р О СТ Ы М И  С Л О В А М И

At the end of the splat 
duplication phase combine 
clones that are nearly identical. 
Reduces data size without visible 
effect. By default on in the 
Quality preset.

T54 densifyPhase2FromIteration

П ОД Р О Б Н О СТ И

Default: 0 (= disabled) Range: 0 or T2  – T1  
Defined in:

Т Е Х Н И Ч Е С К И

V426 experimental: enables a second densification 
phase that starts after the refinement pause at 
this iteration and runs until T55 . Hypothesis: 
after a refinement phase the gradient accumulators 
have more stable magnitudes and can more 
precisely indicate which regions still need additional 
Gaussians. V426 tested and reverted: two-
phase densification fell into 0-Gaussians cascade 
failure (combined with V425 refinement pruning it 
destroyed the buffer). Disabled. CLI flag available 
for experiments.

П Р О СТ Ы М И  С Л О В А М И

Second multiplication round 
after a pause. In tests it 
annihilated the splat inventory. 
Off.

148 / 235



R A D I A N C E K I T Глава 6 — Конфигурация обучения

T55 densifyPhase2UntilIteration

П ОД Р О Б Н О СТ И

Default: 0 Range: 0 or T54  – T1  Defined in:

Т Е Х Н И Ч Е С К И

End of V426 two-phase densification. Only relevant 
when T54 > 0 . Both fields together disabled.

П Р О СТ Ы М И  С Л О В А М И

End of the second multiplication 
round (see T54). Both off.

Post-Processing + Apple AI (T56–T60)

T56 postTrainingCompactification

П ОД Р О Б Н О СТ И

Default: true (in all production presets), false 
( .quickTest , .preview ) Range: boolean Defined 
in:

Т Е Х Н И Ч Е С К И

V443 feature: after training ends, Gaussians 
with sigmoid(opacity) < 0.01 are hard-removed 
(they practically don’t contribute to the image 
anymore). Reduces Gaussian count by typically 
58 % and export file size by 55 % without 
visible quality loss. On by default in production 
presets — the end result should ship as compact 
as possible. Off in .quickTest , because a 
diagnostic run isn’t exported anyway. Unlike T42 
midTrainingCompactificationIterations (V549) 
the compactification only happens at the end — 
refinement can use all Gaussians until then.

П Р О СТ Ы М И  С Л О В А М И

Cleanup after training: nearly 
invisible splats are removed. 
Makes the export file roughly 
half as large without quality loss. 
Mandatory feature, leave off only 
in diagnostic runs.

149 / 235



R A D I A N C E K I T Глава 6 — Конфигурация обучения

T57 metalFXUpscaling

П ОД Р О Б Н О СТ И

Default: false Range: boolean Defined in:

Т Е Х Н И Ч Е С К И

V444 feature: enables Apple’s MetalFX Spatial 
Upscaler instead of bilinear interpolation in the 
3D viewer output. When training resolution < 
viewport size (e.g. training at 0.5×, viewport display 
at full resolution), MetalFX can deliver a clearly 
sharper image. Changes live in the viewport, no 
retraining required. Mutually exclusive with T58 
mpsLanczosScaling — MetalFX takes precedence. 
Recommendation: enable when the image in the 
viewer looks «washed out» compared to expected 
detail.

П Р О СТ Ы М И  С Л О В А М И

Apple ML-based image 
sharpening in the 3D viewer. 
Helps when you trained at a 
lower resolution and want to 
show the result in full screen. 
Live toggle, give it a try.

T58 mpsLanczosScaling

П ОД Р О Б Н О СТ И

Default: false Range: boolean Defined in:

Т Е Х Н И Ч Е С К И

V444 feature: MPSImageLanczosScale for viewport 
scaling instead of bilinear interpolation. Lanczos 
is a classic Sinc-based resampling method that 
delivers significantly sharper results than bilinear 
with minimal overhead. Live toggle. Overridden by 
T57  when both are on.

П Р О СТ Ы М И  С Л О В А М И

Classic sharpening method for 
the 3D viewer (Lanczos). MetalFX 
(T57) is ML-based and usually 
better; Lanczos is a less 
aggressive alternative.
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T59 livePreviewInterval

П ОД Р О Б Н О СТ И

Default: 50 (initializer and most presets) Range: 0 
(off) or 10 – 5 000 Defined in:

Т Е Х Н И Ч Е С К И

How often during training the 3D viewer is refreshed 
with the current Gaussians. 50 = every 50 iterations 
a new render in the viewer — enough to observe 
progress without slowing training. 0 = viewer is not 
updated at all (background training, max speed). 
Typical adjustment: under .quickTest  drop to 10 
(you want to see every step), on long MCMC 
runs raise to 500–2000 (update overhead in sum 
noticeable).

П Р О СТ Ы М И  С Л О В А М И

How often the 3D preview during 
training is refreshed. 50 = every 
50 iterations. Higher = less often 
= a bit faster, but you see 
progress less often. 0 = no 
preview (for maximum speed).

T60 perceptualLossWeight

П ОД Р О Б Н О СТ И

Default: 0.0 (= disabled) Range: 0 or 0.001 – 0.5 
Defined in:

Т Е Х Н И Ч Е С К И

V444 future feature: weight of a perceptual loss 
term via MPSGraph (VGG-like small network). 
Would capture structural and textural similarity 
at a higher semantic level than L1+SSIM — 
typical in research pipelines where «pixel-perfect» 
matters less than «looks realistic». Implementation 
pending (code stub present, but forward pass not 
implemented). Default 0.0. Stays in the field catalog 
for future activation; CLI flag --percep-weight F  
reserved.

П Р О СТ Ы М И  С Л О В А М И

Planned feature that with AI 
assistance aims for «natural 
looking» instead of «pixel-
accurate». Not yet fully 
implemented.
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MCMC Densification (T61–T73)

T61 densificationStrategy

П ОД Р О Б Н О СТ И

Default: .classic  (initializer + Classic presets), 
.mcmc  (all MCMC presets + Scene-Class) Range: 
.classic  or .mcmc  Defined in:

Т Е Х Н И Ч Е С К И

Chooses between classic densification (clone/split/
prune, Kerbl et al. 2023) and MCMC densification 
(Stochastic Gradient Langevin Dynamics with 
relocation, Kheradmand et al. NeurIPS 2024). With 
.classic  T11–T16  is evaluated, with .mcmc  the 
T62–T73 . Beware when switching: Classic defaults 

and MCMC defaults are completely differently 
calibrated — whoever flips the picker in the Expert 
View without loading a matching preset risks 1.4.3-
bug-style mass extinction (460 K → 5 in one 
iteration, because MCMC opacity reg at 0.01 kills 
the Classic opacities). Hence the MCMC initializer 
defaults are deliberately «soft-washed» (all reg 
values 0.0).

П Р О СТ Ы М И  С Л О В А М И

Which algorithm is used to 
multiply the splats. Classic = 
original method (fast, many 
splats). MCMC = newer method 
(slower, far fewer splats, but 
more compact). The presets 
pick the right one. Only switch 
yourself if you also load the 
matching preset (P5–P7 or P8–
P10).
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T62 mcmcMaxGaussians

П ОД Р О Б Н О СТ И

Default: 150 000 (initializer + .fullMCMC  + 
.mcmcBalanced ), 100 000 ( .mcmcPreview ), 1 

500 000 ( .fullMCMCMip  — Mip-Splatting variant 
with 10× budget), 1.19 M ( .renderPreset ), 1.25 
M ( .outdoorPreset ), 670 K ( .indoorPreset ) 
Range: 0 (= «use buffer capacity») or 10 000 – 5 
000 000 Defined in:

Т Е Х Н И Ч Е С К И

Hard upper bound for the number of Gaussians 
under MCMC strategy. The count grows gradually 
by T70 mcmcGrowthRate  (typically 5 %) per 
relocation step up to this cap. V473/V531 found 
150 K as sweet spot — above 200 K dilutes 
splat quality (too many small redundant Gaussians), 
below 100 K leaves the scene under-densified. With 
very large scenes (e.g. 1 545-photo drone flight 
with 158 K SfM init), 150 K is too low — hence 
the 1.4.5 extension T72 mcmcCapMultiplier + T73 
mcmcAutoScaleByScene. Q7 BayesOpt found scene-
specific optima between 670 K (Indoor) and 1.25 
M (Outdoor). With value 0 the engine uses the full 
buffer capacity as cap.

П Р О СТ Ы М И  С Л О В А М И

Maximum number of splats 
under MCMC. 150 000 is the 
default and suffices for most 
scenes. Outdoor and render 
presets (P8, P9) go to 1+ million 
for more detail-rich scenes. 
Raising can bring detail, costs 
memory; lower is more an 
emergency brake.

T63 mcmcNoiseScale

П ОД Р О Б Н О СТ И

Default: 0.00005 (5e-5 = paper default) Range: 
1e-6 – 1e-3 Defined in:

Т Е Х Н И Ч Е С К И

Multiplier for the Gaussian noise that in each MCMC 
iteration is added to the position of each Gaussian 
(SGLD logic). Higher = more exploration (Gaussians 
wander more, finding potentially better spots), lower 
= more exploitation (Gaussians stay where they’re 
already good). V467 and V536 confirmed 5e-5 as 
optimal — 1e-5/2e-5 too little exploration, 1e-4 too 
much (splats diffuse). Cosine-decayed over training 
time until T69 mcmcNoiseDecayEnd — at the end 
of the decay range noise is effectively 0 and the 
Gaussians converge.

П Р О СТ Ы М И  С Л О В А М И

How much random «wobble» the 
app allows the splats so they can 
find the best spot themselves. 
The default value is optimal in 
tests. If you crank this up, the 
splats get restless.
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T64 mcmcOpacityRegWeight

П ОД Р О Б Н О СТ И

Default: 0.0 (= disabled in RadianceKit defaults, 
paper: 0.01) Range: 0 or 0.001 – 0.05 Defined in:

Т Е Х Н И Ч Е С К И

MCMC-specific L1 penalty on opacity. Paper 
default 0.01 (pushes unused Gaussians toward 
zero, makes them available for relocation). V464b 
showed however: without reg it’s measurably 
better in RadianceKit (Session 28 confirmed). 
Reason: the pruning criterion defined with T68 
mcmcDeadOpacityThreshold is enough on its own 
— an additional L1 penalty also forces valuable 
low-opacity Gaussians to die. Hence default 0. 
Caution: in the 1.4.3 beta build the initializer default 
was mistakenly 0.01, which resulted in the mass 
extinction bug (see T61 explanation); since 1.4.4 
fixed at 0.0.

П Р О СТ Ы М И  С Л О В А М И

MCMC special regularization. 
Off because the other MCMC 
mechanism (threshold in T68) 
already covers this. Leave at 0.

T65 mcmcScaleRegWeight

П ОД Р О Б Н О СТ И

Default: 0.0 (= disabled, paper: 0.01) Range: 0 or 
0.001 – 0.05 Defined in:

Т Е Х Н И Ч Е С К И

MCMC-specific L1 penalty on the scale eigenvalues. 
Paper default 0.01. V464b: without reg better, same 
reasoning as T64. Disabled in all RadianceKit MCMC 
presets. Caution as with T64: 1.4.3 bug.

П Р О СТ Ы М И  С Л О В А М И

Like T64 but for splat size. Off.
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T66 mcmcRelocationInterval

П ОД Р О Б Н О СТ И

Default: 100 (initializer + all MCMC presets, 
paper standard), 155 (P9 Outdoor — Q7 BayesOpt 
optimum) Range: 50 – 500 Defined in:

Т Е Х Н И Ч Е С К И

Iteration interval at which MCMC relocates 
dead Gaussians (sigmoid(opacity) < T68 
mcmcDeadOpacityThreshold) to new positions. V537 
tested 50 (too disruptive, loss fluctuates) and 200 
(marginally worse, MCMC loses responsiveness). 
100 is optimal. Q7 BayesOpt on Bicycle found 
155 as scene-specific optimum for outdoor — the 
slightly longer intervals give Adam more time to 
integrate newly placed Gaussians before the next 
reloc event puts them under pressure.

П Р О СТ Ы М И  С Л О В А М И

How many iterations between 
MCMC moving dead splats 
elsewhere. 100 is standard. You 
don’t need to tweak this yourself 
— Outdoor preset already has 
the optimal value.

T67 mcmcWarmupIterations

П ОД Р О Б Н О СТ И

Default: 500 Range: 100 – 5 000 Defined in:

Т Е Х Н И Ч Е С К И

Number of initial iterations during which no MCMC 
relocation happens. Only after this warmup does the 
reloc logic kick in. Reason: in the first iterations the 
opacity values have not yet stabilized — if reloc 
started directly, Gaussians would be placed at the 
wrong spots and have to be moved again right 
away, which would destroy Adam momentum. Paper 
default 500. RadianceKit adopts this value because 
V464b showed it is robust.

П Р О СТ Ы М И  С Л О В А М И

How many iterations MCMC is 
allowed to first «arrive» before 
starting to move splats. 500 is 
standard and fits.
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T68 mcmcDeadOpacityThreshold

П ОД Р О Б Н О СТ И

Default: 0.005 (initializer, paper standard), 0.01 
( .fullMCMC  and all MCMC presets — V535 
optimum) Range: 0.001 – 0.05 Defined in:

Т Е Х Н И Ч Е С К И

sigmoid(opacity) threshold below which a Gaussian 
counts as «dead» and is eligible for relocation. 
V535 found 0.01 as optimal (0.005 marginal, 0.02 
worse). Higher = more aggressive reloc (more 
Gaussians moved), lower = more cautious. 0.01 
corresponds to roughly «0.5 % visual visibility». P10 
Indoor uses 0.0142 as optimum via Q7 BayesOpt.

П Р О СТ Ы М И  С Л О В А М И

Below which transparency a 
splat counts as «dead» so MCMC 
pushes it elsewhere. 0.01 is 
optimal in our tests. You don’t 
need to tweak this yourself.

T69 mcmcNoiseDecayEnd

П ОД Р О Б Н О СТ И

Default: 0 (initializer = «no decay»), 160 
000 ( .fullMCMC  = 80 % of 200K), 96 000 
( .mcmcBalanced  = 80 % of 120K), 40 000 
( .mcmcPreview ) Range: 0 or 1 000 – Defined in:

Т Е Х Н И Ч Е С К И

Iteration at which the T63 mcmcNoiseScale  noise 
is fully damped to zero (cosine decay from iter 0 
to here). V497c/V502 found 80 % of maxIterations 
optimal — gives MCMC enough exploration time 
but leaves the last 20 % to convergence without 
noise. 0 = constant noise over all iterations (rarely 
sensible, MCMC can’t converge then).

П Р О СТ Ы М И  С Л О В А М И

When the random «wobbling» 
of splats stops. In the MCMC 
presets at 80 % of total 
iterations — first exploration, 
then convergence. Leave the 
value.
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T70 mcmcGrowthRate

П ОД Р О Б Н О СТ И

Default: 0.05 (paper standard = 5 %) Range: 0.01 – 
0.2 Defined in:

Т Е Х Н И Ч Е С К И

Growth rate of the MCMC population target 
per relocation step. The logic: at each reloc 
event the target population size is multiplied by 
(1 + growthRate) , until T62 mcmcMaxGaussians (or 

the variant scaled via T72/​T73) is reached. V512/
V522 found 0.05 as optimal — higher values lead 
to too-fast growth (Gaussians are inserted before 
Adam momentum can integrate them), lower values 
to under-densified scenes at the end.

П Р О СТ Ы М И  С Л О В А М И

How fast the splat count grows 
under MCMC. 5 % per step is 
optimal. Leave the value.

T71 mcmcSigmoidK

П ОД Р О Б Н О СТ И

Default: 100.0 Range: 10.0 – 500.0 Defined in:

Т Е Х Н И Ч Е С К И

Sigmoid sharpness parameter for the MCMC noise 
attenuation. In the SGLD step the per-Gaussian 
noise is damped by — high-opacity Gaussians 
(whose logit is positive) get exponentially less noise 
than low-opacity ones. K = 100 is sharp, meaning 
the transition from «full noise» to «no noise» 
happens very quickly around opacity 0.5. V484–
V487 found K = 100 optimal — smaller values 
(10–50) also let high-opacity Gaussians wobble 
(destroys converged Gaussians), larger ones (> 
500) make the transition artificially hard and dead 
Gaussians don’t get moved at all anymore.

П Р О СТ Ы М И  С Л О В А М И

Special parameter that 
determines how sharply 
MCMC distinguishes between 
«transparent enough to move» 
and «solid, don’t touch». The 
default is optimal. Don’t tweak.
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T72 mcmcCapMultiplier

П ОД Р О Б Н О СТ И

Default: 3.0 (initializer + .fullMCMC ), 2.0 
( .mcmcPreview ), 2.5 ( .mcmcBalanced ), 2.98 (P8 
Render), 5.32 (P9 Outdoor), 1.76 (P10 Indoor) 
Range: 0 (= disabled) or 1.0 – 10.0 Defined in:

Т Е Х Н И Ч Е С К И

1.4.5 feature: scene-adaptive cap scaling. When 
T73 mcmcAutoScaleByScene is true, the effective 
cap is computed as (clamped to buffer capacity). 
Background: with large scenes (e.g. 1 545-photo 
drone flight → 158 K SfM init) T62 = 150 000  is 
too low — density control couldn’t grow at all. 
With multiplier 3.0 the cap is scaled to 474 K in 
this example (158 K × 3.0). Q7 BayesOpt found 
scene-specific optima: outdoor benefits from a high 
multiplier (5.32 → ~830 K cap with 156 K bicycle 
init), indoor is happy with 1.76 (walls saturate 
faster). For the complete resolution of the cap see 
the method.

П Р О СТ Ы М И  С Л О В А М И

Multiplier that automatically 
adapts the splat cap to scene 
size. Large scene = more starting 
points = higher cap. The default 
3× fits for most scenes; Outdoor 
preset goes to 5× (large depth 
ranges), Indoor to 1.76× (walls 
bound things anyway).

T73 mcmcAutoScaleByScene

П ОД Р О Б Н О СТ И

Default: true (initializer + all MCMC presets) 
Range: boolean Defined in:

Т Е Х Н И Ч Е С К И

1.4.5 feature: master switch for the scene-aware 
cap logic (see T72 +). When false, only T62 
mcmcMaxGaussians is used as cap (back to 1.4.4 
behavior). On by default because the mass 
extinction problems with large scenes from 1.4.3 
would otherwise return. Manually disable only when 
you explicitly want to set a hard cap — e.g. to train a 
150 K variant whose final size is planable.

П Р О СТ Ы М И  С Л О В А М И

Enables automatic adjustment of 
the splat cap to scene size. On 
by default. Leave off only when 
you want exactly a specific splat 
count yourself.

Mip-Splatting (Q1.5) (T74–T76)

Status: Q1.5 was rejected on 2026-05-25 after 14 autonomous iterations + 
overnight 1.5M confidence check as «closed no-win» (max Δ@2× = +0.27 dB, 
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original gate required ≥ +1.5 dB mean over 0.5×/2×, FAILS on 0/11 pair scenes). The 
fields remain opt-in for research experiments; all production presets have them off. 
See verdict: docs/​plans/​2026-05-25-phase-q1.5-final-verdict.md.

T74 useMipSplatting

П ОД Р О Б Н О СТ И

Default: false (all production presets), true 
( .fullMCMCMip  — research sibling) Range: boolean 
Defined in:

Т Е Х Н И Ч Е С К И

Enables Mip-Splatting (Yu et al. CVPR 2024): 3D 
smoothing filter + 2D filter + α compensation 
that limits per-Gaussian frequency to the Nyquist 
bound of the densest training camera sampling 
rate. Theoretical goal: eliminate aliasing when 
rendering at off-training scales (0.5× or 2× of 
training resolution). Enabled in the preprocess 
and backward projection shaders, functional 
correctness verified in Q1.5-D test. But: the 
original acceptance gate (Δ@1× ≥ +0.3 dB AND 
avg(Δ@0.5×, Δ@2×) ≥ +1.5 dB) was reached 
on none of 11 pair scenes. Maximum observed: 
family 750K classic Δ@2× = +0.270 dB. Outdoor 
scenes (Truck, Flowers) even showed worsening 
1× and 0.5×. Hypothesis: 3D smoothing competes 
with MCMC relocation at high Gs. Field remains 
for future multi-scale re-eval with correct Mip-
NeRF-360 methodology (see O3 backlog in the 
benchmark path).

П Р О СТ Ы М И  С Л О В А М И

Aliasing filter from a 2024 paper. 
Theoretically great, practically it 
brought nothing in our tests and 
sometimes even hurt. Remains 
available for tinkerers, but we 
don’t recommend it. Leave off.
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T75 mipSmoothing3DScale

П ОД Р О Б Н О СТ И

Default: 0.2 (paper default) Range: 0.05 – 1.0 
Defined in:

Т Е Х Н И Ч Е С К И

3D smoothing scale parameter (Yu et al. §3.3, 
paper default 0.2). Larger = more world-space 
smoothing per Gaussian (= more anti-aliasing but 
also more blur at the default scale), smaller = 
sharper but more aliasing-prone. Only consulted 
when T74 useMipSplatting = true. Not further 
optimized in Q1.5 tests — the A/B gate already lost 
with the paper default 0.2, further sweeps would be 
pointless.

П Р О СТ Ы М И  С Л О В А М И

. If you haven’t enabled Mip, 
irrelevant.

T76 mipFilter2DVariance

П ОД Р О Б Н О СТ И

Default: 0.3 (= exactly the V242 legacy behavior) 
Range: 0.1 – 1.0 Defined in:

Т Е Х Н И Ч Е С К И

2D Mip filter variance added to the Σ_2D diagonal 
(variance directly, not squared). 0.3 is exactly the 
V242 legacy value that was hardcoded in the kernel 
before Mip-Splatting. When T74 useMipSplatting = 
false, the kernel ignores this value completely and 
writes the hardcoded 0.3 — so that the baseline 
cannot regress (Codex round 1 S3-1 guarantee). 
When, the value set here is used. Stays in the field 
catalog for Mip sweeps.

П Р О СТ Ы М И  С Л О В А М И

Further Mip-Splatting parameter. 
With Mip off: irrelevant.
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Adaptive Densification (Q5) (T77–T79)

T77 adaptiveDensification

П ОД Р О Б Н О СТ И

Default: false Range: boolean Defined in:

Т Е Х Н И Ч Е С К И

Q5 feature: rolling-median tracker as alternative 
to the fixed T11 densifyGradThreshold. When 
true, in every densify step the current threshold 
is overwritten with median(last N avgGrad 
samples) × T79 adaptiveDensifyMultiplier. N = 
T78 adaptiveWindow . Stricter than V440 p98 (the 

catastrophic 63 K pruning trap), median + 2× sits 
around the p70–p80 of the gradient distribution in 
steady state. Q5 tests: alone FAIL 0/3 scenes, but 
together with Q6 (see T80/T81) PASS 1/3 scenes — 
the Q5+Q6 bundle passed on 2026-05-25 as opt-
in and is enabled via CLI --adaptive-densify . Q6 
is the «carrier» of the quality gain, Q5 contributes 
more to stability.

П Р О СТ Ы М И  С Л О В А М И

Self-learning densify threshold. 
Instead of a fixed sensitivity 
setting, the app adapts to the 
scene. On its own not better 
in tests, but together with the 
curriculum from Q6 yes. Either 
both on or both off.

T78 adaptiveWindow

П ОД Р О Б Н О СТ И

Default: 1 000 Range: 100 – 10 000 Defined in:

Т Е Х Н И Ч Е С К И

Rolling median window in densification events (NOT 
iterations — each T13 densifyInterval step yields 
one sample). Default 1 000 — with that means the 
last 100 000 training iterations contribute to the 
median, so typically the entire training history up 
to here. Early phase (before T78  samples): tracker 
returns nil → fallback to fixed threshold T11 . Only 
relevant when.

П Р О СТ Ы М И  С Л О В А М И

How many old densify steps feed 
into the median for T77. Default 
1000 is good. Only relevant when 
Q5 adaptive is on.
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T79 adaptiveDensifyMultiplier

П ОД Р О Б Н О СТ И

Default: 2.0 Range: 1.0 – 4.0 Defined in:

Т Е Х Н И Ч Е С К И

Multiplier on the rolling median for the adaptive 
threshold. Default 2.0 corresponds to roughly p70–
p80 of the typical gradient distribution. Lower = 
more aggressive growth (more clones), higher = 
stricter (fewer clones). Q5 tests in range 1.5–3.0 — 
2.0 best default. Only relevant when.

П Р О СТ Ы М И  С Л О В А М И

Factor for T77/T78. Default 2.0 = 
stricter than the typical median. 
Don’t tweak.

Curriculum (Q6) (T80–T81)

T80 curriculumResolutionRamp

П ОД Р О Б Н О СТ И

Default: false Range: boolean Defined in:

Т Е Х Н И Ч Е С К И

Q6 feature: training resolution starts at 0.5× and 
switches at T50 positionLRScheduleEndIteration /​ 
2 (or T1 maxIterations /​ 2, if T50 is not 
set) to T22 trainingRenderScale. Uses the resize/​
restoreImageBuffers infrastructure developed in 
Q1.5.1. Overrides T23 resolutionWarmupScale when 
enabled. Q6 passed as «carrier of the quality gain» 
in the Q5+Q6 bundle (see T77) — the gradual 
resolution increase gives the app time to find coarse 
geometry at lower resolution before moving on to 
fine detail work. Via CLI: --curriculum-resolution.

П Р О СТ Ы М И  С Л О В А М И

«First coarse, then fine» for 
the training resolution. Half 
resolution in the first half, then 
full resolution. Helps in certain 
scenes, not in others — best to 
enable together with T81.
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T81 curriculumSHProgression

П ОД Р О Б Н О СТ И

Default: false Range: boolean Defined in:

Т Е Х Н И Ч Е С К И

Q6 feature: overrides T21 
shDegreeUpgradeIterations with [maxIter/​4, 
maxIter/​2, maxIter*3/​4], distributing SH upgrades 
evenly across training time instead of front-
loading them. Hypothesis: stable geometry is 
established before color detail explosion, which 
places the view-direction-dependent gloss effects 
more precisely. Q5+Q6 together PASS 1/3 scenes, 
Q6 as carrier of the gain (Q5 alone FAIL). Via CLI: 
--curriculum-sh .

П Р О СТ Ы М И  С Л О В А М И

«First shape, then color» — the 
gloss effects are unlocked only 
late in training, so the splats first 
find their position and size. Can 
be enabled together with T80; 
alone it doesn’t bring quite as 
much.

Static Presets (TP1–TP9)

Only the structural differences from the initializer default here. The full marketing 
description of the eleven UI presets P1–P11 is in Chapter 7.

TP1 .preview

П ОД Р О Б Н О СТ И

Diagnostic/preview preset for systems ≥ 10 GB 
RAM. Overrides vs. initializer: - 30 000 → 5 000 
- 15 000 → 3 500 (70 % of maxIter) - 1.6e-6 → 
1.6e-5 (10× higher, less aggressive decay) -,,,, each 
2× (V176) - 3 000 → 100 000 (effectively off, V172: 
reset destroys short trainings) - [1K, 2K, 3K]  → 
[1K, 2K]  (V182: degree 3 doesn’t converge in 2K 

iter) - 1.0 → 0.5

П Р О СТ Ы М И  С Л О В А М И

any initial assessment of a newly 
imported image series — 2–3 
min wait, after which the result is 
enough for a binary «is a Quality 
run worth it?».
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TP2 .full

П ОД Р О Б Н О СТ И

Production Quality Classic. Overrides: - 30 000 → 
35 000 (V550: 40K tests Truck overtraining +10.7 
% Gs at −1.3 % L1) - 15 000 → 5 000 (V310 
sweet spot, V338 7K worse) - All LRs 2× (V188) - 
1.6e-6 → 1.6e-5 (V45 10×) - 2e-6 → 1.1e-6 (V335) 
- 100 → 200 (V112) - 0.005 → 0.001 (V393) - 3 
000 → 100 000 (V194 disabled, V421 confirmed) - 
[1K, 2K, 3K]  → [2K, 5K, 8K]  (V228 delayed) - 

0.0 → 0.9995 (V546 HTGS, 14 % improvement) - 50 
(unchanged, V546) - false → true (V438) - 0 → 20 
000 (V431) - true (V443, already initializer default 
for .full )

П Р О СТ Ы М И  С Л О В А М И

any standard photo capture 
(object, small room, sculpture) 
with < 500 images. The 14 % loss 
improvement announced in V546 
vs V438 was confirmed as 3-trial 
average on Horse Full.

TP3 .fullClassicPaper

П ОД Р О Б Н О СТ И

Q1.5-A test sibling of TP2, paper-faithful Classic. 
Overrides vs. TP2: - 35 000 → 30 000 (paper 
standard) - 5 000 → 15 000 (paper: 50 % of 
maxIter) - 1.6e-5 → 1.6e-6 (paper default) -,, back 
to paper defaults (0.05, 0.005, 0.001) - 1.1e-6 → 
2e-7 (calibrated for ~1-2M Gs on Bicycle) - 200 → 
100 (paper) - 0.001 → 0.005 (paper default) - 100 
000 → 3 000 (paper §5.2, risky — can trigger V194 
regression) - 0.9995 → 0.0 (paper has no decay) - 
20 000 → 30 000 (cosine runs to 100 % of maxIter)

П Р О СТ Ы М И  С Л О В А М И

Q1.5 research experiments that 
need paper-magnitude Gaussian 
budgets (1–2 M) for Mip-
Splatting tests. After the Q1.5 
«closed no-win» verdict the 
preset remains accessible for 
advanced users but is not 
production-recommended.
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TP4 .fullMCMC

П ОД Р О Б Н О СТ И

Production Quality MCMC. Overrides vs. initializer: - 
30 000 → 200 000 (V534, MCMC needs 5× more 
iter than Classic) - 15 000 → 160 000 (V504b 80 
% of maxIter) - 1.6e-6 → 1.6e-5 - LR schedule 
like TP2 (all 2×) - 0.2 → 0.05 (V521b/V534: 
MCMC needs stronger L1 signal) - [1K, 2K, 3K]  
→ [2K, 5K, 8K]  - .classic  → .mcmc  - 150 000 
(already in initializer, confirmed in preset) - 5e-5 
(V467/V536 optimal) - 0.005 → 0.01 (V535 optimal) 
- 0 → 160 000 (80 % of maxIter, V497c/V502) - 3.0 
(already in initializer) - true (already in initializer) - 
3 000 → 200 000 (effectively off, MCMC uses reloc 
instead of reset)

П Р О СТ Ы М И  С Л О В А М И

Web delivery, object captures 
with detail aspirations, drone 
flights (although then P9 
Outdoor is even better). 71 % 
fewer Gaussians than Classic at 
comparable L1.

TP5 .fullMCMCMip

П ОД Р О Б Н О СТ И

Q1.5-D test sibling of TP4, with Mip-Splatting + 
paper-magnitude MCMC budget. Overrides vs. TP4:
• mcmcMaxGaussians 150 000 → 1 500 000 (10×, 

paper magnitude)
• useMipSplatting false → true (Mip on)

П Р О СТ Ы М И  С Л О В А М И

All other fields identical to 
TP4. Q1.5 D-PASS on Bicycle 
2026-05-24 (breaks 12-iter 
multi-scale FAIL streak). Q1.5 
final verdict 2026-05-25 still 
closed-no-win — Mip-Splatting 
gain not reproducible across 11 
pair scenes. Preset remains opt-
in.

TP6 .classicBalanced

П ОД Р О Б Н О СТ И

Mid-tier Classic. Overrides vs. TP2: - 35 000 → 20 
000 (V149: 20K = 30K at 33 % less time) - 20 000 
→ 0 (cosine runs to maxIter = 20K, no extended 
phase)

П Р О СТ Ы М И  С Л О В А М И

Standard cases with shorter wait 
time. V149 identified as sweet 
spot.
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TP7 .mcmcPreview

П ОД Р О Б Н О СТ И

MCMC diagnostic. Overrides vs. TP4: - 200 000 
→ 60 000 (V494b) - 160 000 → 48 000 (80 %) 
- 150 000 → 100 000 (V473b) - 160 000 → 40 
000 (V494b) - 3.0 → 2.0 (1.4.5: Preview = lighter 
scaling)

П Р О СТ Ы М И  С Л О В А М И

Quickly see an MCMC result to 
judge whether TP4 or a Scene-
Class preset is worth it.

TP8 .mcmcBalanced

П ОД Р О Б Н О СТ И

Mid-tier MCMC. Overrides vs. TP4: - 200 000 → 
120 000 (V518) - 160 000 → 96 000 (80 %) - 160 
000 → 96 000 (80 %) - 3.0 → 2.5 (between Preview 
2.0 and Full 3.0)

П Р О СТ Ы М И  С Л О В А М И

MCMC without the full 200K run. 
~120 K iterations are a good 
compromise between quality and 
wait time.

TP9 .quickTest

П ОД Р О Б Н О СТ И

Pure functional test. Overrides vs. initializer: - 30 
000 → 1 000 - 15 000 → 500 - 2e-6 → 4e-6 
(calibrated for 0.25× resolution) - 100 → 50 - 3 000 
→ 100 000 (off, since way too short) - 1.0 → 0.25

П Р О СТ Ы М И  С Л О В А М И

Sanity check «does training even 
start sensibly?». Duration < 30 s 
on M3 Ultra. Guaranteed to look 
mushy.

Method:

Signature: public func resolveMcmcMaxGaussians(initialPointCount: Int, 
bufferCapacity: Int) -> Int Defined in:

TECHNICAL  Single source of truth for the question «how many Gaussians can 
MCMC be allowed to grow to?» Computed from three inputs: the configured T62 
mcmcMaxGaussians (with mass extinction floor 150 000 if 0), the (number of SfM init 
points) and the (preallocated Gaussian buffer size). Logic:

1. base = T62 > 0 ? T62: 150_​000 (the mass extinction floor protects against initializer 
default bugs like the 1.4.3 mass extinction incident)

2. If T73 mcmcAutoScaleByScene && initialPointCount > 0 && T72 mcmcCapMultiplier 
> 0:
• scaled = max(base, ceil(initialPointCount × T72)) else

3. If bufferCapacity > 0 : return min(scaled, bufferCapacity)

4. Else return scaled
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Example: Bicycle (Mip-NeRF 360, 194 photo frames) → SfM init ~156 K points, 
T62 = 150 000 , T72 = 5.32 ,, buffer capacity 8 M. Resolved cap = min(8M, max(150K, 
ceil(156K × 5.32))) = min(8M, 830K) = 830 K. That is the effective growth cap the 
MCMC relocation logic adheres to.

 Computes the actual maximum splat count under MCMC. Takes your setting, looks 
at how many points your scene starts with, and scales by the Multiplier , if automatic 
adaptation is on. So the cap adapts to the scene instead of forcing the same value for 
a tiny and a huge scene. You don’t have to call the method yourself — the training uses 
it internally.

Which field for what? (Cheat Sheet)

Goal Fields to tweak

More detail in the 
distance

T62 mcmcMaxGaussians up, T72 mcmcCapMultiplier 5+

More detail overall 
(Classic)

T1 maxIterations  up (≤ 40K), T2 densifyUntilIteration ≤ 14 
% of T1

Reduce floaters in 
drone flights

T43 frustumCullEnabled on, T20 skyMaskingEnabled on, 
T45 skyDomeEnabled  on

Nice sky in 
outdoor scenes

T45 skyDomeEnabled  on, T47 skyDomeRadiusMultiplier 30–60

Smaller export file Strategy .mcmc  (T61), T56 postTrainingCompactification on, 
T62 mcmcMaxGaussians ≤ 200K

Faster training T22 trainingRenderScale 0.5, T1 maxIterations  halved — but 
not both!

Better highlights T21 shDegreeUpgradeIterations with [2K, 5K, 8K]  (no early 
front-load), MCMC + 200K iter

Keep Mac 
responsive

T25 throttleDelayMs 5–10 (costs ~15 % training time)

Live preview more 
often

T59 livePreviewInterval down to 10–20

Smoother 
transitions in 

shadows

T17 ssimWeight  slightly up (0.15–0.25), but not above 0.3

Keep interiors 
compact

P10 Indoor preset (, T72 = 1.76 )
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Dangerous Fields

These fields can, with misconfiguration, lead to OOM, app crash, mass extinction of 
Gaussians, or unusable benchmark data. Handle with care:

• T11 densifyGradThreshold — halving can create 2–4× as many Gaussians, quickly 
blowing up GPU memory. Also note: must match the T22 trainingRenderScale (1.0× 
→ 1e-6, 0.5× → 2e-6, 0.25× → 4e-6).

• T72 mcmcCapMultiplier — with large scenes with > 200 K SfM init points and a 
multiplier > 5 a resolved cap of millions of Gaussians arises. On 36 GB RAM Macs 
OOM is possible. Outdoor preset 5.32 works only because Mip-NeRF 360 Bicycle has 
156 K init points → 830 K cap.

• T39 testViewIndices — manually setting can make the benchmark unusable (all 
indices > N → no holdouts). Let the --benchmark  flag set it.

• T64 mcmcOpacityRegWeight and T65 mcmcScaleRegWeight — In 1.4.3 beta set to 0.01, 
which led to mass extinction (460 K → 5 Gaussians in one iteration). Since 1.4.4 
pinned at 0.0, but manually increasing can reproduce the issue.

• T15 opacityResetInterval — if not 100 000+ (effectively off) and the training is 
shorter than 10 000 iterations, the reset destroys convergence. .preview  therefore 
has it at 100 000 despite maxIterations = 5 000.

• T54/​T55 densifyPhase2* — two-phase densification ended in tests in a 0-Gaussians 
cascade. Leave both at 0.

• T74 useMipSplatting — Q1.5 closed-no-win 2026-05-25, can even worsen PSNR on 
some outdoor scenes. Default off, opt-in only for research.

If a field is on this list and you want to change it, first back up your current preset 
(export as JSON) and consider whether you can reproducibly measure the result — 
otherwise you won’t know afterwards whether you brought about an improvement or a 
worsening.
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Г Л А В А

Глава 7 — Встроенные предустановки 
качества

Рисунок 27.  Секция Presets со всеми четырьмя развёрнутыми группами — CAPTURE 
CLASS (4 предустановки: Drone/Aerial, 360° Walkaround, 360° Walkaround (High Detail), 
Photo/Object), CLASSIC (5 предустановок: Quick/Preview/Balanced/Quality/Ultra Detail), 
MCMC (3 предустановки, пометка «No threshold tuning»), HYBRID (1 предустановка: 

Balanced (Hybrid))

ЧТО ВИДНО НА ИЗОБРАЖЕНИИ  Секция Presets в Инспекторе, все четыре группы раз
вёрнуты. CAPTURE CLASS с четырьмя кураторскими предустановками для реаль
ного материала (Drone / Aerial, 360° Walkaround, 360° Walkaround (High Detail), 
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Photo / Object) — это основная группа и единственная видимая в режиме новичка. 
CLASSIC с Quick (1K итераций), Preview (5K итераций, активный выбор с голубой 
галочкой), Balanced (20K итераций), Quality (35K итераций) и Ultra Detail (35K 
итераций). MCMC с подзаголовком «No threshold tuning» — MCMC не нуждается 
в пороге Densify-Until: Preview (60K итераций, 100K Gaussians), Balanced (120K, 
150K), Quality (200K, 150K). HYBRID с предустановкой Balanced (Hybrid) (20K ите
раций, 150K Gaussians). Нижняя строка действий: Save…, Export…, Import…

Предустановка — это подготовленная конфигурация для обучения. RadianceKit 
поставляется с тринадцатью встроенными предустановками в четырёх группах: 
четыре Capture-Class-предустановки (P9–P12) — кураторские, выверенные гла
зом на реальном материале сообщества рецепты для реальных видов съёмки 
(дрон, 360°-обход, фото-объект), и основная ось с версии v1.6 —, пять классиче
ских предустановок (P1–P5: Quick/Preview/Balanced/Quality/Ultra Detail), три MCMC-
предустановки (P6–P8) и одна гибридная предустановка (P13), которая объединя
ет стратегии Classic и MCMC. Прежние «Scene-Class»-предустановки (Render/3D, 
Outdoor, Indoor, настроенные в фазе Q7 байесовской оптимизацией на сценах Mip-
NeRF-360 и NeRF-Blender) были убраны в v1.6 как видимая группа — выверенный 
глазом на реальном материале Capture-Class теперь основная ось; настроенные в 
Q7 конфигурации сохраняются только внутренне. Вы выбираете предустановки в 
боковой панели в разделе Presets или в режиме новичка при импорте. Кнопки +  
открывают диалоги для создания собственных предустановок рядом — тринадцать 
встроенных удалить нельзя, но их можно дублировать.

В режиме эксперта предустановки сгруппированы по виду съёмки и стратегии 
(Capture Class / Classic / MCMC / Hybrid). Щелчок по записи записывает сохранён
ную конфигурацию обучения в текущее состояние. Это не снимок — если затем 
вы покрутите ползунки, состояние изменится, а сама предустановка останется без 
изменений; цветная подсказка покажет «modified».

Какая предустановка подходит в каком случае, зависит в основном от типа сцены 
и оборудования. Три таблицы в конце главы это суммируют.
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P1 — Quick

ГД Е

Инспектор → секция Presets → группа «Classic» 
→ запись «Quick». UUID-суффикс …001 .

Т Е Х Н И Ч Е С К И

Диагностическая предустановка с 1 000 ите
раций, классическая (адаптивная) стратегия 
Densification и масштаб разрешения тренировки 
0.25× (входное изображение уменьшается до 25 
% перед тренировкой). Не предназначена для 
выдачи сцены, а лишь для быстрого определения 
того, проявляет ли установка (позы камер, об
лако точек, серия изображений) вообще какое-
либо осмысленное движение в значениях loss. 
На M3 Ultra обычно менее 30 секунд на 50–
200 изображениях. Малое разрешение скрывает 
реальное качество изображения, но удерживает 
расход памяти и затраты на рендеринг очень 
низкими. Также автоматически выбирается как 
значение по умолчанию при первом запуске, ес
ли система имеет менее 10 ГБ ОЗУ.

П Р О СТ Ы М И  С Л О В А М И

Быстрый тест работоспособно­
сти. Загружаете изображения, 
ждёте около полминуты, смот­
рите, появляется ли грубый 
контур сцены. Если изображе­
ние в просмотре выглядит как 
размытое пятно — это нор­
мально, так и должно быть. 
Если же видны только тёмные 
точки или совершенно иска­
жённая форма, скорее всего, 
неверны позы камер (см. гла­
ву 9). Для результата, которым 
можно делиться, вам потребу­
ется минимум P2 или P3.

P2 — Preview (Classic)

ГД Е

Инспектор → секция Presets → группа «Classic» 
→ запись «Preview». UUID-суффикс …002 .

Т Е Х Н И Ч Е С К И

5 000 итераций Classic Densification, масштаб 
разрешения 0.5×, удвоенные коэффициенты обу
чения по сравнению со стандартом. Densification 
(clone + split) активна первые 2 500 итераций, 
затем только pruning. Предустановка по умолча
нию для систем с ≥ 10 ГБ ОЗУ. На M3 Ultra обыч
но от 90 секунд до 3 минут для сцены из 200 
изображений. Даёт пригодное представление о 
геометрии и позах камер, но текстуры заметно 
мягкие — обойти масштаб 0.5× при дальнейшей 
тренировке с P3 или P4 напрямую не получится, 
поскольку коэффициенты обучения откалиброва
ны под половинное разрешение.

П Р О СТ Ы М И  С Л О В А М И

Стандарт для «быстро взгля­
нуть». Если вы только что им­
портировали новые изображе­
ния и хотите увидеть, восста­
навливается ли сцена в прин­
ципе, это правильный уровень. 
Подождать 2–3 минуты, по­
том можно покрутить в 3D-
просмотре и оценить, стоит 
ли вкладываться в дальней­
шие прогоны тренировки. Толь­
ко когда результат превью уже 
выглядит хорошо, имеет смысл 
переходить к Balanced или 
Quality.
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P3 — Balanced (Classic)

ГД Е

Инспектор → секция Presets → группа «Classic» 
→ запись «Balanced». UUID-суффикс …005 .

Т Е Х Н И Ч Е С К И

20 000 итераций Classic Densification на полном 
разрешении. Densification идёт первые 15 000 
итераций, начиная с итерации 3 000 с интер
валом densify 100. Эмпирически «sweet spot» 
из задокументированных тренировочных сессий: 
при классическом Densification на Horse Full и 
Truck L1 loss стабилизируется между итерациями 
18 000 и 22 000, более долгая тренировка не 
приносит существенного улучшения относитель
но Quality (P4). На M3 Ultra обычно 30–60 секунд 
на 200 изображениях, 5–8 минут на 1 000+ изоб
ражениях.

П Р О СТ Ы М И  С Л О В А М И

«Хороший компромисс». Боль­
шинство сцен с этим уже вы­
глядят хорошо, без необходи­
мости ждать час. Если вы хоти­
те где-нибудь показать конеч­
ный результат (соцсети, веб-
сайт, демо для клиента), ча­
сто этого достаточно. Только 
когда нужно приближаться к 
splat-модели или нужны детали 
текстуры поверхности, имеет 
смысл переходить к P4 Quality 
или P7 MCMC.

P4 — Quality (Classic)

ГД Е

Инспектор → секция Presets → группа «Classic» 
→ запись «Quality». UUID-суффикс …003 .

Т Е Х Н И Ч Е С К И

35 000 итераций Classic Densification с V546 
«Opacity Decay» (HTGS, Eurographics 2025): по
сле каждого цикла densify прозрачность всех 
существующих Gaussians умножается на коэф
фициент < 1.0, что надёжно удаляет ставшие 
неактивными при pruning Gaussians и тем самым 
даёт на 14 % лучший L1 loss при том же количе
стве итераций, чем классический прогон на 35 
000. SSIM-loss включён ( ssimWeight=0.05 ). На 
M3 Ultra обычно 2–4 минуты на 200 изображе
ниях. Достигает финального L1 ≈ 0.023 на NeRF-
Blender (Lego, Chair, Drums) — лучший Classic-
вариант из 560+ задокументированных экспери
ментов. Примечание: требуется ~3–5 ГБ памяти 
GPU; на системах с 8 ГБ безопасный выбор — P3.

П Р О СТ Ы М И  С Л О В А М И

Лучший классический вариант. 
Даёт чёткую текстуру и тонкую 
геометрию, особенно при ска­
нах объектов (скульптура, стул, 
ваза). Однако на больших улич­
ных сценах или комнатах раз­
ница с Balanced едва заметна 
— там переход к MCMC-пред­
установке (P6–P8) или Capture-
Class-предустановке (P9–P12) 
оправдан больше, чем переход 
с P3 на P4. Кто хочет абсо­
лютного максимума семейства 
Classic, берёт P5 Ultra Detail.
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P5 — Ultra Detail (Classic)

ГД Е

Инспектор → секция Presets → группа «Classic» 
→ запись «Ultra Detail». UUID-суффикс …008 .

Т Е Х Н И Ч Е С К И

Около 35 000 итераций Classic Densification 
— победитель held-out-прогона матрицы каче
ства (2026-06-10). На всех трёх протестирован
ных сценах Mip-NeRF-360 Ultra Detail обходит 
встроенную предустановку MCMC «Quality» (P8) 
при сопоставимом времени wall-clock примерно 
на +0.94 dB PSNR. Тем самым это сильней
шая Quality-предустановка группы Classic и са
мый резкий Classic-вариант, который поставляет 
RadianceKit. На M3 Ultra обычно в тех же времен
ных рамках, что и P4 Quality (2–5 минут на 200 
изображениях), но требует немного больше па
мяти GPU; на системах с 8 ГБ безопасный выбор 
— P3.

П Р О СТ Ы М И  С Л О В А М И

Самый резкий уровень Classic 
и held-out-победитель наших 
тестов качества: на реаль­
ных сценах примерно на де­
цибел лучше MCMC-варианта 
«Quality» — при сопоставимом 
времени ожидания. Если вам 
нужна максимальная детализа­
ция при проверенном класси­
ческом Densification и доста­
точно памяти GPU, это первый 
выбор. Если памяти не хватает 
или нужен как можно меньший 
файл экспорта, оставайтесь на 
P4 Quality или MCMC-предуста­
новке.

P6 — Preview (MCMC)

ГД Е

Инспектор → секция Presets → группа «MCMC» 
→ запись «Preview». UUID-суффикс …006 .

Т Е Х Н И Ч Е С К И

60 000 итераций MCMC Densification (3DGS-
MCMC, NeurIPS 2024) с ограничением 100 000 
Gaussians. MCMC заменяет эвристическую логи
ку clone/split марковской цепью Монте-Карло для 
перерасположения: мёртвые Gaussians переме
щаются через выборку глубин со сглаживанием 
сигмоидой, что даёт контролируемое и воспро
изводимое количество Gaussians. Ограничение 
жёстко ограничивает максимум на 100K — это 
экономит память и время рендеринга, но стоит 
детализации. На M3 Ultra обычно 5–8 минут на 
200 изображениях. Подходит как «тест работо
способности MCMC» — помогает оценить, имеет 
ли смысл переход с Classic на MCMC, прежде 
чем вкладывать больше времени в P7 или P8.

П Р О СТ Ы М И  С Л О В А М И

Как P2 Preview, но с более 
новым методом MCMC. Часто 
даёт более компактные, бо­
лее равномерно распределён­
ные splat-облака, чем Classic-
вариант. Для первой оценки 
сцены 5–8 минут обычно доста­
точно. Если результат превью 
нравится, следующим шагом 
будет P7 (Balanced) или сразу 
P8 (Quality MCMC).
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P7 — Balanced (MCMC)

ГД Е

Инспектор → секция Presets → группа «MCMC» 
→ запись «Balanced». UUID-суффикс …007 .

Т Е Х Н И Ч Е С К И

120 000 итераций MCMC с ограничением 150 
000 Gaussians. Средний уровень MCMC — почти 
финальное число Gaussians как у P8 Quality, 
но только 60 % итераций. Эмпирически L1 loss 
в задокументированных тренировочных сессиях 
составляет 0.026–0.028 на Horse Full, по срав
нению с P8 с 0.0246 — то есть примерно на 
7 % выше, но половина времени ожидания. На 
M3 Ultra обычно 8–15 минут на 200 изображени
ях. Использует процедуру, масштабирующую эф
фективное ограничение Gaussians по плотности 
точек входного облака SfM (см. T75 в главе 6).

П Р О СТ Ы М И  С Л О В А М И

MCMC с приличной глубиной 
детализации, но без длитель­
ного полного прогона P8. Для 
большинства сцен этого доста­
точно, особенно когда хочется 
уложить MCMC-прогон в обе­
денный перерыв. Если памяти 
впритык (напр. на процессорах 
M только с 16 ГБ), оставайтесь 
здесь — P8 требует больше па­
мяти GPU.

P8 — Quality (MCMC)

ГД Е

Инспектор → секция Presets → группа «MCMC» 
→ запись «Quality». UUID-суффикс …004 .

Т Е Х Н И Ч Е С К И

200 000 итераций MCMC с ограничением 150 
000 Gaussians, SSIM loss 0.05, спад шума MCMC 
по 80 % итераций. Лучший single-run L1 в 560+ 
экспериментах: 0.0238 на Horse Full, среднее по 
3 прогонам 0.0246 (по сравнению с P4 0.0230 
на той же сцене). MCMC даёт на 71 % мень
ше Gaussians (150K против ~524K) — решающий 
фактор, если результат планируется доставлять 
в веб, поскольку меньшее облако даёт заметно 
меньшие файлы экспорта. Время тренировки на 
M3 Ultra обычно 20–35 минут на 200 изображе
ниях; на наборах из 1 000+ изображений скорее 
1–2 часа. Лучший выбор, когда требуется макси
мальное качество изображения при минималь
ном итоговом размере.

П Р О СТ Ы М И  С Л О В А М И

Лучший MCMC-вариант. Да­
ёт очень чистые, компактные 
splat-облака — идеален, когда 
результат позднее планируется 
встраивать как 3D-просмотр­
щик в веб или отправлять фай­
лом (файл меньше, чем у P4 
Quality, при сопоставимом оп­
тическом качестве). Но нужно 
терпение — на больших захва­
тах ждать больше часа. Плани­
руйте это скорее как прогон 
«на ночь».
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Рисунок 28.  Группа CAPTURE CLASS, развёрнутая со всеми четырьмя кураторскими 
предустановками для реального материала — Drone / Aerial (MCMC, 40K итераций, Cap 
1,5 M), 360° Walkaround (MCMC, 40K, Cap 1,5 M), 360° Walkaround (High Detail) (Hybrid, 

40K, Cap 1,5 M, opt-in) и Photo / Object (Hybrid, 40K, Cap 1,5 M). Эта группа стоит в 
самом верху и единственная видимая в режиме новичка.

ЧТО ВИДНО НА ИЗОБРАЖЕНИИ  Инспектор с развёрнутой группой CAPTURE CLASS — 
основной группой предустановок с версии v1.6, единственной отображаемой в 
режиме новичка. Каждая запись — это выверенный глазом на реальном мате
риале сообщества рецепт для конкретного вида съёмки (дрон, 360°-обход, фото-
объект), а не значение, оптимизированное под академический тестовый набор. 
Выбор щелчком записывает сохранённую конфигурацию обучения в текущее со
стояние.

175 / 235



R A D I A N C E K I T Глава 7 — Встроенные предустановки качества

P9 — Drone / Aerial

ГД Е

Инспектор → секция Presets → группа «Capture 
Class» → запись «Drone / Aerial». UUID-суффикс 
…010 .

Т Е Х Н И Ч Е С К И

Capture-Class-предустановка для воздушных и 
дроновых орбит вокруг зданий и ландшафтов. 
MCMC-Densifier, 40 000 итераций, Cap 1,5 млн 
Gaussians, SSIM loss 0.5 плюс edge-aware-терм 
0.1. Решающим является штраф за анизотропию с 
весом 0.003 при пороге соотношения 6 — «убий
ца спагетти» против типичных игловидных арте
фактов, которые порождает дроновый материал. 
Проверено на реальном DJI-4K-полёте дрона над 
виадуком Pensford (проверено глазом, не только 
метрически).

П Р О СТ Ы М И  С Л О В А М И

Для съёмок с воздуха — полёты 
дрона вокруг здания, над ланд­
шафтом, вдоль фасада. Мощ­
ный штраф за анизотропию 
убирает игловидные и спагет­
ти-образные артефакты, кото­
рые охотно порождает дроно­
вый материал. Если ваш ма­
териал снят с земли, лучше 
подойдёт Photo / Object или 
Classic-предустановка.

P10 — 360° Walkaround

ГД Е

Инспектор → секция Presets → группа «Capture 
Class» → запись «360° Walkaround». UUID-суф
фикс …011 .

Т Е Х Н И Ч Е С К И

Capture-Class-предустановка для видео 360°-об
хода. MCMC-Densifier, 40 000 итераций, Cap 1,5 
млн Gaussians, SSIM loss 0.5 плюс edge-aware-
терм 0.1, мягкий штраф за анизотропию (вес 
0.001 при пороге соотношения 15). Маска людей 
и маска неба активны. Эта предустановка ожи
дает 360°-equirect-видео, которое внутренне пе
репроецируется в перспективные кропы шири
ной около 90° перед началом тренировки. Про
верено на 8K-360°-обходах с selfie-stick (сцена 
Monument, проверено глазом).

П Р О СТ Ы М И  С Л О В А М И

Для видео 360°-обхода — вы 
проходите с 360°-камерой или 
selfie-stick по комнате или во­
круг объекта. RadianceKit сам 
разбивает сферическую пано­
раму на обычные ракурсы и 
маскирует прохожих и небо. 
Для максимальной резкости на 
том же материале попробуй­
те дополнительно вариант High 
Detail (P11).
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P11 — 360° Walkaround (High Detail)

ГД Е

Инспектор → секция Presets → группа «Capture 
Class» → запись «360° Walkaround (High Detail)». 
UUID-суффикс …013  (opt-in).

Т Е Х Н И Ч Е С К И

Opt-in-Capture-Class-предустановка для видео 
360°-обхода с максимальной детализацией. 
Hybrid-Densifier (классические clone/split по abs-
градиенту + MCMC-шум + relocation), 40 000 
итераций, Cap 1,5 млн Gaussians, штраф за ани
зотропию 0.0015 при пороге соотношения 15, 
SSIM loss 0.2 и edge-aware-терм 0 — зафик
сированный «r50»-screen-split-рецепт. На 360°-
материале он обходит стандартную MCMC-пред
установку «360° Walkaround» (P10) по PSNR, 
LPIPS и видимому конфетти, и это примерно при 
трети числа сплатов. Сознательно стоит opt-in 
рядом со стандартной 360-предустановкой, пока 
не проверено на большем числе сцен.

П Р О СТ Ы М И  С Л О В А М И

Более резкая альтернатива 
стандартной 360-предустанов­
ке (P10): больше деталей, мень­
ше конфетти, заметно меньший 
файл. Сознательно стоит ря­
дом, а не заменяет её — пока 
подтверждено на горстке сцен. 
Если ваш 360°-обход снят чи­
сто, попробуйте сначала эту 
предустановку и сравните ре­
зультат с P10.

P12 — Photo / Object

ГД Е

Инспектор → секция Presets → группа «Capture 
Class» → запись «Photo / Object». UUID-суффикс 
…012 .

Т Е Х Н И Ч Е С К И

Capture-Class-предустановка для орбит вокруг 
объекта из резких отдельных фотографий (не 
видео). Hybrid-t1-Densifier (с relocation), 40 000 
итераций, Cap 1,5 млн Gaussians, SSIM loss 0.5 
плюс edge-aware-терм 0.1, мягкий штраф за ани
зотропию (вес 0.001 при пороге соотношения 
15), Opacity Decay 0.9995 каждые 50 итераций, 
без маскирования. Проверено на 163 высоко
разрешённых 41-MP-фотографиях скелета (про
верено глазом). Небольшое число видов (при
мерно до 600) остаётся при этом ниже порога 
коллапса Hybrid.

П Р О СТ Ы М И  С Л О В А М И

Для съёмок объекта из рез­
ких отдельных фотографий — 
вы обходите скульптуру, мо­
дель, продукт с камерой и де­
лаете фотографии, а не видео. 
Без маскирования, потому что 
у резких фотографий обычно 
чистый фон. Для видео-источ­
ников вместо этого возьмите 
360°- или Drone-предустанов­
ку.

177 / 235



R A D I A N C E K I T Глава 7 — Встроенные предустановки качества

P13 — Сбалансированный (Гибридный)

ГД Е

Инспектор → секция Presets → группа «Гибрид
ный» → запись «Сбалансированный (Гибрид
ный)». UUID-суффикс …009 .

Т Е Х Н И Ч Е С К И

20 000 итераций с гибридной стратегией уплот
нения: классический clone/split по градиенту 
размещает ёмкость там, где она нужна функции 
потерь, шум MCMC SGLD продолжает исследо
вание, а мёртвые Gaussians перераспределяют
ся вместо того, чтобы теряться при отсечении. 
Opacity Decay (V546) заменяет сбросы непро
зрачности; штраф за анизотропию (вес 0.001, 
порог соотношения 15) держит игловидные спла
ты под контролем. Ограничение Gaussians мас
штабируется со сценой (база 150K, scene-aware 
×3.0). Проверено на пяти сценах против чистого 
MCMC при том же бюджете: в среднем +0.45 dB 
PSNR при на 20–30 % меньшем числе Gaussians 
(stonehenge +1.23, family +0.82, garden +0.47 dB). 
На M3 Ultra обычно 5–10 минут на 200 изобра
жениях.

П Р О СТ Ы М И  С Л О В А М И

Сильный первый выбор для 
финального результата: бо­
лее резкая детализация, чем 
у MCMC-предустановок, при 
столь же компактном файле и 
за долю времени обучения P8. 
Если у вас есть время только 
на один качественный прогон и 
ни один из Capture-классов яв­
но не подходит, начните отсю­
да. Классические предустанов­
ки остаются лучше для быстрых 
тестов, а Capture-Class-пред­
установки (P9–P12) — первый 
выбор, когда ваша сцена явно 
соответствует одному из этих 
видов съёмки.
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Какая предустановка когда?

Сценарий Первый тест Основной прогон

Тест работоспособно
сти новых изображений, 

< 30 с

P1 Quick —

Орбита вокруг объек
та из резких отдельных 

фотографий

P2 Preview P12 Photo / Object

Скан одного объекта 
(видео), < 500 фотогра

фий

P2 Preview P4 Quality или P8 Quality 
MCMC

Видео 360°-обхода P6 Preview MCMC P10 360° Walkaround 
(резко: P11 High Detail)

Воздушная / дроновая 
орбита, ландшафт

P6 Preview MCMC P9 Drone / Aerial

Веб-доставка (малая, 
компактная)

P2 P8 Quality MCMC (наи
меньший файл при полном 

качестве)

Резкая детализация за 
короткое время, ком

пактный экспорт

P2 или P6 P13 Сбалансированный 
(Гибридный)

Максимальная детали
зация, стратегия Classic

P3 или P6 P5 Ultra Detail

Печать, маркетинг, пол
ная детализация

P3 или P6 P4 Quality (Classic) или P5 
Ultra Detail
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Быстрое сравнение

Пред­
уста­
нов­
ка

Стра­
тегия

Итер. Макс. 
Gs

Мас­
штаб 

рендера

Типичное время (200 
изобр., M3 Ultra)

Q-Sweep

P1 Quick Classic 1 000 ∞ 0.25× ~30 с —

P2 Preview Classic 5 000 ∞ 0.5× 2–3 мин —

P3 BalancedClassic20 000 ∞ 1.0× 30–60 с —

P4 Quality Classic35 000 ∞ 1.0× 2–4 мин V546 
HTGS

P5 Ultra 
Detail

Classic ~35 
000

∞ 1.0× 2–5 мин Matrix 
Δ+0.94 

dB

P6 Preview 
MCMC

MCMC60 000 100 
K

1.0× 5–8 мин —

P7 Balanced 
MCMC

MCMC 120 
000

150 
K

1.0× 8–15 мин —

P8 Quality 
MCMC

MCMC 200 
000

150 
K

1.0× 20–35 мин V544a

P9 Drone / 
Aerial

MCMC40 000 1.5 
M

1.0× 10–25 мин Глаз / 
Viadukt

P10 360° 
Walkaround

MCMC40 000 1.5 
M

1.0× 10–25 мин Глаз / 
Monument

P11 360° 
Walkaround 

(High 
Detail)

Ги
брид
ный

40 000 1.5 
M

1.0× 10–25 мин Глаз 
(opt-
in)

P12 Photo / 
Object

Ги
брид
ный

40 000 1.5 
M

1.0× 10–25 мин Глаз / 
Ске
лет

P13 Сба
лан
си

рован
ный 

(Гибрид
ный)

Ги
брид
ный

20 000 150 
K

1.0× 5–10 мин Matrix 
Δ+0.45 

dB
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Пользовательские предустановки

Через кнопку Save… в секции Presets (I1 в главе 2) вы сохраняете текущую 
конфигурацию обучения как собственную предустановку. Пользовательские пред
установки не являются «Built-in» и могут быть переименованы, экспортированы (в 
JSON), переданы перетаскиванием, дублированы и удалены. Тринадцать встроен
ных предустановок P1–P13 остаются нетронутыми кнопкой удаления.

Правило большого пальца: Если вы меняете что-то в предустановке, что захо
чется чаще — Sky-Dome on, более высокий вес SSIM для конкретного класса 
сцены, иные количества итераций — то сохраните этот вариант как собственную 
предустановку. Так в следующий прогон вы сразу будете знать, что это конфигу
рация, отклоняющаяся от стандартной.
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Г Л А В А

Глава 8 — Форматы экспорта

Рисунок 29.  Выбор формата экспорта в режиме новичка — шесть карточек формата

Рисунок 30.  Сетка форматов экспорта в реальном времени после 5K-итерационного 
обучения на букете цветов — все шесть карточек с динамическим расчётом размера 
(PLY 742 KB выбрано, SPZ 74 KB, glTF 708 KB, .splat 96 KB, Orbit Video ~Zero KB, Web 

Viewer 133 KB), история экспортов справа с уже сохранённым PLY

Что видно на изображении (2 991 Gaussians, SH-степень 3, синтетический 
букет из Blender как чистый по IP тестовый набор): Размеры под каждой 
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карточкой формата рассчитываются в реальном времени из текущего количества 
Gaussians и накладных расходов формата — не зашиты жёстко. Из 2 991 Gaussians 
(SH-степень 3) получается 742 KB PLY, 74 KB SPZ (примерно в ~10× меньше за счёт 
квантования), 708 KB glTF (с расширением KHR_​gaussian_​splatting, поэтому прак
тически эквивалентно PLY), 96 KB .splat (сжатый формат 24 байта на Gaussian). 
Orbit Video показывает «~Zero KB», потому что размер известен только после 
MP4-кодирования. Web Viewer (133 KB) упаковывает автономный HTML-файл со 
встроенным WebGL- просмотрщиком и сжатыми splat-данными — больше, чем чи
стый .splat, из-за накладных расходов на просмотрщик. История экспортов справа 
перечисляет уже выполненный PLY-экспорт («training_20260527T211321Z.ply, 743 
KB, 23:13») со значком формата и действием Reveal-in-Finder.

Законченное обучение даёт облако Gaussians — набор из нескольких сотен тысяч 
или миллионов 3D-распределений Гаусса, которые вместе восстанавливают сце
ну. RadianceKit умеет десятью способами записать это облако на диск. Шесть 
из них — это чистые 3D-форматы данных (PLY, Compressed PLY, SPZ, SOG, 
glTF, .splat), один упаковывает облако вместе с готовым HTML-просмотрщиком 
(Web Viewer), один отрисовывает MP4-файл по орбитальной траектории камеры 
(Orbit Video), а два не экспортируют содержимое Gaussian, а только результат 
SfM (позы камер и грубое облако точек) для повторного использования в других 
конвейерах обучения (transforms.json + COLMAP Workspace).

Какой формат подходит в каком случае, зависит от цели. Для архивирования 
полных данных без потери качества берётся PLY. Для веб-просмотрщиков на соб
ственной странице обычно достаточно .splat или встроенного Web Viewer. Если 
файл должен быть минимальным, стоит брать SPZ или SOG. Для повторного 
использования результата SfM в Nerfstudio, Postshot или Brush правильные пути — 
transforms.json и COLMAP Workspace.

Все функции экспорта находятся в меню «Export», а также в режиме новичка 
на последнем шаге мастера. Большинство форматов полностью совместимы с 
песочницей и работают в версии для App Store. Только SOG требует внешнего 
бинарного файла ( cwebp ), который не обязательно присутствует в сборке для App 
Store — подробности см. в E4.
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E1 — PLY (.ply)

ГД Е

Строка меню → Export → 3D Formats → Export 
PLY… (⌘E). Режим новичка: шаг мастера Export → 
карточка формата «PLY». Размер: обычно 100 % 
(опорное значение). Совместимо с: SuperSplat, 
PolyCam, все 3DGS-просмотрщики.

Т Е Х Н И Ч Е С К И

PLY — канонический формат хранения для 
3D Gaussian Splatting. RadianceKit записывает 
двоичный little-endian файл со стандартизиро
ванной раскладкой свойств 3DGS: на один 
Gaussian — трёхкомпонентная позиция, три 
нормали всегда равны нулю, три DC-SH-ко
эффициента ( f_dc_0..2 ) для базового RGB-
цвета, далее до 45 дополнительных SH-коэф
фициентов ( f_rest_0..44 ) в транспонирован
ном channel-major-расположении, определённом 
статьёй Kerbl 2023 (сначала все коэффициенты 
канала R, затем все G, затем все B), за которыми 
следуют logit-непрозрачность (сырые значения 
до сигмоиды), три log-space-масштаба и кватер
нион поворота wxyz. Максимальная экспортиру
емая SH-степень ограничивается минимумом из 
пожелания пользователя и реально обученной 
степени; по умолчанию — 3 (45 rest-коэффици
ентов). Перед записью размер полезной нагруз
ки рассчитывается в 64-битном целочисленном 
виде, чтобы поймать переполнение на экстре
мально больших облаках. Файл пишется атомар
но, что на больших облаках кратковременно за
нимает удвоенный объём диска.

П Р О СТ Ы М И  С Л О В А М И

Это «оригинальный файл». Са­
мый большой файл, самая вы­
сокая совместимость, без по­
терь. Если не знаете, какой 
формат брать, берите PLY — 
он открывается почти в любом 
3DGS- инструменте. Для 1 мил­
лиона Gaussians это от 200 до 
800 МБ в зависимости от SH-
степени. Если файл становится 
слишком большим, посмотрите 
на E2 (compressed PLY) или E3 
(SPZ).
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E2 — Compressed PLY (.ply)

ГД Е

Строка меню → Export → 3D Formats → Export 
Compressed PLY…. Режим новичка: карточка фор
мата «Compressed PLY». Размер: прим. 10–20 % 
от PLY (5–10-кратное сжатие). Совместимо с: 
SuperSplat, движок PlayCanvas, веб- просмотр
щики.

Т Е Х Н И Ч Е С К И

Вариант PlayCanvas формата PLY с chunked-
квантованием. Gaussians группируются в чанки 
по 256. На чанк — min/max-границы для позиции, 
масштаба и цвета хранятся отдельно в заголов
ке; отдельные Gaussians ссылаются на свои зна
чения относительно этих границ и сжимаются в 
32 бита: позиция и масштаб с упаковкой 11-10-11 
бит, поворот — как «Smallest-Three»-кватернион 
2-10-10-10 бит, цвет — 8-8-8-8 RGBA. Высшие 
SH-коэффициенты квантуются с всего 8 бита
ми на компоненту ( shCoeffCount * 3  uchar на 
Gaussian). Сам формат всё ещё — ASCII-заголо
вок PLY и поэтому в принципе валидируется PLY- 
инструментами, но vertex-properties объявляются 
полями uint . SH-степень по умолчанию — 0 
(нет rest-коэффициентов), чтобы максимизиро
вать сжатие — более высокие SH-степени можно 
выбрать явно.

П Р О СТ Ы М И  С Л О В А М И

Экономящий место вариант 
PLY. Совместимость с движка­
ми такая же, как у обычного 
PLY, но в 5–10 раз меньше. 
SuperSplat и PlayCanvas читают 
его нативно. Для веб-доставки 
почти всегда лучше, чем обыч­
ный PLY. Потеря качества из-за 
квантования обычно визуально 
незаметна, если сцена не со­
держит экстремально высоко­
частотных деталей.
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E3 — SPZ (.spz)

ГД Е

Строка меню → Export → 3D Formats → Export 
SPZ…. Режим новичка: карточка формата «SPZ». 
Размер: прим. 10 % от PLY (на 90 % меньше). 
Совместимо с: Niantic Scaniverse, Niantic Spatial 
Fields, MetalSplatter.

Т Е Х Н И Ч Е С К И

Формат SPZ v2 от Niantic. Позиции упакованы 
как 24-битный fixed-point (что даёт разреше
ние около 0.25 мм), масштабы — как 8-битное 
квантование в логарифмическом пространстве, 
повороты — как 8-битный Smallest-Three (в v2 
хранится только xyz, w выводится в декодере из 
нормы кватерниона), непрозрачности — как сиг
моидированные 8-битные значения. DC SH хра
нится по специальной SPZ-формуле упаковки (dc_​
raw * 0.15 * 255 + 0.5 * 255), высшие SH-поло
сы — 5 битами (полоса 1) или 4 битами (полосы 
2–3) на коэффициент. Весь упакованный двоич
ный блоб затем сжимается стандартным gzip 
(RFC 1952), что даёт gzip-контейнер с magic-
байтами 1f 8b . RadianceKit вызывает для этого 
системный gzip , поскольку встроенный zlib-API 
Apple генерирует фирменное обрамление Apple, 
несовместимое с SPZ-читалками в Spatial Fields 
или MetalSplatter. Системный gzip  к тому же 
остаётся запускаемым внутри песочницы macOS.

П Р О СТ Ы М И  С Л О В А М И

Наименьший стандартный 
файл. Если вы знаете 
Scaniverse от Niantic — это и 
есть формат, который исполь­
зует то приложение. Очень ма­
ленький, очень удобный для 
мобильных приложений. На­
прямую пригоден для об­
лачного просмотрщика Niantic 
(Spatial Fields). Примерно на 90 
% меньше PLY с теми же данны­
ми, при этом для большинства 
сцен визуально едва отличим.
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E4 — SOG (.sog)

ГД Е

Строка меню → Export → 3D Formats → 
Export SOG…. Режим новичка: карточка формата 
«SOG». Размер: прим. 5–6 % от PLY (15–20-
кратное сжатие — самый маленький вариант). 
Совместимо с: движок PlayCanvas, редактор 
SuperSplat.

Т Е Х Н И Ч Е С К И

«Spatially Ordered Gaussians» — формат 
PlayCanvas, который хранит облако в формате, 
готовом для GPU, в нескольких WebP-изображе
ниях без потерь. Сначала все Gaussians сорти
руются пространственно через 3D-код Мортона 
(30-битный Z-порядок, по 10 бит на ось), что 
даёт изображениям кэш-локальность в ренде
рере. Затем позиции квантуются в 16-битные 
значения с симметричным логарифмическим 
преобразованием (для лучшего динамического 
диапазона) и разделяются на два RGBA-изоб
ражения ( means_l.webp  для младших 8 бит, 
means_u.webp  для старших). Повороты кодиру

ются как Smallest-Three с 3×8-битами плюс 2-
битный режим в RGBA-изображении (режим по
падает в альфа как 252 + largest ). Масштабы 
и DC SH каждый квантуются с кодовой кни
гой на 256 записей (распределённой по пер
центилям всех значений), индексы попадают в 
scales.webp  и sh0.webp . Пять изображений 

плюс meta.json  с кодовыми книгами и граница
ми упаковываются в ZIP-файл (собственный эн
кодер, поскольку песочница блокирует систем
ный zip ) и сохраняются с расширением .sog .

Предупреждение о песочнице: SOG — един
ственный вариант формата, требующий внеш
ний бинарный файл. Этап WebP-энкодера вы
зывает cwebp  из /​usr/​local/​bin/​cwebp или /​
opt/​homebrew/​bin/​cwebp. Если бинарный файл 
cwebp не найден, код откатывается к необ
работанному PNG-кодированию — но: PNG-
fallback не работает в SuperSplat. В версии 
для App Store доступность оценивается по ва
рианту сборки; в варианте для разработчиков 
cwebp должен быть установлен через Homebrew 
( brew install webp ).

П Р О СТ Ы М И  С Л О В А М И

Самый маленький 3DGS-фор­
мат в целом, заметно мень­
ше SPZ. Но: нужен инструмент 
cwebp  на вашем Mac, пото­

му что RadianceKit сам не уме­
ет генерировать все форматы 
изображений. Установите его 
один раз через Homebrew, по­
том всё работает. В версии для 
App Store, возможно, не полно­
стью функционален — если из 
экспорта получается PNG вме­
сто WebP, файл нельзя открыть 
напрямую в SuperSplat. Тем, кто 
работает без Homebrew, стоит 
брать вместо этого SPZ (E3).

187 / 235



R A D I A N C E K I T Глава 8 — Форматы экспорта

E5 — glTF (.glb)

ГД Е

Строка меню → Export → 3D Formats → Export 
glTF…. Режим новичка: карточка формата «glTF». 
Размер: сопоставим с PLY. Совместимо с: glTF-
просмотрщиками с расширением KHR_​gaussian_​
splatting (черновой стандарт Khronos).

Т Е Х Н И Ч Е С К И

Записывает самодостаточный двоичный файл 
.glb  (без отдельного приложения bin-фай

ла) по спецификации расширения KHR_​gaussian_​
splatting. Позиции хранятся как обычные glTF 
POSITION  vertex-data (float3), все остальные ат

рибуты (поворот как float4, масштаб как float3, 
непрозрачность как float, SH-коэффициенты как 
float3 × shCoeffCount) находятся в дополнитель
ных vertex-атрибутах и ссылаются через расши
рение. Важно: glTF использует правую систему 
координат с Y-up, тогда как COLMAP/3DGS рабо
тает в Y-down/Z-forward. Поэтому экспортёр при
меняет поворот на 180 градусов вокруг оси X — 
позиции переписываются как (x, -y, -z) , ква
тернионы корректируются как (w, x, -y, -z) . 
Это даёт геометрически корректное, правильно 
хиральное (не зеркальное) отображение в glTF- 
просмотрщиках. JSON- и двоичные чанки выров
нены по 4-байтовой границе, как требует стан
дарт GLB.

П Р О СТ Ы М И  С Л О В А М И

Официальный формат стан­
дарта Khronos для 3D-дан­
ных, в свежем расширении 
для Gaussian Splats. Преиму­
щество: glTF распространён 
во всех крупных 3D-движ­
ках (Babylon.js, Three.js, Unity, 
Unreal). Недостаток: расшире­
ние в 2026 году ещё находит­
ся на стадии черновика, мно­
гие просмотрщики его пока 
не читают. Имеет смысл в ос­
новном, если вы интегрируете 
splat-данные в существующий 
glTF-конвейер или пишете про­
смотрщик, уже умеющий рабо­
тать с glTF.
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E6 — Splat (.splat)

ГД Е

Строка меню → Export → 3D Formats → 
Export .splat…. Режим новичка: карточка формата 
«.splat». Размер: ровно 32 байта на Gaussian. 
Совместимо с: gsplat.js, веб-просмотрщики 
(эталонная реализация antimatter15), большин
ство браузерных 3DGS-демо.

Т Е Х Н И Ч Е С К И

Формат .splat  от antimatter15 — 32 байта 
на Gaussian, без заголовка, без косвенности. 
Раскладка на запись: 3 × float32 позиция (ми
ровые координаты), 3 × float32 масштаб (exp-
преобразование из логарифмического простран
ства внутреннего буфера), 4 × uint8 RGBA-
цвет (DC-SH-коэффициент, масштабированный с 
SH_C0 = 0.282...  и обрезанный в [0,255]), 4 

× uint8 кватернион (w,x,y,z, нормализованный 
и закодированный в байтовом диапазоне как 
128 + 128*q ). Хранится только DC SH — высшие 

SH-полосы отбрасываются. Это делает формат 
чрезвычайно компактным, но стоит зависящих 
от направления взгляда изменений цвета, возни
кающих при отражениях или бликах. Порядок 
записи соответствует индексному порядку обла
ка (без пространственной сортировки), веб-про
смотрщики вроде gsplat.js  рендерят, исходя 
из этого предположения.

П Р О СТ Ы М И  С Л О В А М И

Формат выбора, если хоти­
те отображать splat в соб­
ственном веб-просмотрщике с 
gsplat.js . Очень компакт­

ный (32 байта/Gaussian), но без 
высших SH-степеней — значит, 
без блестящих отражений или 
едва уловимых изменений цве­
та в зависимости от угла обзо­
ра. Для большинства веб-при­
менений не проблема, посколь­
ку DC-цвета вполне достаточно, 
а отсутствие зависимости от 
угла обзора едва заметно.
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Рисунок 31.  Web Viewer, открытый в Firefox — splat букета отрендерен с окружающими 
сферами-маркерами камер, видна верхняя панель браузера, не нужна настройка CDN/
сервера. Автономный flowers-01.html  открыт напрямую из Finder двойным щелч­
ком в браузере по умолчанию — встроенная программа WebGL2 немедленно рендерит 
облако Gaussian, без сети или сервера. Чёрные маркеры вокруг букета — тренировоч­
ные камеры, опционально переключаемые. Drag мышью вращает, scroll приближает.
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E7 — Web Viewer (.html)

ГД Е

Строка меню → Export → Media → Export 
Web Viewer…. Режим новичка: карточка формата 
«Web Viewer». Размер: splat-данные в base64-
кодировке (≈ 4/3 накладных) + прим. 5 KB HTML/
JS-оболочка. Совместимо с: любым современ
ным браузером с WebGL2 (все десктопы, iOS 
15+, Android 5+).

Т Е Х Н И Ч Е С К И

Упаковывает облако Gaussian вместе с полно
стью встроенным WebGL2-рендерером в один 
файл .html . Нет зависимостей от CDN, нет 
WASM, нет второго файла. Облако внутри снача
ла кодируется как двоичный .splat  (та же 32-
байтовая логика, что у E6), потом встраивается 
в base64, потом декодируется atob  в браузе
ре. Встроенный рендерер делает собственную 
WebGL2-сортировку, mouse-orbit-controls и CPU-
сортировку каждый кадр; весь JS-код (шейдер, 
математика, цикл) виден в выходном HTML. Со
глашение об осях на границе хранения и рен
дерера — ровно такое же, как у E5: позиция 
(x, -y, -z) , кватернион (w, x, -y, -z) . Оп

ционально может отображаться брендинг-овер
лей (переключатель free-tier). Поскольку всё 
inline, файл работает и напрямую с протокола 
file:/​/​ — никакого локального веб-сервера для 
теста не нужно.

П Р О СТ Ы М И  С Л О В А М И

Один HTML-файл, который мож­
но отправить кому-нибудь по 
почте или встроить на сайт. 
Двойной щелчок в Finder — 
и браузер показывает вашу 
сцену с поворотом мышью. 
Не нужно загружать в облако, 
нет второго файла, нет серве­
ра. Идеально для презентаций 
клиентам, портфолио, вложе­
ний в почту. Недостаток: файл 
становится примерно на треть 
больше, чем чистый .splat , 
из-за base64-кодирования — 
для очень больших сцен по­
этому имеет смысл размещать 
.splat -файл отдельно вме­

сте со стандартным просмотр­
щиком.
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Рисунок 32.  Один кадр, извлечённый из flowers-01.mp4 — букет в профильном ренде­
ре, белая площадка с маркерами камер видна, чёрный фон (стандартный фон viewport, 
изменяемый в настройках). Камера движется вокруг сцены по параметрической траек­
тории (наклон + расстояние фиксированы, yaw вращается), длительность обычно 6–10 

секунд при 30 или 60 fps. Разрешение кадра масштабируется от 480p до 8K через 
VideoPreset.
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E8 — Orbit Video (.mp4/.mov)

ГД Е

Строка меню → Viewport → Record Turntable 
Video ИЛИ строка меню → Export → Media → 
Export Orbit Video…. Режим новичка: карточка 
формата «Orbit Video» с ползунком длительно
сти 3–30 с. Размер: зависит от длительности, 
разрешения, битрейта. Совместимо с: всеми 
платформами (H.264 и HEVC — стандарт Apple).

Т Е Х Н И Ч Е С К И

Рендерит облако Gaussian вдоль параметриче
ской орбитальной траектории камеры и кодирует 
каждый кадр через AVAssetWriter в файл MP4 
или MOV. Орбитальная конфигурация управляет 
скоростью вращения (revolutions), расстоянием, 
наклоном, FOV, длительностью и фактором ease-
in/out. Экспорт orbit-видео проходит через СОБ
СТВЕННЫЙ ForwardPass RadianceKit с полным 
вычислением SH — пиксель-в-пиксель идентич
но viewport в приложении (WYSIWYG). На кадр 
матрица выравнивания мира (рассчитанная рен
дерером для поворота внутренних координат 
в мир орбиты с Y-up) умножается на каме
ру, после чего применяется переворот соглаше
ния камеры (camFlip: orbit Y-up → COLMAP Y-
down). Цель оффскрин-рендеринга вытаскивает
ся через IOSurface в CVPixelBuffer для энкодера. 
Энкодер поддерживает H.264 и HEVC, настраи
ваемый битрейт и разрешение от 480p до 8K. 
Перед первым кадром рендерер ждёт 200 мс, 
чтобы завершилась начальная сортировка splat. 
Этот экспорт ограничен GPU — при 8K и миллио
нах Gaussians время рендера на кадр составляет 
несколько секунд, так что суммарное время рен
дера 10–30 минут для 6 с видео вполне возмож
но.

П Р О СТ Ы М И  С Л О В А М И

Готовый MP4-файл с поворотом 
вокруг вашей сцены. Идеален 
для соцсетей, маркетинга, пре­
зентаций. Можно задать дли­
тельность (3–30 секунд), на­
правление и скорость враще­
ния. Файл встраивается напря­
мую на YouTube, в Instagram, в 
PowerPoint и куда угодно ещё. 
Иногда медленно, потому что 
приложение должно полностью 
отрисовать каждый кадр — на 
8K видео можно планировать 
от пяти до тридцати минут в за­
висимости от числа Gaussians.
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E9 — SfM Transforms (transforms.json)

ГД Е

Строка меню → Export → Photogrammetry → 
Export SfM (transforms.json)…. Размер: обычно 1–
10 KB (только позы + intrinsics, без изображений, 
без Gaussians). Совместимо с: nerfstudio, Brush, 
gsplat, OpenSplat, Meshroom, со всеми современ
ными feed-forward 3DGS-тренировщиками.

Т Е Х Н И Ч Е С К И

Записывает формат transforms.json  от 
nerfstudio со списком поз камер плюс общие 
intrinsics. На камеру view-матрица (внутреннее 
представление RadianceKit: World-to-Camera в 
соглашении COLMAP) инвертируется, после че
го камеро-локальные векторы базиса Y и Z 
зеркалируются для конвертации в соглашение 
nerfstudio (стиль OpenGL, камера смотрит вдоль 
-Z , +Y  направлено вверх). Финальная матрица 

4×4 попадает как row-major вложенный массив 
double в поле transform_matrix  каждого кад
ра. Intrinsics хранятся на верхнем уровне (focal 
length x/y, principal point x/y, ширина/высота изоб
ражения, camera_​model = "OPENCV", плюс коэф
фициенты искажения k1, k2, p1, p2 ) — кроме 
случая, когда экспортёр обнаруживает несколь
ко разных наборов intrinsics, тогда они пишутся 
на кадр. Пути изображений пишутся как images/​
<filename> относительно JSON-файла; пользова
тель должен создать соседнюю папку images/​ с 
тренировочными фотографиями.

П Р О СТ Ы М И  С Л О В А М И

Этот JSON-файл описывает для 
каждого фото, где стояла каме­
ра и куда смотрела. Сам по се­
бе файл маленький и бесполе­
зен — он используется вместе 
с исходными изображениями в 
одной папке. Nerfstudio, Brush 
и пара других тренировщиков 
читают ровно этот формат, и с 
ним можно передать ваши SfM-
результаты RadianceKit в дру­
гой инструмент, без того чтобы 
там пришлось заново рассчи­
тывать камеры. Экономит часы 
на больших сценах.
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E10 — COLMAP Workspace (sparse/0/)

ГД Е

Строка меню → Export → Photogrammetry → 
Export SfM (COLMAP Workspace)…. Размер: три 
двоичных файла вместе обычно 4–8 MB — 
points3D.bin  доминирует (одна строка на каж

дую 3D-точку sparse-облака), images.bin  и 
cameras.bin  — каждый заметно меньше 100 

KB. Совместимо с: самим COLMAP, Nerfstudio, 
Postshot, Meshroom, всеми инструментами, ожи
дающими директорию COLMAP sparse/​.

Т Е Х Н И Ч Е С К И

Записывает стандартную раскладку COLMAP 
sparse/​0/​ с тремя двоичными файлами: 
cameras.bin , images.bin , points3D.bin . Эта

лон формата — официальная документация 
COLMAP. cameras.bin  содержит дедуплициро
ванный список intrinsics (камеры с идентичными 
intrinsics + размером изображения объединяются 
в одну запись); используемая модель камеры — 
OPENCV  (model 4), с fx/fy/cx/cy плюс четыре ко

эффициента искажения k1/k2/p1/p2. images.bin  
перечисляет на каждое изображение позу как 
wxyz -кватернион плюс перемещение, за кото

рым следует ID камеры и имя файла; 2D-3D-
соответствия не сохраняются. points3D.bin  со
держит SfM-облако точек с позицией, цветом 
(0–255 RGB) и значениями по умолчанию для 
репроекции и длины треков. Всё пишется в little-
endian. Повторный импорт в RadianceKit работает 
через меню File → «Import COLMAP/Metashape 
Workspace…» (см. Q3 в главе про SfM-бэкенды).

П Р О СТ Ы М И  С Л О В А М И

Официальный формат COLMAP. 
Если хотите продолжить обуче­
ние в Postshot, Nerfstudio или 
другом ПО, умеющем работать 
с COLMAP, это путь. Три малень­
ких файла плюс ваши исходные 
изображения, и целевая про­
грамма принимает это так, буд­
то исходной программой был 
сам COLMAP. Этот формат по­
нимает больше программ, чем 
формат transforms.json (E9), но 
он чуть менее удобен, потому 
что двоичный, а не текстовый.

195 / 235



R A D I A N C E K I T Глава 8 — Форматы экспорта

Какой формат когда?

Цель Формат

Веб-просмотрщик на своей стра
нице

E7 Web Viewer (.html)

Веб-просмотрщик с gsplat.js E6 Splat (.splat)

Повторное использование в кон
вейере Postshot / Nerfstudio

E9 transforms.json + E10 COLMAP Workspace

Редактирование в SuperSplat E1 PLY или E2 Compressed PLY

Niantic Scaniverse / Spatial Fields E3 SPZ

Максимальное сжатие E4 SOG (требуется cwebp)

Маркетинговое/соцсетевое видео E8 Orbit Video
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Быстрое сравнение

Формат Расширение Песоч­
ница

Размер (1M Gauss) Лучшее 
примене­

ние

E1 PLY .ply да ~250 MB Архив, наи
высшая 

совмести
мость

E2 Compressed 
PLY

.ply да ~40 MB Веб + 
SuperSplat

E3 SPZ .spz да (gzip 
spawn)

~40 MB Niantic + 
мобильные

E4 SOG .sog условно 
(cwebp)

~20 MB Макси
мальное 
сжатие

E5 glTF .glb да ~250 MB Конвейер 
Khronos

E6 Splat .splat да ~32 MB gsplat.js 
веб- про
смотрщик

E7 Web 
Viewer

.html да ~45 MB Автоном
ный бра
узерный 

файл

E8 Orbit 
Video

.mp4 / .mov да переменно Соцсети/
маркетинг

E9 SfM Transforms .json да ~5 KB Передача 
поз

E10 
COLMAP Workspace

Директория да ~4–8 MB Передача 
поз двоич

но

Колонка размера — грубые опорные значения для 1 миллиона Gaussians с SH-сте
пенью 3. Реальные значения варьируются в зависимости от сжимаемости сцены; 
SH-степень 0 уменьшает PLY/glTF в 4 раза.
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Г Л А В А

Глава 9 — SfM-бэкенды

Рисунок 33.  Режим эксперта с переключателем Camera Alignment в Инспекторе (Apple 
Photogrammetry / Native (Beta))

Рисунок 34.  Инспектор с активной опцией Native (Beta) — выбран второй вариант пе­
реключателя Camera Alignment, все остальные параметры конфигурации обучения без 

изменений

ЧТО ВИДНО НА ИЗОБРАЖЕНИИ  Переключатель Camera Alignment в Инспекторе — 
это сегментированный элемент управления с двумя вариантами — Apple 
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Photogrammetry (значение по умолчанию для сборок App Store, полностью сов
местимо с песочницей) и Native (Beta) (собственный бэкенд RadianceKit на 
базе FAST+BRIEF+GLOMAP, разработанный в фазах 3.8/3.9, по состоянию на 
2026-05). Native (Beta) проверен только на орбитальных съёмках и быстрее Apple 
Photogrammetry при ≥1 000 кадров, но пока не проходит порог качества фазы 3 
§5 (finalLoss ≤ 0.0115) — отсюда и тег Beta. Внешние результаты SfM из Metashape, 
COLMAP или любого другого фотограмметрического ПО можно дополнительно 
импортировать через меню File (текстовый формат Q3 COLMAP, импорт рабочей 
области Q6) — сам переключатель при этом не меняется, но импортированные 
позы заменяют результат SfM.

SfM расшифровывается как Structure from Motion. Из набора перекрывающихся 
фотографий программа восстанавливает для каждого изображения положение и 
направление взгляда камеры в общей 3D-системе координат. Попутно создаётся 
грубое 3D-облако точек, которое инициализирует обучение Gaussian Splatting. 
Результат SfM является входом для собственно обучения и решающим образом 
определяет конечное качество изображения.

RadianceKit предлагает пять путей SfM: два бэкенда, встроенных в само прило
жение (Q1 Apple Photogrammetry, Q4/Q5 Native), два пути импорта из внешних 
инструментов (Q3 текстовый формат COLMAP, Q6 двоичный импорт Workspace), а 
также Q2 двоичный COLMAP, доступный только в сборках для разработчиков вне 
App Store. Какой из них подходит, зависит от типа сцены (орбита вокруг объекта, 
помещение, полёт дрона) и от того, предоставляет ли уже внешнее ПО готовую 
реконструкцию.
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Q1 — Apple Photogrammetry

ГД Е

Режим эксперта → Инспектор → Training 
Configuration → переключатель Camera Alignment, 
запись «Apple Photogrammetry».

Т Е Х Н И Ч Е С К И

Обёртка над встроенным фреймворком фото
грамметрии Apple, изначально разработанным 
для Object Capture. Внутри Apple извлекает при
знаки своим проприетарным конвейером (эта
пы публично не документируются), проверяет 
их многоракурсным сопоставлением и реша
ет bundle adjustment на Apple Silicon Neural 
Engine + GPU. Бэкенд полностью совместим с 
App Store (никакого внешнего бинарного файла, 
Sandbox=true, on-device), но выдаёт только позы 
камер плюс грубое облако точек — никаких ди
агностических метрик вроде длины треков или 
ошибки репроекции. Масштабируется согласно 
рекомендации Apple до нескольких сотен изоб
ражений. При количестве кадров более ~500 в 
линейных пролётах дронов или больших уличных 
сценах наблюдались воспроизводимые сбои или 
тихий пропуск отдельных камер.

П Р О СТ Ы М И  С Л О В А М И

Это самый простой путь. За­
гружаете снимки, приложение 
считает. Очень хорошо подхо­
дит для классических сканов 
объектов — когда вы обходите 
предмет мебели или скульпту­
ру и делаете 50–200 фотогра­
фий. Для полётов дронов над 
пейзажами или при очень боль­
шом числе изображений (бо­
лее 500) метод Apple, однако, 
склонен к нестабильности. Для 
таких сцен попробуйте бэкенд 
Native (Q4/Q5) или просчитайте 
камеры в Metashape и загрузи­
те их через Workspace Import 
(Q6).

О П Ы Т Н О М У  П ОЛ Ь З О В АТ Е Л Ю

Q2 двоичный COLMAP — запускает внешнюю программу COLMAP как подпро
цесс и поэтому недоступен в версии для App Store (песочница). Работает 
только в сборках для разработчиков вне App Store. Для качества, которое 
даёт COLMAP, в версии для App Store есть Workspace Import (Q3 или Q6): 
просчитайте SfM внешне в COLMAP или Metashape и загрузите результат.
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Q3 — текстовый формат COLMAP (Metashape / ETH3D)

ГД Е

Меню «File → Import COLMAP / Metashape 
Workspace…» (Cmd+⇧+I) ИЛИ перетаскивание 
папки с sparse/​0/​cameras.txt.

Т Е Х Н И Ч Е С К И

Читает стандартизированный текстовый экспорт 
COLMAP — три текстовых файла cameras.txt , 
images.txt , points3D.txt  в подпапке sparse/​0/​ 

— и преобразует во внутреннюю модель резуль
тата SfM. То же определение формата, что и 
у двоичного экспорта COLMAP, только в ASCII 
вместо двоичного представления. Экспортиру
ется Agisoft Metashape, RealityCapture, PolyCam 
и бенчмарком ETH3D ровно в этом виде. Пар
сер разделяет с двоичным парсером опреде
ление модели камеры (все распространённые 
модели: SIMPLE_PINHOLE, PINHOLE, OPENCV, 
OPENCV_FISHEYE, FULL_OPENCV). Устойчив к 
строкам-комментариям и пустым строкам. В те
стах масштабируется до ~1 400 камер (ETH3D 
Tunnel) без проблем.

П Р О СТ Ы М И  С Л О В А М И

Если вы уже работали с 
Metashape, RealityCapture или 
другой коммерческой програм­
мой для фото-3D и экспорти­
ровали результат — этот экс­
порт можно загрузить прямо в 
RadianceKit, не пересчитывая в 
приложении. Это экономит ча­
сы ожидания. Просто загрузите 
всю папку через меню File или 
перетащите её в окно.
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Q4 — Native SfM (инкрементальный)

ГД Е

Режим эксперта → Инспектор → Training 
Configuration → переключатель Camera Alignment, 
запись «Native (Beta)». Инкрементальный — ре
жим по умолчанию для этого бэкенда — отдель
ного переключателя маппера в Инспекторе нет. 
Через CLI режим можно задать явно ключом 
--native-sfm  или --sfm-mapper incremental.

Т Е Х Н И Ч Е С К И

Собственная реализация всего конвейера 
SfM с ускорением на GPU: признаки 
FAST+BRIEF ИЛИ SuperPoint+LightGlue через 
CoreML (с --coreml-features ), затем сопостав
ление Hamming-KNN, RANSAC фундаментальной 
матрицы, построение треков, выбор начальной 
пары, двухвидовый bootstrap (F→E плюс DLT), 
жадный инкрементальный маппер с регистра
цией PnP и многоракурсной триангуляцией, и 
наконец bundle adjustment через Schur-редуци
рованный Levenberg-Marquardt с функцией по
терь Хьюбера и аналитическими якобианами 
через Cholesky-solve. Полностью совместим с 
App Store: никакого внешнего бинарного файла, 
Sandbox=true. С детектором коллапса R2, по
ставляемым в фазе 3.10: если приложение реги
стрирует менее 60 % входных кадров или коли
чество точек на камеру падает ниже 13, оно ав
томатически переключается на глобальный мап
пер (Q5). Эмпирически чист на сценах орбита/
поворотный стол; при более общих движениях 
(полёт дрона, помещения со сложной геомет
рией) показатель успешности ниже — однако 
детектор такие случаи перехватывает. Надёжно 
масштабируется до ~200 камер, выше — со зна
чительно бóльшим временем выполнения.

П Р О СТ Ы М И  С Л О В А М И

Сильные стороны Apple (сов­
местимость с App Store, быст­
рая работа на орбитах) плюс 
дополнительные диагностиче­
ские значения. Особенно хоро­
шо работает, когда вы обходите 
объект, как для Object Capture. 
При более сложных съёмках 
(полёт дрона или жилая комна­
та) RadianceKit автоматически 
распознаёт, что так не полу­
чится, и переключается на гло­
бальный метод. Помечен как 
«Beta», потому что ещё про­
веряется — стандартной ре­
комендацией остаётся Apple 
Photogrammetry для простых 
сканов объектов и Workspace 
Import (Q3 или Q6) для требова­
тельных уличных наборов.
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Q5 — Native SfM (глобальный)

ГД Е

Вызывается автоматически, когда инкремен
тальный маппер (Q4) срабатывает детектором 
коллапса (зарегистрировано менее 60 % вход
ных кадров или количество точек на камеру 
ниже 13). Принудительно вручную — только че
рез CLI --sfm-mapper global. В Инспекторе гло
бальный метод недоступен через отдельный пе
реключатель — приложение само решает, когда 
переключаться.

Т Е Х Н И Ч Е С К И

Глобальный вариант собственного конвейера. 
Сначала извлечение признаков + сопоставление 
как в Q4, затем оценка относительных поз для 
всех проверенных пар, после — усреднение по
воротов (синхронизирует все повороты камер в 
мировой системе координат) и усреднение пе
ремещений (на основе LSQR в matrix-free sparse-
формулировке, чтобы избежать переполнения 
integer при большом числе камер). В принципе 
масштабируется до ~5 000 камер, на практике 
с потерей качества при числе свыше нескольких 
сотен камер — замер порога приёмки фазы 3.8 
§5 на K-1351 дал finalLoss 0.07 вместо целевых 
0.0115. Трактуется как «fallback-уровень»: всту
пает в действие, когда инкрементальный маппер 
вырождается, но сам по себе на качество по
вторно не проверяется.

П Р О СТ Ы М И  С Л О В А М И

Запасной путь нативного движ­
ка. Вызывается автоматически, 
когда более быстрый инкре­
ментальный путь не справля­
ется. Выдаёт рабочий резуль­
тат, но на очень больших или 
сложных сценах обычно не так 
точен, как то, что получает­
ся из Metashape или внешней 
установки COLMAP. Если Native 
станет вашим основным рабо­
чим процессом, в таких случа­
ях имеет смысл сделать обход 
через Workspace Import (Q3 или 
Q6).

203 / 235



R A D I A N C E K I T Глава 9 — SfM-бэкенды

Q6 — импорт рабочей области Metashape / текстового COLMAP 
(фаза Q7)

ГД Е

Меню File → «Import COLMAP / Metashape 
Workspace…» (Cmd+⇧+I). Перетаскивание папки 
с sparse/​0/​cameras.{bin,txt} и images/​.

Т Е Х Н И Ч Е С К И

Автоматически распознаёт, соответствует ли 
папка, выбранная перетаскиванием или через 
open-panel, одной из трёх схем размещения ра
бочей области COLMAP (sparse/​0/​, sparse/​ или 
корень), и является ли реконструкция двоич
ной ( cameras.bin ) или текстовой ( cameras.txt ). 
Двоичный путь использует двоичный парсер 
COLMAP, текстовый — загрузчик ETH3D — оба 
порождают одну и ту же модель результата SfM, 
и остальной конвейер (импорт изображений, 
запуск тренировки MCMC) безразличен к ис
точнику. Изображения открываются через систе
му bookmark песочницы приложения с security-
scoped-доступом, так что импорт работает и в 
версии для App Store. Специально рассчитан на 
случай «экспорт из Metashape без перерасчёта 
реконструкции». Упомянутый в пункте меню File 
детектор предупреждает в журнале приложения, 
если выбранная папка не является распознавае
мой рабочей областью.

П Р О СТ Ы М И  С Л О В А М И

Это специальная функция для 
пользователей Metashape. Ес­
ли у вас есть лицензия на 
Metashape или RealityCapture и 
реконструкция камер уже сде­
лана там, можно просто пере­
тащить папку экспорта сюда и 
сразу запустить обучение. Эко­
номит несколько часов вычис­
лений на больших сценах, по­
тому что RadianceKit сам SfM 
тогда не делает.
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Какой бэкенд когда?

Сценарий Рекомендуемый бэкенд

Скан объекта, 50–200 
фотографий

Q1 Apple Photogrammetry

Крупная уличная съём
ка / дрон / >500 изобра

жений

Q6 Workspace Import (рассчитайте в Metashape или 
COLMAP, затем загрузите)

Имеется экспорт 
Metashape/RealityCapture

Q6 Import (SfM не нужен)

Набор ETH3D / ака
демический текстовый 

COLMAP

Q3 текстовый импорт COLMAP

Строгая совместимость с 
App Store + орбитальная 

сцена

Q4 Native инкрементальный

Q4 не справляется Q5 Native глобальный (автоматически)

Данные бенчмарка 
ETH3D

Q3 (autotest precomputed)
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Быстрое сравнение

Бэкенд App Store Песоч­
ница

Внешний би­
нарный файл

Лучшее 
приме­
нение

Макс. 
~камер

Q1 Apple 
PG

✅ ✅ — Объект-
орбита

~300

Q2 
COLMAP 
двоич

ный

❌ (только 
сборка для 
разработ

чиков)

— colmap/glomap Большие 
уличные

~5 000

Q3 тек
стовый 
импорт 

COLMAP

✅ ✅ — Бенч-на
боры

~1 500

Q4 
Native 
инкре
мен

тальный

✅ ✅ — Объект-
орбита

~200

Q5 
Native 

глобаль
ный

✅ ✅ — Откат с 
Q4

~1 351

Q6 Workspace 
Import

✅ ✅ — Повтор
ное ис

пользова
ние Metashape

по источ
нику
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Г Л А В А

Глава 10 — Режим новичка

Режим новичка (нем. Einsteiger-Modus, Cmd+1) — это направляемый рабочий про
цесс для всех, кто впервые восстанавливает 3D-сцену Gaussian Splatting. Вместо 
боковой панели, полной полей Инспектора, приложение проводит вас через четы
ре шага: сначала импорт изображений или видео и выбор Quality Preset, затем 
выполняется обработка (SfM + Training), после чего готовую сцену можно осмот
реть в 3D-предпросмотре, и наконец — экспорт в нужный формат. Тонкая полоса 
прогресса в верхней части окна всегда показывает, на каком шаге вы сейчас 
находитесь.

По сравнению с Expert Mode (Cmd+2), который показывает все панели управ
ления одновременно, Режим новичка скрывает неиспользуемые опции, выдаёт 
валидационные предупреждения при слишком малом числе или плохом качестве 
изображений и на каждом шаге предлагает только те кнопки, которые имеют 
смысл в текущем состоянии. Переключаться между Simple и Expert Mode можно в 
любой момент (Cmd+1 / Cmd+2), всё состояние — импортированные изображения, 
выбранная предустановка, текущая тренировка, готовое облако точек — сохраня
ется и сразу доступно в другом режиме.
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Z1 — Импорт (выбор изображений и предустановки)

Рисунок 35.  Simple Mode шаг 1 — пустая зона дропа до импорта изображений, хлебные 
крошки сверху (Import → Frame Quality → Cameras → Training → Preview → Export), 
пилюли форматов JPG/PNG/TIFF/HEIC/MP4/MOV/PLY/SPZ/SPLAT/SCENE/COLMAP

ЧТО ВИДНО НА ИЗОБРАЖЕНИИ  Хлебные крошки (Import активен) показывают четы
рёхшаговый рабочий процесс. Слева — зона дропа с тремя CTA: «Browse 
Files» (NSOpenPanel), «Try Sample Scene» (встроенное демо), «Download Sample 
Photos (~427 MB)» (подмножество flowers из Mip-NeRF360). Пилюли форматов 
под ними перечисляют все принимаемые типы файлов. Справа — «Imported Files» 
со счётчиком «0 images» и пустым состоянием «No files imported yet». Ниже — 
Quality picker (по умолчанию: Preview) и «Start Processing» (деактивирован, пока 
нет изображений).

Первый шаг состоит в том, чтобы передать приложению изображения. Через drag-
and-drop в большое пунктирное поле посередине, через кнопку «Browse Files» или 
щелчком по встроенной демо-сцене. Справа появляется список всех импортиро
ванных изображений с разрешением и размером файла; ниже во всплывающей 
панели инструментов вы выбираете Quality Preset и запускаете конвейер кнопкой 
«Start Processing». Валидационные предупреждения (красное при < 3 или < 10 
изображениях, оранжевое при 10–19) показывают, ожидает ли приложение разум
ную реконструкцию или нет.
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C-01 ProgressIndicator (индикатор шага)

ГД Е

Сверху над рабочим процессом, всегда виден.

Т Е Х Н И Ч Е С К И

Показывает горизонтальную полосу прогресса 
по всему конвейеру (Frame Quality → SfM → 
Training) с распределением по этапам: Frame 
Quality занимает 0–5 % (фаза 3.11, очень корот
кая), SfM — 0–30 % полосы, Training — 30–100 %. 
Рядом текст статуса и проценты с именем фазы 
(«SfM 41 %», «Training 12 500/20 000»), чтобы 
пользователи не читали кажущуюся регрессию 
«41 % SfM → 25 % Training» как ошибку — 
полоса показывает общий прогресс конвейера, 
а не подшаг. Расчёт ETA стартует, как только из
мерена достаточная скорость обучения (обычно 
после первых 100 итераций). То же отображение 
используется и в Expert Mode над Инспектором.

П Р О СТ Ы М И  С Л О В А М И

Тонкая полоса в самом вер­
ху — ваша карта по рабоче­
му процессу. Она говорит вам 
не только что приложение сей­
час делает (выравнивает каме­
ры, идёт обучение, …), но и 
насколько далеко в целом про­
двинулось. Деление сделано 
намеренно так, что вычисление 
камер занимает первую треть 
полосы, а собственно обучение 
— задние две трети, иначе бы 
казалось, что прогресс внезап­
но скакнул обратно к нулю по­
сле SfM. Так вы можете рас­
слабиться, взгляда на полосу 
достаточно, чтобы увидеть гру­
бый этап. Текст рядом говорит, 
в каком вы сейчас этапе SfM 
(напр. «SfM 41 %») или в обуче­
нии (напр. «Training 12 500/20 
000»), чтобы цифры не каза­
лись запутанными. Если ETA не 
показан, обучение просто ещё 
слишком молодое — приложе­
ние оценивает только когда из­
мерило достаточную скорость.
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C-03 DropZoneView (зона drag-and-drop)

ГД Е

Левая сторона шага импорта, большой пунктир
ный прямоугольник с символом. В Simple Mode 
отображается с надписью «Drop photos or a video 
here».

Т Е Х Н И Ч Е С К И

Зона дропа, которая кратко подпрыгивает сим
волом и тонирует фон, как только над полем 
появляются drag-объекты. Принимает JPG, PNG, 
TIFF, HEIC, MP4, MOV, PLY, SPZ, .splat, банд
лы .radiancescene и директории. Маршрутизация 
дропа по типу: изображения собираются и пе
редаются в отсортированном порядке, видео 
триггерят путь frame-sampling, splat-файлы от
крывают предпросмотр напрямую, scene-банд
лы прочитываются. Директории перечисляются, 
и все содержащиеся изображения импортиру
ются. Security-scoped bookmarks для sandbox-
совместимого доступа корректно приобретаются 
и отпускаются. Неподдерживаемые расширения 
отображаются как warning-баннер на 5 секунд.

П Р О СТ Ы М И  С Л О В А М И

Большое пунктирное поле — 
главный элемент управления 
первого шага. Просто перета­
щите в него фотографии или 
видео, или целую папку — при­
ложение возьмёт всё, что зна­
ет, и проигнорирует остальное. 
Когда поле становится синим 
и символ кратко подпрыгивает, 
приложение распознало drag. 
Отпустите, и импорт сразу нач­
нётся: изображения переходят 
в список справа, видео автома­
тически триггерят шаг frame-
sampling, а уже обученные фай­
лы .ply / .spz / .splat  от­
крывают предпросмотр напря­
мую. Если формат вообще не 
подходит (напр., PDF или BMP), 
сверху на короткое время появ­
ляется уведомление — прило­
жение не глотает молча неиз­
вестный материал.

C-05 Кнопка Browse Files

ГД Е

Внутри зоны дропа, видная кнопка.

Т Е Х Н И Ч Е С К И

Кнопка, открывающая файловый диалог macOS с 
множественным выбором и типами файлов JPG, 
PNG, TIFF, MP4, MOV, папки, а также собствен
ным форматом сцены приложения. Результирую
щие URL — security-scoped и проходят через 
те же пути импорта, что и drag-and-drop. Когда 
пользователь выбирает папку, она рекурсивно 
перечисляется на предмет изображений.

П Р О СТ Ы М И  С Л О В А М И

Если drag-and-drop вам неудо­
бен, просто щёлкните по этой 
кнопке и в файловом диало­
ге macOS перейдите к вашим 
фотографиям. Можно выбрать 
несколько файлов сразу (Cmd-
клик по отдельным изображе­
ниям) или выбрать целую папку 
— приложение тогда рекурсив­
но ищет в папке все поддержи­
ваемые типы изображений. Это 
особенно удобно, когда ваши 
съёмки разложены по вложен­
ным подпапкам (напр., «shoot-
day1/», «shoot-day2/») — од­
ного щелчка по главной пап­
ке достаточно. Функционально 
кнопка делает ровно то же, 
что и drag-and-drop; выбирайте 
путь, который удобнее вам.
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C-06 Кнопка Try Sample Scene

ГД Е

Внутри зоны дропа, видна только когда бандл 
приложения содержит демо-сцену и пока не им
портированы изображения/splats.

Т Е Х Н И Ч Е С К И

Появляется только если (a) в бандле приложе
ния есть sample-scene.splat , .spz  или .ply  И 
(b) не импортированы изображения/видео и нет 
облака точек. По щелчку загружается готовое 
облако точек (предпочитая наименьший формат 
— .splat  ~3 MB, .spz  ~1.4 MB, fallback .ply ) 
и через 400 мс устанавливаются жёстко заши
тые значения камеры из исходных метаданных 
flower-сцены для эстетически приятной началь
ной перспективы.

П Р О СТ Ы М И  С Л О В А М И

Если вы впервые запускаете 
приложение и просто хотите 
увидеть, что выходит в конце — 
щёлкните здесь. Откроется го­
товая обученная flower-сцена, 
которую можно сразу крутить 
и экспортировать, без необхо­
димости что-то вычислять. Ка­
мера предустановлена в эсте­
тически приятную начальную 
перспективу, так что вы сра­
зу видите красивое. Идеаль­
но для безрискового испыта­
ния 3D-управления и шага экс­
порта, прежде чем браться за 
собственные съёмки. Как толь­
ко вы импортируете собствен­
ные изображения, кнопка авто­
матически исчезает — она по­
казывается только пока проект 
полностью пуст.

C-07 Кнопка Download Sample Photos

ГД Е

Внутри зоны дропа, рядом с «Try Sample Scene»; 
те же условия видимости.

Т Е Х Н И Ч Е С К И

Запускает загрузку (репозиторий github.com/​
bkindler/​radiancekit-sample-photos), которая за
гружает прим. 427 MB из 960 кадров полно
го разрешения и скармливает их приложению. 
Во время загрузки кнопка деактивирована. Про
гресс появляется в верхней полосе прогресса 
как «Downloading X %» на собственном этапе, 
потому что этот этап держит собственную шкалу 
0–100 % и не пересекается с последующим эта
пом SfM.

П Р О СТ Ы М И  С Л О В А М И

Как и демо-сцена, только с ис­
ходными фотографиями вместо 
готового результата. Так можно 
один раз самому прогнать весь 
конвейер и увидеть, сколько на 
самом деле длятся SfM и обу­
чение на вашем Mac. Загрузка 
большая (около половины DVD 
= 427 MB), но происходит толь­
ко один раз — после этого 
фотографии локальны, и мож­
но запускать конвейер сколь­
ко угодно с разными предуста­
новками. Пока идёт загрузка, 
верхняя полоса прогресса по­
казывает текущий статус за­
грузки в процентах, чтобы вы 
могли оценить, когда она за­
пустится. Совет: используйте 
быстрый Wi-Fi или проводную 
сеть — 427 MB иначе займут ка­
кое-то время.
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C-09 Quality Presets Picker

ГД Е

Всплывающая нижняя панель инструментов 
import-оверлея, слева от Start-кнопки.

Т Е Х Н И Ч Е С К И

Элемент управления с меткой «Quality» группи
рует доступные предустановки по категориям 
(Classic / MCMC / Custom). Встроенные предуста
новки группируются по категориям; заголовки 
секций жёстко зашиты. Пользовательские пред
установки видны только если они есть. Locked-
состояние: предустановки не из бесплатного 

списка (Quick + Preview) получают суффикс «🔒» 
при имени, если пользователь не купил; при 
выборе picker отскакивает обратно к Preview 
и автоматически открывает purchase-sheet. При 
выборе предустановка применяется, что заменя
ет всю конфигурацию обучения.

П Р О СТ Ы М И  С Л О В А М И

Здесь вы выбираете, насколь­
ко точно и долго приложе­
ние должно считать. «Quick» и 
«Preview» можно использовать 
без покупки и они дают первый 
результат за несколько минут 
— идеально для проверки, на­
сколько ваши изображения во­
обще разумны. «Balanced» и 
«Quality» требуют полной вер­
сии и дают существенно более 
чистые модели, но длятся ча­
сами вместо минут. MCMC — 
другая стратегия, обходящая­
ся меньшим числом Gaussian 
splats — хорошо, если позднее 
хочется компактно экспортиро­
вать модель или положить в 
сеть. Премиум-предустановки 
узнаются по маленькому знач­
ку замка при имени; если на­
жать на одну из них без лицен­
зии, picker отскакивает обратно 
к Preview, и purchase-sheet от­
крывается автоматически. Пра­
вило большого пальца: всегда 
начинайте с Preview, посмотри­
те результат и только потом ре­
шайте, стоит ли более длинный 
прогон.
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C-10 Кнопка Start Processing

ГД Е

Всплывающая нижняя панель инструментов 
import-оверлея, справа от preset-picker.

Т Е Х Н И Ч Е С К И

Кнопка, остающаяся серой, пока не импорти
рованы ни изображения, ни видео. По щелчку 
запускает конвейер и переключает stage-маши
ну в порядке Frame Quality → SfM → Training. У 
самой кнопки нет дальнейшего статуса; вместо 
этого идущая обработка появляется как отдель
ный processing-экран.

П Р О СТ Ы М И  С Л О В А М И

Кнопка «Go». Пока она серая, 
не хватает входных изображе­
ний или видео. Как только вы 
перетащили фотографии, она 
становится активной, и щелч­
ком запускаются SfM и обу­
чение последовательно. Даль­
ше приложение берёт на се­
бя весь рабочий процесс, и 
вы автоматически попадаете 
на processing-экран (Z2). Боль­
ше ничего не нужно нажимать 
— только после окончания обу­
чения приложение переключа­
ется обратно к предпросмот­
ру (Z3). Если вы передумаете, 
в любой момент после этого 
можно также отменить через 
Cancel.

C-11 Слайдер Video Sampling

ГД Е

Правый список изображений, виден только когда 
импортировано видео (вместо изображений).

Т Е Х Н И Ч Е С К И

Слайдер 0.5 fps – 30 fps с шагом 0.5. При изме
нении обновляется плотность кадров и дополни
тельно из плотности и длины видео вычисляется 
целевое число кадров (минимум 10). Слайдер 
расположен вне списка изображений, поскольку 
элементы списка блокировали бы события мыши 
от слайдеров. Под слайдером показываются вы
численные target-frames («247 frames») и длина 
видео («1m23s video»). Tooltip предупреждает: 
«Удвоение плотности удваивает количество кад
ров и увеличивает время SfM на ~100 %».

П Р О СТ Ы М И  С Л О В А М И

Если вместо фотографий вы 
импортировали видео, этот 
слайдер решает, сколько от­
дельных изображений прило­
жение должно извлечь из ви­
део. Больше изображений = 
лучше качество, но линейно 
больше времени вычислений. 
Для 30-секундного orbit-видео 
5 fps (150 изображений) — 
хорошее начало; для 1-минут­
ных записей 3 fps часто бо­
лее чем достаточно. Под слай­
дером приложение показывает 
вживую, сколько кадров полу­
чается при текущей настройке 
— так сразу видно, попадае­
те ли вы в разумный диапазон 
около 100–300 изображений. 
Если результат становится пло­
хим, потяните слайдер вправо 
и попробуйте снова; но удвое­
ние частоты кадров также при­
мерно удваивает длительность 
SfM.

213 / 235



R A D I A N C E K I T Глава 10 — Режим новичка

C-12 Кнопка Clear All

ГД Е

Правый список изображений, внизу справа; вид
на только если импортированы изображения.

Т Е Х Н И Ч Е С К И

Красная кнопка. Щелчок открывает диалог под
тверждения с заголовком «Clear all imported 
files?» и сообщением «N images will be 
removed.». Подтверждение очищает все импор
тированные изображения/видео, staging- дирек
тории, облако точек, статус обучения, результат 
SfM и все кеши; этап прыгает обратно в Import. 
По Cancel всё сохраняется. Диалог настроен 
как недеструктивный default-путь (деструктивная 
кнопка помечена красным).

П Р О СТ Ы М И  С Л О В А М И

Если хотите начать совсем сна­
чала, щёлкните здесь. Запрос 
подтверждения появляется, по­
тому что удаление выбрасыва­
ет все текущие импорты, вклю­
чая уже рассчитанные камеры 
и результаты обучения — от­
менить нельзя. Полезно, когда 
хотите полностью заменить вы­
бранный материал изображе­
ний или избавиться от старого 
проекта перед началом ново­
го. Примечание: удаление од­
ного изображения делается че­
рез список справа (см. следую­
щий пункт), не через эту кноп­
ку. Ваши файлы на диске при 
этом не удаляются — приложе­
ние только забывает свои ссыл­
ки на них.

C-13 File List ForEach (удаление одного изображения)

ГД Е

Правый список изображений, каждая запись.

Т Е Х Н И Ч Е С К И

Список по импортированным изображениям с 
swipe-to-delete. На каждое изображение — стро
ка со значком, именем файла, разрешением 
(«1920 × 1080») и размером файла (форматиро
вано KB/MB). Разрешение приходит из metadata-
кеша, заполняемого асинхронно из заголовков 
изображений, чтобы UI не блокировался. Дей
ствие удаления предлагает типичный для macOS 
swipe-delete (свайп влево трекпадом по строке) 
и delete с клавиатуры для выбранной строки. 
Примечание: расширенный путь удаления изоб
ражений с явной кнопкой минус, backspace и 
Cmd-Z для отмены был добавлен только в Expert 
Mode в Project Navigator — в Simple Mode остаёт
ся swipe-delete.

П Р О СТ Ы М И  С Л О В А М И

Список справа показывает каж­
дое импортированное изобра­
жение с разрешением и раз­
мером файла — удобно для 
быстрой оценки, не смешали 
ли вы высокого разрешения 
с низким. Для удаления одно­
го изображения свайпните его 
двумя пальцами влево по трек­
паду — как в iOS Mail — или вы­
берите и нажмите Delete. Сам 
файл приложение не удаляет; 
оно только убирает его из те­
кущего проекта. Если нужна 
полноценная кнопка минус или 
Cmd-Z для отмены, переключи­
тесь в Expert Mode (Cmd+2), там 
это есть в Project Navigator. В 
Simple Mode сознательно оста­
ётся простой паттерн swipe.
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C-15 Валидационные предупреждения (3 уровня)

ГД Е

Под списком изображений, над кнопкой Clear All.

Т Е Х Н И Ч Е С К И

Три последовательных порога на основе числа 
импортированных изображений (активно только 
когда есть изображения и нет видео): - < 3 
изображений: красный баннер (красный восьми
угольник), текст «At least 3 images are required. 
Camera alignment cannot be computed from fewer 
images.» - 3–9 изображений: красный баннер, 
текст «With fewer than 10 images, SfM often fails 
and the trained scene tends to overfit […]. 15–
20 images minimum recommended; 30+ for object 
captures.» - 10–19 изображений: оранжевый бан
нер (warning-треугольник), текст «Workable, but 
quality usually improves with 20+ images and good 
coverage around the scene.»

Начиная с 20 изображений баннер исчезает. По
роги жёстко зашиты и основаны на эмпирике 
560+ экспериментов по обучению.

П Р О СТ Ы М И  С Л О В А М И

Приложение смотрит, сколько 
изображений вы импортирова­
ли, и даёт цветную оценку. 
Красный означает: это скорее 
всего не получится — либо SfM 
не сможет вычислить камеры, 
либо обучение переобучится 
на слишком малом материале. 
Оранжевый означает: возмож­
но сработает, но не ждите то­
пового качества, потому что ал­
горитм находит мало перекры­
тий между изображениями. Ни­
какой баннер означает: хоро­
шие условия, у вас достаточно 
материала. Если действитель­
но хотите чистые модели, цели­
тесь минимум в 30–50 равно­
мерно распределённых сним­
ков вокруг вашего объекта — и 
значительно больше для улич­
ных сцен или больших комнат. 
Можно стартовать и при преду­
преждении, но не удивляйтесь, 
если SfM прервётся без ком­
ментариев или модель окажет­
ся дырявой.
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C-16 Распознавание COLMAP-workspace

ГД Е

При дропе папки — не видимая кнопка, а логика 
распознавания.

Т Е Х Н И Ч Е С К И

При дропе директории проверяется, содер
жит ли она одну из трёх канонических рас
кладок workspace: sparse/​0/​cameras.bin, sparse/​
cameras.bin или напрямую cameras.bin  в корне. 
Если да, стандартное перечисление изображе
ний прерывается, и вместо этого открывается 
модальный alert, спрашивающий пользователя, 
использовать ли существующую реконструкцию 
или прогнать изображения заново через Apple 
Photogrammetry. Тот же путь и для workspace в 
текстовом формате (cameras.txt) и для ETH3D-
экспортов. Подробности — глава 9, бэкенд Q6. 
Работает в Simple Mode так же, как и в Expert 
Mode.

П Р О СТ Ы М И  С Л О В А М И

Если вы уже работали с 
Metashape, RealityCapture или 
COLMAP и сделали там вы­
числение камер, можно про­
сто перетащить папку экспорта 
сюда. RadianceKit автоматиче­
ски распознаёт по содержимо­
му, что это COLMAP-workspace 
(он проверяет sparse/​0/​, 
cameras.bin  и т.п.), и спра­

шивает, взять ли готовое вы­
числение или вычислить са­
мому. Принять готовое сэко­
номит часы ожидания на 
больших сценах, потому что 
SfM полностью пропускается 
— обучение запускается сра­
зу. Также распознаются тексто­
вые workspace (cameras.txt) и 
ETH3D-экспорты. Эта функция в 
Simple Mode доступна так же, 
как и в Expert Mode; подробнее 
— в главе 9 под бэкендом Q6.

Когда переходить к следующему этапу?

Щёлкнуть Start Processing можно, как только (a) импортировано хотя бы одно 
изображение или видео и (b) баннер валидации оранжевый или его нет. При крас
ном баннере приложение даст стартовать, но с высокой вероятностью обработка 
тут же отменится сама. Рекомендация: минимум 20 изображений, резких, с чёт
ким перекрытием между последовательными снимками, все примерно с одного 
расстояния до объекта. Перед стартом выберите предустановку под ваш бюджет 
времени — с 30 изображениями и предустановкой Quick вы готовы за несколько 
минут, с Quality скорее уйдут 1–2 часа.
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Z2 — Обработка (SfM + Training)

Рисунок 36.  Z2 SfM-фаза — значок этапа «Structure from Motion» с 41 % в большом 
круге, верхняя статус-полоса на «SfM 25 %», кнопка Cancel внизу справа

SfM-фаза (камеры выравниваются): Большой круг прогресса показывает про
гресс подэтапа (здесь 41 % текущей сессии Apple Photogrammetry). Текст статуса 
«Aligning cameras…» вверху слева. Хлебные крошки помечают «Cameras» как ак
тивный этап. Верхняя статус-полоса показывает общий прогресс конвейера (25 
%) — SfM занимает первую половину полосы. Парящие wireframe-камеры на фоне 
намекают, что идёт оценка поз.

Рисунок 37.  Z2 фаза обучения — значок этапа «Training Gaussians» на 6 %, живые 
метрики сверху (Training: 400/5000 — Loss: 0.1642 — 138.7 it/s), ETA 33 с, Pause/Cancel 

внизу

Фаза обучения (оптимизируются Gaussians): Значок подэтапа переключается 
на «Training Gaussians», проценты считают итерации выбранной предустановки 
(здесь 400 / 5 000 для Preview-предустановки = 8 % этапа). Строка живых метрик 
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показывает значение loss (0.1642), итерации в секунду (138.7 it/s) и ETA (33 с). 
Общий прогресс конвейера в этой фазе поднимается с 50 % до 100 %. Кнопка 
Pause (вместо только cancel в SfM-фазе) позволяет позднее возобновить; Cancel 
отбрасывает результат обучения и возвращает к Z1.

Как только конвейер запущен, приложение скрывает import-overlay и показывает 
полноэкранный processing-экран. В центре движется большой круг прогресса 
(220 × 220 пикселей) со значком этапа, текстом статуса и числом процентов; 
в фоне тонкая splat-анимация символически визуализирует идущие вычисления. 
Вверху слева можно показать info-панель, отображающую живые метрики из обу
чения и SfM. Внизу есть Pause/Resume, Cancel, а в случае ошибки — кнопка Retry.

C-18 SplatTrainingView (фоновая анимация)

ГД Е

Полноэкранный фон за кругом прогресса, скры
вается при отмене или ошибке.

Т Е Х Н И Ч Е С К И

Декоративная анимация, которая в зависимости 
от прогресса конвейера (0…1) рендерит рас
тущее число маленьких анимированных splat-
частиц. Источник — вычисляемое значение про
гресса, которое мапит SfM-фазы в 0–0.2, а обу
чение — в 0.2–1.0 (Frame Quality в 0–0.05). Так 
splats заметно «нарастают», пока идёт обучение. 
Чисто декоративно — отображение не показыва
ет реальные промежуточные результаты текуще
го обучения (это был бы live preview в Expert 
Mode). При отмене или сбое скрывается, и виден 
только круг статуса.

П Р О СТ Ы М И  С Л О В А М И

На фоне идёт маленькая ани­
мация танцующих точек, что­
бы экран не выглядел таким 
пустым во время вычислений. 
Это не ваша реальная 3D-мо­
дель — её вы увидите только 
после обучения, на шаге Z3. 
Анимация, однако, имеет ту же 
тональность, так что по при­
близительной плотности мож­
но прочитать, насколько дале­
ко продвинулось обучение. В 
начале видны лишь несколько 
точек, к концу фон заполня­
ется заметно плотнее — сим­
патичный визуальный индика­
тор в дополнение к процентно­
му отображению в круге. Если 
анимация вам мешает (напр., 
потому что вы хотите парал­
лельно работать в фоне), можно 
переключиться в Expert Mode, 
где её нет.
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C-19 Большой круг прогресса

ГД Е

Центр processing-экрана, 220 × 220 пикселей.

Т Е Х Н И Ч Е С К И

Два кольца, отрисованных поверх друг друга: 
снаружи — приглушённое track-кольцо, внутри — 
заполненное кольцо прогресса с акцентной или 
красной обводкой (красный при ошибке). Внутри 
круга — значок этапа (мозг для обучения, камера 
для SfM, плёнка для извлечения кадров видео, 
искры для Frame Quality), заголовок этапа и жи
вое анимированное процентное число шрифтом 
32 пункта rounded. Значок мягко пульсирует, 
пока обработка активна. Отображение интерпо
лирует на таймере 30 Гц плавно к текущему 
фактическому прогрессу — с постоянной creep 
(0.0003/кадр) плюс пропорциональной долей (4 
% от gap) и мягким потолком, устанавливающим
ся на 80 % следующей ожидаемой вехи (для SfM 
— из жёстко зашитой таблицы вех). Так прогресс 
ощущается плавным, даже если фактические об
новления SfM приходят раз в несколько секунд.

П Р О СТ Ы М И  С Л О В А М И

Большой круг посередине — 
ваш главный экран, пока при­
ложение считает. Он наполня­
ется плавно, даже когда обнов­
ления реального вычисления 
приходят раз в несколько се­
кунд — это даёт ощущение, 
что что-то происходит, вместо 
того чтобы минутами смотреть 
на замёрзший процент. Символ 
в середине меняется в зави­
симости от того, идёт ли сей­
час извлечение кадров (значок 
плёнки), выравнивание камер 
(значок камеры) или обучение 
Gaussians (значок мозга). Чис­
ло процентов относится к теку­
щему подшагу — общий кон­
вейер видно в тонкой полосе в 
самом верху. При ошибке коль­
цо становится красным вме­
сто синего, а значок перестаёт 
пульсировать, так что вы сразу 
замечаете, что что-то пошло не 
так.

C-22 Info-кнопка (показать метрики)

ГД Е

Вверху слева на processing-экране, 32 × 32 пик
селя.

Т Е Х Н И Ч Е С К И

Простая кнопка с material-фоном. Переключа
ет info-панель вкл/выкл. Значок переключается 
между info-circle-outline и info-circle-filled при 
активации. Плавная fade-in-анимация. Tooltip 
«Show detailed processing metrics».

П Р О СТ Ы М И  С Л О В А М И

По умолчанию экран созна­
тельно опрятен — только боль­
шой круг прогресса, больше 
сначала ничего не видно. Если 
как технически заинтересован­
ному пользователю вам хочет­
ся точнее знать, что происхо­
дит (какая итерация, какой loss, 
сколько Gaussians), щёлкните 
по значку i вверху слева. Вни­
зу выезжает маленькая панель 
и показывает все живые значе­
ния. Повторный щелчок снова 
её скрывает. Настройка не пер­
систентна — при каждом новом 
прогоне обучения панель сна­
чала снова скрыта, что созна­
тельно выбрано, чтобы не пу­
гать новичков.
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C-23 Info-панель (живые метрики)

ГД Е

Внизу слева на processing-экране, видна только 
когда showProcessingInfo == true.

Т Е Х Н И Ч Е С К И

Двухколоночная панель с ultra-thin material-фо
ном. Левая колонка: специфичные для этапа info-
строки — для SfM текст статуса и проценты; для 
обучения — итерация, комбинированный loss, 
L1 loss, D-SSIM loss, число Gaussians (оранже
вым), скорость (it/s), прошедшее время, рассчи
танный ETA, SH-степень и learning rate. Правая 
колонка: текст статуса, строка с информацией 
о времени, инлайновый loss- график (см. C-28) 
и discoverability nudge (см. C-32). Все значения 
считываются из training status, который обновля
ется на каждом тике обучения.

П Р О СТ Ы М И  С Л О В А М И

Info-панель показывает все жи­
вые значения, которые в Expert 
Mode постоянно были бы на 
боковой панели Инспектора: 
текущая итерация, значение 
loss (меньше = лучше), число 
Gaussians, скорость, оценочное 
оставшееся время, SH-степень 
и learning rate. На правой сто­
роне дополнительно идёт кро­
шечная кривая loss, которая на 
одном взгляде говорит, идёт 
ли обучение в правильном на­
правлении. Если обучение ка­
жется вялым, взгляд сюда по­
могает — loss, который боль­
ше не падает, или ETA, кото­
рое больше не уменьшается, 
указывают на проблемы. Ес­
ли loss взрывается (внезапно 
становится огромным) или по­
казывает NaN, обучение стало 
неустойчивым, и имеет смысл 
Cancel + Retry или переклю­
читься на другую предустанов­
ку.
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C-25 Кнопка Pause/Resume

ГД Е

Нижняя navigation-панель, видна только во время 
этапа обучения (НЕ во время SfM) и пока обра
ботка идёт.

Т Е Х Н И Ч Е С К И

Bordered-кнопка. Вызывает Pause или Resume 
в зависимости от статуса. Метка переключа
ется между «Pause» (со значком pause) и 
«Resume» (значок play). На SfM-шаге кноп
ка не показывается, потому что у Apple 
Photogrammetry нет семантики pause. Состояние 
pause полностью сохраняет итерацию, статус 
Gaussian и optimizer momentum — Resume про
должает с того места, где ранее остановилось.

П Р О СТ Ы М И  С Л О В А М И

Пока идёт обучение, в любой 
момент можно его остановить 
и позднее возобновить. Полез­
но, когда между делом хочется 
на Mac заняться чем-то дру­
гим, требующим много GPU — 
напр., видеомонтажом, тестом 
игры или экспортом рендера 
из другого приложения. Щел­
чок Pause, делаете своё, щел­
чок Resume, обучение продол­
жается ровно там, где оста­
новилось. Счётчик итераций, 
число Gaussians и optimizer 
momentum полностью сохраня­
ются, состояние pause не сто­
ит вам качества. На SfM-фазе 
Pause недоступна — у Apple 
Photogrammetry нет функции 
stop, там в крайнем случае 
приходится работать с Cancel.

C-26 Кнопка Cancel

ГД Е

Нижняя navigation-панель, видна пока идёт обра
ботка (SfM или Training).

Т Е Х Н И Ч Е С К И

Красная bordered-кнопка. Открывает диа
лог подтверждения с заголовком «Stop 
and discard progress?», кнопками «Discard 
Progress» (destructive) и «Keep Running» (cancel). 
При подтверждении устанавливается cancel-
флаг, training-задача завершается, при необ
ходимости завершается SfM-подпроцесс, и в 
JSONL-лог пишется summary-строка с cancel- 
статусом. В отличие от Pause, training-буферы и 
статус отбрасываются.

П Р О СТ Ы М И  С Л О В А М И

Кнопка отмены. В отличие от 
Pause это окончательно — если 
потом захотите перезапустить, 
обработка пойдёт с начала, все 
уже обученные итерации поте­
ряны. Полезно, когда вы ошиб­
лись с предустановкой, обуче­
ние идёт слишком медленно 
или приложение явно выдаёт 
мусорные результаты, и не хо­
чется ждать. Перед собственно 
отменой приложение ещё раз 
спросит через диалог подтвер­
ждения, чтобы вы случайно не 
потеряли часы вычислений. Ес­
ли хочется только кратко пре­
рвать, лучше возьмите Pause.
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C-27 Кнопка Retry

ГД Е

Нижняя navigation-панель, видна когда конвейер 
сорвался (SfM-статус начинается с «SfM failed» 
или обучение в error-состоянии).

Т Е Х Н И Ч Е С К И

Accent-кнопка. Перезапускает весь конвейер. 
Перед стартом проверяется, есть ли ещё импор
тированные изображения/видео. Предыдущие 
error-логи сохраняются в JSONL-директории; но
вый прогон пишет новый лог-файл с текущим 
timestamp.

П Р О СТ Ы М И  С Л О В А М И

Если SfM или обучение сорва­
лись с сообщением об ошибке, 
здесь можно попробовать сно­
ва. Иногда это помогает, пото­
му что многие шаги (RANSAC, 
densification) имеют случайные 
компоненты, и со второй по­
пытки получается там, где пер­
вая не сработала. Затем весь 
конвейер запускается заново с 
самого начала — SfM и обуче­
ние, в свежий JSONL- лог-файл. 
Если даже вторая попытка не 
удалась, обычно проблема во 
входных изображениях (слиш­
ком мало, слишком малое пе­
рекрытие, motion blur, плохой 
свет); тогда вернитесь через 
Back и поменяйте материал. 
Совет: параллельно загляните 
в training-логи (Help → Open 
Training Logs), там подробнее, 
где именно застряло.
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C-28 Инлайновый loss-график

ГД Е

В info-панели, правая колонка, виден только во 
время обучения с непустой историей.

Т Е Х Н И Ч Е С К И

Компактная область рисования (высотой 40 пик
селей), рисует историю loss как линию в 1 пик
сель акцентным цветом. Данные фильтруются на 
конечные значения (NaN-защита для нестабиль
ных обучений). Min/Max вычисляются по всей 
истории — график автоматически зумит на диа
пазон значений. Последнее значение loss сидит 
вверху справа над графиком. Сама история на
капливается в app state на каждом training tick 
(обычно каждые 100 итераций).

П Р О СТ Ы М И  С Л О В А М И

Крошечная кривая loss, которая 
на одном взгляде показывает, 
«сходится» ли обучение (линия 
падает вправо) или оно застря­
ло или взрывается (линия плос­
кая или растёт). При здоровом 
обучении линия в начале кру­
то падает, потом выполажива­
ется — это ожидаемый ход, 
похожий на кривую половинно­
го распада. График автомати­
чески зумит на текущий диа­
пазон значений, так что даже 
маленькие улучшения в конце 
обучения остаются видны. Ес­
ли линия вдруг прыгает вверх 
или замораживается, это хоро­
ший сигнал, что что-то идёт не 
так — либо материал проблем­
ный, либо лучше бы подошла 
другая предустановка. График 
вы найдёте в info-панели, кото­
рую показываете вверху слева 
значком i.
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C-32 Discoverability Nudge (подсказка Expert Mode)

ГД Е

В info-панели, правая колонка внизу, видна толь
ко во время обучения И в Simple Mode.

Т Е Х Н И Ч Е С К И

Маленькая строка со значком глаза и текстом 
подписи «Switch to Expert Mode (⌘2) for live 
splat preview», в сдержанном тоне и шрифтом 
10 пунктов. Никакого интерактивного элемен
та, просто подсказка. Не реагирует на щелчок 
— пользователь должен действительно нажать 
Cmd+2 или щёлкнуть меню Mode → Expert Mode.

П Р О СТ Ы М И  С Л О В А М И

Ненавязчивая подсказка, что 
в Expert Mode во время обу­
чения текущая промежуточная 
версия вашей 3D-модели вид­
на вживую в viewport. В Simple 
Mode это сознательно скрыто, 
чтобы держать UI спокойным 
— но многие пользователи не 
знают даже, что такая функция 
существует, поэтому здесь мы 
мягко на неё указываем. На­
жмите Cmd+2, и обучение про­
должит работу в фоне, а вы 
сможете наблюдать, как ваша 
модель складывается на гла­
зах. Это также хороший инстру­
мент, чтобы уже после несколь­
ких тысяч итераций оценить, 
выйдет ли результат хорошим, 
или лучше отменить и начать 
сначала. Cmd+1 в любой мо­
мент возвращает обратно к 
Simple-виду.

Когда переходить к следующему этапу?

Приложение автоматически переключается на Z3 (Preview), как только обучение 
успешно завершено — ничего щёлкать не нужно. Нижняя navigation-панель тогда 
переключается с Pause/Cancel на кнопку Back (назад к Import) и кнопку Export 
(вперёд к Export). В случае ошибок (красное сообщение об ошибке, значок этапа 
— X) вместо этого появляется Retry, и надо решить, начать ли снова или вернуться 
через Back к Import, чтобы сменить материал изображений.
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Z3 — Предпросмотр (повернуть 3D-модель)

Рисунок 38.  Simple Mode шаг предпросмотра с 3D-просмотрщиком

Рисунок 39.  Z3 предпросмотр после окончания обучения — реконструированный син­
тетический букет, заголовок показывает «Training complete — 3,022 Gaussians in 13 s», 

кнопки Back и Export внизу

ЧТО ВИДНО НА ИЗОБРАЖЕНИИ  Хлебные крошки помечают «Preview» как активный 
этап. Полноэкранный 3D viewport рендерит законченно обученную сцену буке
та (синтетический тестовый набор Blender, подмножество 60 кадров из 960 
hemispherical- камер). Заголовочная статус-полоса: «Training complete — 3 022 
Gaussians in 13 s» — даёт финальное число Gaussians и время обучения. Drag 
в viewport вращает камеру (yaw/pitch); колесо скролла зумит вдоль направления 
взгляда. Кнопка «Back» (внизу слева) возвращает к Z2 для resume или re-run; 
кнопка «Export» (внизу справа, primary) ведёт дальше к Z4.

После завершения обучения приложение автоматически попадает в предпро
смотр. Здесь вы видите вашу законченную модель Gaussian Splatting в полно
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экранном Metal-виде и можете её вращать, зумить и панировать мышью и трекпа
дом. Поверх viewport сидит маленький оверлей с управлением камерой и инфо 
— авто-вращение, статистика обучения, кнопка сброса. Перед следующим шагом 
(Export) полезно осмотреть модель с разных ракурсов, чтобы убедиться, что ре
конструкция чистая.

C-36 SplatViewportView (главный 3D-вид)

ГД Е

Полноэкранный фон шага предпросмотра.

Т Е Х Н И Ч Е С К И

Metal-based 3D viewport, рендерящий закончен
ное облако точек. Рендерер — это СОБСТВЕН
НЫЙ ForwardPass- растеризатор RadianceKit, тот 
же самый, который уже рендерит splats во время 
обучения, поэтому это настоящий WYSIWYG (что 
обучено, то и показывается, и экспортируется 
в точности так же). Tile-based рендер-конвейер 
с order-independent transparency. Если рендерер 
не может быть инициализирован (напр., потому 
что Metal недоступен в системе), вместо этого 
появляется чёрный фон с текстом «Metal not 
available». Вид игнорирует safe area, так что мо
дель достигает края окна.

П Р О СТ Ы М И  С Л О В А М И

Главный viewport. Здесь вы ви­
дите вашу законченную 3D-мо­
дель, реконструированную из 
ваших фотографий, рендери­
мую на GPU в реальном вре­
мени. Щёлкните и тащите ле­
вой кнопкой мыши, чтобы вра­
щать. Колесо скролла или жест 
трекпада двумя пальцами для 
зума. Правая кнопка мыши 
или Cmd+drag для пана. Мо­
дель состоит из десятков тысяч 
полупрозрачных 3D-эллипсои­
дов («Gaussians»), фотореали­
стично реконструирующих ва­
шу сцену — у каждого есть 
позиция, ориентация, форма и 
цвет, которым научилось обу­
чение. В редком случае, ко­
гда ваш Mac не поддержива­
ет Metal, вы вместо этого уви­
дите чёрный фон с сообщени­
ем-подсказкой — RadianceKit 
непременно нуждается в Metal-
совместимом GPU.
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C-37 CameraControlsOverlay (оверлей управления)

ГД Е

Над viewport, плавающий.

Т Е Х Н И Ч Е С К И

Компактный UI-оверлей с кнопками для авто-
вращения (turntable), сброса камеры, выбора 
фона (gray/black/white), сохранения скриншота, 
переключения info-панели. Привязывается к па
раметрам камеры (distance, azimuth, elevation, 
target, FOV) и управляет auto-turntable. Во время 
обучения (когда пользователь в Expert Mode хо
чет видеть viewport сопроводительно), оверлей 
дополнительно показывает компактную строку 
статуса обучения.

П Р О СТ Ы М И  С Л О В А М И

Маленькая плавающая панель 
над моделью. Здесь вы за­
пускаете авто-вращение (мо­
дель крутится сама, удобно 
для скриншотов и коротких де­
мо), сбрасываете камеру через 
Reset в стартовую позицию (ес­
ли потерялись), переключаете 
фон (серый для нейтрально­
го, чёрный для максимального 
контраста, белый для светлых 
моделей) и напрямую делае­
те скриншоты, которые сохра­
няются под  /Pictures. Удобно, 
когда хочется показать опре­
делённую деталь с конкретно­
го ракурса, не экспортируя до­
полнительно всю модель. Авто-
вращение также — хороший 
тест того, выглядит ли мо­
дель одинаково хорошо со всех 
сторон, или есть «обшарпан­
ная сторона», возникшая из-за 
недостающих кадров.

C-38 Кнопка Export (панель навигации)

ГД Е

Нижняя navigation-панель в Z3.

Т Е Х Н И Ч Е С К И

Accent-кнопка с меткой «Export» и значком 
share. Щелчок триггерит переключение в Z4. Пе
ред этим parent-вид проверяет, разблокирована 
ли полная версия — если нет, вместо этапа экс
порта показывается lock-вид (см. U-06).

П Р О СТ Ы М И  С Л О В А М И

Когда вы довольны результа­
том, щёлкните Export, и попа­
дёте в последний шаг, где вы­
берете формат и сохраните. 
Без купленной полной версии 
вы вместо этого попадаете на 
экранную блокировку с под­
сказкой разблокировки и кноп­
кой покупки — приложение не 
хочет навязывать вам полную 
версию, но Export — одна из 
premium-функций. Как только 
покупка завершена, приложе­
ние сразу продолжает работу в 
разблокированном состоянии, 
и вы попадаете на привычный 
этап экспорта. Если передума­
ете, через кнопку Back вернё­
тесь к предпросмотру и сможе­
те продолжать крутить модель.
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Когда переходить к следующему этапу?

Перед экспортом проверните модель один раз полностью и проверьте: все ли об
ласти, которые вы покрыли во входных изображениях, на месте? Есть ли парящие 
«floaters» (splat-облака Gaussian, свободно висящие в воздухе)? Чисто ли выгля
дят фон/небо или смазаны? Серьёзные проблемы могут быть исправлены только 
повторным обучением — либо с большим числом изображений, либо с другой 
предустановкой, либо в Expert Mode с настройками floater-reduction.

Z4 — Экспорт (выбор формата и сохранение)

Рисунок 40.  Simple Mode шаг экспорта с карточками форматов

Рисунок 41.  Z4 карточки экспорта — 6 форматов (PLY 742 KB выбрано, SPZ 74 KB, 
glTF 708 KB, .splat 96 KB, Orbit Video, Web Viewer 133 KB), история экспортов в боковой 

панели справа с уже экспортированным PLY
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ЧТО ВИДНО НА ИЗОБРАЖЕНИИ  Хлебные крошки помечают «Export» как активный этап. 
Слева — сетка карточек «Choose Export Format» со всеми шестью опциями: PLY 
(стандартный 3DGS, 742 KB, с полными SH-коэффициентами — здесь предвари
тельно выбран синей галочкой), SPZ (сжатый формат 3DGS, ~90 % меньше PLY, 
74 KB), glTF (с расширением KHR_​gaussian_​splatting, 708 KB), .splat (совместим 
с веб-просмотрщиком через antimatter15, 96 KB), Orbit Video (360° MP4 сцены, 
live-вычисление размера), Web Viewer (автономный HTML со встроенным 3D-про
смотрщиком, 133 KB). Размеры считаются вживую из текущего числа Gaussians и 
overhead формата. Справа «Export History» перечисляет уже завершённые экспор
ты со значком формата, именем файла и timestamp — щелчок открывает в Finder. 
Primary CTA внизу слева: «Export PLY (3DGS Standard)» с подзаголовком про 
Gaussians «2,991 Gaussians · SH degree 3».

На последнем шаге вы выбираете один из 6 форматов экспорта (PLY, SPZ, 
glTF, .splat, orbit video, web viewer) через сетку карточек из 2 колонок, щёлкаете 
Export и выбираете место сохранения в диалоге macOS. Справа идёт история всех 
предыдущих экспортов — при выборе карточки оценочный размер файла сразу 
показывается под каждой карточкой, так что вы, напр., предпочтёте SPZ, если 
хотите идти в веб (маленький), и PLY, если хотите импортировать в другое ПО 
(SuperSplat, Postshot, Blender через плагин) (большой и полный).

C-39 Сетка форматов из 2 колонок

ГД Е

Левая основная сторона шага экспорта.

Т Е Х Н И Ч Е С К И

Сетка карточек с двумя гибкими колонками и 
интервалом в 12 пунктов. Итерирует по форма
там, предлагаемым в Simple Mode — отфильтро
ванное подмножество полного списка форма
тов, содержащее только 6 важнейших форматов: 
PLY, SPZ, glTF, .splat, orbit video, web viewer. 
Compressed PLY и SOG предлагаются ТОЛЬКО в 
Expert Mode.

П Р О СТ Ы М И  С Л О В А М И

Сетка карточек с 6 форматами, 
актуальными в Simple Mode: 
PLY (стандартный формат для 
других 3D-инструментов), SPZ 
(сжатый вариант для веба), glTF 
(официальный Web3D- стан­
дарт), .splat (для веб-просмотр­
щика antimatter15), orbit video 
(готовый MP4 для показа) и Web 
Viewer (автономный HTML-файл 
со встроенным 3D-плеером). 
Так покрываются 90 % вари­
антов использования. Если ну­
жен один из менее распростра­
нённых форматов (compressed 
PLY или SOG для экстремаль­
ного сжатия), переключитесь в 
Expert Mode, там доступны все 
8 форматов. Компактный выбор 
здесь сделан намеренно, что­
бы новички не были подавлены 
разнообразием.
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C-40 Кнопка Format Card

ГД Е

Каждая карточка в сетке.

Т Е Х Н И Ч Е С К И

Простая кнопка с card-раскладкой: значок 
(напр., document zipper для PLY, archive box для 
SPZ, video icon для orbit video) сверху, имя 
формата как заголовок, описание caption (обре
зается до 2 строк), под ним оценочный размер 
файла (вычисленный вживую из формата, числа 
Gaussians и SH-степени, отформатирован как KB/
MB). По щелчку формат выбирается. Выбранная 
карточка получает accent-фон, accent- обводку и 
значок check в правом верхнем углу. Tooltip — 
описание формата.

П Р О СТ Ы М И  С Л О В А М И

По карточке на формат. Щёлк­
нете по одной, она выделяется 
акцентным цветом и галочкой, 
а кнопка экспорта ниже под­
страивает свой текст («Export 
PLY», «Export SPZ» и т.д.). На 
каждой карточке — подходя­
щий символ, имя, двустрочное 
короткое объяснение и оценоч­
ный размер файла для ваше­
го текущего результата обуче­
ния. Размер помогает разум­
но выбрать — если хочется 
отправить результат по почте, 
возьмите наименьший вариант 
(обычно SPZ или .splat); если 
хочется продолжать работу в 
другой 3D-программе, возьми­
те тот, у кого лучшая совмести­
мость (обычно PLY). При наве­
дении на карточку tooltip пока­
зывает более подробное описа­
ние — если различия между 
форматами кажутся вам неяс­
ными.

C-41 Слайдер длительности видео

ГД Е

Под сеткой форматов, виден только если выбран 
видеоформат (orbit video или social video).

Т Е Х Н И Ч Е С К И

Слайдер 3–30 секунд с шагом 1 секунда, привя
зывается к длине видео в app state. Максималь
ная ширина 300 пикселей. Показывается только 
если выбран видеоформат. Для не-видео форма
тов слайдер полностью удаляется из вида — без 
мёртвого пространства.

П Р О СТ Ы М И  С Л О В А М И

Если в качестве экспорта вы 
выбираете orbit-видео, здесь 
можно задать длину. 3 секун­
ды = очень быстрое вращение, 
30 секунд = медленное, спо­
койное вращение вокруг вашей 
модели. Для социальных reels 
(Instagram, TikTok) обычно 6–10 
секунд идеальны — достаточно 
долго, чтобы показать модель, 
достаточно коротко, чтобы зри­
тели не отскочили. Для пре­
зентаций или портфолио-видео 
можно смело взять 15–20 се­
кунд. Слайдер появляется толь­
ко если выбран видеоформат; 
для файловых форматов вроде 
PLY или SPZ это было бы бес­
смысленно, и он скрыт.

230 / 235



R A D I A N C E K I T Глава 10 — Режим новичка

C-42 Кнопка Export

ГД Е

Под сеткой форматов (и под слайдером длитель
ности, если выбрано видео).

Т Е Х Н И Ч Е С К И

Большая accent-кнопка. Метка: «Export {format-
name}», значок share. По щелчку открывается 
save-диалог macOS с подходящим формату рас
ширением и именем по умолчанию «scene.
{ext}»; при подтверждении экспорт пишется в 
выбранный URL. Деактивирована, если нет ре
зультата обучения или уже идёт экспорт.

П Р О СТ Ы М И  С Л О В А М И

Щелчок, выбор места сохра­
нения в диалоге macOS, гото­
во — приложение записыва­
ет файл в выбранном форма­
те в выбранное место. Имя по 
умолчанию — «scene.{расши­
рение}» (напр., «scene.ply» или 
«scene.spz»), его можно изме­
нить в диалоге как угодно до 
сохранения. Кнопка серая, по­
ка ещё нет результата обуче­
ния (здесь такого случиться не 
должно, иначе вы бы не были 
на шаге экспорта) или уже идёт 
другой экспорт. Как только экс­
порт идёт, под ним появляется 
индикатор прогресса; прило­
жение остаётся работоспособ­
ным, так что вы можете уже го­
товить следующий экспорт.

C-43 Прогресс-бар экспорта

ГД Е

Под кнопкой экспорта, виден только пока идёт 
экспорт.

Т Е Х Н И Ч Е С К И

Индикатор прогресса с максимальной шириной 
300 пикселей, под ним подпись «Exporting… N 
%». Значение бежит от 0 до 1 и обновляется при 
записи — у PLY кусками по 10 000 Gaussians, у 
SPZ один раз после квантования, у orbit video — 
в frame-интервалах.

П Р О СТ Ы М И  С Л О В А М И

Пока идёт экспорт, здесь видна 
тонкая полоса прогресса плюс 
отображение процентов. PLY 
обычно готов за секунды, пото­
му что файл просто записыва­
ется двоично. SPZ длится чуть 
дольше, потому что данные при 
этом квантуются и сжимаются. 
Orbit video — самый затратный 
по времени экспорт — здесь 
каждый отдельный кадр пере­
рисовывается; в зависимости 
от разрешения и длины мо­
жет уйти минута или больше. 
Во время экспорта приложение 
остаётся работоспособным, так 
что можно уже готовить следу­
ющий формат или продолжать 
щёлкать в viewport.
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C-44 Отображение ошибки экспорта

ГД Е

Под прогресс-баром, виден только если при по
следнем экспорте произошла ошибка.

Т Е Х Н И Ч Е С К И

Красная строка со значком warning и текстом 
ошибки. Красный фон с 8 % opacity, скруглён
ные углы. Максимальная ширина 400 пикселей. 
Распространённые причины ошибок: SOG ожи
дает cwebp  в системном PATH (не совместимо 
с App Store); ошибка записи при полном диске; 
sandbox-ошибка с целями сохранения вне разре
шённой области.

П Р О СТ Ы М И  С Л О В А М И

Если экспорт срывается, здесь 
красным появляется краткое 
описание проблемы простым 
языком. Обычно причина оче­
видна — нет места на диске, 
нет прав на запись в целевую 
папку, или цель вне разрешён­
ных sandbox-областей. Кон­
кретно с форматом SOG быва­
ет, что cwebp  отсутствует в 
системе; в этом случае SOG 
непригоден, и придётся отка­
титься к SPZ. Если сообщение 
об ошибке неясно, посмотрите 
в лог-директорию (Help → Open 
Training Logs), там подробнее 
описано, что пошло не так. В 
сомнительных случаях помога­
ет просто выбрать другое место 
сохранения — напр., рабочий 
стол.

C-46 Список истории экспортов

ГД Е

Правая сторона шага экспорта.

Т Е Х Н И Ч Е С К И

Список по истории экспортов (персистентен как 
JSON в UserDefaults, поддерживается после каж
дого успешного экспорта). Каждая строка пока
зывает format badge (маленький, accent-цвета), 
timestamp (HH:mm), имя файла (обрезается до 1 
строки) и форматированный размер файла. Щел
чок по строке открывает Finder с выбранным 
файлом. Пустое состояние: «No exports yet».

П Р О СТ Ы М И  С Л О В А М И

Список ваших предыдущих экс­
портов — формат, время, имя 
файла, размер, в хронологи­
ческом порядке. Щелчок по 
строке, и файл подсвечивает­
ся в Finder — без необходи­
мости самому навигироваться 
по папкам. Удобно, когда час 
спустя снова нужен последний 
экспорт, и вы уже не знае­
те, куда сохранили — история 
это помнит. Если вы ещё ни­
чего не экспортировали, здесь 
стоит дружелюбная подсказка 
«No exports yet». Список пе­
реживает перезапуски прило­
жения, потому что хранится в 
UserDefaults.
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C-48 История контекстного меню (правый клик)

ГД Е

Правый клик по строке истории.

Т Е Х Н И Ч Е С К И

Контекстное меню на каждой записи списка с 
двумя действиями: «Reveal in Finder» (открыва
ет Finder с выбранным файлом, как одиночный 
щелчок) и «Copy Path» (помещает полный путь 
файла как текст в буфер обмена). Последнее 
полезно для drag-and-drop в другие приложения 
или для передачи в командную строку.

П Р О СТ Ы М И  С Л О В А М И

Правый клик по записи исто­
рии открывает маленькое меню 
с двумя действиями. «Reveal in 
Finder» делает то же самое, что 
обычный щелчок — открыва­
ет Finder с выбранным файлом, 
чтобы вы сразу его увидели. 
«Copy Path» помещает полный 
путь файла в буфер обмена, 
чтобы можно было его, напр., 
вставить в команды термина­
ла, в другие приложения или в 
заметку. Особенно удобно, ко­
гда вы хотите передать экспорт 
кому-то или открыть в другой 
программе, работающей с вво­
дом пути. Функционально ма­
ленькая, но полезная деталь, 
делающая ставку на типичные 
для Mac паттерны взаимодей­
ствия.

Когда рабочий процесс завершён?

После успешного экспорта у вас есть ваша 3D-модель файлом на диске, а в 
истории появляется новая запись. Нет кнопки «Done» — можно последовательно 
сделать любое число экспортов в разные форматы без повторного обучения. Если 
хочется вернуться к предпросмотру (напр., чтобы ещё раз проверить перспекти
ву камеры), используйте кнопку Back в нижней navigation-панели. Если хочется 
начать совершенно новую сцену, через Back вернитесь к Z1 и используйте там 
Clear All, либо File → New Project (Cmd+⇧+N).

Переключение в Expert Mode

В любой момент нажмите Cmd+2 или выберите Mode → Expert Mode ( M8 ). Сохра
няется всё состояние: импортированные изображения, выбранная предустановка, 
идущее или законченное обучение, готовое облако точек, история экспортов, да
же текущий этап. В Expert Mode вместо четырёхшагового этапа показывается пол
ная боковая панель Инспектора со всеми ~150 полями управления. В частности: 
Project Navigator (см. главу 2) предлагает расширенные операции с изображения
ми (кнопка минус, удаление backspace, отмена Cmd-Z, предпросмотр Quick Look), 
живой предпросмотр в viewport во время обучения, а также все параметры loss, 
MCMC, densification и Mip-Splatting. Cmd+1 переключает обратно в Simple Mode — 
при этом тоже не теряется никакое состояние.
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Часто задаваемые вопросы

Почему моя кнопка Start Processing остаётся серой?

Вы ещё не импортировали ни изображений, ни видео. Перетащите хотя бы один 
файл в зону дропа или используйте «Browse Files». Как только список изображе
ний справа содержит хотя бы одну запись, кнопка становится активной. (С всего 
1–2 изображениями старт сработает, но SfM сразу прервётся с ошибкой — см. 
красный валидационный баннер.)

Почему моя кнопка Export заблокирована?

В Simple Mode есть два уровня: (a) Если training-конвейер ещё не завершён и 
у вас его нет, кнопка деактивирована — сначала надо завершить Z2. (b) Если 
полная версия ещё не куплена (PurchaseManager.hasAccess == false), вы вместо 
этапа экспорта видите lock-вид со значком замка и кнопкой «Unlock Full Version», 
открывающей purchase-sheet. Предустановки Quick и Preview позволяют обучаться 
бесплатно, но экспорт — премиум.

Почему я не могу выбрать предустановку?

Можете выбрать — но если нажмёте на premium-предустановку (Balanced, Quality, 
варианты MCMC) без купленной полной версии, picker автоматически отскочит 
обратно к Preview, и откроется purchase-sheet. Quick и Preview — единственные 
свободно используемые предустановки.

Почему моя зона дропа пустая и пунктирно-серая, хотя я перетаскиваю в неё 
изображения?

Вероятно, расхождение типа UTI. Приложение принимает JPG, PNG, TIFF, HEIC, 
MP4, MOV плюс собственные splat-форматы приложения. Другие форматы изоб
ражений (BMP, GIF, WebP, RAW-форматы) НЕ распознаются. Если уверены, что 
ваш тип изображения должен включаться, проверьте расширение имени файла — 
приложение в первую очередь ориентируется на расширение, а не на содержимое 
файла.

Почему SfM длится так долго, хотя у меня всего 30 изображений?

Apple Photogrammetry не масштабируется линейно — при определённых констел
ляциях изображений (помещения со сложными текстурами, motion blur, плохой 
свет) она длится значительно дольше, чем подсказывает число изображений. Если 
SfM с 30 изображениями всё ещё висит через 10+ минут, прервите и попробуйте 
снова с лучшим материалом, либо переключитесь в Expert Mode и попробуйте 
COLMAP/Native SfM (Cmd+2 → Inspector → Camera Alignment).

Где я найду свои training-логи?

Help → Open Training Logs (Cmd+⇧+L). Это откроет ~/​Documents/​RadianceKit/​Logs/​
. Каждая сессия обучения пишет собственный JSONL-файл с timestamp в имени 
файла — первая строка — конфигурация, затем каждые 100 итераций идёт 
progress-строка, последняя строка — summary с финальным loss и success-фла
гом.
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